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L,· Overview 

• Visual Basic Tools 

• Building a Simple Visual Basic Application 

• Visual Basic Menu Commands 

Overview 
The purpose of this module is to introduce you lo thc h:l'y l'kllll'lliS or Visual HasiL'. 
This is not intended to be an cxhaustivc rcvicv .. · of al\ ft1nctions and tools: rathcr. it 
is designed to gct you up and running on tl_1c prmJuct. l.:ttcr modules will rlesh out 
all of the details that you nccd to know to beco111c Visu;d Basic programmcrs. 

The bcst way to learn about Visual Basic is to rcvicw thl' individual functions in 
each major portian of the Visual Basic interface amlthcn w;dk through thc stcps 
you should follow 10 develop an application. 

The module is divided into thrcc majar scctions. Thc fir:-.1 111ajor scction is a kcturL· 
about the clemcnts ofthc Visual Basic application that ynuusl' in thL! crc;Jtitm 111· 
t~pplications. Thc sccond is a dclllOilSiration \vhnc tht· tr;LÍII~·r w;dl.;s yntl tiiHHI)!h tlll· 

applicalÍOil dcsign proccss ami you cnd up with a (Oillpilcd l'.\l'L'lllilhl~: rik. Thl' 
tin;.¡J SCCIÍ(In ÍS :1 lah thal givcs ytlll handS·tllllll'al'IÍl'L' IISÍII~ Stlllll' tlfllll' ltHlb 111:11 

you ha ve jusi hccn introduccd tu. 

Prerequisites 
There are two kcy skills that you nccd for succcss in this 111oduk·: 

• Practice in using a mousc 

• Understanding of graphically bascd appliccllit>ns 

Overall Objective 
At the cnd ofthis module, you witl ha ve succcssfutly LIL';Ill'tl ytnlr lirst Viqt;tl l{;~. ... it 
application. 
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Learning Objectives 
,\tille cnd of tilis rnouule. you will be ablc to: 

'• ... ;.;. 

• J)l.·sign an application user interface ~sing the Fonn window, Toolbox, toolbar, 
ami Propc11y window. ~ 

• N;nnl' ;111d save 111~ ,applicJtion's fopps apd projcct files. 

• St;11t anJ stop an application frorn the Visual Basic menu and/or thc loolbar. 

• ( ·rl';I[L' anexcnnablc file o.tnd <.H.Jd it to u Wintfows group. 
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• Form and Project Windows 

• The Toolbox and Properties Window 

• The Toolbar and;Code Window 
·~ . . . 

. ¡ 

--------~---_, _____ _ 
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Form and Project Windows 

·; 

(!) ~ ·• 

GJIJ!m'l 
l.'!"~• mn 
, • .., .•), ¡;;¡ 

j;;;].~ ~ 
r. [J • 
~ Flt!F!J 

ICi Forml -- ' DIIJ 

------·-------------------------~ 

What ls a Form? 
Fonm are !he hcarl nf a graphically based application. Thcy are what thc user sces 
<liltl iltln<KIS wi!li in ordcr to accnmplish .">omc task. Thcy are also thc place whcrc 
yo11 hl'J..'io In huild ;¡pplications: un tlwm you place controls-commanc.J button.s, list 
hll.\l' ...... ~~ption hultllllS-that prcscnt thc uscr witll tlle choiccs th<ll thcy llave. 

What ls !he Project Window? 
TIK' l'rojecl winlhHv is a list tllat Visual I3asic uses to kecp track of thc forms that 
you <lll' 11sing for your application. You will ha ve us many .FRM files listed in the 
Projl'rt window as you ha ve fonns in your application. In addition you may ha ve 
otlrcr file_,_ .llAS and . V!3X filcs-but wc will hold off talking about thosc for a 
little while. 
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Pointer 

Label 

Frame 

Check Box · 

Combo Box 

Horizontal Scroll Bar 

Timer 

Directory List Box 

Shape 

lmage 

Custom Controls (·.vsx) 

What's in the Toolbox? 

o • 
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tE 
El 
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Picture Box 

.Text Box 

Command Button 

Option Button 

Lis! Box 

Vertical Scroll Bar 

Orive Lis! Box 
... 

File Lis! Box 

Une 

Data Conlrol 

As thc name suggests, thc Toolbox is whcrc you. go to g.et thc hasic clemcnts of 
every Windows-based application you crcalc in Visual llasic. 

There are two ways that you can place controls im a f¡JnJl, ~.:ither by doubk-clickin~ 
· the control too! in the Toolbox or by clicking and dragging lhc control. For 1hc n1oSi 

part, eithcr method has thc samc rcsult. Whcn you douhll'-dick a tuol, thc coutrol 
ShOWS Up in the middJC Of the fonn: SO YOll thCil.IJ<.JVC (ll tlrat! tlJL' C(lll!rol lo tJH.: 

correct position on thc form. 

Each control that you place on a form has a sct or pmpntics tllat you can tL"l' in 
arder to gct thc right "lonk ami red" for your applic1ti"''· hn·tfll· tinu .. ; hei11~. ;di )'PI! 

ncct..l to know is that thcrc are propenies 10 cach corHnd. In latLT nwLluks you will 
gct a much closer loo k at tl1c most C(lll1/1HJ/l 1 y tt.'\L'd pn •Jh ·r 1 it·s f, n· r lH 1st ( ¡f 1 lrt~ ¡, ., •ls i 11 
thc Tootbox. 

Custom Controls 
You can add controls to the Toolbox. Some thin.J partiL·.s h;rvc crc~rted custnm 
conti-ols that you can purcha.sc sc.parately. Thc l'rofcs.si,•n;d cdition of Visual H;1:-;k. 
contains various custom controls. 

L To Add a Custom Coptrol 

l. From thc File mcnu, clloosc 1\dd File. 

2. Select the appropriate file. Custom Control files ha"" a . VIL\ cxtcnsioll. 

3. Choose OK. 

•> 
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What Are Properties and How Are They Set? ., 
Propcrt ies for a control are set using the Propenies window: 

L.'~_~To .1\l'l propcrlies 

! . Click tllc control whosc properti~s you want S~.t. 
., 

1 Scroll thc Propcrtics lisl on the Properties window until you find the property 
y!ltt want to set arHJ sclcct it. 

• ~ ¡ 

:1. l'lacc 1hc valuc f<lr tlic propci1y in the Scttihgs cómbo box. 

4. Click thc check box to the Jcft ofthc'Sc'ttings·co.mbo box. 

Whatls the Toolbar? 
Thc [!l()lhar proviUes quick acc.css to common commands or functions. These 
functi11ns-likc .'\aving projccts antl starting the application during thc dcsign phasc 
·-;~re als!l ;~vailahlc rrorn thc Visual Uasic mcnus as wcll as through acccss and 

:--Ji¡>l'lcut kcys. 

t\JÍIIl' of lhl' fCic\';tll[ ÍICillS Oll thC too] bar are. 

·¡·uull,ar Ml'IILI p;llh Shnl'll'lll kcy.o.; 

1\]l'\\'' h lt 111 Fromthc File mcnu. n/a 
¡;huosc New Form. 

i'lt:\\' tvl1 1dult: From thc File mcnu, n/t~ 

chomc Ncw Module. 

( J¡H.'II 1 'H ljl'L'I h·o¡n thc File mcnu, n/a 
duxJ~c (Jpcn Prujc¡;t. 

St~\"l' I'H 'lt:1. . ."1 from thc File menu. n/a 
< choose S ave Project. 
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Toolbar 

Menu Design window 

Properties win~ow 

Start 

Orca k 

End 

ivtcnu Path 

from the Windmv mcrru. 
choosc M en u Dcsign. 

Frorn the Wintlow,rncrnr. 
choosc Propcnics.~ 

Frorn the Run lllcnu. 
choosc Run. 

From lhc Hun llll'IHI. 

choo...;c Un.:ah.. 

From the Run mcnu. 
choo.se End. 

Shurll'UI 1\.cys 

('"fl~ l. + i\'1 

Note The restofthc functions dcal witl~ dchugging iuhl will hL' L·m-crcd durin¡2 tllal 

module. 

Position and Size Coordinates 
Visual Basic displays thc coordinatcs for the uppcr-lcrt l'1rrncr frrr cach C!llltmlrllr 

the form rclative to the insidc' uppcr-tcft comer of thc f,lrtll. lt al so display~ thc 
width and height ofthe control. You can sct thcsc valuL·~ hy placing thc furm or 
control approximatcly whcrc you want it, or you can spcL·iry LL'I't amJ Top 
coordinates from the Propertics Jist. The unit of mcasurL'JllL'Ill is in twips (thcrl' al'l' 

1,440 twips in aií.inch). You will finJ out latcr th.at youL·;JII changc this unit of 
measurement to something you are .nl'ore familiar'with . 

What ls a CodeWindow? 
Codc.windows display thc codc that implcJllL'II[S your ;tppiÍL'iLIÍilll. ¡\[ rirst ( ·,nlc 
w.i,ndqws oniY canta in the tcmplatc for proccdurcs and túnctions: yuu will add lllPt"l' 
code to them as you dcveJqp your application. Titen.! ;m· :-oc\'cral ways to opcn ;r 

Code window. The casiest way is to doublc-click tlw ohjl'l·t wiltJ.'C codc )'tlll w;tnt ¡, 

vicw. For cxamplc, to locatc thc Clitk cvcnt tcmplatc fnr <lL·onHnamJ huttPll. 

doublc-click thc command button on thc form Uuring dc:-.i);!ll tilllc. 

~ ~ · ·· ' · Form1.frní · · · . · ICIIS 
Object: 

Sub Cotnmandl_Click () 

1 

End Sub 
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Building a Simple Visual Basic Application 

lit · · 'Helio, .World! . llle:J 

" 

Walk Ttlrough-Building a Visual Basic Application 
L To slarl \I'()J(LI) 

l. hornlhe Walk Throughs progmm group, slart WORLD. 

Thc purpuse of lhis little applicalion is lo givc you a chancc lo walk lhrough 
111ostof thc nwjor stcps n~ed~d for dcvcloping a Visual Basic application. 

llow docs thc arplication work? 

Jt has one tcxt box and two command buttons. 

, Cllonsc thc hll button. 

Whcn thc u ser clicks lhe bulton, tcxt is rcvcaled in the text box . 

. 1. Clloose thc Clcar hutton. 

\VI ~en lile u .... cr dicks tllis bullon, thc tcxt in thc tcxl box is ch:arcU. 

4. ()uit the WORLD application. 

hulll thc Control menu, choose Clase. 
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L To start Visual Basic 

1. Double-click thc Visual Basic icon. 

Visual Basic wi\1 sta1t with a blank form1H1 thc ~l-rt'l'll. 

2. Resize the form to: 

Height 

Width 

2700 

4065 

I To dcsign thc base rorm 

Thc lirst Stcp in dcsigning thc uscr intcrfan: is 111 ;-.1.,'[ thl' prupl'rtics rm tlil' 

npplication's base form. lnthis case, sct thC propntiL·s ftlr thL' Helio. \Vt1rld! 
form. ' 

l. In thc Propertics window Propcttics list, sclcct Bac~Colnr. 

2. Click the ellipsis ( ... ) at thc cnd oi' thc tc.xt hox. 

3. Selcct a shade of grecn. 

The background of thc form turns grccn. Sc1ccting any color will automaticall1 
hidc thc color. palcttc. 

4. In thc Propertics list box, sclect Caption. 

5. In thc teit box, type 1-Icllo, Wor1d! 

The Form tit1e bar wi11 contain Helio, Wmi<l' 

6. In the Propertics window Propc1tics list. sclt:ct N~tllll'. 

7. In the text box, type fnn Wor1d 

I To add controls and sct propcrtics 

To crcatc thc rorm's controls, doublc-click thc appropri;1tt' ht1tl1111S inthc Toolho.\ 

l. Doublc-click thc command bunon too\ inthl' Toolh11.\. 

2. Set the following propcrties: 

Caption Fill 

N<IIIIC Cllldl'ii\ 

FontS izc 1 X 

3. Move the Fill button to thc uppcr-rigiH cmnt.:r uf tlll' !"tn·lll. 

25 
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-1. 1 '"""le-c/id 1hc cornmanu butlon too/ in the Toolbox. 

5. SL'I lhl' following prope11ics: 

Ciiplion 

N;Hllt' 

Clcar 

crnuCiear 

IX 

1>. M""" !he Clc:~r hu !Ion ro the lowcr-right corncr of the form. 

7.· 1 >ouhk-click tlu: tcxt box too/ in thc Toolbox·. 

X. SL·lrlle fn/Jov.'ing propc11ics: 

N;'r'll' 1.\tllux 1 

De/ele aríy text.in thc text box for this propcrty. 

Í: To add lhc Basic ende to cnaiJic thc controls 

In 1/1is sic p. couc wil/ be adued to activa te the functionality ofthe contro/s in the 
"""'· The codc will enab/e thc tcxt box lo be filled with the words Helio World! 
whcn 1/ic uscr clicks thc Fil/ butlon and enable thc text box 10 be cleared whcn thc 
user dicks the Clcar button. 

l. 1 J"~rhle-did thc Fil/ butlon that youjust crcatcd to open thc Code window.: 

W/rc11 Y"" u"uhlc-click this cornmand button, Visual Basic brings you directly to 
1/ic ICillplatc 1"11r a proceuure that responds toa Click event for this control. The 

. ll<~rllL'S o( cvcnl proccdurcs fo/Jow thc pancrn: 

:-.;11h ,fijectname_eventname () 

In this case thc procetlurc ís namcd: 

~-:lit) ':mr!F'ill_Click !) 

Al."o note tlwt Visu<c~ll3<1.Sic pro vides thc statcmentthat cnds thc subroutine: 

/11 tl1c gruphic bclow, notice that the objcct na me shows up in thc Objectlist box 
on rile lcft, Wlll tlle evcnt namc shows up in the Procedure list box on thc right. 

· · .. 'frmWorld.frm · . ' ·· 1111 
OI.Jjecl: 

.Sub cmdFill Click {) 
1 

End Sub 
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2. Add the following code: 

AUU a line of cmk bctwccn thc (\V{) lincs !Ir thc IL'IIljlLilL' r(lj' tllt; Clkh: l'\\'111 

procCdUfC. 111iS CüdC giVCS lhC appliCatiOJl tlJC targcl for \he ilclÍOil (i'illillg lhL' 
text box) and the contents that you want assigncd Hllhl' te.\t hox. In this c;1sc. 

"Helio, World!" is tbe contents. 

3. In tbe Objectlist box, select cmdCicar. 

4. Add tbe following text: 

txt:.Boxl.Text = "" 

Insi<.Je the templatc for this Click cvent proceJun:. add a linc or cmJc to giw tilL' 

application the target for the action (clearing thc tc.\t hox) ~111d thc contc1Hs tllat 
you want assigned to th~ text box. In this case thc contL'nL..; is an cmpty 
string (""). 

L To savc your work 

Befare you create an executable vcrsion of this Visual IL1siL· application that yo u 
can·run directly in Windows, you shou\J savc thc somcc l·mk ltl disk. You \vill dtl 

this through two actions-saving thc form and savin~ lhl' pro.iel'l. 

l. Fromthe File menu, choosc S ave File As. 

File !::!ame: l 
ri.-=F=cRM:-:-------,~ ce OK 

1 Cancel 
c:\walkthru\samples 

Directories: 

[ ... ) 
[-a-) 
[-e-] 
1 -d-) 
[-z-] 

1~ 
2. Make the curren! dircctury C:\WALKTIIRU\SAMI'I.I·.S 

3. Save the file as WORLD.FRM. 

4. Choose O K. 

5. From the File menu, choose Save Projcct As. 

6. Save the file as WORLD.MAK. 

7. Choose O K. 
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L. To 111akl' an cxccutahlc file 

To CIL';tll' an cxccutablc file, makc su re thc sourcc codc for the projcct is open in 
Visual Basic. 

l. ¡.,.,,, tilc'Filc mcnu, choose Make EXE File. 

' M<1ke tile cuJTeJJI clireclory C:\WALKTHRU\SAMPLES . 

. \. S;J\'e lile file"-' WORI.D.EXE. 

-L ( 'ltoti.'\L' OK. 

,.;;, r..·Jintmize Visual Basic. 

I To ."ilarl thc cxccutable from \Vindows 

You can . ..;tart an cxccutablc file from Windows in two ways: 1) crcatc a program 
J..!l'tHrp. :tnd ;ald !he n;unc of thc file lo !he group; or 2) swn Progr;.tm Mou1;.1gcr. opcn 
thc hk rllt:nu, anLI dwosc thc Run command. Wc'll use thc tirst mcthod. 

l. Front thc Progmrn Manttgcr File rncnu, sclcct Ncw. 

TIJe New Progr<1111 Objccl clialog box appears . 

...., Sclect thc Program Group option. 

~- ( :¡1011.'\C OK. 

Thc Prograrn Gmup Propcrties dia!og box appears. 

lnthc Group Propcrties Dcscription control, namc the group something likc 
S!\MI'I.ES. . 

~- In the Group File control.type SAMPLES 

) . C:hoo~c OK. 

A hlank WÍIHJow wil/ appcar. 

h. h·om thc Program Manager File mcnu, choose New. 

The Ncw Program Object clia/og box appears with tile Program ltcm option 
.... e ILT 1 l'll. 

7. Choo~e OK. 

The /'n •gram liems Propertics clialog box appears. 

X. ~ame thc application. 

In tilc Description control, na me the application WORLD or another name that 
ref/ects its function. 

Nmv comes thc trie k y pan. You necclto ilclp Winclows /acate thc exccutablc lile 
that you creatcJ. 

lJ. ('lit· k thc Brmvsc button. 

Tl1c Hrowsc. winJow wi/1 appcar. 

111 .. ';c·kct drivcs anu directnrics lo loca1c WORI.D.EXE. 

/t "''""'"he i11 C':\WAI.KTIIRU\Si\MI'I.ES. 
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11. Chaase OK.----

The Program ltems Propcrtics Jialog bo.x appcars wirh \VOI<I.D.EXE inllw 
Command Line tcxt box. 

12. Choose OK. 

29 

The SAMPLES Program Group will appcar conlilÍIIÍil).! \V( H\1 .D ;mJ a prosr;11n 

icon. 

L Ta run yaur app1ication 

• Daublc-click thc World icon. 

The Helio, \Vorld! application will star1 inthc: s;unl' '-CI'L'L'Il ltlCation \l..'lll'r'l: tlll' 
form was crcated. 

L To stop your app1ication 

l. Click the Control mcnu in thc urPer-tcft comer of lhl' 1 kilo. \Vorld! fnrm. 

A mcnu will appcar. 

2. Chaase the Clase cammand. 

Windows clases thc app1ication for you. 
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Visual Basic Menu Commands 

• Managing Forms and Projects: The File Menu 

• Editing Visual Basic Cede: The Edil Menu 

• Testing Applications During Development: The Run Menu 

• Visual Basic Window Management: The Window Menu 

• Getting More lnformation: The Help Menu 

1 n 1 11 1 k r 11 1 dcvl' lt 'P 1 h~ si rnpk:-.1 of ~1ppl icat ions, thcrc are a numbcr of V isu;.ll llasic 
L'tnJnn;u¡d:-; that you ncccJ to knmv about. Bclow is a brief listing of these commands. 
TIK· list is not cxhaustivc: thcrc are a couplc of tapies that ha ve been lcft toa later 
llh1duk 

'-

Managing Forms and Projects: The File Menu 
11 ;\dding a Ncw Fürm 

Fik rncnu, Nc\v Form· 

• ;\dding an Existing Fonn toa Projcct 

l'ilc "'"""·A u u File 

• 1 klcting a Forrn from a Projcct 
¡:jlc menu, Rcmove File 

• · rvlaking an Exccutab/e File 

hk "'"""· MaKc EXE File 
• l'rinting CoJc 

File rnenu, Print, selcct Code option 

• l'rinting Forms 
File rne11u, Print, select Form option 

• Saving a File and Narning It 
¡:¡k rncnu, S ave File As 

• Savii1g a Form 
l'"ilc lllCilU, Savc File 

Note .'iavi11~ a file does 11111 nwanlhailhc prnjcc1 is a !so savcd. 

• \;rvrng a l'ro_jcL"l 

Frie mcnu. Savc Project 

• S:rving a Proj~ct ;mJ Naming lt 
¡:¡¡1.' lllL'Illl, Sav~ Projcct As 
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Note A Walk Through showing you how to savc a k>.t vn.-.ion (Ir thc t.:od~ i~ 
locatcd at the end of this po11ionnf thc module. 

Editing Visual Basic Cede: The Edil Menu 
• Scarching Codc for a Tcxt String 

Edil mcnu, Find 

• Searching and Replacing a Tcxt String 
Edil menu, Replace 

• Culling and Pasling Texl 
Edil menu, Cut, Copy, and Paste 

• Undoing Changes 
Edil menu, Undo 

Testing Applications During Development: The Aun Menu 
• Starting the Application 

Run mcnu, Start 

31 

N atice the changc in thc titlc bar whcn you sclcct this option to inUic1h.~ tlwt ytnl 
are now in Run mode. 

• Slopping !he Application 
. Run menu, End 

Visual Basic Window Management: The Window Menu 
• Displaying !he Properties Winuow 

Window menu, Propcrtics 

• Displaying !he Toolbox 
Window menu, Toolbox 

• Displaying the Projcct Winuow 
Winuow mcnu, l'rojccl Winuow 

• Displaying the Color Palcnc 
Window menu, Color Paleue 

Getting More lnformation: The Help Menu 
• Using !he Help Tahle oi' CorHcnts 

Hclp mcnu, Contcnts 

• Searching for a Spccii'ic Topic 
Hetp menu, Search 

• Locating Product Su'pport Infonnatinn 
Help menu, l'roduct Suppo11 
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Walk Through-. Saving a Text Version of Code 
l'l'tll'L'dur;d progranuners are uscU tn sccing al! of thcir codc in onc place. 
1\L:IllL'Illht.:r. hmvcvcr, that thc codc is not cxccutct.l in thc ordcr it t~ppcars in thc tcxt 
rile yo u cn:ate hcn.:. lt is sti!l cvent-drivcn'cot.lc. und the tlow of exccution still 
dcpcnds on user am.l systcm cvcnts. 

L. To sa\'l' a tcxt \'crsion of codc 

l. Rcstorc Visual Basic. 

1 1 'n" 11 1 he File mcnu, choosc Open Projecl. 

\. l lpc·11 WORI .1 l.MAK, locatcu in 1\VALKTHRU\SAMPLES. 

J.,•all !he S<nnpk project that you ha ve just completed, but do not run it. 

.'i. htnn lile Projccl winJuw, sclcct.WORLD.FRM. 

Ma•c su re tila! you sclcctthc CO!TCCI file. When you loau a projcct, lile tirst lile 
in thc list is sclcctcd by dcfault. 

h. h·onJ the File mcnu. choose Savc Tcxt. 

Visual l3asic will give your text file the same nume as the form, in this case 
\V( ll{ 1 .D.TXT. Tlwt wi 11 probably Jo in most cases. Makc su re that yo u savc 
tlic· fik tolla: 1\VALKTHRU\SAMPLES subdircctory. 

7. ('h1111;.:L'ÜK. 

X i'vlinilllÍZC Vistlill Basic. 

1J. lkltll'll to Progr:tm Manager. 

JO. In lliL' ;\cccssories group winc.Jow, open Notcpatl. 

1 l. htnn tlle File rnenu. Choosc Opcn. 

Use lile Opcn Jialog box to locatc WORLD.TXT. 

1 ~. Chot1se OK. 

This loaJs WORLD.TXT into Notepad so that you can revicw thc codc. 

11' you v.:ant to print ende dircctly tn a printcr. choosc thc Print commancJ from 
lile Visut~l Uasic File mcnu. 

You can print just the form or code or both for the curren! file, or you can print 
all fonns or coJc or both for your cntire application. Remcmber, howcvcr, that 
.H1\S files do nnt llave a l'orm associatcd with thcm, so in this case you will only 
he al1lc to print codc. 

L Tosa n• a tcxt vcrsion of propcrtics and codc 

Yt 111 r<.lll ;ti so savc tlle form \vith thc propc11ics and codc in a tcxt file. 

l. ~'~•"" Visualllasic, opcnthc projcct WORLD.MAK in 
\IV t\ 1 .r;TIII{l lUGII\SAMPLES. 

1''""'''"' l'n•jo·ct windmv, scl,·,·t \VOIU .D.FRM 

·L Sell't.'! liJe clteck bux Save ;\s Tcxt am.l chuosc OK. 

:'\. Tlll' l'orrn is sa\·ed in tcxt forma t. Thc cxtcnsion .FRM is uscd. 

r .. t lsl' Nt11cpaU to compare the two tcxt files. 

' 
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Walk-Through -. Using VisuaiBasic-Help 
L To use Hclp 

l. From the Visual Basic Hc!p mcnu. clwu~c Cc1nlc1H:-. 

The Visual Basic Hclp wincJow appcars. This wind,i\\' prm·idt.:s a hricf lopic;d 
tour of the majar componcnts of Visual ll•"ic. 

A topicallist thm might be of intcrcst tc1 )'tHI is Pni)!I":IIIHllÍn!-! l.angua~L'. 

2. Choose thc Programming Languagc topiL·. 

Infonnation on that topic appcars in a wintlow. 

· 3. Choose the Beep Statcmcnt. 

Language rcfcrencc material on thc purpose. use. illlli ,..,,.llliL\ nf this statclllCill 

appear on scrcen. 

I, To use thc Search command 

33 

Like Standard Windows Hclp, thc Visual Basic 1-lclp sy.-..!L'Ill h;1.-. a Scarch corn1n;tnd 

on the Hclp scrccn. To use Scarch. siniply type in thc ll'l'nl you ¡¡re Jooking lúr. 

l. From the Visual Basic Hclp window. clwos~ Searcll. 

2. Type Toolllox in thc tcxt box. 

Thc tcxt box is locatcd at thc top or thc SLTL'l'll. 

3. In thc Scarch dialog box, sclcct Show Topícs. 

4. Selectthe.topic Toolbox. 

5. Choose Go To. 

Visual Ba.sic opcns a window with infonnation onlhl' ltTIIl "Toolbox ... 

6. From the Help screen, choosc Back. 

Visual Basic returns you to carlicr topics. 

I Tn use lhc llislury cummand 

Use the History command to rcturn to topics tlwt yuu han: L"ll\"t'l\:d carliL·r in thl· 

scssion. Topicallists in this uption are arranged in J"L'\"LT:--t' t·hnHllllogical nrdcr. 

l. From thc Visual Basic Hclp \vindow, ciHHJSC History. 

The Windows Hclp l-listury dialog box appcars. 

2. Double-click the topic of your choice. 

The Help scrccn for that topic appcars. 
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¿ To l'lll o111d paste samplc codc into your codc 

Thl' nrosr powcrful p<1t1 of thc Visual Basic Hclp systcm is thc largc numbcr of codc 
s;rrrrplcs rhat you can paste into a projcct anc.J run. 

Tllt· (ol/owing proccc.Jurcs al!ow you to copy nnd paste samplc codc for a Click 
L'\'t'IIL 

J. Visual 13asic slwuld airead y be running. 

l'd;r~L' su re lhcrc is a ncw form on thc scrcen . 

.., Frorn tllc Hclp rncnu, c!loo.sc Scarch. 

J. Tvpc Click in lile text box. 

4. Clirk lile Slww Tu pies buiton. 

( "lirk Evenl slwuld be highlightcd. 

'1. ('hcHIScGoTo. 

(J. ;\r rhc top of rlrc Hclp form, click thc word "Exnmplc." 

·nu.-; hrings up sarnplc coUc in :r wimlow. 

7. ¡:rorn llll.~ /~vcnr_Click cxttlllplc window, choosc Copy. 

Thi.-; hrings up ;rnot!Jcr window with al/ thc stunplc coc.Jc in it. 

:-;_ lliv.ldiglll_llll' l:odc you w;uJI. 

lnt/Ji." case.!<lkc only thc lincs starting Picturel.Move. 

~J. ( 'lic~ liJe Copy htlllon. 

"lilis c<>pies lile sclection 10 lile Clipboard and hides thc copy form. 

111. hit Visual [J¡¡sic He/p. 

1 1. 1 ¡, •uhlc-c/ick 1 he piel u re box too/ al thc top of the Toolbox. 

1 2. Drag lile piclln·c box lo the lower-lcft corner of the screen. 

1 .1. 1 Jouhlt>click t/Jc picturc box on thc form. 

T/Jc Cm/e wimluw wil/ opcn. 

I...J. h·o111 thc Editn1cnu. choosc Pa,~;tc. 

l';1sll' rhc s;1111plc coJc from thc Clipbo<lrJ lo your form. 

1 ). h·o¡¡¡thc Run mcnu, choosc St:.lll. 

1 (¡_ CJid\ lhc piclllrc box once. 

/t wil/ 111ovc to\\'<trc../ tiJc uppcr-right corner Of the screen. 

1 7. ( 't~nl in u e el ick ing thc pie tu re. 

11 H.:il/ disappc;1r into !111.: uppcr-right c:orncr. 

J ,'\. hHilliiJc Run lllcnu, clwosc EnJ. 

¡q 1\-lininli/.c Visu;d Basic. 
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Summary· 

• Visual Basic Tools 

• Building a Simple Visual Basic Application 

• Visual Basic Menu Commands 

Objectives 
In this module, you learncd to: 

• Designan application uscr interface usin!! lhl' Fonu ,,·indtl\\·. Toolho.\. \tudh;lr. 

and Propcrty window. 

• N ame and savc thc application's furrns <!lid projL'l·t rilt''· 

• Start and stop an applic1tion frolll thc Visual Ha ..... il· 111l'll11 .1t1d/or thc ltHdh:u·. 

• Crcatc an cxccutahle file and add itto ;1 \Vindow:-- !-'lifllll 
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Lab Time 

~~-----

(itl\tllill' Crcating ·An About l3ox portion uf yuur lab manual. 
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-¿ Overview 

• Event-Driven vs. Procedural Programming 

• Microsoft Visual Basic Terminology 

• Application Development Process 

• User Interface Design Guidelines 

• Configuring Your Environment 

Overview 
The purposc of this module is to introduce )'llll to st.::\'L'I ;il rL·!atL'd Lunceph that llL'il' 
you make the transition from thc procedural world to tilL' l'\'Cnt-drivcn wnrld. Thi .... 
module creates the logical fra111ework for much IJftllL' h·~t tll" tlh: L'IIUI'Sc. lt Cllllll"<l~t, 
programming for Microsoft \Vindows with ivtS-DOS <111d 1l\lll'r L·haract~:r-h:1scd 

applications. 

It also providcs a high-lcvcl overvicw of ami estab!i.'-IIL'." rvl<llÍtlllsllips betwccn 
objects and cvcnts_ 

Thi~ module also outlincs thc general pron·ss tliat i ..... 11:-.l'd tn dL'\'L'hlp Visu;d IL1:-.il 

applications anU solllC general suggcstions for uvcr:dl <Lpjllll'iltiun th.:si~IL 

Prerequisites 
None_ 

Overall Objective 
At the end of this module, you wi!l understanJ t!;c pariltli!!lll ..... 11¡ r1 lúHn ¡m1ccdur;tl 1• • 

event-driven programming. 

Learning Objectives 
At the end of the module, you will be "blc to: 

• Explain the key Jiffcrences bctwecn graphical and L·h;u·aL'ILT-bascU_applic;Hitlll.' 

• ProviUc high-levcl dellnilions ror so me kL'Y Visu:d ILl.,ic tcnn-.. 

• Oullinc a hasic ;q¡pJic:llion dl'.sig11 ;11HI dl·vl'ltl!Jilh'lll ¡ut)("t'tlilll' 

• \~xpJaÍI\ SCVCfal rullllillll¡;llliil pi'ÍIILÍpk.<., !ti ti.<.,LT Íllil'tl.l• ,. dt"d.\'11 
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Event-Driven vs. Procedural Applications 

VS 
' ' ':- . '. ¡¡ • ' -·~·' . Event·D•wen· __ 
~ .• ~ ~' ~1' ·" -• .. t:f 

Programmer-Driven ' User-Driven 

Character-Based 

Single Tasking Multitasking 

j 
H 
'.! 
:j 
~ 
lj 

~ 
Programmer Control ·~ Windows Control '' 

of Environment 1/ of Environment ~ 
""'~,,~~ ,;,~¡.';W'-.''"'!~.~:s::;;~"'~\Jti··"~'"''llh~~Jif;.a ... p;:.;·.;.~!M:~~u.:;.«~»>!;w~v:.::~-.¡tJ.~ 

----··---

Example 

Aeferences 

Tr;11lit'1t lll<d progranHning is linear. 1t has a lop~liown scqucncing lhat is cuntrollcd 
hy tlil' Jllt1):!fillllllll:L 

\Vindo\\·s-hast:d prugramnting is cvcnt-Urivcn. \Vindows~bascd cvcnts can be 
tri~~·.l'rcd in onc of two \vays. They can be eithcr uscr-triggered or systcm-triggered. 

lkl( !\V. i11 psculltiCtHJe, is a vcry general summary of the structurc of an event-driven 
pro!;!I'<IIIJ lúr thc \Vindmvs opcrating systcm: 

'· 

"' 
1' 
1?. 

1 1 

'., 
.. '1 

l',•·ui n f1A1fJ PROGRAM 

1'-'!~j i (1 I,IHJ!J 
A~k Windows to pass m~ssages to your program 

,,¡,,lllt wh<tt evcnts have occurred 

C~se Statement GETEVENT 

CASE click 

l·:¡¡d ¡,," '1' 

·.-ou can choosc to insert code to respond to 

· click events for the appropriate objects. 

CASE Change 

Yo11 can choosc to insert code to rcspond Lo 

· change events for the appropriate objects. 

CASJ? ... 

CASE Oefault: 

VB will handle other events internally 

without giving your program access. 

One of the default cases is the ~end 

applicat_ion" message that causes an exit 

l1•>1n ·1.!1•! l'"'l' <~nd ¡;¡¡u~~~:-; yuur dlJpliL"<ILiuu 

•·1o·! "'tdrJ ¡•¡,¡¡¡;H/,/·1 

h11 <1 '"'11plele li>luflhe cvenls 1ha1 Visual Basic recognizes, see the lntroduction 
i11 thl· .\/in·osr~/i \'isual Bc~sic Longuoge R(ference. 
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--------
Notice_tllaithcre JS nota llnc<H~ lluw to.the prugr.tm h~..·~ .tii..,L' tlll' 11m., Ue¡K'rH.I'- t'll-

what events are gencratcd amlthc ordcr in wllich thL·: :11'1' rqltlrlt'd to yuur prn~rar1• 
by the Windows opcrating system. 

Applications that run in thc MS-DOS cnvironment art' pmgrarnrncd to bc tllL' tllli~ 

application running. !vlS-DOS-based applicuions do llt•l handlc multitaskin); ,·cr_, 
wcll. 

\Vindow applications are multitasking. They can sh;n\' :··lTt't'll .-.p;rn: and ~,_·tllllputill!..' 
ti me. 

MS-DOS-bascd applications are charactn-hascd. \\'indtJws-h:L'-'t'd applil;llÍtliL'- :u, 
graphically bascd and typically use proportion:dly spa.-.-d lúnt.,. 

Applications programmcLlto run in thc MS-I)OS cnvil'tliiiiiL'Ilt 111c ablc \11 colltlld 
the environment the uscr opera tes within. Thc progranlL:illl h;1vc control ovcr lhl· 
Sequencing and appcaraOCC Of WhCrC thC USCI" WÍII go IIL'.\\ Íll \he appiÍCOJ(Íilll. 

Applications programmed to run undcr \Vint.lows givc L"lll\\rol or thc cnvironmcllll'' 
Windows. How the user movcs bctwccn cvcnts is contndk·d tllruugh thc \Vimhl\\ . ..., 
operating system itself rather than through thc \VinJmv ..... -hascd application . 
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Visual Basic Terminology 

Application ' 
' l ... .... ''1 ......... ~-~- ~-~ 

- - -- - -
1 

: 

Forll\2l - - Form1 t 1 

1 
--· ,_,..............-

1 
1 1 1 l 
1 Control J Control ' Control~~ 1 Cor;trol 11 Co~troll 
1 1 . 2 3 l 
1 .. ~· oo~o«o· ¡"'~""'*""--' >;•-••-<<'o'~"""""" 

1 1 1 1 1 1 
1 1 IPro~ertylliPro~ertylto~erty lll"ro¡¡mtyl 
ent Event 1 ¡ ., __ .,._ ___ ,,.._ ........... i • .._¡, ............... ,.,............, J Ev 

Proccdure Procedure 

Tht· tnrns 1m this foil Jcpicttwo major componcnts or thc Visual Basic 
dcvclopnrcnt environmem: the graphical side of it and the code side. Put in tabular 
fomr. tllcy look likc this: 

t\pplicatitHl 
h H"lllS 

Jlnl¡)crtics 
1 -:,·cnts 

( 'tllrlnll:-; 

1 'n 1pcrtics 
J: \'t'lllS 

What ls an Object? 
Considcr this cxamplc: Thc dashboan.l of your car offcrs users a varicty of gauges, 
dials. ;urd acccssorics that takc input and give output. Thc thcrmostattclls you how 
hoilhe engine is. The steering wheellets you change direction. Each one of thcse 
"ohjccts" perfonns a spccific purpose, and you use it to attain a given goal or 
llhjL'Cii\"l:. Uscrs learn how tu use thcsc objects. 

hu-lhL· llHISt pmt, users do not Jcarn how to install, maintain, or troubleshoot thcsc 
thin~s. They do notlcarn how thl'sc tllings function. Thc uscr only nccds to know 
!h;ll tht'Sl' tlbjccts wurk and wl\;¡tto ex pe!.:\ fnu11 thcm. In a likc 111anm:r. Visual 
llasicollers programmcrs objccts-fonns and controls-that they can use to build 
applications. For thc most part, thc programmer need only use the object without 
llL'LTSSarily having a dctailcU UJH.lcrstanding orhow thc object docs what it Unes. 
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The Graphicai=Side- · 
Objects 
Componcnts of an app!ication, usually forms ;md contrt•h. 

Forms 
Forms are thc building hlocks or applicllinns. Tire y ;1rl· lhl· windows !ha! usn ..... '-l'l' 

whcn thcy run your ;rpplication; tllcy ;m.! tllc flliljor .... lf'lll'ltJr;tluJril.-. tlJ;¡¡ rn:1kl' rrp 
your application. Visual Basic is m;H..k: up o( s~vcr;tl (tii'IIJ:-.. TI! e Tt•olhn.\. !lll' 
Propcrtics window,thc Projccl window. and 1111.' Sa\l' l'1,•in·1 :\_..., t!'l;do~ htl.\ ;ttl' ;di 

cxnmplcs of forms. 

Walk Through-Forms and What You Get Free 
L To opcn a blank form 

l. Start Visual.llasic. 

A blank form should bc on tlu: scrccn. 

2. From the Run mcnu, choosc S tan, 

Notice all ofthc things that Visual Basic givcs yt•tJr (,,r1n. -;¡¡eh as: 

• Sizing bordcr 

• · Control menu 

• Minimize button 

• Mnximizc button 

You don't need to write any of tlle code for paintin!:! any nf tllcsc fcaturcs or ~·o111 
application. You al so don't nced to writc <lllY of thc code for nwnaging thl'~L' 
features. 

3. From the Ron menu, choosc En d. 

Controls 
Controls are the tools you pltlCe on forms tlJ;¡t prnvidL' 11\l'l'.'i \\'Ítli applk:~t!Í<!II 

functionality. Examp/cs of controls are the con11nand hntl111l .... ;nHIIahds . 

Properties 
Forms ;md cnntrnls havc prnpcrlil's {allrihnll'S) llt<ll _\11111 ;llll"ll<trlJ .. 'L' dnrin~ dl· ... i~ll 

and run time .. An c;wmplc or ;¡ pruperty is tlll' captiPn lllitl ;¡ppl'di"S Oll ;¡ (\lllllllillld 

button. Generally spcaking. you sct thc valucs l"or conrnd ;111d fonn propertic .... H"hL'II 

you nre designing your application. 

E ven! Procedures 
Evenl proccdures are coUe interna/ tu Visu;d Basic ;u1d \Vindt•w~ that i~ writtcn !tlr 

you and provides your app!ication with so me nf its h;1sk !"11nction;dity. For cx;unpl~· 
when a user clicks a cl1eck box, tllc Click cvent k no\\'" ht•w to p<1i11t an X in thL· 
squarc .. However, you must place cm/e inside 1h~ CliLt l'\'L'Jlt h1r tlwt chec~ ho.\ lt• 

cause your application to react appropriatc!y whcn a u:"l'r pJ;¡n·.-; ~111 X inor n'lll\1\'l"· 

an X from thc check hox. 
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The Code Side 
Project 

Y1111r dL·\·eloprnent project is mac.Je up of more than graphical forms and controls; it 
al~o has Hasic cude in it. Tllis is m:magcd and acccssed through thc Projcct 
WÍ11dow. 

Walk Through-Visual Basic View of Your Project 
L To \'il'H" _rour projcd 

l. Ir i1 i.-:n't alrL·ady startcd. St;¡rt Visuall3asic. 

¡:¡·, 1111 thc File lllCnu, choosc Opcn Projcct. 

_1_ 1-'""1 the ICONWRKS.MAK file. 

TI,¡_, lik is lm·"ted in \VB\SJ\,\-11'/.ES\ICONWRKS. 

~- ¡:nnntllc /{un 1ncnu. clwose start w run thc application. 

W«rk with the "PPiication for a minute, but thc point hcre is that this application 
is 111<1Lie up of a number of diffcrent forms. 

). l'i<<rnthc Run rncnu. choosc End to stop the application. 

(l. i\LTL'SS thc Projcct window. 

Thc Pr«fect window kecps trae k of thc forms and modules that makc up your 
<ljl!Jlication. 

1 :or nur purposcs, Visual B<.~sic t1~eats ea eh of your forms as a scparatc 
CllllqHlllCrlt. 

Visual Basic kceps track of t/Jc numbcr and kinds of files t/Jat you are using in 
your application in thc .MAK file amlloads thcm whcn you want to start 
wor~ing on your projcct. 

7. C)uit Visual/lasic. 
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Module------
In Visual Basic a module is a file that contains only codl·. One L'.xarnplc ora .B:\S 
file t hat yo u cou Id scc at 1hc top of a Prhjc,·t w i11dow i., ~·~~ >11111 .1, 1 .IJ AS. 

Another way of showing thc rci<1Lionship <.11\Jong fonn:-.. 1 ·i Hll r1 ,1:--.. pmpert ic:-.. <uHI 
cvent proccdures is this: 

MODULE1.BAS 
Data and Code 

FORM1.FRM 
Graphical Elements 
Data and Code 

FORM2.FRM 
Graphical Elements 
Data and Code 

1 

Project 

.MAK \'-----, 

1 

The .MAK file contains names o! both lhe .FRM ami tlw .BAS ltt•" '" 1111: pro1ect. 
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Application Development 

1:11 Calculator 8:1 

Creating an Application 
I To tTl'alt' an <1pplicalion in Visual llasic, follow this suggcstcd scqucncc 

l. ( lpL'Il a ncw pmject (or use thc new projcct crcatcd whcn you st~111 Visual Basic) 
In l!l'_!;<llliZC !he par! S uf your appJication. 

1 
( 'r"L'alL' a forrn forcach winUow in your upplication . 

. 1. 1 lr;l\\' lht: corllrols !'or Ci!Cil funn. 

). SL'[ tite ronn illlcl control propc11ics. 

(l. \VritL· L'Vcnt procedurcs and general procedures. 

7. Sii\'L' your work. 

X. 1 khug your cmle. 

lJ Cn.:atc.an cxccutablc file to turn thc projcct in tu :Jll application. 

Distributing the Application 
\Vhcn yr 1u distrihutc thc cxccutablc of your application to uscrs, you nccd to 
Jislribule a copy of the Visual Uasic dynamic-link library VBRUN300.DLL with it. 
This dyn:nnic-link library (DLL) is a part of the Visual Basic installation files, and 
"""can distribule it royalty free. lf you build your application using any of the 
:1\:tilable custom controls, you will also need to ship all appropriate .VBX files, and 
in s<11ne cases .DI.L ti les. The product documentation for the custom controls will 
IL'II _\'1>11 ll'll:tllill'Sl' files :tiC. 

¡:j¡¡;dly. during tksign tinu.:, you may tkciUc lo movc thc forms for thc application tu 
;uullhn lllitchinl'. In this ClSL', you will prohably nccd tu rchuiiLlthe .MI\ K fih:, 
hecansc· il kceps !rack of allthe files that makc up your applicalion as wcll as the 
lull~- qu:ilified palli tu tliem. ToJo this, copy all thc files to thc ncw machinc, thc11 
upd:llc' 1l1c pallis in the .MAK file by using the Remove File command fromlhe File 
llk'llll. iltHithLil tllL' Adcl File command. 
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User Interface Design 

General Guidelines 

• Design Basics 

• Color 

• Fonts 

U ser interface dcsign guidclincs are an agreement tu crl'atc Cllll:--ist~nt LISLT 

interfaces . 

U ser interface guidelincs are important for ease or IL·iii'IIÍil~ hy tlle uscr. TilL'Y ab~ 1 

prevcnt programmcrs and dcvclopers from "reinvcntill):! tllc wiH·L·I." 

Thcy are guidclincs-suggcstions on thc way you 111i~llt want ltiLksign tllc USL'I 

interface. There are no hard and fast rules. 

General Guidelines 
• Design basics 

• Dcsign for the user, not thc systcrn 

Composition and functi{mality 

• U ser control 

• Dircctncss 

• Consistcncy 

• Clarity 

• Aesthetics 

• Feedback 

• Forgivencss 

• Color 

• Color asan attcntion-gcttcr 

• Complcmcntary versus circus colors 

• hllliS 

• Sizc 

• Numhcr (varicty) 

47 
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For More lnformation 
h~r- llllll'l' dct;lils on uscr interf'acc dcsign guidclirícs, scc: 

• lhl' \\!indo11·s lllft'l:fan•: ¡\111\f'f'licalion. Dc•si¡.:11 Guidl' 

• Vi.\1/u/ !Jesig11 Guide corHaincd within Visual Basic 

Walk Through-Designing the User Interface 
As Y"" walk tlno11gh this application, look atthe property listed and answer the 
quc."l i!ln that folluws. 

I l'rint lltility #1 

1. htrrn 111~.:: Walk Tllrougln; prograrn group, st:.11t Print Utility #l. 

¡:irsl irnprcssi¡111s are importan t. Are thc function and purposc of thc application 
:rp¡1;rrt·rH frorn a first look at thc interface'! 

, Titk Bar 

Tlrl' 1i1lc b;u· <h!luiJ corllain !he twmc of'thc application. Docs it? 

Till' tnenu slructure should rcvcal somcthing about the contcnts of thc 
;1pplication. Docs it? 

IJocs the first menu item follow user interface,guidelines? 

t.... llrt' llc/p conlln:ulJ in !he st~u1darJ pl:.¡cc'? 

ls tl1c <,iuit cuntmand handled suitably' 

\\'l11'll' d11es llll' 1\hotrl cotnln;uHI rwrrn:dly appcar'! 
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4. Scroll bar 

ls this thc most cffcctivc way to ask uscr .... for thc lltllnhl'r o!" l·opics tiiL·y willt11' 

wanting? 

Are the size and location ofthe scroll bar appropri;ttl' ~i,·cnthc ovcrall purpt,r· 
of the application? 

5. Options 

How many scts ofoptions are thcrc rcally onthi .... r,1nn·.~ 

Are the check boxcs prcscntcd in red. thc hcst \\·;¡y 111 !-'L'l inr,,nn~Hion lúnntll,· 
u ser? 

How should the header, footcr, ami p;tgc numbcrin~ qttL'.'-li,,ns he irnpknlL'rllcd·· 

6. FileN ame text box 

Ifthc user wants to finLl a rik and print it. wllat tilhl't ¡,,,,L, tlt1Ls thc us,:r !ll'l'd 

besides this simple lexl box '.' 

7. Stop and Print buttons 

Are these buttons appropriately sized for this fonn ;111d its fum:tion? 

8. Exit 

Close the ·application. 
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2.: l'rint lllility #2 

l. 1'""" tilc Walk Tilrougils program group, stan Print Utility #2. 

1 < >pcn thc sccond version of this application. 

ls thc ovcrall layout of lhe form cflcctive? How docs thc layout suggcst how thc 
tt~.n might work with thc fnrm? 

1111\\' do thc rr;uncs help structurc thc uscr's dccisions? 

¡¡.,,,. i~ thc tn~..:nu structurc consistcnt with uscr interface guidclincs? 

\Vhy \\\:re thc hcaJcr and footer options úroppcd from thc form? 

\Vlly \\·as thc Pcrccnt Done !abe! added? 
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User Interface Design Guidelines 

Device Input 
Getting Input from a Mouse 
There are a limited numbcr ofthings that USL'rs ctn d11 wi11l 11 rnot1sc: 

l. Singlc-click with cithcr thc prirnary m SL'l'IIIHI;¡.ry 1 kl1 111' n~l1l. top or h1•ll,11111 
button. 

2. Doublc-click with cithcr thc printary or .\l'l'lllldary IHllltlll. 

3. Drag normally with thc primary buuon. 

4. Drag and drop. 

For example, a single click with thc primary 111ousc hulltill nonnally indi~,.·;He:-- lila! :1 

choice such as a bold, italic, or undcrlinc tcxt formal u¡1tion h;t.-. hccn malle un tllL· 
ribbon of a tcxt editor. Sclcction o fa file to h~ opencd ¡ .. , lll•rrn;dly indicnL·d hy ,, 
single click. 

Double·clicking sclects thc objcct to be ~cted u pon :tnd initiatc:-. thc action. Tllo.1t 1:--. 

if you want to select and opcn a file. you simply tlouhlc-dici< a lilcname. Thc >ame· 
thing happens when you doublc-click an icon. 

Dragging is used to resizc a window, movc thc \vindo\~· hl a lll'\\' location. m 
reposition an icon. Drag and dror is normal! y uscd tP sciCL·t an ohjcct. for ex;tnlpk. 
thc namc of a file, anU thcn pi:JCc it ovcr annthcr oh.il~l·t. l'i 1r L'.\;1111plc. a printL·r. '-!1 

that the file can be primcd. 
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Keyboard and M o use Functions 
Whl'lll'\'l'!' pos.\ihlc. ;tll I!HJUSI..! actiorlS)dwulc.J be UuplicatcJ with ;.m equivalen! 
~L·yh!liiJd ~1ction. KcyboarJ shortcuts ami acccss charactcrs should also be used to 
rcdlll"l' 1lw nun1hn Df kc'ystrokcs ami potcntial for crrors by thc uscr. 

For c.xarnplc, in nwst cases you will want to give.a keyboard shortcut for the most 
mllllllonly uscd cornmands. If possible, use the first letter of a mcnu or control as 
the.orc'l'C>S charaetcr. If therc is a contlict, use another lcttcr in the menu or control 
!ltlllll'. 

\\'lil'll .\'1111 designlhe <ipplicJtiun ami it.s forms, .spccify the shortcut kcys. 
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Configuring Your Environment 

(1 íi 

Cancel 

Res el 

1 Reset All 

=·· 

You can configure much or thc !ook and fecl or thc dl·,vltljllllL'Ilt cnvironlllcnt. h·tll)i 

the Options menu, choose Environment Options. FruJJl 1hi ..... windnw you can :-;el 

everything from the-default tab stop in codc to thc forq!nllllld <~nJ hackgn!und 
colors of comments in codc. 

Sctting 

Tab Stop Width 

Require Variable Occlaration 

Syntax Checking 

Dcfnu lt S ave As rormat 

Savc Project Bcfore Run 

Sclcction Tcxt 

Sclcclinn Backgnlund 

Ncxt .Statcmcnt Tcxt 

Next Statement Backgrouml 

Brcakp<lint Tcxt 

Breakpoint DllckgrounJ 

Commcnt Tcxt 

Comment Background 

Kcyword Tcxt 

Keyword Background 

ldentifier Text 

ncraull 

-1 

No 
Bi11;try 

No 
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- ,...;l'll Ílll! 

lckltlilú·1 II:H.:kgltllllld 

(_.t•tk Wi1tdc1W Tcxt 

( 'cuk \VitHiow /l¡¡d¡;round 

1 khll¡; Wi11dow Te>.! 

Lkln1¡; \Vi11dow UadgrounJ 

<irid Wid!ll 

( ;,·,d 1 ki~hl 

Shc 1\\' ( i1 id 

,\li¡,:n In ( irúl 

Dcfolult 

120 Twips 

120 Hciglll 

Y es 

Y es 

For a lis< of the colors available, see thc Colors scction of CONSTANT.TXT 
Jc,l..';lll'd Íll tllc \YH suhUircctory. 

Note Cllilnging toa largcr griJ size ami thcn aligning thc comrols to thc grid may 
ch;ul!_!l' the size or yoUr controls. ' 

Automatically loading Visual Basic Extensions at Startup ' 
You can control which of the .YI3X or Visual Basic Extcnsions are loaded whcn 
starting up a ncw project by editing AUTOLOAD.MAK with·a tcxt editor. This ti le 
"locatcd in the \VB subdircctory. The default settings are: 

GRI/J.VIlX 
MSI JI.F2. VI3X 
¡\NII!liTON.VBX 
CMJ)J¡\LOG.VIJX 
CJ{YSTi\L.VIlX 
(i¡\ll(i/: VllX 
(;1{¡\J'II. VBX 
KI:YS'IAJ'.YI!X 
MSCt >MM.VIlX 
MSM¡\SKED.YI!X 
MSC >liT/ .IN.VI\X-
1'11 '1 '1.1/'.VI\X 
Sl'IN.VI\X 
Tlll<l:LI>.VIlX 
l'n 1_j\VinS izc= 1.'12,402,24X,215 
1 'r1 q \\' i nSlu 1w:::tJ 
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• Summary 
• 
• 
• • Event-Driven vs. Procedural Programming 

• • Microsoft Visual Basic Terminology 

' 
• Application Development Process 

• User Interface Design Guidelines 

• Configuring Your Environment 

····----------

Objectives 
In this module you lcarncd to: 

• Explain thc kcy dillcrcnct.::s h~twccn gro1pllic;tl a11d ~-lt;Jr;tl·ln-h;,scd ;¡ppli~.·;¡\Ítlll'-

• Providc high-lcvcl cJcrinitions l'or somc kcy Visu;il ILI_...,¡L- lL'rlllS. 

• Outlinc a basic npplications design aml dcv~:lopnlL'Iil prtlt:l'dtJrc. 
' 
• Explain severa! fundamental principies ()r t1scr inl~.·rf;¡,·~_· d~.·:--i~rl. 



56 Module 2: Designing and Building Visual Basic Applications 

~~--~~====~~---

Lab Time 

-----~---·~·~--------------------

l iu 111 tll~_· 1 :tnploy\.'c 1 )ataba:--c i\pplicatiun Spi..!l.:i!"ic;.niun pmtinn or your lab mamml. 

1 

' 
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L, Overview 

• Forms and Their Properties 

• Message Boxes 

• Starting the Forms of the Employee Database 

• Multiple Document Interface Applications 

Overview 
Thc purposc ofthis module is to intrmlucc you lll lile \'i:·,JJ:illLJsJc prograJnnlL'r'." 

fundamental tool- thc form. 

. 59--

Evcn though this is a rebtivl'ly hricf Jnndnl,·. i1 Ílllltllllllt'' .,,,,,¡,· kt·y IVI'IIL" tii;JI ;¡¡¡· 

rcquircll for a full LIIH.lcrst¡mding or thc prugrilllHllÍII~ l'/1\ lllllllllt'lll. This llllldllk 

primurily focuscs on thc various propc11ics associóilcd WJIIJ fonns. scparoJIL' I"HHII 11¡¡· 
u iscussion or con! rols ami propcn ics. Th is 11\t ll h ilc ;d.\t 1 1• lt lt'hl·~ llll L'\'L'l\1 pn Jl'l'dtll\ ., 

and mcthoUs associ;Jtcd with J'orll\S. ;\ JllOrl' dL'laih:d dJSt'li."SÍltll of tht:sc issm·s will 
be founJ in a scpar.Hc module. 

This module also serves as thc introductionto thc motinl'll'lllL'llt." or thc cl¡1ss 
application and walks you through crcating. namin!;;. 1111d Sil\'in~ thcsc forrns. 

Prerequisites 
Prior to starting this moUulc, you should h<l\'l' ;1 fulldilllll'nl;d ;lWilrcm:ss uf: 

• Windowing tcchnology frorn the uscr perspectivo 

• Thc Visual Basic programming cnvironmcnt 

Overall Objective 
At the cnd of this module, you willurHJcrstand thc rundillliL'Il[;lb of \l.'orking with 
fonns in Visual Basic. 
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Learning Objectives 
t\t thc cnU of this module, you \Vill llavL: 

• Sct captions on forms . 

• Set the N ame property for a form . 

• AúJcd a form toa projcct. 

• Saved all of the forms in a projcct. 

• Snved the project itsclf. 
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Forms and Their Common Properties 
i'<>rrns are !he central clcmcnt of Visual Basic. They are thc design of your 
iipplicatiow. tlley are thc thing that your uscr intcracts witl1. Thcy are whcrc you 
pl;1u: thc controls for your application. 

Y11ll wi/1 noticc that many of thc propcrties for fonns ha ve the same namcs as those 
l'o1111d for contmls, but 011 fonns tllcy ha ve a diffcrclH use. 

J)cf:ltllt CuiiiiiH'II ts l'ropt·rty 
~-------------------------------------------

( ';ljllitHl 

( ·, IJJlrolilox 

¡:,,11tSi1c 

¡:lllltNanH: 

Nante 

f lright 

ln111 

f\cy/ 1rcvicw 

l.crr 

r-.-la-' lluttoll 

'2- Sii'.ahk 

Forrnl 

Truc 

~L25 

Hclv 

Forrn 1 

4425 twips 

F<Jisc 

True 

Sct BonkrStylc to "3- FixcU Doublr.:"to ~.:reate u rncx.lo.d 
fonn (u sed for di;llog hoxcs). 

Appcurs ut thc top uf thc furm. 

Enables the Control menu. 

U.scú in printing toa form. 

Uscd in printing 10 a form. 

The name in t.:odc. 

A !.so appcars on Projcct list. 

Dcfi.lull kan for your cxccutablc. 

Dctcr1nincs whcthcr the fonn keyboard events occur 
befare control kcyboard cvcnts. 

From len cUgc of scrccn. 

Disah!c for a 111ndal di;Jiog hox. 
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Example 

Example 
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Property 

MinButton 

MousePointer 

Top 

Visible 

Width 

Events· 

Default 

True 

O Dcfault 

True 

7485 twips 

ComnH.·nts 

Di.sable for a rnod;d dialog h11.\. 

Also scc UorderStylt:. 

Scts cursor .shapc nn l"orm- 1 1 pn..,sihk choit:cs. Scc 
the Micm.wfr Vi.wol /fosi1· l.llll,t:llfl~¡· l<l'(C'rCIICl'. 

Fro111 top cdgc of .... nccn. 

f-'a]SC is C4Uiva]Cil[ [O caJiill_:! Jlil' Jfidl' lllC\IJod. 

Load A Load cvcnt occurs whcn a rmm is lo;Jdcd. Norrn;lllv. \'1111 will 11:-.L' a hll'ln 
1 .oad cvcnt lo se! initial valucs !"or tlll' contrnls on ;¡ J'onn 

Sub Porm_Load () 

Top = 1~00 
Left = 1000 

End Sub 

Unload An Un load evcnt occurs whcn a form is ;dHitlt tu hl· l't'lthl\"t•d !'mm mcn1111Y. 

This cvent is normully triggcred by thc u ser e los in~ thc fur111 11.-.ing lht· Control 
menu. 

Methods 
Hide This mcthod is uscd to rch1ovc a fnnn fromtht..: scrCL·n wi1hou1 unloadin~ i1. 

\Vben you use thc Hidc mcthod, thc Visible propL:riY of lhl· l11rt11 i:-. -..l'l to Fal.'ic. 

Show The Show mcthod is uscd to display;¡ hiddL'tl rnnn. 

:;tdl mnnrrint.Options._CI ick 1) 

[rmPrintOptions.Show 

End Sub 

• 



Message Boxes 

r¡J Microsoft Visual Basié · · · 

@ Save changes to 'Form1.frm'? 

What Are Message Boxes? 
l:or thc most part. Visual I3asic applications are mude up of forms. You will find 
:-.cvnal pbccs in your applications whcrc you want to convcy fairly routinc kinUs of 
ini'Pnnation l!l uscrs anU you rcally don't want to dcsign and build a form to deliver 
11. 

Visual Basic h<IS a convcnicnt toolthat displays a kind of form-c:..lllcd a mcssage 
ho.x- whcrc all yo u necd todo is to pro vide the mcssage string and, optionally, a 
"'""hcr that imlicatcs thc numbcr and typcs of bunons and icons to be displaycd on 
thc form, anda lit le for the dialog box. 

lf y<>u wantcd lo make sure that users had saved all of their new data prior lo 
closing an application that you are writing, you could create a wholc new form, or 
yotJ could use thc l\l[sgBox function. 

Walk Through-Coding Message Boxes 
I To inspcct lhc mcssagc box samplc application 

l. homthc Walk Throughs program group, starl MsgBox. 

, ( 'lick the r~xit button ()[} l~onnl. 

This displays a dialog box lhat querics users aboutthc status of their data . 

.\. Choosc Y es, No, or Cancel. 

;\ny onc of thcsc choiccs e loses the dialog box. lmplcmcnling codc lhat 
dii'Ji·n·nti;<I<'S ihc'lll will he· a•hkd in anolhcr tnoduk. 

·l. 1 1pt.:11111L' l)nltrul Jllt.:IIU unl.-unlll, anJ chuusc Clusc. 

·¡ his clo:-;es Form l. 

.., 
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I To codc thc mcssagc hox samplc application 

l. lf Visual Basic is not running, start it. 

2. Double-c\ick thc commanú button too! in thc Tut1lbo.\. 

3. Place it in the lowcr-right corncr or the form. {)[" ;IJI)' llllll'r !llll-llt"-tllc-w:¡y plaCL'. 

4. In the Prope·rties window.Propcnics list for thl' cullllll:IH,I htlll,Hl. t·hangc thL· 
following propcrty: 

Captioo: Exit 

5. Click anywhere on the form. 

This puts the focus back on thc rorm. 

6. Double-click the commantl button. 

This will automatically orcnthc Codc window ror !he t'!illll ;¡¡llll;tl-.:l' Yllll\ll liiL' 

Command I_Ciick event tcmplatc. 

7. Atltl thc following cotlc: 

Hsg$ = ~Have you saved all your work?" 

MsgBox Msg$, 3 + 32, "MsgEox i•lalk Thru" 

\Vhat tloes the code do? First you e reate a strin);! vari:d1k· with ihl· mc."s.:I!_!C .''o ti 

want to display, and then you call thc Msgllox st"tCillcnt You """ 1'"" thc 
1\'IsgBox statement thrce argumcnts. Although tllc second ;uHJ third arguments 

. are optional, in this case we ha ve you inclutlc thcm. 

The first argument is the messagc string that is display~.:d in..,idc thc mcssa~c 
box. 

The sccond is a su m of valucs that indicatcs to Visual ILL\11. thl: type of mc:-.~<tgL· 
box you want. More about thcsc numbcrs in a minute. 

The third argument is the titlc of thc mcssage h"'· 

R. From the Run menu, choosc Sl"l1. 

9. Test thc dialog box. 

Use the mousc pointcr to choosc thc Exit comlll~tnJ butt1 ¡JI Thl· di;dog ho.\ \\'ill 
appear in the middle of your display. 

10. To close thc Mcssagc \ValkThru dialog hox. l"I11HJ~c tlw 1 ";ttlú'l biJttoll. 

1 l. From thc Run menu, choosc Enll. 

12. In the Code window, highlighl Msgl3ox. 

Use thc mouse pointcr to highlight this word i11 thc cudL". 
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~-=-~~~---:_-:_~:__-__ :=====-=-- ------
1.\. PrcssFI. 

tvlakc surc you are in thc dcsign modc, not thc run rnode. 

By adding the appropriate kcy values listed in the second tablc in the Visual 
1 klp lopic for thc MsgBox statcment, you can control thc numbcr and typc nf 
huttons. control thC icon JisplaycLI in thc mcssagc box, oJJHJ cvcn sct a Jcfault 
hu!tt Hl. 

!11 tliis w;Jik through, you <HJLlthl.! valuc 3 (to n.:qucst a mcss<1gc box with Y es, 
No. and C;mcd buttons) and thc llUJllbcr 32 (to rcqucst a mcssag.c box with i..l 

\\';1rning ()m:ry or qucstion mark it.:on). 

Thcrc <11'1.: 1non.! suphisticatcd ways of implcmcnting amJ using mcssage boxcs, 
hut this givcs you a :-;tan. 

UiJ you 110ticc that thc Y es, No, anr.J Cancel command bultons do much, yct'! 

11 you rcau funhcr down in thc Hclp window, you see that cach of the diffcrcnt 
huttons returns a ditlcrcnt valuc. You will use thosc valucs a liltlc later in lhc 
L·oursc, a long wit!l so me conditional logic to code thl! thrcc butlons on the diulog 
ho.x. For the time bcing ... 

1 "'· ¡\-Jin.llllizc Hclp. 

1.\ h·nm tllc File menu, dwosc Su ve File As. 

Savc this form in \\VALKTHRU\STUDENTI as MSGBOX.FRM. 

1 (l. J:rnnl"thc File mcnu, choosc S ave Projcct As. 

Savc tllc projcct in thc samc subdircctory as MSGBOX.MAK. 

17. SL·Icct the Visual Uasic Cuntrulmcnu, anU choosc Closc. 

()uit Visual 13asic and 1-lclp. 
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Modal and Modeless Dialog Boxes 

File N ame: 

lllliiru 
pToject1.mak 

• 

Q.i1eclorier: 

c:\vb 

(do e:\ "',. 
CJ bitmaps 
LJ cdk 
O he 
LJ ico01 

O metalile 

• 

• 
lill Filet of Jype: Olive1: 

IProiect Filet(".lo!AKJ 1 ti ~~9::=',"','------T~ !'"'J 

Modal, Modeless, and System Modal 

O< 

Cancel 

You can designate a formas bcing cithcr mnUclcss or mod;d. Thl: dl'i"ault is 
motlclcss, which mcans that thc u ser can opcn thL· !'1ll'lll ;u1d .-..r i 11 gL'I 111 11\IH.:r r, ll'lll~ 
within the application todo work. Modal forms. in corHr;t:-.1. rcquil"l' rliat thc uscr dll 

something-click a button, check to makc surc tllcy real! y d11 w;lllt \P dclctc all 
those liles-bcfore thcy can do any work. 

Walk Through-Modal Dialog Boxes 

L, To use a modal dialog box 

l. From the File menu, choose Opcn Projcct. 

Bring up thc Open Projcct dialog box. 

2. Access the Project window. 

Place thc cursor on any ot!u;r portiun ol' tllL' Visu;d ILI:-.i1· illll·ri':ll."l'. l'rc:-.s L'ithL'I 
onc of thc mm1sc buttons. 

A bccp sounds and thc cursor continucs to fhtsll in tite lL'.\1 hn.\. l11 this case thl.' 
u ser must choose onc of thc thrcc choiccs prcscntcU: L' lCltl.' thL' narne of a 
projcct using thc list boxcs, input a val id projcct namc. ;¡nd l"iHHl~l.' OK or 

Cancel. 

3. Click the Cancel button. 

Close the dialog box. 
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Application Modals and System Modals 
rv¡, '"'" ui<~lng boxes do ha ve a limit; they only guide lhe u ser within their own 
i1pplication. Thcy h;¡vc no cffcct if thc uscr switchcs to \Vindows or w anothcr 
i1pplicaiion. In orcJcr to Jllakc a form system modal, al/ you ncccJ todo is to use tlle 
lf\·f¡.l;{; p<lr<~nlctcr ror both 1\'l.sgBox stutcmcnts anU functions. 

Thl' syni<Lx looks likc this: 

In addition. you wouiLI nccd to declare thrcc globi.ll constants: 

.¡ .. ¡,:,1 C(JII,">I. t100AL = 1 

1··1•-•l CIJn:-;1 MODEL!::SS = 2 

l·•l•>ll ConsL SYSTE!1~l0DAL = 4096 

Walk Through-Making the Forms of the Employee 
Databas e Application 

L To rnakc !he forrns of !he Ernploycc Dalabasc applicalion 

1. lf Visuall3asic isn't already running,slart il. 

' Set 1he following properties for 1he form: 

C:aplion Employee Da/abase 

Name frmErnpDB 

lleight 

le un 

Wiuth 

5760 (approximmely) 

1 Vl311CONS\MISC\MISC28.1CO 

7(,()0 (approxima/Ciy) 

Note \Vhen you set the !con property for a fonn, you will necu to know 1he full 
path tu tia: sourcc fik. butthc Visual Uasic interface will only tcll you that you 
ha vean icon by displaying lile properly as (!con). 

3. ¡:mmthc FiJe mcnu, choosc Savc File As. 

l'vl<tkc . .;,ure tlwt you save thc file in thc appropriatc subcJircctory. lf you don't, thc 
.~IAK lile will not be abic lo find this part of your projecl. This first pass a11he 
application slwulu be savcd in ISTUDENTi\FORMS. 

"'· Name lile file El'vii'DI3.FRM. 

) . Cl HlOSC o K. 

This saVL's thc form. 

r,. Uick ti1c Project window. 

No/ice thallhe filcname is in thc iefl column on lhis lisl, and lhe name of1hc 
lúnn is inthc right column. 

So far. you ha ve ~ivc'n /he form thc n:tntcs /ha/ ;u-e, kuown lo tite file systent and 
lo Visu;il IL1sic. 

'1. humthc Control mcnu for thc Employec Databasc form, choose Clase. 

Closc H-IPDI3.FRM. 

X. homthc File mcnu. choose Ncw Fonn. 

t\dJ a seconU form to thc application. 
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9. Set the following propenies for the form: 

Caption Employee Record 

Name frmEmpRcc 

Height 4545 (approximatcly) 

MaxButton Falsc 

Witlth 54X5 (approximatcly) 

1 O. From the File menu, choose Savc File As. 

Now, renamc and savc rhc ti le. making surc that you _,;¡\·t· il in 
\STUDENTI\FORMS. 

11. N ame the file EMPREC.FRM. 

12. Choose OK. 

13. From thc Controlmenu on your ncwly crcatcd ft)l"lll. t·J¡¡ •~ •. ,t' Clt,..,;t•. 

Close the forrn, and noticc that thc IW!llC of this fonn ll<L" ht'L'Il <Jddcd to thc lisl 
in the Project window. 

User interface guidclincs suggcst that applic:~tions han: :tn :\htllll ho.x-a r.,nn 
tllat indicates that thc application is copyriglliL'll. You ll:i\'t' .ilrL·:nly crcall:d :1n 
Aboul box; now you ncctl to atltl it to this application. 

Note You will also want to makc somc changcs to thL 1\htHII l"orm, but thc 
·· directions for doing this ~trc not includcd hcrc. You \\.'ould. for ~.::-.amplc. cllangc 

the caption for the About box so that it contained the naniL' of tllL' application. 
but doing that here dislracts frorn the point oftllis wall; tlli<Htgll. 

-----
14. Copy ABOUT.FRM from \STUDENTI\AilOUT lo ISTIII ti'NTI\I·ORMS. 

Befare you add the About box form to thc prnjectlisl. yotl ~llould makl! a L'llJlY 
of the About box form that you ha ve airead y complctc•l :.nd pl;tc·c tllat in 
\STUDENTI\FORMS. 

15. From the File menu, choose Atltl File. 

ABOUT.FRM should appcar in thc \FORMS suhdirccltlry. ~o ;di )'llll nced tu lit) 
is selcct the narnc so thnt it appcars in thc lc.\1 hox. 

1 (l. Choosc OK. 

17. From thc File mcnu, choo'sc Savl! PrP.icct As. 

Now that you havc madc most ofthL: basic fonn:-. for thl· l·.n1pi11)'L'L' Dat;th<l:'l' 
application, you nced to rcnamc ;111d savc tht: file th;1t ~v~·p, tr;tL'k td. tht..: l'iil·.~ 111 

the project. 

The Savc Projcct As dialug box shouiJ appear centcr ,..,l.ll't'll, ,,.¡¡J¡ tllc Ctll'l\'1.:1 

subdirectory already listcd in thc currcnt working direc\lH'Y ;md "suggcstcd 
tilename with the appropriate lile cxtcnsion. 

18. Narne the project as EMPLOYEE.MAK. 

1 '). C'ltoose OK. 

This savcs all of your curn::nt build infonlla\Ítlll. 
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~() h·orntllc Run 11\Cillt, choosc St~ul. 

Ir you want to t~..:st thc application, you should scc the Employcc Databasc form 
appcar "'' scrccn. This form appcars only bccause lhal was the tirst form you 
ncatcd. lf you try to opcn the Employec Record form, you will sce that you ha ve 
not implcmcrHcd code for that task yet. 

~l. Fmm thc Run mcnu, choosc End . 

...., 
1 (}uit Visual l3asic. 



• 
.. 
.. 
.. 

' 

70 Module 3: Working with Forms 

Multiple Document Interface Applications 

Placing Forms Within Forms 
-Visual Basic allows you to write applications that can CJ"t.:;clL' nudtipk copies ot' il 

fonn and display all the fonns within a single container fonn_ Micro~on WorJ (or 
\Vindows and Microsoft Exccl are both applications that ;d[¡J\\' uscrs 10 Jo thi.'. 

Walk Through-Creating MDI Applications 
L To scc thc final vcrsion of your MDI applicaliou 

l. From the Walk Throughs program group, starl MIJI. 

For the most part, in this coursc. wc \vil/ focus allcntion 1111 pi<Kinp control." cJn 

forms. Howevcr, Yi.sual Uasic Jws thc cap<lcity to plan· ~~~rn1s 1111 forrns and 

multiple instances of fonns on forms. 

Thc purposc ofthis walk through i.~ to givc youtiJc fllllcLlllll'lllah cJf 

irnplcmcnting an MDJ application. \Ve don'! inrltJdc ;di 1111· ('nh;ult"L'lllC.:Jlls lli;tl 

youmighl wantto implemclll. Dci;li/ctl ctn·c.:r;lgt..' Cllllll' ¡,,,rnd ir1 lllt'l"oll"""·'''l 
Programming in !vlicro.wji Vi.wo/!Jasic 3JJ l"lHirsc. 

2. From the File mcnu, sclcct Ncw. 

Do this three times. You may not see muc!l happening di i"ir~L htll c.:ach time }'PII 

sclcct New, anothcr in~lancc nf the cJ1ild windov .. · is he lit)! dr ;rwrt 1111 ..... cn.:cr1. lllll" 

atop tllc othcr. 

3. From thc Window mcnu, choosc Ti le. 

This organizcs ami tlisplays a JI of thc child windmvs th:il )'"''· ha\·L' cn.:;¡tnl. 

4. From the Control mcnu on thc Paren! forrn, eh""'''· \1'"''· 

In onJcr lo crcatc thi~ :1pplication fr;tnwworJ..:. i"tdlow llll' '.lql~ ltt·l,tw: ln11 tltt'IL' , .. 

a warning rcquircd hcrc. You wiJJ be typing in ;1 lllllllh~.·r o/ thin!!s tlwt hav~.·n't 
becn cxplaincd yct. Don't worry: thcy will he. For thc tir<H' he in~. ;¡cccptth"l 

· tl1ings work and that the dctails will follow. 



I. Tu lTcatc a .simple l'v1DI application 

1. Sttlrl Visual Basic. 

t\ ncw. hl;nlk form will ;1ppcar on scrccn. 

From tllc File lllcnu, clwosc AUJ File . 
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. t. llsc thc hruwscr 10 add I'ARENTI.FRM locatcJ in \WALKTHRU\FORMS. 

Note Undcr normal circumstanccs, you wouldn't go this mute. You'd sclcct thc 
Nl'w rvlDI Form command. Ir you did that. a sccond form would appcar on 
:-.tTl'l'll, lile l.·ntry llillllL'd rvlJ)IFORM I.FRM would hc adlkd to your projccl list. 
;1nd tllt: Ncw MOl Furm comm<1ntl on your File mcnu wouiLI be Uisablcd. Fmm 
thcre. you wouiJ necJ to aJJ all thc menu itcms; but sincc you havcn't done that 
yct. wc will givc you thc c01nplcted form, so that you can conccntratc on the 
,\11)1 capahilities. 

N11w you shouli..l ha\'c two forms in your projcct. 

.t. In thc prujcct list, put the focus on FORMI.FRM. 

That is. make su re that you scc FORM I.FRM on top of all tbe other forms 
within Visu~il Basic. 

·"· hum tlll' 1-'ile Jncnu, choosc S ave File . 

.\;¡ve tllc file as FORM I.FRM. 

(J. From the \VimJO\V menu, select Propcrties. 

This displays the Propcrties window for FORM I.FRM. 

7. 111 thc l'ropcnies window Properties list, locate the MDIChiiJ propcrty. 

The dt.:i'<llllt valuc for this propcrty is Falsc. 

~. Uoublc-click !he value in the table. 

This to~gles thc valuc to Truc. 

'1. Sclect thc Cuntrolmcnu for the Propenies winJow and choosc Clase. 

111. In thc l'rojccl window, highlight PARENTI.FRM and choosc View Form. 

This rlaCt.:'S thc focus Oll this fonn. 

1 l. f 1pc11 tll~.: ¡:jJ~.: 111cnu on thc Parcnt hmn anU choosc thc Ncw conunanJ. 

This is tht.: shortcut ror gctting from thc form lo thc ClH.lc that supports it. You 
sllould now be in a Cm.Jc winJow thatlooks likc this. 



72 

• 
1 

1 

Module 3: Working with Forms 

12. Place your cursor on thc linc bctwccn thc Suh amJ End .'luh linL'-" ;md add 1his· 
code: 

Dim NewDoc As New Forml 

rlcwooc.Show 

That's all thcrc is to it. Your qucstions aboul Di111 <Hld 1~t'\\' ;1nd Show will ;di h,· 
answcrcd in a littlc whilc. 

13. From the Object Urop-Jmvn combo box, chtHJSL' (lcnn;ll. 

This moVcs you lo thc General Dcclarations SL'I.:tion ul l11c l'otk. wllcrc )'ti\J ~·;¡n 
declare a couplc of constants that Visual Basic n~cLls !'or iiJT;¡nging thc windtJW:-

that your application crcatcs. 

14. Add the following code: 

Const CASCADE = O 

Const TILE_HORIZONTAL = l 

15. From the Object drop-down combo, sclcct mnu\VinLlmd ·,I"L'iltk. 

16. Add thc following codc on the blank linc hctwL'L'Il thc ."iul1 ;1nd Eml Suh linL·:.;: 

MDIForml.Arrange CASCADE 

17. From thc Object <.lrop-down combo. sclcct thl' lllHU\Vindu\\'Tik. 

18. Add the following codc on thc blnnk linc: 

MD!Forml.Arrange TILE_HORIZONTAL 

That should do it. Now all you nccd todo is to n111 y¡n¡r ;qlplil·;l!itnl. 

I To run your ncw application 

l. Choosc thc Run icon on thc toolbnr. 

2. From thc File mcnu on thc Parcnt form, clwosc Ncw. 

3. Do this a couplc of times so that you ha ve SCVL'ral windtJW:-. to \\·or'k with. 

4. From the Window mcnu on your applic;:~tion. dJonsc Ti k 

Tl1is ti les all of your windows. 

5. From thc Window menu on your application. choosc Ca .... L·:tdc. 

This re-arranges all of thc windows. 

6. From the Run mcnu, choosc End. 

7. From the Visual Basic File menu, sclcct ·savl' l'mjcct :\:--. 

Now that you ha ve thC frarncwork f<Jr an MDI a¡J¡Jlic;¡rj,,rl l i11islll·d. savL' y1•ur 

work. 

X. Savc thc projcct as MDI.MAK and m;¡ J.,; e surL· thal it i .... 111 
\WALKTHRU\SAMPLES . 
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Sumrhary 

• Forms and Their Properties 

• Message Boxes 

• Starting the Forms of the Employee Data base 

• Multiple Document Interface Applications 

--- ·--~-- -------------------

Objectives 
In 1his module you [carncU to: 

• SL'l captíons on forms. 

• Sct the N ame propcrty for a form. 

• AJcJ a fonn toa projcct. 

• Savc ;lll uf thc forms in a projcct. 

• Savc tlw projcct itself. 
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· L, Overview 

• Menu Guidelines 

• Microsoft Visual Basic lmplementation 

Overview 
Previous modules gavc you a chancc to scc aiHI use !ltv prol·~ssc...; you slwuld fnllm\ 
for Ucvcloping Visual Basic applications. lnlho:-.c rlllldtdc.-.. )'llll tk·vclopcd :1 sirl!-!iL'

form application. [n anothcr module. you dc\'clopcU ;dltla: fonns tllat are ncclkd 111 

implement the databasc front-end. but thcrc was a par1 lh;~t wa.-. rnissing-thc, 
menus on sorne of the forms. Tllis module bcgins wit!J ;~ discu.ssi1111 of the fl'tlcr:li 
layout of menus and thc u ser interface spccilkation. 11 ,·¡¡ds with a 
dC1110llStration/waJk through orthc i'v1cnUDL'SÍ!-!Il \VÍ!lil,,w 

Prerequisites 
To successfully complete this module, you 111ust he ;d1l1· to tlsL' ;¡ 1nousc. E.\pcrÍL'IIn· 

with Windows-bascd applications i~ useful hutnot n.:qttirL'tL You .-..lwuiJ also I1L· 

able tostan Visual Basic and create a form . 

Overall Objectives 
The overall objective ofthis module is to tcach you httl\ 111 de:-;ign uscr-fricndly 
menus and create them us~ng Visual Basic. 
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Learning Objectives 
1\\ llll· l'lld orthis 1\HKJU\c's \~tb. you wi\\ he ab\c tu: 

• J .i~l :nH\ cxp\;titl thc USL: <lllli va\uc u[" aJ\ Uf \he kcy 111Cilll cJCillC\llS: 

• i\cccss ur hot kcys 

• Sl\1 it1cut kcys 

• rvknu bar 

• Scparator bar 

• Ll\ipsis 

• Crl'atc an application that uses at \east one mcnu on an application window and 
uses more than onc form. lt should includc a lcast onc functionality mcnu as wcll 
as;, 1 klp tlll'tHl tlwt incluJcs choiccs lo display a simple Hclp fonn andan 
i\]H!U[ hoX. 

--
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-M en u Guidelines 

Sty\e Guidelines 

Cut 
Qopy 
E aste 
Paste Sp§cial. .. 
Paste .i k 

Lin!s.s ... 
Qbject 
[nsert Object... 

Move Picture 
$ize Picture 

Ctri+X 
Ctri~C 

Ctri+V 

Menus and Their Standard Properties 
Under user interface guidclines, mcnus are onc or thl: pri!llary ways fnr 

., programmcrs to structurc application function~ditics for ttSL'I'S. Nnr111ally. lnenu:-: d!l 

one oftwo things: explicitly invokc a command, such ·~~-" L'l()sint! an applicati!lll 
using Exit, or invoke a dialog box that offcrs usc:rs lll!ll\' llptions. such :t."i tht.: h1dd 
and italic text-formatting options. 

Menu Structure 
Under normal circumstanccs, most applications will stdrl out lifc on.thc 
developmcnt side with thrcc main menus-Filc. Edit, and 1\clp. Thc File mcnu 
normally will contain commands that are rclatl'd to riiL· tnanipulation: 

• Ncw 

• Open 

• Savc 

• S ave As 

• Print 

• Print Setup 

• Repaginate 

• Exit 

Quitting the appliCatiOO, by COllVCn!Í0/1, is done !'ro111 !IJL' hol[lllll uf t!Je first lllt.:lllL 

Hclp is normally thc Jast mcnu onthc right. 
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Styte Guidelines 

Tlll' ¡..:t'lll'l'<tl Edit lllcnu norrnally contains at least thcse four comn1anJs: 

• C 'ut 

lt 111<1)' ~..·Prllain severa] other commands aS they are nccúcd for spccitic functions 
wiiiiÍII tlll· application. 

h11;dly. 1 klp is normally implcmentcU with at lema thcsc four clllliccs: 

• Cllnlcnls-Tahle of contcnts for Hclp 

• Sc;llciJ lúr Hclp on ... -lndcx lo Hclp 

• llow lP Use Hc!p-Dircctions for using Hclp 

• Ahout ap¡J/icmionname-Copyright notice 

Special Features of Menus 
Period Ellipses 
Thc ¡llrt'L' dots <JIIhe emJ of a commanJ on u mcnu indicate that a dialog box will 
<lppcar tdlcriilg ytntmorc choiccs rclatcd to thc command. A lack ofthrcc dots 
indiL·<ncs that as a n.:sult of choosing thc command, an action will be carricd out. 
For c··"""l'lc, if y11u choose Ccntercd from the Paragraph menu, al! highlighted 
par;r~r:rphs wi/1 be ccntered on the page. 

Checking Options 
A chL'ck rnark next toa menu item indicates to the user that thc option is currently 
ill\'!l~l'll. 

Separating Clusters of Related Commands 
.'\L·p;rroti!\J hars <tll' ust.:d to visu:dly cluster rclateLl commanc.ls so that the uscr sccs a 

~hon lisr uf rc/;rtcd itl!ms. rather than a long list of sccmingly unrelated itcms. 

Access or Hot Keys 
1\n:L'SS kl'ys are markcd by an undcrscorc bcncath a single lcttcr in thc mcnu item 
or collllllttrHJ. Access kcys are thc kcyboard (as contrasted with the mousc) input 
ele vice forthc menu. Access kcys are invoked by pressing the ALT key and then the 
undcrscored lcucr in thc cornmand. For examplc, pressing ALT+F opens the File 
llH.'nU. Prcssing ALT+F+O opcns the File mcnu and then chooscs thc Open commaml. 

For acccss kcys, yuu shoutd try w selcctthc lctter that will be most memorable for 
IIH>st·uscrs. Nonnally this is thc firstlcller in the word, but that might not always 
wor~. For cx:11npl!.!. r-.·tinimizc and Maximizc both bcgin with "M," so~~ bcttcr set of 
optioll ..... lnight lll' [tlliSl! lhl! "n" rrom Mi~limizc ;mr.J thc "x" from Maximizc for thc 
aL·n·ss kcvs. 
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Style Guidelines 

Shortcut Keys 
Shortcut keys are a sccond form of kcyboard <~cces~ t() !lit' Illt.:lltl Ttt use \;hortcLI\ 

keys. tllc uscr nccd only prcss a runction key llr Stllllt' ltlllt'r k~· y ,·ltlllhinatiltll t:-l.lt"ll 

as CfRL+A) in arder to cxccutc a cornmanJ. 

Some examples of standard shoncut kcys are as ftJ!!tm ,: 

Fl 

CTRL+X 

CTRL+C 

CTRL+V 

CTRL+Z 

Hclp 

Cutting sclc<.:tcJ lc.xt 

Copying sclcctcJ tcxt 

Pasting .scJcct~d tcxt 

Un do 
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Visual Basic lmplementation 

Menu Oealgn Wlndow · · 

N.'lll"; 

lndel!. (=:=J 
O 'tiinJuw Li1l 

O !:;_hechd 

r?GFEJI 
0 E.no~bled 

Ned 1! [nlerl 11 Delete 

j 

1 
i 
l 

The Menu Design Window 
h·otttllll' \Vind11\~' 1m.:nu. choose Mcnu Dcsign window. lfthc Mcnu Dcsign 
\\'itHitn,· l'!ltlllllttnd is unavai!abk (Llimmcd), click any of thc fonns in your Visual 
1\;¡;-.ÍL· ••pplicatiun. You \vill thcn be ablc lO acccss thc Mcnu Dcsign Wimlow. Thc 
t'vknu 1 >csign wimluw dialog box appcars. 

The rctnaindcr of this topic divides the Mcnu Design window intu two units
MctHt 1 .ayout ltc111S and Layout Manipulation Itcms. 

Menu Layout ltems 
llt'lll 

( '¡¡p1Írrn 

NatHt' 

lndcx 

SIHirll'lll 

Window l.ist 

llclpl'Pnll'xtiD 

l'hl'd:nl 

Ddault 

Not dtct.:kcLI 

Chccked 

Layout Manipulation ltems 

lkscriptinn 

Namc that nppc<1rs on the mcnu. 

Nante uscd in cod~.:. Us~.: mnu ¡¡s <1 prclix. 

Uset..l for at..lding menu items Uynamic<.~lly. 

CTRL + shortcut kcys. 

Spccilics whcthcr a mcnu control will inc.:ludc a 
list of opcn MDI chi!J fonns. 

Spcc.:ilics an idcntilicr for thc mcnu itcm in¡¡ 
Hclp system. 

lnLiicatcs whcthcr a t.:hcck mark will be 
<.lisplaycJ to the left of a mcnu choice. 

Imlicates whether a menu choice is available to 
thL' uscr (disablcd t.:hoit.:cs are dimmcd). 

ILHiicatcs whcthcr a IIH.!IHL itcm is visible 10 thc 
uscr. 

In c1nk·t to use mostof the Layout Mnnipulation Itcms on th,e Mcnu Dcsign window, 
yott nHt>.;t first select thc control (mcnu) nnd thcn prcss the manipulation itcm to alter 
lhL' l'lllll!Ld 
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!te m Function -------
---------~===-'--'--

LEFT ARROW 

RIGHT ARROW 

UPARROW 

DOWN ARIWW 

Ncxl 

Inscrt 

.Dclc!c 

Raiscs a rncnu ÍIL'Ill tHIC ln·L·I --!'tu· L'\dlllplc. ¡n;d,c~ :t 

submcnu into a lli<IÍil lllL'Ilu 

LPwcrs a nll'llll ÍlL'JII <lile k' ~-1 !"tll' t.'\alnpk. ma~t:-" ;1 

rnain mcnu irl!tt :1 suhrm'lltl. 

ivlovc~ thc mcnu ÍIL'III up ttlh' p•t"ÍIÍtln inthL' lllt.'llll li"l. 

M oves lhc lllt:tlll Ílt:lll dtt\1 11 ollll' Jhl\llltlll lllllil' IIIL'll\1 11'-l. 

f'vlOVCS [IJC (UfS!ll" dttWiltllh: fll'lll Íll IIJL· lllCIHI jj_\[_ t\1.\o. 

dcar:-. thc C:1p!Ítlll antl N:tut•· ''' 1h:11 yo1t1 c:u1 iidtl ¡¡ IIL'II 

111cnu itcm. 

lnscns a blank li11c inthL· ¡¡..,¡ 11r ruL·nu:-- :--n th:ll y11U 1..':111 :tdd 

a ncw mcnu itcm. 

Dc)ctcs thc sckLIL'd llll'tlll lh'lu II'Pill lhc li:-.L 

In arder to implcment acccss or hot kcys. placean anqll·r-..<tnd ~ & ¡in front or thl' 
letter to be used in thc ALT+ combination. F(ll" c.xa111pk·. 111 irnplt.:111t..:nl ALT+I: <lS tht' 

access key combination for thc File mcnu. you woullltypL' &Fill- in thc Captit1n 
control of the Meno Design window. 

Separator bars are implcmcntcd by cntcring a single hypl1t:n (. ¡ ;ts a Ca¡nitlll. 

Note Yoo must assign a meno name to the scparator e ven ihuugh it is not realll' 
acting as a control. 

Walk Throughs-Startup Application with Menus and 
Click Events 

I, To scc thc final vcrsion nf lhc mcnus \Valk Througll 

l. From the Walk Throughs prngralll group. start Starlltp . 

Thb samplc applic<~tion serves two purposc~. J¡ inll'lltltln':-. )'IHJ 111 thc 11\l'tllotl.-.. 
for implcmcnting mcnus in Vi~ual Hasic 11Jiplictlilllt'>. :tnd it ~ivcs you <t sÍiliJlk 
cxamplc of how Click cvcnts wmk in Vi.'iual Ba:-.il·. ltlt'idcnt;dly. this s;unpk 

application also shows youlww to use tht: Shcll !'ullt"litlll. 

2. Choose the Cardtile command buttun . 

3. Clase Cardfile. 

4. From the Edit menu, choose Colors. 

Thc application shows thc implcmentationtlf llll.:IHI:-.. ~·;¡sc;1ding rnenu.'i ami 
checked mcnus. 1~ al so uses the ampersand for lllll ~~.·v~ . 

5. From the Colors cascading menu, choose Red. 

Firially it shows thc use ora Click cvcnt to rescttlil' h:tc~gl'llllllli color 11!" tilL' 
application . 

Now, the question is: How did we do all or that'! 

1>. Clusc tite Startup applicati.<lll. 
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L. To itnplt:lllcnt meuus on thc Startup application 

1. Ir Visutd Basic isn't running already, start it. 

¡\ ncw hlank rorm shou\d be on the screen. 

¡:¡-,,111 thc file mcnu, choosc New Project. 

Sttlll a new pro.iecl. 

.~. SL·I thc fo\lowin¡; rroperties for the form in the Propcrtics winJow: 

1 kr~ht 

\Vtdth 

i'rmS tart u p 

Startup Applct 

2K60 ( approx i mate\ y) 

26 70 ( approx i mate\ y) 

-L OpL'Il the Menu Dcsign window. 

). t\1;,\\v tlle ftdlowing changcs. 

.\h·nu iiL'Ill 

Red 

\\-"hite 

Blue 

lld]l 

t\htllll 

c~lplitm 

&EUit 

&Colors 

&Re u 
&White 

Sdcu thc CheckcJ 
option. 

&lllue 

E&xit 

&Hclp 

&About... 

Desclcct thc 
ErwblcU option. 

N ame 

mnuEdit 

mnuColors 

mnuRcd 

mnu\Vhitc 

mnuBlue 

mnuSepl 

mnuExit 

mnuHelp 

mnuAbout 

lndcntation 

o 

2 

2 

2 

o 

Note Notin: that thc mcnu namcs incluUe only tbc pn::llx anU thc mcnu 
IÚIIL·ti!•ll. \Ve shurtencU the naml!s for this excrcise to facilitate complcting thc 
Wtllk through. 

(,_ CIHll•:--.c OK. 

7. l>ouhle-click thl! command button too! in thc Toolbox hdce. 

t\dd '"'" conHnamJ bunons :tnd p!:tce them approprialely onlhe form, 

S. Sl't till' f¡ll\0\.,_'¡11~ propcrties for thc COilltni.illtl butlüllS. 

Bultun 

( ";udl ilt.: 

·l'aint Hrush 

N:unc 

l'mdCan.llile 

l'mdPaintBrush 

1 l. ht•llllln· l'1ojtTl \Vindmv.clHIIISC Yiew Code. 

M<~•c- 'urc tltal STARTUP.FRM is in lhe foreground, 

C:1ption 

&Cardtile 

&PaintBrush 

ltl_ lnthc· llbjecl drop-down combo box, choose General Declarations. 

--

• 
• 
• 
• 



1 l. Add the following-code: 

Const RED = &HFf'& 
Const WHITE = &HFFFFFF 

Const BLUE = &HFFOOOO 
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Make su re you t ypL' si.x r:. .... 
~v1akC Slll"l: J'Oll typt' four /.L'I"OS. 

Set the hexadecimal valucs fnr thc color.-; th:11 ynu \\'iilll. YtlllL·an rimltlll'.'-L' 
colors and severa! nthcrs in CONSTANT.TXT. 

Note . There is a sccorHJ mctllod for cnrnpkting thc .... lcp ;dltH'L': Opcn 
CONSTANT.TXT, and copy and paste thc approplittc lino into thc GcnL:ral 
Declnrations scction of thc form. 

12. In the Objcct drop·down combo box, sclL'Ct cmdC:rrdlilc :tnd loc;.Hc thc Clid; 
cvcnt tcmplatc. 

\Vhcn the uscr clicks this command button, use ti K' Shdl l"ur1~·tion lo Sl<~rl 

Cardfilc in a regular window. Add thc following l'!llh·: 

x~ = Shell("c:\windows\cardfile.exe'' l) 

13. In thc Object drop-down combo box. sclect cmui'ailltllrush amllucatc thc Clid 
event procedurc tcmplatc. 

When thc user clicks this command buttun, use tllL· Shcll l"unL·tiun to swrt 
Paintbrush in a regular window. Add thc following coJc: 

y't = Shell ("e: \windows\pbrush. exe", l J 

14. In the Object drop-down combo box, sclcctmnuRcd and l<~c:ltc thc Click cvcnt 
proccdure tcmplate. Aud thc fnllowing c<~dc: 

frmStartup.BackColor = RED 

mnuRed.Checked = True 
mnuWhite.Checked = False 

mnuBlue.Checked = False 

15. In the Object list box, sclcctmnu\Vhitc amllocatL· lili' Clit·~ t'\'Cilt pnJL·cdurL· 

tcmplatc. Adtl thc following cotlc: 

frmStartup.BackColor = WHITE 

mnuRed.Checked = False 
mnuWhite.CheCked = True 

mnuBlue.Checked = False 

16. In the Object drop-down combo box, sclect 1nnulllu,· and i<~c<nc thc Click clc'llt 
procedure template. Adu thc following codc: 

frmStartup.BackColor = BLUE 
mnuRed.Checked = False 
mnuWhite.Checked = False 

mnuBlue.Checked = True 

17. From the Run mcnu, choose Start and test your applicati<~n. 

18. From thc Run menu, choosc End. 

Closc !he npplicalion. Yon111ay 11111in· thatthl' 1·:.\it illld J\hoHI ¡·onllllilluls aH' 

not implcmcntcd yct. Y1111 will cornplclv lllos¡· fnlli'IÍ,,n .... in llw nc.xl 1ncuhll,· 

1'1. S ave the fonn as STARTUP.FRM in \W i\I.KTIIIUI\Si\~·II'I.I'S. 

20. Save the project as STARTUP.MAK in \WALKTIII<II\SA~WLES. 



a6 Module 4: Laying Out Menus 
~~---------------------------------

Summary 

• Menu Guidelines 

• Microsoft Visual Basic lmplementation 

Objectives 
In this rthlllulc you learncLI to: 

• l.i~l :111d expl11i11 lht.: LISC ;¡nd v;dll!.! uf a]\ of thc kcy lllCiltl c!clllCillS: 

• ¡\n·css or IH rt kt.:ys 

• .~IHnlcut 1\cys 

• r\'lt:llll h;u· 

• Scparator bar 

• 1-:ilipsis 

• Creatc an application that uses at lcnst onc menu on an application window and 
use.' rnorc than one form. 11 should include a least onc functionality mcnu as well 
'"a 1 klp menuthal includes choiccs to display a simple Hclp form andan 
1\horrt hox. 
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Lab Time-=---. 

Go to lhe Creating Application Menus portion or your l"h n"""'"L 
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L. Overview 

• Form Management 

Statements 

Methods 

Event Procedures 

• Selling the Startup Form 

Overview 
This module has two broad goals. FirSt, it proviJcs an introJuctionto thc conccpt..., 
of event procedures and mctl10ds as they relate to managing th~ rorms or yuur 
application. Second, it reviews all tllc importt~nt cvcJ\l . .;. and Jncthm.ls, ami thl'n:fnrt· 
is a cruciallead-in to the controls modules, and thc general Jiscussion of functioJJs 

and statements as they are implemented in Visual Basic. 

This module also contains thc first actual hands-on cx1wricncc you will gct in 
writing code that will be implcmcnted by user actions with thc t~pplication in~crfilCl' 

Prerequisites 
Prior to starting this module. you slwuld aln:¡¡dy he fiLIJ1ili;1r with thcsc IL'l'llJ.\: 

• Controls 

• Forms 

• Properties 

Overall Objective 
The primary objcctive of this module is to prL·sentlhl· Jhl!itlll of L'\'Cill pnlcedurL'." 
and to discuss the esscntial cvcnts m~cded to rnanagc i"tll'nl~. 
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Learning Objectives 
t\l thc l'llLI uf th(.; 1noLlulc, you will be able to: 

• Use tlie Unload statemcnt to un load a form from memory. 

• Use the Load statemcnt to load a form into memory. 

• U."L' tlu: Show mcthod to display a form. 

• u,c tlw Hide lllcthod to hiuc a form but not unload it from mcmory. 

• Sct lhL' starlup fnnn. 
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Statements 

Syntax 

Example 

Further Examples 

File tiame: 
L-------------~ 

s :\ ... \vb -di sc\em ploye e 
Cancel 

E.iles: 

employee.mak 

The Load Statement 
Thc Load stntcmcnt is uscd tn loaLI a rorm or control i1ll1J lllt:llltli'J'. lt normal! y 
appenrs within other evcnt procedun.:s .. 

Load object 

'Eyent procedure for a control on Fonnl 

Sub Commandl_Click () 

Load Form2 

End Sub 

Importan! Lond docs not automatically display the f'""': it.tust l11ads it Íllt" 
mcmory. To makc thc form visible tu thc uscr, calltlll' Show lllt:lhod, Lliscusscd 
later in this module. In sorne cases you may choosc \() pll'l(l;¡d ;1ll thc forrns in thc 
application at npplication startup. Doing this causes till'lll 1(1 be displaycd rnorc 
quickly when thc Show method for the forms is calbt "' thc "I'Propriatc time. or 
course this tcchniquc will.ndd to thc time it takcs tostan your ;qlplicati()n initially. 

Applic3lion Form 

Calculator CALC.I'RM 

Prm:cdun·/1•: \"cnl 

Ftlnn_l..tJ:Itl 

C11H.:ci_Cli\·J.. 
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Syntax 

Example 

Syntax 

Example 

The Unload Statement 
Th~ Un load state111cnt is used to rcmovc a form or control from mcmory. Unloading 
:1 l"onn l"rom memory may be ncccssary whcn the memory rcsources uscd are necded 
for so1nc othcr object or whcn you need to rcset properties to their original value. 
AnothL'I typicalusc for thc Un load statement is in an OK button Click event for a 
f11r1ll lih· ;ul Ahout box. There is no reason to kcep the About box form in memory. 
h~r<nlSt' .it is scldPlll uscd. 

Note th;1t whcn a lúnn is unloadcJ. only tbe display C0111poncnt is unlomlcd. Thc 
C11d~ <ISSIICÍatcd with the formmodulc rcmains in memory. 

Unload i!hject 

:;,¡], 1 ,,,.,,,.;,,,dl_Cl ick {) 

\Ir• 1 ',;,ri Forml 

End Statement 
Thi~ ,..,,,,IL'IllCilt c11ds a Visual Basic program, proccdurc, or block. By itself, thc End 
;o.{<th.'nlL'Ill stups pm¡;ram cxcculion, e loses all files, clcars tllc valucs of all variables, 
<llld dl'~ll'l!\'.\ ¡¡]] fPI'lllS. 

y,,u h<~,.L' ~c~,;n or will sce various uses for the End statcmcnt in othcr modules to 
cnd ll' 1r1 itll\S or ende. The tapie appears he re beca use yo u can use the End keyword 
;d(llll' i11 codc to cnJ your application. 

E mi 1 1 Function 1 Select 1 Sub 1 Typc ) ] 

:.;nd 1 1 

1·.11•1 1''.'1"' 

'1·:, .. 1 ::toL•~Jn<:>nt Example 

::•11• l<ndDcrnn 1) 

Dcscriptiun 

Ends a Functiun procedurc deflnition 

Ends a block lf ... Thcn statcmcnt 

Enus a Sclcct Case block 

EnJs a Suh proccJure 

Ends a uscr-Jctincd typc dclinition 

IJo 'Set up infinite loop 

!1sg5 = "En ter A, B, e, or X." 'En ter X to exit 

') U ser Input$ = UCaseS ( InputBoxS (Msg$) ) · Get u ser input 
1
J Selec;t Case Userinput$ · Evaluate input 

;; 

;r¡ 

¡ 2 

i .¡ 

• • •UIJ 

16 End ·•¡b 

Ci1Se "A" t·t~g$ 

Ca!:ie n [3 ~ ; !1sgS 

Case "C": t1sg5 
Case n X"; End 

case El se: l1sg S 
ATry again.· 

E11tl S<:\P.ct 

r.f.<;ql\"x Msg~ 

"You ente red 'A' • H 

"You ente red ·u· .. 
"You ente red , e .. " 

'End if u ser ente r-ed X 

= "You m a de an inval id choice. 

'UlSlJlay t'CSultr; 
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Methods_:-:- Hide 

Syntax 

Example 

Further Examples 

E11PDB.HIDE 

1!1 -- ·· -- Employee Datallasll · - 11 
Employee: 

Maria Lopez ·_ :: -_·:-': ·." · .. · 
Peter Krauss 

Barbara Richardson 

liirfUpdate.:.•· __ 

Derartment: 

SAL 

1 :-:·;e i:íelete '- Exlt 

Hiding a Form 
When a form is hiddCn, it is removed from thc sL:n.:~..:n lllh-1 it:-. Visihl¡; propcny is .'L'l 

· to Falsc. A hidden form's controls are not acccssibk \! 1 1 he u ser. hut thcy are 
availablc to thc running Yisu;1l Basic application, to 11llln ;tppliL'<ttions 
cummunicating with thc Visual Basic' application tiHtltl~ll dyn;unic data c.\ch;ul~L' 
(DDE). and lo timer events. 

!fa form is not Joaded when the l-lidc methud is invui;,·,l, th•· funn is Juadcd but 11<<1 

shown . 

[form.] 1-lidc 

Note thc optional rorm in thc squan.! brad~L·ts./\lsolHil•' 111:11 tlll' pcriod withinlhL' 

brackets is not optional. 

Thc following cx:unplc is availab\c from Visual IL•si,· 1 kl¡l . 

1 

2 

3 

4 

5 

6 

7 

8 

'Hide Method Example 

Sub Form_Click () 
Oim Msg$ IJ1~cl"'' '·'' ir~lol·· 

Hide !1 i dE: 1 · ·• n• 

Msg$ = ~choose OK to make the f•1rm r·-••i·i"'"t 

MsgBox Msg$ 

Show 

End Sub 

Oisp! .. , ,~,.,,.o:.;a~¡·· 

Application Form J•rotcdlll'l'/10: \TIIt 

Mcnu MA!N.f'RM 
-------

_IIIIIUAppf>-1,1-'1' Clil'k 

IIIIHtEdiltu 1 ']¡t"J., 

lllllliNUII'• _l 'lid.: 

IIIIIUToD•' 1 'J¡d, 
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Walk Through-Hide vs. Unload 
I To st·t· the diffcrcnce !Jctwcen Hidc and Unload 

l. ho111 the \Va/k Throughs program group, start Hide vs. Un load. 

WhL·n thc application starts you see two forms. Forml. on thc lcft, contains two 
hut!tllls: onc lo show Form2, thc othcr to un load Form2. 

Fr rrm2. on thc right. contains nine buttons, Command 1 through Command8, and 
a hutton Jabelcd Hide Form2. The eight command buttons were placed on the 
h 1rrn In makc su re that Fonn2 uses enough mcmory and \Vindows resources to 
tll!ls!rate thc point. 

Tlll' pltlpOSC or thc application is to dcmonstratc thc diiTerencc of thc impact 011 

tlll'ltn 1ry and \Vindows-bascd rcsourccs whcn hiding a form versus unloading it. 

' ("lid.: thc !-Ji de Fnrm2 buuon. 

Tltl'' ltidcs thc fonn. 

·'· l11 l't11t'ram M;tnagcr, chousc Al)out Program Manager from thc Hclp mcnu. 

h·otn thc Hclp rncnu in Program Man~gcr. choose About Program Manager. 
Nt 1\t' the valuc~ !'or the t\VO lincs ut the bottom of the form for amount of 
1\-krnory ami Systcm Rcsourccs free. 

4. Cl!tliiSl' OK. 

( 'ltl.'-l' lile ;\htllll Program Manager dia!og box. 

:i. l'rc'.'·' <TRL+t'.)C to display thc Windows Task List. 

(,. 1 ), ttrhle-clic~ lliUe. 

7. Clrd: thc Un load Fonn2 button. 

UnloaJ your Form2. 

X. In l'ro~ram Manager. choosc About Program Mannger from thc Hc/p menu. 

Nt~tt· llll' v;tlut·.'- !úr !he twn lincs al !he bolltutt o!' thc fonn for ;unount uf 
ivk11H1ry i.tllLl System Resources free. 

Nttw tll<Jt Fonn2 has bcen unloadcd,notjust hiddcn. you :--;houhJ scc more 
trlt'ltHtry ;rrul!t1r rcs1Htrccs availablc. Thc a!lHIUJlt will vary dcpcnUing on y11Ur 

Hr;tclr i lit'\ en vin 111 t11Cill. 

'J. 'IJollSI: the UK button. 

'lo."l' thc Ahout Program Manager dialog box. 

1 O. l'rcss CTRL +ES C. 

1 1 . Sckct JI iuc frr "" thc Task Lis t. 

1 c. < 'líck the End Task button. 

Tcnninatc thc projcct. 
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Methods- Show 

Syn!ax 

Example 

Further Examples 

EMPDB.SHOW 

l!j ·. · Employee Database '• ' ' . Dll 
Employee: Depar1mcnt: 

Maria Lo ez :. .• ·' - · ·· •': 

~ ¡SAI_j 
Peter Krauss 

Barbara Richardson 

Showing a Form 

Ex~ 

Show is uscd to display forrns tlwt ha ve bccn loadcd. 11 ~'tHI ust.: thc Show 1ncthod· 
on a form t~at has not bccn loadcd, thc Show llh.:tlwd n·iJI ;~utolll<llically load tilL' 

fonn and thcn show it. 

lform. 1 Show [styleo/o [ 

Note The style% parametcr is an intcger value that dctcrnlÍIH.'S whethcr thc fonn i~ 
modal or modeless. If styleo/o is O, thc form i.'> llHJdch: ..... ~..: i! .1tyle 1if- is 1, tllc form is 
modaL 

Users must rcspond toa modal dialog box by clickinl:! :n1y onc of a numbcr of 
buttons. Any dialog box that lcts the uscr contintle Wt•r~ in~ \\'Ítlltllher f111"1llS in tllL· 

application is a modeless dialog box . 

This examplc is availablc from Visual Basic l·klp . 

2 

3 

' 

'Show Mclllnd EXiHUp ll! 

sub Form_click () 
Dim Msg$ 

Hide 

'," ·1 ., 1 • v;j r i ,,¡,¡ · 

,¡,. ··1111 

Msg$ = "Chuu~;c Ul\ Lu lllilkc I.IP· lo•rn• 1• .,¡.¡· 

MsgBox Msg$ 

Show 
6 

7 

8 End Sub 

Applic<Jtion Funn 

Helio GETST ART.FRM 

··¡,,,._,• l••riTI é\tjil!!. 

l•rnr~.:dun.'/E n·nl 
-----

IIIIILJillLUCJ tly ( "lil·k 

lllntd ldhr '1 "lh·~ 

llllllLShcll._l.lil"k 
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Walk Through-Connecting Forms in Startup 
L Tu n111 !he STA /{TUI'.MAK projccl 

--------· ····~-· .. ~--·~--·-··-· ~ ···- ·-

l. lf Visual Basic i..-n'l runuing alrcady, sturt il. 

A 11cw. bla11k form should be on the screen. 
, Fnnn thc File lliCIHI, clloosc Opcn Projcct. --- ~----------~--- -- --~- -------

.1. e >pt'" )TAI<TUI'.MAK. 

"f"llls """''"he localctl in \WALKTHRU\Si\MI'LES. Loatllhc cotk, bu! du nol 
11111 llll' appl ical inn y e t. 

.¡ ¡-,, '"' ;,, lviS-1 JOS prompl cupy 1\IJOUT.FRM from \STUDENTI \AIJOUT lo 
\W;\1 1\Tl/IW\S/\MPLES. 

S. rr!llll !he File lllCI1U, c/wosc Add File. 

r,_ C'l" •ose A IJOUT.FRM. 

7. Choosc OK. 

This adds 1\llOUT.FRM lo !he .MAK file for !he Slar!up appliculion. 

X. Sclt·cl STARTUI'.FRM inthc l'rojccl Window und choosc Yiew Code. 

'!. In !he· Objccl lis! bux. sclcctmnuAbout. 

(io !o the Objcct list box am.llocatc thc tcmplatc for thc mnuAbout_Click cvcnt. 
/1 . ..;/u•uld be cn1pty. 

10. 1\dd 1/Jc folltÍwing ende: 

lllllillu•'IL.:iiiiJW l 

Add liJe code !ha! will show !he Aboul box when the user sclccts !he Help meno 
;nHIIhc Aboul curnmand. Rernember !he 1 causes this form lo be modal. N atice 
the '-'Yiltax llcrc'? FormNamc.SI10w. 

lmporlanl You migiH he tcmpled lo use !he Load stalcrnelli!O display !he 
iúnJ\houl fonn, hut you will fimJ tlwt wou't work lwrc. Loading a form on/y 
lllf,"OIII~ [l¡¡¡( il j:-, Íll lllCIIHII"Y. lt Jocsn'llllC:IJI that lhC /"01"/11 is aClU:il/y JispJo¡ycJ 011 

.'rrt'Cil. For lhal you nccd to use thc Show mcthml. 

11. 1:1o1n lhc Run IIIÓlll, clwosc Start . 

. ~l;lrl tiH: applicalionlo test thc rcsult. 

12. e >pt·n !he l·lelp menu a11d choosc the Aboul comma11d 011 !he S!a~tup applica1io11. 

Thc t\hout hox from thc lab appcars on scrccn. 

N ole You will11ecd lo 11ow chu11ge !he Caption propeny 011 !he Aboul box form 
,~,.., \\·cll as thc lron anJ Tcxt propcrlics un thc labclto fitthc currcnt upplication. 

1.1. Choosc OK. 

Try lo chuu>c !he OK bullo11 011 !he About !Jox form. 

Yo11 lia\'l'll'l t'lltic'd tli;11 Yt'l. 

-
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14. From the-Run·menucchoosc·End-. ----_-_-_ .. . . .. 

15. Select ABOUT.FRM. 

Select thc ABOUT.FRM file in thc Projcct wind<>\\' 

1 ó. Choose View Code. 

Bring up thc Codc window . 

17. In the Objcct list box, select cmdOK . 

~acate thc code tcmplatc l"or thc crndOK_Click 1.:\'Lill fH!lCL'dun:. 

18. Add the following codc: 

Unload frmAbout 

Adú that codc on the hlank linc in thc tcrnpl;rtc. 

99 

Notice the syn~ax hcrc'? Thc Unlond statemcnt con1cs fjr;..;t, ;¡mJ thc oh,icct 11arnc 
follows. Notice al so that thcrc is no punctu.,tion . 

19. From the Run menu, choosc S tan . 

Start the application again to test the succe" of )'<>ur chan~cs. 

20. Open the Help menu and choosc tllC About comm;11HI on thc Stanup applicatio11 

This should display thc About box . 

21. Choose OK . 

Choose the OK command button on lile About bo.\. alltl it Liisappears fn>m thc 
screen . 

Now the question is what do you doto cnd or clo.-.e tllc ;rpplication itsclf? 

22. From the Edit menu, choose Exit. 

Try exiting from this comrnand . 

In arder to el ose thc application cntircly. you still JIL'l:d to rn<~kl.' une lll11rt: L'lran~L' 

to the source codc . 

------------·---
Note This placcmcnt of Exit is not standard for \Vindows. /\n applicdtion lh:11 

follows interface guidclincs for \VinJows wou[d plill'l' l:xil ;¡..;lile [;L'\l itC!ll.tlll 

the File menu . 

23. From the Run mcnu. choo:-;c End. 

Stop the application . 

24. Select frmStartup in the Projcct \Vindow <lllll chot)~l· Vicw C'odc 

25. In the Object list box. choose the Exit mcnu Clid c·n·nt proc·cdurc. and place tlw 
appropriate codc thcre. 

26. AJJ the following codc: 

En~ 

Put this code on the blank linc in thc tclllpl;>tc. 

• 



100 Module 5: Connccting Forms 
---~-- ---~--·· ----------'---------

~7. Frornthc Runmcnu, choosc Start. 

Tc:-1 thc Exit co111mand on thc Edit mcnu, and test thc About box cle.mcnts. 

~X. Frorn the Run rncnu, choosc End. 

2lJ. Fronr the File mcnu, choosc Save Projec~ . 

. Sa.vuliis projcct_as_ST ¡\I(f_U_P.MA_K_in \WALKTH_R_l!\~_AMPLE!). _ 
---------~----
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Event-:p_rocedures ~-

Syntax 

Sub Form_Load ( J 

Forml.Left = (Screen.Width- Forml.Widthl 
Forml.Top = (Screen.Height- Forml.lleighti 

End Sub 

Event Procedures 

. r 

An event procedure is dcfincd as J proccdurc invokcd hy ;1 u~t..:r or systcm-triggert.:d 
event. Evcnt procedurcs are always altachcJ toa giv~:n !"tlflll or control. und tht..: 
syntax for an evenl procedure \ooks like the i"ollmving: 

Sub objectname_eventname 

state1nentblock 

End Sub 

Exa.mples of event proccdurcs me: Command I_Ciick ;111d h11·m Click. 

Loading a Form 
A Form Load cvcnt occurs whcn a t'orm is loadcd. lt non11;tlly occurs whcn an 
application is run oras the rcsult ofcithcr a Load stall'llll'll\111" an implicitlo;a\tiJ;¡t 
is causcd by any rcfcrcncc to an unloadt.:U form's propl·t 1 ic~ or L'!JIItftlls. 

Typically you place initialization codc for a form in a hH·1nl.oad cvc1~l proccdurc. 
For example, you would spccify dcfault scuings for L1111tnds. initializc thc contcnt." 
of a combo or list box, and initialize form-k:vcl variahll· . .., in a ¡:or111 Load e ven t. 
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Syntax Suh Forrn_Loau () 

'lnili;llization ende 

End Snh 

Example :-rr F'onn .• Load () 

C~nl:•~t· r.he form on the scr:_:e:_:e:,:n:._·----:-,-~-----~---------~- ----------- ~ 
--:-------- ·,..J·,ml~Let·t -~--~screen~Width Forml.wictthJ '2 

Further Examples 

~-~>rml.Top = (Screen.Height- Forml.Height:.l /2 
": · ~-.r"! é>llb 

Unloading a Form 
t\n \Jr¡Jcr:HI cvent happcns \vhcn a form is about to be removed from memory. \Vhcn 
th;11 f(lnn i:-; n..:JoadcJ, thc contcnts of al! the controls are reinitializcd. Normal! y, this 
L'\'l'll! i~ 1ri~gcred hy a uscr <.tction, by choosing Clase from thc Control menu or by 
illl llnln:ul stalt.:1111.:nt. 

i\·L111Y 1in1l'.'-' thl: Fonn_Unload cvcnt proccdure contains a Sclcct Case statemcnt to 
,·crify lhilt unloading should procccd orto specify actio_ns that nced ro be taken prior 
lll lttlltl;lllill~. 

::•JI• Fu.rm Unload (Cancel As Integer) 

('t•tttpk'lc .infomwtion on thc Un load cvcnt is availablc from Vis mil Basic He! p. 

,\ppliralintt Form l'roccdurc!Evcnt 
----------~-------------------------------

AI'I'MGR.FRM 

EDIT.FRM 

NUMSYS.FRM 

TDAJJOUT.FRM 

TODO.FRM 

mnuDeiApp_Click 

mnuExit_Ciick 

mnuCiosc_Ciick 

mnuExit_Ciick 

mnuExit_Ciick 

Command J_Ciick 

mnuEdit_Click 

' 
q 

' 

, 
• 
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Setting-the Startup ~orm:_ -_ --:-

' · · , PraJed Opllons ·. - . • 

.S.el1ing: OK 1 
Cancel J, lrmEmpOB · . -· ··~ ·'' • • • 

Comm<'lnd Line A1gument .. : 
ReuJI 

1 Rert~t All 1 

Setting the Startup Form 
If you have a multiple-form application. by default tllL· l'irsl rnnll you crc;JIC will h~· 
thc startup form. lt is easy to makc anothcr funn thc :-t;trtnp fllnll <lS you will Sú' in 
the demonstration. 

Walk Through-Setting the Startup Form Comment 
L To sct thc startup form 

1. Start Visual Basic. 

2. From the File menu, choosc Opcn Pro_iccl. 

Loca le EMPLOYEE.MAK in \SOI.UTII rNIH W ,\ 1.--; 

3. EMPLOYEE.MAK. 

Load thc Employcc Databasc ;lpplic;ttillll itt\tlllw l't,•i('l·t wirHitlW. 

4. From thc Options mcn11. choosc ProjL't'l. 

5. Choose tl~e Sclcct St;:u1up Form option. and prcs:-. tln· dH,p-dtl\\'11 arrow onthL· 

combo box at the lop. 

6. Select frmEmpDB from thc lisl. 

7. Choose OK. 

Set the startup form. 

8. Save the projccl. 

9. Quit Visual Basic . 
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Summary 

• Forrn Management 
--stiileliielifs _____________ _ 

Methods 

Event Procedures 

• Setting the Startup Form 

Objectives 
llltlli'- 1111•duk )'!lll karncti to: 

• 1 :..,t. rhL· Unlo:ul statcmcnt tu un load a form from mcmory. 

• l :,t. IIH· Load q;¡tcmcnt to load a form into mcmory. 

• 1 ''-t' 11~>: Show rncthod w display a form. 

• 1 í"t' thL· l-lidc rncthod tn hide a form but not unload it from mcmory. 

• SL·t thl' :-.tartup form. 
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L. a b:-Ti m_e 

Lab Time 
Go to the Loading and Unloac.ling Forms pon ion of ~' 1111 l;d) rn;ultla!. 
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• Types of Controls 

• Properties for Controls 

Overview 
The purpose of-this module is to make sure that you untkrswnd thc general 
purpose of control properties and cvents as wcll as thl' l·s.-.cnti;ll propcrtics r,,r 
each of the controls in the Toolbox. 

This is not intended to be a comprehcnsivc tn.:atmcnt 11f ;dlthe possiblc prop~.:rti~.-·., 
and events for all of the controls. In addition. this lllt~tlulc covns only h~ilf ol' thc 
total number of controls in Visual Basic. Thc llHJdUil· ltdlowin!! this cuvcrs thc 
other ha! f. 

Thc general approach hcrc is to kt you pral·tilT L'lltiii)!III.L' llll' ¡n·,,pntic." r,,r ~·;¡,·J¡ 

control antJ actually scc lww thc changc ttfftoch thc ,.,IIIIJ•IL 

Prerequisites 
Prior to starting this module, you should ha\'l' ;1 (und;lllll'llLd ;1\\';ll't:lll'S ..... ~~!': 

• Thc functionulity ol' Microsoft Visual Hasic 

• The general use for each of thc conlrols in tht,; T111 dh11\ 

• The general methods for sctting propcrtics nn con1r1•h 
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Overall Objective 
1\t tht· t·!ld of 1hiS rr~tldule. you wi!l be ;.1blt.: tu use kcy propcrtit!.s on half of thc 
LPillrol...; locatcd i11 the Toolbox. 

Learning Objectives 
:\1 llil' t'IHI of this 111oJulc, yo u wi!J ha ve SCt kcy propcrtÍCS for: 

• Tc.\1 boxc~ 

• U¡llr,orr hutltlllS 

• 11~''1/tllltal ;rnd \'cnicll scroll bars 

• Tirnn:-
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Types · of Controls =======~:__= 

Pointer 

Label 

Frame 

Check Box 

Combo Box 

Horizontal Scroll Bar 

Timer 

Directory List Box 

Shape 

lmage 

Custom Controls (·.vBX) 

o .. 
11; 

A 

o 
¡z¡ 

§;! . 
EEl 

ó 
b 
!01 

Gil 
m 

~ 
@El 

o 
(!) 

ijffi . 

[B 
EJ 

~ 
...._ 

~ 

Picture Dox 

Texl Box 

Commancl Gullon 

Option Bullen 

List Box 

Vertical Scroll Bar 

Orive List Box 

File List Box 

Une 

Dala Conlrnl 

This module covcrs the various clustcrs of controls (111111d in the Toolbo.\, thcir ~ 

most commonly uscd properties, and thc cvents th<.1t :1rt: norrnally uscU with thcnL 
One of the first things you will see is that many of tllL' nmtrols ha ve thc samc 
-kinds of attributes. In many cases, a property will be l·,,vcr~d only once. e ven 
though it shows up with almost evcry controL 

Controls will be discusscd in arder of phiccment in tlll' T,,oJb,,.\, with thc 
cxception ofthe picturc box. which will be covcrcd b.'.l. ami thc drive. dirL'L'tury. 

and file list boxes, which will be discusscU in a scpar;tiL' rnnduh.:. 

A good way to get a hanúlc on propertics as ¡hcy I'L'Lth' lo cotHnds is In lool\ al 

the very front of thc Microsoft Visual Bosic /.onguagt· 1\'t:fC·re//n'. There you Ctll 

fimJ a comprchcnsivc list or cuntruls ami thcir propcr 1 il·~ . 

Adding Controls to The TooiBox 
Thc graphic on this pagc displays the dcLntll TooiBtl.\. Y1H1 c;Hl ;tdd contrt1h ltttlh· 

Toolbox . 

L To add a custom control to thc Toolbox 

l. From thc File mcnu choosc Add File. 

The Add File dialog is displayeJ . 

2. Fromthc Atld rile tlialog, lncttc thc CUS[t\111 L'tllllrtd i'ill' ¡J¡;¡[ )'llll wanl [tl add . 
Forcxamplc. locatc thc file THREED.YIJX. This lile- si1<>Uid he inthc 
C:\WINDOWS\SYSTEM directory. This is a cust11111 Clllltrol providcd hy 

Visual Basic . 

3. Select the file THREED.YBX and choosc OK. 

The new conlrols arL~ addtd to thr Toollut.\. You ttt;•v rc·t :tu c'ttor llll'~":t¡~t· il 
THREED.VBX has alr~ady hceu ;uldcd 111 tite Tlt~tlt"'' 

4. Use this same process to add any custom control to lllv Toolhox. 
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2:: Properties for Controls 

• Labels, Text Boxes, and the Masked Edil Text Box 

• Regular and 3-D Frames, Check Boxes, and Option Buttons 

• Regular and 3-D Command Buttons 

• Combo and Lis! Boxes 

• Horizontal and Vertical Scroll Bars 

• Timers 

• Picture Boxes 
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La beis and Text Boxes=-·-

1!,1 ·~, Form1 ' aa 

Label1 r=l· - .. Form1 · 1:111 

Text1 

Labels and Their Common Properties 
Labels are rnost commonly uscU to tlispltly IL'.\1\hal :-••tt dt•n'¡ \\iHlt tll(' tt~cr l•J ht· 
nble to change. Typically tllis woulcJ be a ctption tll~>l,·t :1 ~r;tpllil' or c;qllitttL-. f11t 

urive. directory. and file list boxcs. 

Property 

Alignment 

AutoSize 

BackColor 

BorderStylc 

Caption 

For11Namc 

FontSize 

ForeColor 

Height 

Left 

Nmnc 

Tablndcx 

TabStop 

Dcfcmlt 

O- Lcft Justify 

Falsc 

Whítc 

O- Nonc 

Labell 

Hclv 

8.25 

I3lack 

500 

l.abcll 

i\ssigncd hy Vi~u;d 
B<~sic 

Truc 

Ce llllllll' 111_, 

IJetermin~..· ... \\'llcthct :1 L·ontrol adju ..... t~ h1 

fit ÍIS COrliL'Ilh, 

Titk l"ut lit ... · ,·,Jttltol 1111 .-.crc~.:n. TIH: 
c;tption ¡, tlt.· ,kf;udt propcny t'or tlli-. 
Lttnlrol. S;.ttl:t\· .J.alu.:ll = "Fill'.'" 

In twip.' 

From kltl~<•td ... -r•d·f,•rnl. 

lktt.'rmirt~·, \\hl'lhl'r rr:-.c crn u:-.c T;rh ~l'\ 

[\l[IHI\1 lo• ¡1¡.·[¡·\11111\ 
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Text Boxes and Their Common Properties 
:\ !t'\1 11<1\ t'llt1!nd di:-.plays ..:itl11.:r infonnation that is proviLh:d hy the application 
~~~- ltll<llllldliontll;ttlllt: ust:r can typc. 

T~ pH.:;tl 11,..:_, of IL'.\1 hu.xcs would includc the box \Vhcre uscrs type the string of 
L·h;II'<IL'It't' thcy want thc application to find in a search function. lfyou were 
LTL'<Ilin~ 01 rront-cml for a Jatabasc. you could use a sequence of tcxt boxes to 
!-'"titL't itdlll"lllitlilnl ahout memhns of thc data base: 

l'rnpt-rl_\ 

.-\Jt~IIIIIC!!I 

¡., >111 .') 1/t' 

llt-i_l'llt 

1 l'll 

\L1d ¡·rn:lll 

,\llllttlllll' 

1',¡-.·,\\<•l•lf 'll;u 

1 ,. \ r 

lh:fault 

fl- Lcft Justify 

Ht:l\' 

11 

F~lisc 

Tt:.\tl 

tl-Ntlll!.: 

Tc.\1 1 

Commcnts 

In twips. 

Frurn h:ft burJcr of furrn. 

Comrols ammmt of uscr input. Rangcs 
frorn O to 6-l ~.:haractcrs. 

l\.lt:ans no muhilinc l.:<lpability. 

Ni.lmc used in coJe. 

Use txt as a prcfix. 

Spccili~.:s thc ~.:h;¡r;ll'lcr to be displ;¡ycd 
whcn uscr typcs IC.\1 in thc tcxt ho.x. 

¡:or lllHlc. a~!'>ign "". This Í!'> thc dd;lllll 
property for thc control. 

Syntax-Tc;o.,:tJ; llll 

From top bonJcr of form. 

Witlth of tcxt bo:·c 
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Walk Through _ T:ext Box with éfScrolfB-ar. 
I. To use thc tcxt hox with a scroll har 

l. From thc Walk Throughs prograrn gruup. st;trt TL·\t 1\11.\ \\·ith a Scroll Bar. 

When you start the npplication, you will SL'L' :1 !'tll'lli H·ith a IL'\1 hox with :1 

vertical se rol! bar in the ccntcr of thc fm111. 

The purpose ofthis application is to d~mutlstra!l' tiJt' hclla,··¡¡¡f of a tcxt ho.\ 
with a scroll bar and how toe reate a tcxt llnx witll ;¡ 'L·ndl har. 

2. Type sorne text into the text box. 

Type enough text into the text box to cause it to ~¡an scro!IJng. Noticc tl1;.1t tht· 

text will automatically wrap at the riglll rnargin. Notin~ also tlwt you can 
select text and then cut and paste it justas in a stand,nu \l'indows-bascd tc.st 
box. Use CTRL+C to copy, CTRL+V to inscrl. CTR.I , \ to ctJl :tnd CTRL+/. lo urhltl. 

3. Ooublc-click thc Control mcnu. 

Closc thc walk through. 

4. Start Visual Basic. 

5. Double-click the tcxt box tool in thc Toolho.x. 

This will create a tcxt box control. 

6. In the Properties window drop-down cornho bo.\. n1:d\L' tlll':-.L' change:,: 

Hcight • 1000 (approxirnatcly) 

Scroi!Bars 2- Vertical 

Sct thc ScroiiBars propcny lo 2- Vertical. Notil"l._' rl1;11 you d"n't SLT th~.· 

control changc. Thcrc's a Jiulc problclll ht'fL'. St'llill~ rht· SooliiL!r~ propcn_v 
for a tcxt box only bccomcs cllcctivc if tlu: Mullil Jlll' Jlf!ljll'J'IY ror thL' ll'\1 llP\ 

is al so sct to Truc. 

7. Sct the MultiLinc propcrty to Truc. 

Notice that a vertical scroll bar now appc;Jr." on rlw lt'\1 htl\. 

8. From thc Run rncnu. choose Start. 

Test the behavior of the text box to sce if it bch<~\ L' .... :1" it did in lhc dcmo. 

9. From the Run menu, choose En d. 

· Closc thc application. 

• ' ) . 

.i' 
'' ¡•·. 
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Masked Edil Control 

Masked Edil Control 
Tlli:-. L"!llltrol is ;r spccial fonn nf the tcxt hox control. h is uscd to rcstrict uscr input 
;1." \WII ;1:-. 1!1 fonnat data output. 

,\: 

11 

1 >ese ri pl inn 

Dcci mal placeholdcr 

TlHJUS;uHis scparaHlf 

Ti 111c scparatur 

Date scparator 

Trcat ncxt cllaracter as a literal 

Clwral:tcr placcholdcr 

t\Jphanumeric placcholder 

Lcttcr placcholdcr 

Digit pl:.u.:choldcr 

Walk Through-Valídatíng User Input 
I. To 111o11ilor uscr input with thc maskcd cdit control 

l. 1:ro111 1hc Walk .Through program group, start Maskcd EdiL 

·¡·Ju· ¡Hrrpc,sc c1f tlris walk tllnntgh is to dcmonstratc une ofthc llJU!.inc uses of thc 
r_n;r-.~c..:d cdit cuntrol-displaying a tc~t box that prompts for and monitors the 
L·orHTtness uf a uscr-addcd telcphonc numbcr. 

1 Ty¡tt' tl tclcphonc numbcr. 

N<>lilT lhallhc use of lite rarcnlltcscs allCIIhc undcrlining rromrts lhe uscr 011 
IIH' 1\'jlt' allll ;1111\JlJJI{ or iÍli'lll'lli<Jtiun lo be typcd. Noticc also that thc maskcJ cdit 
lt:xl l111.\ <Hlloln;HiLally tal1s ¡IJ¡; (ursur lu tlu; ncxt contrul as you typc tllc 
tclcpiH1ne mnnhcr. 

.1. ( 'lo ..... t' thc ;¡pplicalion. 
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·~_2:,_ To crcatc thc·?rPiic¡¡tion 

l. S1art Visual Basic. 

2. Rcsizc thc form ~md sct its propcnics as follmvs: 

Hcight 

Width 

2850 (approximatcly) 

4560 (approximatcly) 

Alignmcnt 2 - Centcr 

AutoSize Truc 

Caption Customcr's Tclcphone Numhcr 

117 

4. Place the masked cdit control in thc ccntcr or thc l"onn and sct its prupcrtie:-. as 
follows: 

Mas k 

Width 

(###) ###-#### 

1635 (approxirnatcly) 

Visual Basic calls thc parcnthcscs anJ thc hyphcn "lilL'rals." "Jh:y are the visual 
cues that tell the user the typc of data that is c.'<pcctl'll. and yo u typc thcm tiS pan 
of the input m:.tsk. Thc numhcr signs (#) ;trL' c;1lkd .. di!!il pl:trl.:hoiJcrs ... ;Hld thL·y 
spccify that a digit is rcquircd. As you llave scen. \\ ill'll )'!ILI run thc applicatiun. 
the control places an appropriatc numhcr uf umh:r:-.L'!)J\'s that tcll thc uscr thc 
totnl numbcr of charactcrs in thc numbcr ilS wcll a~ lht· n:-;cr\ rclativc po . ..;itillll 
within the number. 

5. From thc Run mcnu, choosc Stal1. 

Test thc bchavior or thc maskcd cdit L"lllltrol to SL'l" il it llL'ha,·L·s as it did in lht· 

dcmo. 

fl. Frorn thc Run mcnu, choosc End. 

ValidationError Event 
If a uscr typcs an. invalid charactcr. a ValidatÍtllll·:rrm t'\1'lll tiL\"III"S. You L·a11 pl;lll" 
code in the ValidationError evcnt to display an error llll ........ :t,t!C. h11· cxamplc. yuu 
might want to becp if the uscr typcs an in val id characiL'I 

l. Place the following statcmcnt in the MaskcdEJit 1 \'alidationhror cvcnt: 

Beep 

2. From the Run menu choose Start. Type a lcucr inlhc· maskcd cdit ficld . 

The system beeps . 

3. Save the form and .MAK file with appropri:1tc nanw~ in 
\WALKTHRU\SAMPLES . 
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Regular and 3-D Frames, Check Boxes, and Option Buttons 

11 · -. -- Form1 · ~-- · .:ii' 11111 

Frame1------. 

@[option11 
~ Check1 

Q Option2 O Check2 

ThL· fr;nnc. chcc~ hox, ~1nd option bunon controls providc a way to prcscnt uscrs 
wi¡h ;1 SL'I of optiuns from which thcy can choose. 

hn· L'.x;nnplc, if ynu start thc Solitairc gamc in Windows, then opcn the Gamc 
menu. ;111d thcn clwosc Options, you will sce a dialog box that contains two scts 
nl'oplicn¡ hultons. lnsidc thc framc labclcd Draw are the options affccting how 
lllinly carLls are Jrawn. Insidc thc othcr framc labeled Scoring are the options that 
allcct hnw thc game is seo red. The arrangement olÍ the screcn and thc use of 
franlL's IL'II thc u ser ami thc systcm that thcsc are indcpcnUcnt groups of option 
htllltliL". 1\ choicl' 111adc in thc Draw group will not aiTcct thc Scoring group, :.uH.I 

\'ICL' VCI.\;1. 

Frames and Their Common Properties 
Fr;nncs pro vide a nH:ans for graphically and functionally grouping controls. 
Framcs <~re most commonly uscd to group two or more option buttons in a sct of 
lllutuall_v exclusive choices. 

___________________ Note_lllilll'llliilillll_prcsentcdjnJramcs and ORlion buttons can also be prescnted 
in drop·down list boxcs. 

l'ro¡inly Dcfault 

Truc 

Commcnls 

On S(.;rccn labcl. This is thc dcfaull 
propcrty fur this !..:ontrol. 

Synta.x-Fnlllu..' = "lkl'initions" 

Use fra as a prclix. 

Falsc hides thc framc anJ any con!rols 
insidc iL 
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Caution WheifPiacing Controls on Frames 
TJ1erc are two methods for placing con! mis 1111 <1 fnr111 Tlil' silllpksl lllt:lhod ¡_... (!' 

double-click a control icon. An in5t;n1Cc o( thc contr'd wil/ ~~ppctlr in thc ccntcr lll 
the form, and you can position the control /ÚIJll tlll'rt' l"llis i.-, ;¡ parlicuJ;¡rly tiSL'I'ul 

<~pproach when you are placing scver<d contnds 011 01 '-lll)..'k r,lflll. 

Thc sccond approach is to singlc-click a too! in thc -r,,,JIIJo\. 111ove the cur..,ur ¡,, 
thc form .• and drag the control on thc fnrm unlil il Í-" tht' si1~ you wanl. Thi., 
.\'eCOmf metfuuJ is requirctf for pfacing cuntrn/.r !JI/ 11 j/-t/11/t'. J (y u u Jo JlCll USe 1 111.' 

mcthod. you willlosc tl1c controls whcn you 1ry lo rllll\'t' the fr;une around on tlll' 
form. 

3-Dimensional Frames 
Addcd propcrty Ocfault 

Alignment O- Lcft Justify 

Ct~ption 

Font3D O- Nonc 

N ame Frame3DI 

ÜIIIIJIICill.'i 

You carmoll'L'IIIl"f· or right·ju.stify fr;tmc 
~:ap!itllls wirltrltc.: tJ!hc.:rciHHrols. 

Tltis is rhc.: dct'<tlllr pHlpc.:rty for rhi .... control. 
SynlcJx-Frarut'l = "Dl'finition.s" 

.Scts rile anttiUIII ;¡n¡/ dircclion o( sh;tdin~ 111 

1 he C'apt ion. 

N;unc ust:d Ílll'tltlt.:. 

u ... e: fra as ¡11 L'li'. -

Check Boxes and Their Common Properties 
Prnpcrly Dcfnult 

Caption Check 1 

Enablcd True 

N ame Check 1 

Valuc O- UrH.:hcáctJ 

Visible Truc 

l'O!IIIIICIII:-. 

F:ll.'ic dis;Jhk.~ ;di ti~L'I ;tL'l'css. 

Nan1c uscd inl'thk. 

USL' l'hk iiS ;¡¡lft'/1.\. 

1 · Chcdcd: 2 · ( ir;ly'l'd. 

(Fills hox wi1h ~r;tyJ. This is rhc dcfaulr 

propcny li1r lite Ctllltrol. 

Fal.w hidcs J/tc dtc:ck ho.x. 

Click Normully a Click evcnt indic<lfcs t/J;JI ¡/¡r.; usn lt;L" rn;rlk <r sdcctic>n. In tlrL· 

case of a check box, thc Click cvenl ;.rcts as,¡ t{)ggk. JI" rllere is an X irJ..;,ide thL' 
check box when the user clicks it, the X will he rcllHII't'<i. lf thc check box is 
empty, an X will be placed insidc the check hox ¡¡ftc·r thc user clicks it. In cithcr 
case, the Value property wi/1 be rcsct. A typical use e d. ;r dJL'Ck hox might hl' te, 

a/low rl1c uscr lo choosc bcrwccn bc>IJ t>r ncll"lllill J"c>rll. 
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Style Guidelines 

Events 

Option Buttons and Their Common Properties 
Option hultons, as notcd prcviously, are used to display an arra y of choices from 
whidc lhc uscr ""'Y sclect only onc. An example is found in the Microsoft 
\\'indo\\' S \Vritc Print Sctup dialog box. where thc uscr can sclcct eithcr the 
dcl:aull printcr ora specific printer ami cithcr ponrait or landscapc pagc 
\ li"Í L'lllill ¡, lll. 

l'ropnly Ocfault Commcnts 

.1 ';1pl11111 

N;HIIl' 

-------------------------------------
( lplion 1 

Option 1 

Truc 

On-snc:en vahLl.'. 

N ame uscJ in L"mlc. 
Use optas a prcfix.. 

Uscr has a(.;ccss to L"ontrol. 

This is thc Jcfault propcrty for this control. 

Syntax-Optiunl = F:llsc 

t\lw;Jys ha ve une Dpti.on button in a group sclected as the dcfault for the user 
whl'll tlll' rorm is displaycd. 

Click \V leen the u ser clicks an option button, the Click event actually invokcs 
>cvcr•d auivitics. lt paints the dot on the selected option button, removes the dot 
fro111 """ 111her option button within the frame, and resets the appropriate values 
for all option hullons in the same group. 

Walk Through-Option Buttons and Displaying Their 
Values 

L To compare !he effcct of !he Click event for a check box versus an option 
huHou 

l. "''"" the \Val k Throughs program group, start Check versus Option. 

\\'hl'll you start the application. you will see a form with tluee option buttons, 
lwo check bo.-.;es, anda clcar scrccn_ button on thc right sidc. 

The 1'"'1"'-'C of this application is to compare the etTect of thc Click cvcnt fur 
:1 clwd.:. hox versus an option button. 

1 ('lid, thc Opliunl optiun bulton. 

Tlll' 1alucs for allthree buttons should be displayeu on thc lcft side ofthe form . 

. 1. Clid the Option2 option button. 

_______________ _..:·¡:llL'''I¡JatcJ.valucs-for-all-threc-bullonsshoulu-be-uisplayeu-on-the-lcft.sidc.ut·--------1 
thc rorm. 

4. Click thc Check 1 check box lo placean X in it. 

Thc value of Check l. Valuc is printed on the form. 

C'IHllp<lre the numbcr that is printed for the valuc of a check box when it is 

·'"k' ll'LI ( 1 1 to thc valuc that is printcd for an option button whcn it is 
"·l····ll·d 1·11 
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~~5. Click the Check2~check box to place~an-X-in it. 

The value of Check2.Value is printed on the fonn. 

Compare thc effcct of thc C\ick cvcnt for check IHI_\l'~ .\'cr:--us option hulloiL". 

Clicking one option button al'l'ccts thc statc uf tht: IJIIIL'r option buuon:-. in il:-

group. Clicking a check box wi\1 not allt.Tlthc ... t:lk 1)1' tJ!ht'r check htlXt.'S 

ó. Double-click thc Control mcnu. 

Clase the walk through. 

I, To codc val u es for oplion and check hoxl'S 

l. lf Visual Basic is not running alrcady. stan it. 

2. Double-click thc framc control too\ in thc Tooliw.\. 

Add a frame to the form. Click and drag thc siziH);! h;HJdks to rnakc it big 
enough to hold thrce option buttons. Place it llCtlr lht.• lowt.•r-riglll comer or tlll' 
fOfl11 SO that thCfC is p\cnty of 1'00111 {()"display lhl.' \';dtiCS fnr thc thi"CC oplion 

buttons you will add. 

3. Click the option button tool in thc Toolhox. 

4. M ove thc mousc ovcr tlw framc you ju.'-l cn:atcd 1111 htnnl. 

Note that the mouse pointcr has changcú from an arro\v toa cross ha ir. 

5. Click and drag inside thc arca of Framc 1 to dra'"' an option hutton therc. 

6. When the button is thc size you want. relcasc thc nH>tJSC. 

7. Draw two more buttons insidc Framc l. 

8. Double-click the top option button. 

This displays the FORM I.FRM Codc windmv 11itl1 tl1<: Opti1111I_Ciick n·cnt 
procedure template. 

9. Add the following codc: 

Print "Optionl.Value 
Print "0ption2.Value 

Print "Option3.Value 

". 

Optionl 

Option2 

Option3 

. ·,¡ ;¡ i ll ~~ 

,V,.]IJ" 

.Vét.lltf'".! 

This adds the codc that prints the valucs fm thc h11ttons. 

10. In thc Objcct list box, sclcct Option2 amllocatc tiH' < 'lic~ L'VL'Ill tclllplatc f1·o1n 

the Procedure list box. 

11. Add the following codc: 

Print "Optionl.Value Optionl . Vñ ]IIC 

Print "Option2.Value " . Option2 .Vdllle 

Print "0ption3.Value OpLion) . v, )¡¡,, 

This adds the samc codc that prints the valucs t"u1 tiiL' hul\tli\S tu thc Clic~ 
event for Option2. 

12. Using the Copy command, place thc ende abovc into tllc Clipboard. 

13. In the Objectlist box, sclect Option3 ai!LIIocatc thc Clid nTnt tcmplatc Ir'"" 
lile Proccdurc list hox . 



lü Module 6: Using Conlrols 
~------------------------------------

1 ~- {.f_...,¡,,t' thc Paste commanc.J. copy the contcnts of the Clipboard to this cvcrH 
pmn·dure lt.;tllplatc. 

TllL· L'odc slmuld look like this: 

l'! i ,,. 'Optinnl .Value Optionl.Value 
)'t Íl!' "f)ptiorr2 value ., . Option2 .value 
1' 111' "Opl i on'3 .vulue OptionJ.Value 

This ;¡dJs !he"""" coJe lhal prinls thc valucs for !he buttons 10 !he Click 
t'\'l'lll l"<ir Option:O. 

l:i. l:nrtntllc RutlllH~nu. clwosc Start. 

TL'.'-1 _\·our cmlt..:. 

1 IL h·!llrr rile Run tllLilLI. choose L~ml. 

{ 'lr•'>r' lile ;tppliL·;¡tiorl. 

17. ()llil Visual B~•sic. 

3-Dimensional Frames, Option Buttons, and Check Boxes 
For thc llHJSt part, these thrcc controls are identical to the thr~e controls just 
discu.w:LI. Howcvcr, 1hcrc are a fcw subile differcnces that need to be notcd as well 
"' lhc l""rcJurcs for sclling lhc 3-D qualitics for these controls. 

3-Dimensional Option Buttons and Check Boxes 
Ocfomlt Addl'd prupl'rty 

--··-=--=------------------------------
Commcnts 

N;JillL' r f, •r (heck 
h! 1.\L':-- 1 

NnriH' lfl'l tlplion 

hulhiiL'-1 

hun.11 r 

ChccUDI 

OptionJD 1 

3 - ln.set with Light 
Shading 

N ame uscJ in code. 
Use chk as a prclix. 

N ame uscd in codc. 
Use optas a prcfix. 

Sets or returns the three-dimensional style 
of the caption. For examplc. you can set 
Font3D to ha ve font appcar raiscd or insct 
with light or dark shading. 
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Regular and 3-D-command Buttons· 

Style Guidelines 

Events 

[ Command1-] 

--·----.. 

Command Buttons and Their Common Properties 
A command button pcrforms a task w/1en thc uscr prL·:-. .... cs it. 

Propcrty 

Cancel 

Caption 

Default 

Enablcú 

Hciglll 

Lcfl 

N :une 

Top 

Width 

Value 

Dcfault 

F<Jise 

Comma1HJ 1 

F01lsc 

Truc 

51111 

Ct H!llllamll 

1215 ~wips 

Ct11JIIIICI11S 

Tn•t·-huH•lll :ldÍ\';Itt·d hy ESC. 

011-.-.LTCI.:Il \ :dtit~. 

TnJt•-hutl••l• :1.-1 ··\·:IIL'd hy Ei\'TI.-.1~. 

J<':JJ.'il' di:-.ahk:-. tliL· htl!ltlll ftl( U~CL\. 

lht: ruul a .... a flld"i\. 

Syrll<P:.-CnlllllliiiHil = Enuhlcd 

Place buttons in a group on a form, cithcr /ltlrizont;d!y ;don¡; lile hotlorn o( thc 
form, or vertical! y along. thc right 'iuc of lhc forrn. 

Click With command buttons, a Click cvcnt normally lllL'<JJlS that thc uscr wa1H:-. 

sorne _kind of action to takc pJ;:¡cc. In the case of an OK h111ton, i"or cxample. u ser." 
might want a form removed from thc scrccn so that tlwy can continuc work. In 
this case, you will be proviuing coúc . 
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Example 

\VilL·rr thc us~.:r u:-;c:-; tlle mousc pointer tu choose a command button, thc Click 
L"vcrll l:llanges the cólor of thc button (to simulate its being pressed) and executcs 
wlratL'\'L'r coUc you llave adUeU tu thc Click cvent proccdurc. A ·uscr can al so use 

tlic· kn·h .. aruto gcncrate a Click CVCIH for a button by tabbing to the button anu 
thcn prcssing lhc SPACEBAR. 

::111• f"••IHff•<iii(Jl_CJ ick () 

.:• ··~· id l execution of the· program 
;:¡,•[ 

3-Dimensional Command Buttons 
This lúnn uf thc cormnanU buuon bchavcs in much thc same manncr as thc othcr 
l·nnrnr;rrrd huuons. hut thcrc ;u\: a couplc of intcrcsting dillcrcnccs. 

l'niJit'rly l>cfault Cummcnts 
--·· ------------------------------------

C(Jillmturd~l) l 

( )llllllll" Truc 

Nonc 

.Spccific:-.tlrc tlridncs:-. oftlrL' lri!!,hli~.lll ;un! 
shaUow urounU thc button. VnliU rangc is 
from O 10 1 O. 

N ame úscU in co<.lc. 

Fulsc disnblcs thc bordcr m line cdging thc 
button. 

Enablcs pladng a picturc or icon on a 
com!llanú button. 
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O - Drop-down Combo Box 1 - Simple Combo Box 

--_ · -Form1" - · :· 

J[ti•Ju!ffilJJJ±'I 

List Box 2 - Drop-down List Combo Box 

There are actually four kinds of list box cuntrols. cach nr whic!l has a sli~htly 
different functionality. 

Both drop~down stylcs ofboxcs are dcsi!:!ncd to S<t\"L' 1111 i!JL' initial a1nnu.n1 111 

screen space in use by thc controL 

Users can only add ncw itcms directly into eitller a drtq)-downor simple combo 
box. With a list or drop-down list. thcy are limited llf lhl' t:hllin~s rrovidl'Ll hy lhL' 

apptication. 

List Boxes and Their Common Properties 
List boxes display a list of itcms from which !he u:-.t.!.r ,·<111 SL'iL'L'I tlnly onc at';¡ 
time. Through thc list box control, uscrs can tlnly SL'k,·t rrorn tlle fivcn lis! 11! 

articles, but you can writc codc that allows thcn1 to ;llld ;111d dL'ILIL: items durin~ 
run time through some other controL 

Automatic Scroll Bars 
Alllist and combo boxcs will automatically add a ,-vnll·at -''L'I'ul! har if th¡; nutnhvt 
o_fitems contained in thc list is grcater than what will t'il 111 thL' maximum di . ..;p!ay 
sizc of the control, which is sct by thc Hcighl prop~1ty 

l'ropcrty 

Colunms 

List 

ListCount 

Listlndex 

Dcfault 

Dcfault 

Cmnm en ts 

Enahlcs nwllipk ,-,,Juillll di .... pl;¡y pfdat;¡ in ;1 

single list box. 

Acccssihlc only al r11n IÍIIIL'. St:ts or rc1urns lhc 

itcrns cout;lincd in ;1 l'ontrol'_.., list str'tng arra~· 

Rcwrns thc numlwr of itcms in thc lis t. 
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Events 

Methods 

----------------~----------~-------

Propnt_r Dcfault 

l'\'lutliSdt·l't O- None 

NalllL' LIS! 1 

F'cilsc 

Comments 

Other options: 1 -Simple and 2- Extended. Nonc 
means that the uscr can sclcct one Wilhin thc lis!. 
Simple means uscr can select multiplc itcms 
using the cursor. Extended means user can prcss 
CTRL to selcct multiple itcms. 

N ame usctl in codc. 

Use 1st as a prctix. 

This is thc tJcfault propcrty for this t.:ontrol. 

Syntax-Listl = "Hcml" 

Click \Vitll ;1ny or thc list bo.xLs. ;¡ Click cvcnt occurs wltcnuscrs sclcct an itcm 
rl'lllll ()1¡' Jist (O Índkt~\L' tflcJr prcfCl"CilCCS. 

DbiClick 1\ douhk· click nonnally is used as a shortcutthat combines two actions: 
lht· ~L·In·tion and thc Starting up of a procCSS. 

N:11nt· 

¡\ddltt'lll 

Fum:tiun 

U sed to add individuul itcms to 
list box. Sccding a list box is 
done from Form_Load. 

U sed to remove itcms one ata 
time from a !ist box. 

U sed to rcmove all itcms in a list 
box in onc stroke. 

Syntax 

Listl.Ac..ldllcm "mrmc" 

List l.Rcmovcltcm (ListCoun t) 

Listl.Cicar 

Walk Through-Adding and Removing List ltems 
2:. To add and remo\'C list itcms 

l. h"~~nl thc Walk Throughs program group, start List Box. 

Whc·n the applícatíon starts up, the cursor should nlrendy be placed ín thc text 
ho.\. 

Tl11: pmposc of this application is to t.lcmonstratc a simple procct.lurc for 
;u.ldin!;! itcrns to anJ rcmoving itcms from a list box. 

Ty¡1l' llarwood, Gene inthc text box. 

t\dd <J new n:nnc in thc tcxt box. -----------------------
.'. Chott:-;c AJd. 

You L'illl do this with cit!lcr tlw mousc or thc ENTER kcy. 

~. s,·kc'l thc tcxt box. 

'j';tl1 ¡,, or click thc tcxt box . 

. \ Tv¡w .~inwns, Anna in !he 1cx1 box . 

.'\dd .1 '-l'CtliHI I!;JIIIt' lo thc list hox. anda vertical scroll bar slwuld appcar on 
~~~~~~ dr-,play. 
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6. Choose Pfeiffer,-Terry, _ 

Single-click this Iist item. 

7. Click the Remove button. 

The Iist item is removed frorn the displ;,y. 

The question herc is this: Hov .. · Uocs all of this Wtlll' 

L To code Iist box handling 

l. lt'Visual BasiL isn'l nHllllll~ ;d1cad~. :-Lllltt. 

2. From the File menu. chonsc Ncw Projcct 

Note lf yo u want to ·u o all or lile \Vtllt ft 11" tlli.-.. \\ ;d ~ 11 ll"i tll~ ll. ~() lo 1 ilL' IlC.\ 1 

stcp and start changing thc propcrtics l'tlf tllc fon11. 11 ytlU \\';llltto st;trt fn1111 ;1 

complctcd interface, you can also fiml a partially ~··,IIIJliL'lL'd form callcd 
LIST.MAK in \\VALKTHRU\SAMPI.ES. JI' ynu 1 ~¡,.,¡~l_' this option. skip 
down to stcp !2.thc point \\'hcrc you stan :tddin~ ~-~~~IL· \tlllh.' Ft>nn_l.ti;Hl 

CVt!Jlt. 

3. Sct thc propcrtics for thc: for111 ;ts follow: .. : 

Caption 

N ame 

Height 

Width 

Consultants 

Forml 

3075 (approximatcly) 

3420 ( approx i matel y) 

4. Double-click the Jist box tool in the Toolhox. 

Add a Iist box to the J"orm. 

5. Set the following properties: 

Name Listl 

Height 

Sorted 

Width 

1005 (approximately) 

Falsc 

2775 (approximatcly) 

6. Double-click the text box tool in thc Toolhox. 

Add a tcxt box to thc form. 

7. Set the following propertics: 

N ame 

Height 

Tablndex 

Tcxt 

Width 

Tcxt 1 

555 (approximately) 

1 

Blank 

2775 (approxim;,tcly¡ 

8. Double-click thc comrnaml button too! inthl! T'11dlu•\. 

Add a command hutlOil (() tht' rnrrn. 
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LJ. Sct lht.: following.propertics to crcate an Add button. 

C;tpl ion 

1 h'f:ttill 

1 h-1!~111 

\Vid11l 

¡\JJ 

CommanU l 

Truc 

555 (<~ppn>Xim:llcly) 

1215 (<~pproxim<~tdy) 

111. 1 ><>lll>lc-click thc commanJ bu non tool in the Toolbox. 

Add ;1 :-;Lx:ond commanJ butlon to thc form. 

1 l. SL'l !he following propcrtics to create a Rernove button. 

Ctt¡I[Í!lll 

Nanll' 

1 ki.eln 

\\'¡dlh 

Remo ve 

C(Jmmand2 

555 (<~pproxirn<~tciy) 

1215 (<~pproxim<Jtcly) 

N(lH that 'you llave crcatcc.J thc interface, you necd to add thc coJc lo make it 
t't111Ciiclll. 

1 ~- In IIIL' Projcct windnw, clwosc thc Vicw Cude button., 

i\Lt~l' :-;urc thilt !he Fonn is sclcctcd. 

1:\. 111 llll' Objccl list box, sclcct Forrn. 

1 ~. In lile l'roccdllrc list box, sclcct Load. 

t\<hlrhc inili<~liz<~tion cmk tlwt loaJs thc namcs into the list box when the form 
i." [ll<llkd at run time. 

i· i:! the 1 ist box at. run time 

·: .!,ddi1.<!111 'l·íorton. Joan" 

: . .rltll r •·rn "\•/hite, Don" 

.·\dcl!t.'!lll ··¡.¡arshall. Lynn" 

:.: .·\ddlle1n "'Pfeiffer. Terry" 

1 ~- In llll' ( Jbjl:ct list bnx. sclcct Command 1 <111d locatc thc Click cvcnt proccdurc 
in tlll' proccdurc list box. 

u;. ¡\lid 1hc following codc; 

l.i.'-'t •\ddiLcrn Tcxtl.Text 

This coJe l<~kcs whatever is in the Text property of the text box and aJds it to 
thl' list box. 

17-1·¡:¡-;¡-¡-¡-¡hc Run rnenu, choose-Sfart. 

Rtlll your application. 

1 X. Type llarwood, Gene in thc text box. 

Typc Gene Harwood's name in the text box and press ENTER or click Add. His 
n;1111L' should be added to the list box but not deleted from the text box. · 

1 'J. ¡:,""' rhe Run menu, chnose F,:nd. 

In ~~~-tl~·r to cle;1r !lE~ tcxt hox, you nccd to add a scconJ linc In thc Click cvcnt 
pr1•l·l.'durc lwrc. 

• 
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Textl.Text = "" 

This takcs care of thc simple addition ur iiLillS [ti il li··.t ho.\ . 

21. From lhe Run menu, choose S tan . 

Try adding Gene Harwood's namc onc more tinll' l! ..,JJuuld work ju:-.t finl·. h11t 
what about rcmoving it? 

22. From thc Run menu. choosc End. 

Rcmoving itcms from a list box is fairly straightrurward . 

D. In thc Objectlisl hox, sclccl CtHnn¡¡¡mi2_Ciid . 

24. Add the following codc: 

l.isLl.Rcrnovf!ll.f!m J,i;,tl.J,i:;t ll~<h·:" . 

This ende rcmovcs thc itcn1 indicJtcd hy tllc vtdilt' 1d l.i-..t l.l.istlndcx Tllc 
Rcmuvcltcm n1cthod rcn1ovcs itcn;s tllh' "' 11 tin11· Wlllt :->~JJ;tll lists. lhi:- ·1111)..:111 

be suitablc. With largcr lists, you would use thc ('!toar lllL'liltlll. 

The abovc codc will cause an error if no list itcm i." -.,t·il·l:tl..'d. You c;n1 ;~void 
this by modifying thc codc as follm'.'S: 

If Listl.Listlndex = -1 1'h0n 

El se 

msg$ = ~Please SclecL <l Cutl.'>lllt .. rrl · 

MsgBox msg$, 64, ~List ;.;electll'•rl" 

Listl. Removeltem Listl. Listlncle:< 

End If 

25. From thc Run mcnu. choosc S tan. 

Add and dcletc n couplc of na mes lo scc th;1t thc ~-~~~k· wnrk ...... 

26. Fram the Run mcnu, chaose End. 

Clase thc applicalian. 

How about sorting this list? Don't yo u ha ve tu add :1 lot of cmlc Lo son thc 
items in the list? No, you don't! You simply sct thL· Soncd propci"ty to TruL· 
for Listl, and al\ items insertcd in thc \ist will be :-.ortcd aut~tmatically. 

27. Clase thc Codc window. 

2X. Frwn thc l'ropcrtics list hox, sckct Sorll'd lor lh1· !J.,I !u l.\. 

Click the List 1 list box on thc form. 

Se! thc Sortcd propcny 10 Truc. 

29. Fram thc Run rnenu, chaosc S tan. 

Note that thc namcs in thc listare tww sortcd. Add ;Hhl d,:ktc ;¡ coupk 11!" 
names to see that the sortcd urdcr of thc list is maint;Jincd. 

30. From the Run menu, chaosc End. 

Clase the application. 

J l. Savc your form and .Mi\ K riks with ilJljll'tljlfÍilh' lli!IIIL''\ in 
\W/\I,KTHRU\S/\MPIJ~S. You c:111 "'"L"Iwrilt•tll,· Id,· ii" 11 ;dn•;¡dy l'.\i<..ts. 
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Walk Through-Combo and List Box Differences 

I To add l'lllrit..·s lo t.:omho amllist boxcs 

1. ¡:¡·,,¡n lhc \Vtll~ Throughs program group, starl Combos. 

Ty¡l(' Fn:d in th<.: drop~Juwn combo box. 

1!. yc•ll pr~ss !he DO\VN AIU{Q\V kcy. the Jist of namcs is tJispJaycJ . 

. ~. l'tl'"' I:NTER 

TIIL' ll<lllll! Frcd is adtk:J to thc list. If you adtl severa! more namcs, a vertical 
.'<:1<>11 bar is al so added to the list. 

4. Ty¡>t' Natasha in the simple combo box. 

:'i. i'l"l'\\ ENTER 

Thl· tll'\\' n<llllL' will be addcU to this list. Noticc hcrc tllat thc scroll bar is a\so 
iltltlt•tl. 

(J. SL'iL'ct thc nalnc Larry inthc tlrup-downlist box. 

Thi.' n;11nc appcars in thc box at the top of the list, but users cannot add items 
111 !he list Uircctly. 

7. h·orn thc Control rncnu clwose Close. 

C'lo.'L' the application. 

--------· 
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Events 

_ Combo-Boxes andTheir-Corrimon Properties 
Propcrty 

Nnmc 

Style 

Text 

Heíght 

Tcxt 

Dcfoult 

Combo 1 

O· Dropdown Combo 

Combol 

300 

Comn H' o r .... 

u~c chn ;,, ;¡ pn:fi\. 

1 · Sir11pk ( ·,,r¡rht~ 

~- Dr(lp-d111\'ll Li~r 

Sirnpk l'IIJJihti-Thc hciglll di .... playL·d 
hoth ;u dl'.-.Íen tÍillL' ;un! run !Íllll'. 

' ' 

/)n,p-llto\\!1 SL'IIIL'Ígltt pnl[IL'I'ty ;¡¡ 

dL'sÍ_glllilllt' (tll' flllliÍrtH.:). hui IÚ/J ln:1~111 

willnlll hL· di:-.plttyed until thc u.'il'r 
drop . .;, d1111 n rlu: lisr ;rt nm time. 

·¡_-hi~ Í~ ti11' d,·(·,¡tdt fllll[lCrl}' (¡IJ' llil' 

UllrtroL 

Changé A Changc cvcnt indicatcs that thc contcnts ,¡(" ;1 L·orllrol ha ve changcd. In :1 

combo box, a Changc cvcnt occurs whcncvcr you cdit llrv tc.\t Jlnx poriion of lht· 
combo box or whcn you <Jssign a ncw value to the T ~.\1 prtlpcny from cmk. : 

Drop-Down and Simple Combo Boxes 
Drop-dow-n combo boxes are an alternativc to option J¡JJ!tons within frarncs: tll;tt 

is, thcy are designcJ (O display a JimitcJ llUillht:r of J¡¡~jl·;I]Jy !IJTilllgc<.J c!JoÍL"L:-. 

from which the user may sclcct onc. A classic cxallljllv <Ji" :1 drop-JownL·onJh<' 
boX is found in tllC Wimlows Control P~l/lCJ. Frnm lilL' s~.·ttillt_!.>; llll'IHI. !llL' ll."l'l" L"illl 

choose Po~ts and thcn Set the baud ratc for thl' mmktn 011 ;¡JI)~ n11e of cight J"l1L..;sihll' 

values, or type a valuc into thc text box portinn of thc l·ontrol. Tllc ncw ,·,duc 
typed can then be added to thc lis t. Thc úmp·down L"lllllho hll.\ cnablcs ;¡ 

scroiJable Iist that allows thc uscr to revicw more clll,in·:-. lht~nc;ul be casily 
presented on screcn. The u~cr's choice is displayl'd in 1111' 1op ho.\. 

Drop-Down List Combo Boxes 
Drop-down list combo hoxes are uscd lo pa·:--.l'JII tl.,l'f .... \\"1111 :1 lnnitL·d rlltlllh,·r !!l 

choiccs, from which thcy may sclcct only onc. 

Key Feature 
Both drop-down combo ami drop·down list cot11bo h1.l.\l'S displ<~y Uata frolll \\'hiL"ll 

the user may selcct only one choice. But \vith ;¡ Jrop·d¡J\\'11 lisltlsers can onl~' 
select from the list; they cannot add to it. 

'j_,c·. :;m.¡¡¡u as. 
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Scroll Bars 

~ ,'f,11f -. ·. Form1 lall 

Scroll Bars and Their Common Properties 
Sen di h;¡r~ are 1lwst commonly uscd to cm1blc quickly moving ;.Icross a long list 
or itL'In:-.. ~uch a~ a long list of filenames. Thcy can al so be used for indicating thc 
cutTL'III position nn a sea le. Such as shadcs of coloring for customizing thc look 
<HHI rcl'l of tllc scrl'cn. Or. scrnll bars might be u sed to inUicatc the vol u me of an 
;¡udio ."~'"IL'Ill. 

llcfault 

1 (1-02.71>7) 

.12.7(,7 

1\lin () 

N<lllll' IIScrolll 

-or-

Vs~.:rolll 

Commcnts 

Amount of changc \vhcn uscr clicks scroll 
bar shaft. 

Maximum value of scroll bar handlc in 
bottom most position. 

Mini m u m value of scroll bar handle in 
topmost position. 

N ame used in coUe. 

Use hslJ as a prelix. 

N ame uscU in codc. 

------------------------~----------------------------------------~U~s~c_v~s~u~a~s __ a¡~>r~c~ll~x~·--------------------------------

Events 

SIIl;dl< 'h¡¡nge 1 ( 1-32,767) Amount of change when user cli~ks a scroll 
:UTOW, 

11 This is the Ucfault propcrty for this control. 
Can be set by user's direct interaction with 
the control or through code in response to 
othcr events. 

Chanye 1 k\·ms wilc11 lile cottlculs of lile cottlml ha ve chaugcu. 
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Walk Throligh-·· Scroirsars,-Properties, and tne Change 
Event 

L, To scc scroll hars, propcrtics, aJHI thc Clwngc en· ni 

l. From the Walk Throughs program group. Slart Scr,ll llars. 

You will scc a form with a vertical scroll h:rr on iL 

133 

The purpose of this application is ro UcnlonstratL tltt· hdJ;tvior of a scroll h;11 

and thc cffccts of thc propcrtics LargcChangc :111d \rnaiiCiwngc on thc V:dul· 
property. 

2. Click the arrows on both cnUs of thc ."LTtdl har. 

·Note thc change inthc Va fue propcrty. 

3. Click on thc shaft of thc scroll bar both ahnvc :111d IH·Iow tllc scroll ho.\. 

Note the chnngc in the Value propcrty. 

4. Close thc applicatiun. 

5. Start Visual Basic. 

6. From thc File menu. choose Ncw Projccl. 

S tan a new project. 

7. Set thc following form propcrtics in thc Pn1pcnic.' H·indow: 

Height 

Width 

4425 (approxim:l!clyl 

5430 .(approx imalcly ¡ 

8. Double-click tllc vertical scroll bar tool ÍJJ ll1c. Tot)l/111\ 

Add a vertical se rol/ bar ami c/wngc son1e ur its pn lJlt'rl ics · 

·Height 

LargeChange 

Max 

SmaiiChange 

Width 

3495 (approxim<lleiy) 

20 

100 

10 

lJ. In thc Projcct wimlow, clwosc the Vicw ('t)tk hll!lll/1. 

Makc surc lhal Fonnl lliiS ht'l'll sckt"ll·d. 

10. In the Object list box. selcct VScroii_CIJallgc. 

Locatc thc Changc cvcnt procct.lurc ror lhL' vcnk;d '>dtdl hill". 

!l. Add the following code: 

Print ·vscrolll.Value = ~. VScrolll.Vnlue 

Display the Value property each time it changcs. 

12. From the Run menu. chooseStart. 

Test thc application you ha ve writtcn. 
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1.\. ¡:l'tllll lile Ru11 menu, chuosc End. 

('111'-l' !he application. 

1-!. <)11i1 Visual Hasic. 

1 .". Savl' ynur form anti .MAK files with appropriatc name.s in 
1\1' ¡\I.KTHIWISAMPLES. 
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Timers and Their Common Properties 
Timcrs are uscd to run cvents ata spcciric tin1c or witlli11 ;111 Íllh.;rval that y()u 
spccify. For cxample, within a schcduling applicati~~n.tinler~ \\'ould h\>Uscd tP 

cnablc alarms for thc u ser. 

A spccial characteristic of this control is that it is llt:\'L'I' visihk· at run IÍlllL'. 

Propcrty Dcfault 

Enablcd Truc 

lntcrvnl o 

N ame Tirncrl 

Commcnls 

Tllis iS tllc dt·l:ulll l'll'PLTIY fnr 1hi." 
con! rol. 

SynttL\ Tinu-rl = Fnahkd 

Countdown Ílltcn·al for thc IÍml'r. 

Jlll':L\llll'd IIIIIHiiiÍ.\t't'lllldS. 
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Walk Through-Ciock Application and the Timer Control 
I.. To 11M' lhl· timcr control 

l. l:nnnlilc W;dk Tilrougils program group, slart Clock (Timer). 

\Vlwn you s\art !he application, you will scc a form containing a Jigital clock 
di .... pl:tying lile dt1tc ami ti111c. The cluck will be updatcd evcry scconJ. 

'Jh.· Jlll!'posc 11r this applic;ttion is to úcmonstratc the bchavior ami use o!' a 
tillll'l ciHltr()l 

lltltlhit'-click thl' Control rnenu. 

<.·¡~''t.' tllc v.:alk through. 

.\. S!atl Visual Ba .... ic. 

-1. h·o¡n tlle File tncnu. chooSI.! Nt.!W Projcct. 

St;t.r 1 <1 ncw prujcct. 

s. Sl'l lill' propcl'lics ror tiH.: fmm as fullows: 

HadJ'¡¡Jor Ycllnw 

Ht1nlnStylc :\- FixcJ Doublc Also rcmovcs Min/Mnx buttons 

('aptilnl 

1 ki~ill 

Witllil 

Clock 

22:15 (appro.ximatcly) 

lrmCiock 

4:145 (approximatcly) 

¡, 1 ).,llhk-click lile labcl 1ool in thc Toolbox. 

Add " labcl lo lile form. 

7. St·t the propenies for thc labcl as fol\ows: 

,\IÍ).!Illllt'lll 2- Ccntcr 

H;1l·U ,dor 1\cd 

1 ';q'l'''ll 1 lliHa· J 

1 ki~ht 

l .• ·rt 

Nolllll' 

TIJ!l 

\\'idl h 

12 

\V hite 

1.<~0 (approximalcly) 

1:'11 

lhiU11tcTimc 

4:'11 

·10 15 {approximatcly) 

S. u .. uhlc-click lile timer tool in thc Toolbox. 

IJ. SL't thl' following propcrtics: 

Nan1e tmrTimerl 

1111111 

l'lill"l' a LÍIIIL'I' 1111\hl: rui·nl. Scl th~: ¡_Jropcrtics l"or il. You ~:an place it anywhcn:. 
· llchiml thc lahcl will be fine, because timers are not displayed on screen at run 

1 i llll' 

e 

e 

e 

e 

e 
e 
e 
e 

' 
' 
' 
' 

• ' 



1 

,¡ 

" 

• 

' 
' 
t 

1 

---------------------------M~o~dute 6: Using Controls 

---10. In thc Project-window, choosc-thc-V-ic\\'-~tllk \\'IIHh•w. 

Make sure that frmCiock has the focus. 

11. In thc Objcct and PrnccLlurc list ho.xcs. hH_·;¡tc thv 1.1111-"l"ilnl·r l_Timcr. 

Locate the Timcr cvcnt in thc ende. 

12. Add the following code: 

. lblDateTime.Caption = f.'orrnnL::;(No• ..... "uHnnun d. , , :.- 1, :'"":::·· .. no/¡,,,··¡ 

AJú thc codc on thc bl;.lllk linc in thc Click cvcn1 Jt·¡npl:lll'. 

13. Double-click the Control menu. 

Clase the Codc window. 

14. From thc Run mcnu, choosc Start. 

Testthe Clock application that yo u ha ve just crcat•·•l. 

15. From thc Run mcnu, choosc End. 

Clase thc clock. 

16. Quit Visual Basic. 

17. Save your form anú JvlAK files with Jppropriatc 11:1n1c .... in 
IWALKTHRU\SAMPLES. 

Using a Timer to lnitiate a Task ata Specific lnterval 

137 

You.can use.the timcr to initiatc a task after a ,o.;pcciric Íllh'rv:d. IIJthc lúllmving 
example, thc timcr cvcnt starts a backup ¡xoL·cdun.::. Tlh· 1 inlLT l'\'C11l occuL" ;tftn <tl 

least 60 seconds ha ve clapscd. Yo u couiLl p!;tcc cmk in lhl· Titlll'l' t:\'Cntto L"hL·ck tllt· 
current time and start thc backup routinc only ;ti ccrt;1ill ltttlc:- . 

1 ., 
) 

4 

S 

6 

7 

8 

Sub F'orm_Load \) 

Rem Timer will go off after 60 

timerl.Interval = 60000 

·timerl.Enabled = True 

End Sub 

Sub Timerl_timer () 

x = Shell ("e: \mybackup bat .. ) 

End Sub 

se<:<Htds. 
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Picture Boxes 

Events 

a; · .. = ... Form1 · : · ···1111 

Picture Boxes and Their Common Properties 
1 'Íl'lllll' ho.\cs are useJ lo display a rangc of graphics, from icons to ~itmaps to 
llll'lodi,l¡·s. Youcould use a pictun.: box. for t:X:.tmplc, to display thc icons in thc 
Vi>ual Ha>ic icons library. You coulu also use thc picturc control to display thc 
Klllll> .,¡ card hacks availablc for users of a Solitaire gamc. 

J•n,¡wrlr Dcfault 

:\ttlidü·dr;¡w Fa !se 

;\ llli 1.\1/l' Falsc 

1'\J Olllll: Picturc 1 

1 'Íl'llll t' (nonc) 

Commcnls 

Willnot l.lutonwtically rcpaint. 

\Vi\1 not automl.ltically rcsizc control to fit 
its contcnts. 

N ame uscli in codc. 

Use pie as pretix. 

Use Load Picturc dialog box at dcsign time 
to sclcct a .ilMP, .WMP, or .ICO file. This 
is the defauh property for this control. 

Syntax-Piclurcl ::; LoadPicturc(''\¡mth'') 

Paint Tllis event occurs whcn a fonn or control is movcJ, cxposing parts that 
H\.:n.:rr't initially paintt:J on scrccn. Note thut this applics only whcn AutoRcdruw is 

.'l'! lit Valse. lf J\utnRcJnJw is sct to Truc, rcpainting is done automatically, anú no 

P:lill! l'·\"L'Ill ()CCLII"S. 
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Example 

Example 

Example 

Loading:a~Picture at R~n-Tim~_-
To load a new picturc file from Jisk into a picturc h,,_, ;tl r_un time, call tlle 
LondPicturc function with thc namc of,thc fik you w;rrrl 111 lt1ad. 

Sub Commandl_Click () 

Picturel.Picture 

End Sub 

LondPiCtllr<~ l"\IJI'.\Io·r,;¡:: :.¡~·•:!:: '••!11'1'1/..:r·o.· 

~f you want to copy a picture rrom onc piL·turc !Jo.\¡,, ,IHiilllt·r .11 run tilllL'. u.'-L' tht' 

Imagc property of thc picturc you \\'ish to cupy . 

Sub cmdCopyPicture () 

Picture2.Picture Picturel.Image 

End Sub 

Clearing a Picture Bo'x 
At design time, clcar thc Picturc propcrty by clickinli !lit· pictur"t.~ box you wish ¡,, 
clcar. Make sure thc Picturc propcrty is sekctcd in tllt· l'rnpcrtics list. click thc 
settings box, and thcn press the DEL kcy. ThL scttin~:- b11\ will now rcad 1no1h .. 'J. 

At run time, clear a picture box's Picturc prupLrty hy ~·;dlin!-! !In: l.o;niPh.:ture 
function with an empty argument. 

Sub Comrnand2_Click () 

Picturel.Picture = LoadPicture (J 

End Sub 

c.. ~ ,, 
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Walk Through- Pie tu re Box Controls and AutoSizing 
I Tu liSl' pirturc ho.x rontrols ami autosizing 

\. Slilll Vi;.;ual H<1sic. 

h·~~~~~ tln: Fill: mcnu. choos¡; N¡;w Projccl. 

( l¡wn ;1 ncw hbnk form. 

1 )ouhll'-click th¡; picture box icon in thc Toolbox. 

PL1n' :1 picture cuntrol on t[l¡; form. 

_¡ SL·[ 1hl' rolltnving propcrties for the control: 

AutoSize 

JiL'I,i!hl 

\Vitlth 

Truc 

1 llllO (approximatcly) 

111110 (approximalely) 

.'1 Pl<tcc an icun in thc picture control. 

(J. Sct thc Piciurc property to: 

1 Vl\111 'ONSIAI<ROWS\ARWO 1 DN.!CO 

Thc ¡1il"lurc bo.\ automaticall)r rcsizcs to fit the graphic wbcn it is added. 

7 I'Lw\' '' hítmap inthc picturc control. 

X. Sl't thl' Pictun.: property to: 

1 Vl\11\ ITMI\I'SIGAUGE\CIRCLOCK.BMP 

TIH' ¡1 il"lurc l1ox <tUtolll<llic~llly rcsizes to fit this graphic. 

lJ. TP !L'IIHlVC thc Picture propcrty: 
C'lwk lile N:unc property and thcn click back on the Picturc property. 
( ·¡,d, in thc Scuings combo box ror thc Picturc propcrty. 
I'!"L.'-'- thc DIJ. h·y 

Tite ."clting~ hox wi\1 rcaJ (nonc). This will rcmove thc graphic from the 
l'i~·tmc propcny of thc picturc box. 

111. (Jtlll Vi>uallla>ic. 



Summary-

• Types of Controls 

• Properties for Controls 

Objectives 
In this module you.sct kcy propcrtics !'or: 

• Labels 

• Tcxt boxcs 

• Frames 

• Command buttons 

• Check boxcs 

• Option buttons 

• Combo hoxcs 

• List boxes 

• Horizontal anU vertical scroll bars 

• Timers 

• Picture boxes 
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Lab Time 

(i,llt•IIIL' r\ddin¡; Controls to Forms portion nfyour lab manual. 
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I. Overview 

• File Browsing 

• Grid Control 

• 3-D Panel Controls and Group Push Button 

Overview 
This module is designed to dircctly follow tlle control..., 11111du1l'. <~llJ ir covers mo:-.1 

ofthe rest ofthe tools in thc Toolbox. Howt.:\'l'L hccau:--l' ~~r tilllL' limits it Uocs 11111 

cover picture clip, lightwcight linc and shape. ÍIJlilge. ;¡¡¡d "l'l"ialt·ommunication." 
controls. 

The first part of the module discusscs file browsi ng ct 1111 r1 d ..... ~- ri k. di rectory. ;md 
drive Iist boxcs as we/1 as thc common di;dog L'Oillrol: Tlit' (i~: ... t linee are s¡wci;llil.l'il 
cnntrols that actjust likc regular list boxl's; hui ;1s yott H ill Sl'l'. tilL'Y hii\'L' -~PLTI<d 
fcaturcs that makc thcm distinct. 

Thc purposc of this module is lo wa/k you tJm,ugh lhl· J J, n\· ,,f vn·nts that ;1n· 

nccdcd lo conncct thc various controls. Thc L'111ph;¡si:-. llt'll' rs on !;dking ;rbout tllL' 
kinús ofcvcnts that nccd to be uscd in ordcr 1"1n·Jhc L'lt;lll!-'l'S ort llltL' corund to hl· · 
rc!lcctcd on thc othcr control.' 

Thc rl'sl ofthc rnodulc pnrvidl'S )'1111 wit/1 dis,·t¡·.sH,II ,¡ .111d \\·:dk drltlll~l,_..., lo1r llll''•t 

of tl1c rcst or thc tools in thc Toolho.\. 

Prerequisites 
This module assumes prior cxpcricncc with: 

• List boxcs 

• Click event implemcntation 

Overall Objective 
Thc ovcrnll nhjcctivc is ror you [(l dvve!Pp ;[ll awarl.'IH'\"• '" llll' 1\'.\[ uf liH: ltHII.\ 111 

thc Toolhox. 
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Learning Objectives · 
:\1 t!J,· cm! of this module. you will be ablc to: 

• 1 k.-.;i~n and dcvelop a form that lets uscrs browse drivcs, directoriCs, and ti les. 

• 
• 
• 

lJsc· lile Chaoge and PathChange events . 

1 1:-l· 11tl· grid con! rol. 

ll ..... l' lile group push butlon and 3-D panel controls . 
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L, File Browsing 

• Scenario 

• Properties and Events for File Browser Controls 

• The Common Dialog Control 
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Scenario 

File t!ame: 

• .txt 
3270.1xl 
byle.lxl 
networks.lxt 
printers.txt 
readme.txt 
sysini.txt 
sysini2.\xt 

Qirectories: 
c:\windows ··· 

oc:\ 

L!windows 

O syslem 

File Browsers 
A quiá revicw of the workings of thc file browser in Notcpad shows that a number 
<>f cvenl< occur when thc uscr sclect~ a differcnt drive or directory. lf the user 
selccts" ncw drivc. the dircctories and files Jist boxcs are automatically updatcd, 
:-.h,lwin~ thc curren\ working c.lirectory for the systcm and any files (of the file typc 
:-.p~.:cifit•d inthc List Files OfTypc list box). 
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Style Guidelines 

Walk Through-How File Browsers Work 
L To use file browsers 

l. In the Accessories group window. open Notcpad. 

All of you ha ve used a file brow.scr of (1/ll.' scwt <)r <JJlt f!l¡er. hui yc1u rnay ncll !J;J\'l' 

looked closely at how it works. 

2. From the File menu, choose Opcn. 

Drives list box Tbe Dri_vc.s !ist box is ¡¡ s¡JL·ci;J! !onJ111f dro¡Hlownlisr ho_\_ Tl1c 
user can sce options prcscntcJ in thc list hut cannor ;1dd iiL'IIL\ ro ir. 

The more imponant clcment to notice atthis poi ni. !toWL'\'L'I'. is th;l! wllcn the 
u~cr sc(ccts a ncw Orive. t/Jc ch;¡ngc in sdection ¡_.., rdkL-rl'd in 1!1c dirccrory and 
file list boxcs as wcll as in thc curren! working dirl'L'!Hry. 

Oirectories list box T!lc Dircctorics Jisr hox is a ,..;pt·l"i<d fon11 of list hox. lt 
bchavcs likc a regular list bnx but displ;tys only dirL'clurio ;111d subJircctoril'\,. 
Uscrs cannot add items to or de!ctc itcms frorn thc !i:-.1. 

File Na me combo box Tllc File N ame combo bm. i., ;t "Pl'Li;d l'orm of the lis1 
box that scnds ami rcccivcs rncssagcs from a texr /)11.\. TllL' 1~·.\1 bú.x a!!ow." user.' 
to add itcms to thc list, Somcthing that C<Ul/lol be d11lll' wi1!1 11 lis! box. 

List Files of Type Combo Box Noticc tlwl 11lis. !tul. ¡, ;1 dr~~p-down lis1 ho.\. 
Users can sclcct itcms from it, but thcy CI/Hlol add irt·nts In it tlu.!msch·cs . 

.. Curren! working directory Finally. rwticc rllat tllc·r.· ;, ;r la he! t!Jat tclh tl1e "·'"" 
the current drive and directory. · 

3. Choose Cancel, and close Notcpad. 

End walk through. 

Typically, file browscrs can be sct to display only a givcn typc uf file in tlle 
specified drive and directory. Becausc Notcpau is dc.,igrrcd to l'l'<td lilcs tlr;rt lr;l\·c 
the .TXTextension, .TXT is the default file typc a·nd ' ' is rhc sccond clwicc. 

Bccausc lile Employcc Datab<tsc application is dL:signcd lo lm·;lll' .HMP ;~nd \V¡\·11· 
tiles, they will be the dcfault file typcs. 
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Properties and Events for File Browser Controls 

Example 

oc:\ 

Dr~ve, Directory, and File List Boxes 
Allthn:l' of thesc controls are spccial fonns of list boxes. Thcy ha ve many of thc 
:-;;11m: chtlracteristics, but thcrc are a\so a numbcr of spccial propcrtics that they use 
111 enahk navigating through a file systcm. 

Orive List Boxes and Their Common Properties 
Thl' 1 ir;;~ or thcsc controls is thc drivc list box. It is a special form of the drop-down 
list hux. lnitially it only shows the current drivc For the Form. Howevcr. i[ the user 
1.:1 icl\slhc drop-down arrow •. thc control wi JI U isplay all of thC othcr drivcs currcnt \y 
tl\·ailahk on thl! system. 

l'rupl'l"l y l>chlUlt 

Drivel 

1 )riv~ 

Synchronizing the Orive Property 
:,, ¡, 1 '~ ; · ... 1 __ ch.-IIHJ" ¡ ¡ 

CtHliiiiCJlls 

N ame uscJ in codc. 

Use drv as a prctix. 

Accessible only at run time. this propcrty 
returns the selected drive. This is the dcfault 
property for this control. 

"';/l,•·r' tlr iv" i~; <"h<~w.wd, ~~~!H.:L Lhc dircc.:tory lisl bux piLLh 

lliri.Path = LJt·ivel.Drive 



Module 7: Building a File Browser 151 --------------------------------------

Example 

Example 

Directory List Boxes and Their Common Properties 
Propcrly Dcfnull 

N ame Dirl 

Path 

Synchronizing the Path Property 
Sub Dirl_Change () 

COIIIIIlt.:IIIS 

U.'>C dir a,..,;¡ JHet'i\. 

i\CL'l~~sihk otil_\' ;rl run IÍIHL'. this prop~;l'!y 

rcturns thc ah~r dutc..: palh l(rr thc sdL'CtL'd 
Jircctory. Thi .... ¡..., thc dl'fault propcny for thi., 
l'Oiltrol. 

' When directory is changed. res'::!t llH~ fil1:: ! i.--:r hr·.;-: pilt.h 

Filel.Path = Dirl.Path 

End Sub 

File List Boxes and Their Common Properties 
Propcrty 

Archive 

N ame 

f<'ilcNmnc 

Hiddcn 

Lis! 

LislCoum 

Listlndcx 

Normal 

Path 

Pattem 

ReadOnly 

System 

Dcfault 

Truc 

Filel 

Fal.<ic 

Truc 

• • 
Truc 

Falsc 

Accessing the FileN ame Property 
Sub Filel_DblClick () 

Labell.Caption = Filel.FileName 

End Sub 

Commcnts 

Displays all fik" witll ;rn:hivc bit on. 

N ame uscd in .. :lltle. 

Use lilas ;r prL'Ii\. 

St.:ts or n:tunrs rile SL'k·~·rcd file frnrn 1he list 
pnrlion of a fik li.'-1 hrr\. At.:ccssihk: only at 
n11r tinrt.:. Thi:-. is lile dcf;rult propcl'!\' frrr tlli, 
e! lltlrr rL . 

Dol'S not di .... pl;r\' hiddl·n l'iks. 

t\Cn:ssihlc 111ll~· ;¡l I"UJl IIIIIC: I'CIUr/1.\ lhL' ÍIL'IIl.\ 

cnntaincU i11 ;1 11...,1 hu.\. 

1\Ci...'t.:.\siblt; only ;11 ru11 tin1c:. rclurns thc !tl!al 

numbcr of itcrn .... i11 tlw list box. 

;\cccssibk only ;11 run IÍrm:: rctum." thc ÍIHk.\ 

of lile (lliTL"IIIIy ~t"lt:L'IL'd ÚL'Ill. 

j)j,..,plays ;i/1 l'il,·.., wi1l1 ;lll'llivc hir .\vi 1111. 

J\l'l'CSSÍhk tlllly :11 l'llll lllllL". 

Display a!l J'iln . 
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Events ~ - ~ ~~ . ~~Ciick ·1.,, <111· tlirc:li ,)(ílíc5asic controlS,UCTicl. event irídlcates th<il ilie~userl1as~
llwde ;1 sl'lection. That is, thc uscr is sclecting or changing drivcs, dircctorics, 
~lihdilt'L'Illi"ÍCS, lll" fi[cJlalllCS. 

Double-click The unly time that a double click is routincly used in a file browser is 
whL'Ii thv uscr u~cs thc File N ame combo box.·In this case. thc doublc click 
indicalt"' that thc u ser has locatcd a spccific tile of intercst antl wants the 
ilppliL·alion that uses thc file browscr to actual! y opcn that file. 

Change The real workhorses of a file browser are thc Change events. Code that 
yt 1t1 ;u Id In thc cvcnt proccdurc tcmplate kccps the thrcc controls synchronizcd 
wh~..:ncvt'l' lhc uscr ~¡;Jects a ncw itcm in one of thc list boxcs. 

PalhChange This c:vcnt occurs when the sclccted path has bccn changed by setting 
tlle hld"h1mc or P:1th propc1ty from code. 

PatternChange This cvent occurs when the pattern has bcen changed by setting the 
l:ikNollliL' or l'allcm prorerty from cmlc. 
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:L Change Events 

• Change Event 

• PathChange Event 
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The Change Event 

Example 

Example 

Dirl_Change () 

ilttloexec.bat 

autoexec.bak 
command.corn 
conlig.bak 
config.sys 

O discover 

O dos 
O lm.dos Dri vel_Change ( ). 
O lmdos.old 
O windows 

,., 
. ' Changing the Path for Differing List Boxes . \:Y,. 

Change Events Changc cvenls intlicale thal thc contcnts of a conlrol ha ve changcJ~ 
Change evcnls are associated with a wide variety of controls·including combo 
ho.xcs. horizontal aiu.l vertical scroll bars, labcls, aml picture boxes. For our 
purposcs. this module focuses on thc Changc cvents for dircctory und drive list 

Directory List Box Thc Clwngc cvcnt is invokcd whcn thc uscr clicks a ncw 
dir'l.Ttor~· ti!' whcn thc Patl~ propcrty is ¿hangcd from thc coc.lc. It indicates that ~he 
L'otJ!l'tJI." uf thc t:ontrol havc bccn changcd. 

;..:q]) Die l_Change () 

' \Vil"'rl direc.:tory is changed, reset the file path 

Fi l~l .Path = Dirl.Path 

l~11d S•il • 

Orive List Box The Change evcnt is invokcd when the uscr sclccts a new drivc or 
whcn tllL· Drive propcrty is changcd from thc code. It rcscts the path for the 
tlin:ctory list bux. 

.''lh Drivel_Change () 

•,Jir·'!l driVf~ is changed, reset the directory's path 

l!irl í'irth;; Urivel.Drive 

:id ~;,¡¡. 
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Walk Through-Drawing and Coding a File BrOwser 
I To draw and codc thc file browscr 

l. From the Walk Throughs program group, stan Browser. 

\Vhen this application starts, you will seca simplifi•,:d rllrnl uf thc fílc browst.'r 
used in the Employcc Database. This form has rilé. dtrcctory, and Jrivc li" 
boxes only . 

Click a ncw dircctory and noticc !he file list is updatcd . 

The purpose of thc application is to dcnwnstrate 1hc 1\uh ;md Drivc prnpcrtit.'~ 
t1nd the Change evcnts tlwt are u sed to . ..;ynchroni!.l' n 1111 rol:-. . 

2. Closc llrowser. 

3. Start Visual Basic. 

4. From thc File, choosc New Projcct. 

5. ForForml, set thc followíng propcrtics in thc Propt.:ni~.·s windnw: 

Height 

Width 

3930 (approximatcly) 

42~0 (approximatciy) 

6. Doublc-click thc file list box too] in lhl' Toolhnx. 

7. Set the following propenics: 

Hcight 2760 (approximately) 

Width 1455 (approximatcly) 

8. Double-click_ thc directory list box tool in the Toolh, '·'. 

9. Set the following propertics: 

Hcight 2175 (approximatcly) 

Width 1455 (approximately) 

10. Double-click the drive list box tool in lile Toolbox. 

1 1 . Set the following propcnics: 

Width 1455 (approximatcly) 

Thc first step of implcmcnting a file brow.st.:r is to add 1he Cll<l!lge cvent ende 
that synchronizcs changes in the S tate of the orive"'"' directory list boxcs. Tn Jo 
this, you need to: 

12. Double-click the drive list box. 

This displ~tys !he Cmlc window wilh lhl' 1 hÍ\'t'! ( 'h:uq:t· c\·vn! pnwt·dun· Í11·11 

13. Add thc following code: 

Dirl.Path = Drivel.Drivc 

This code resets thc Path propcrty of lile dircctory ¡,,¡ hox 1<> tllat of !he Drivc 
property of the drive list box. 

Now the directory 1i~t hox willlw. keptrurn.'lll with ~·h;111~t·~ inthe. drivc li\1 ho, 

llt!l wltat abnut tite file lis! hox'! 

14. l'ront !he Objcctlist, sclecl Dirl. 

Thc Code window witlt the Diri_Change e ven! tcnq•lalc ¡, di,playcd .. 



i 
. ~ 

;¡ 

1 :; .. , ¡, ., 
¡ 

' ' 

~ 1 

i: 

1 
1 
1 
' 1 

j 

156 Module 7: File Browscrs and Othcr Controls 
--------------------------------------------

1.,. Add lile following code: 

Fi ¡ .. 1 l'iH.h Dirl.Path 

1 1>. C:lid hmnl lo display the interface. 

Tlle code adtlcU above rcscts thc Path propcrty of thc tilc Jist box to that of the 
Patll propcrty of thc Jircctory list box. 

Tilc cilaractcristics of the Path property of a directory list box vary depending on 
whcthcr thc uscr's currcnt wnrking dircclory is the root Jircctory. 

Ir thc u ser sclécts thc root Jircctory, the path will be"\" -that is, a path (in this 
GI~L· the root). \\'hich is a backslash. If the uscr sclccts any other dircctory, thc 
p;1th will cnd in the currcnt working din;ctory, with no backslash at the en d. 

Tliis is i111pmtant wilcn a program needs to boild a foil y qualified tilename. The 
codc must clicd; to sce if a backslash must be added to the current value of thc 
P;1th propc11y hcforc concatcnating it toa filcname. 

Thl' l"l 1Uc tu hanJie this rcquircs a knowledgc of conditional proccssing. To sec 
lHI\\" 1his is done. inspcct thc cmd OK_click proccdurc in thc AddPhoto.FRM 
wdc in \SOLUTION\PRINTING. 

17. Fro1n the Run mcnu, choose Start. 

T c~1 to scc ir your codc works. . ' 

l X. Fnnnthc File mcnu. choosc Save As. 

I'J. Saw the file a.s BROWSER.FRM in \WALKTHRU\BROWSER . 

.'ti. S'"''' lile rroject as BROWSER.MAK.in \WALKTHRU\BROWSER. 

·' 
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Examples 

Further Examples 
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Filel_PathChange ()~ 

apps 
ardace. 
arches.bmp 
argyle.bmp 
boollog.txt 

PathChange 

Di r- l_Change ( ) 

QsysÍem 

Palh: c:lwindows 

The event occurs when the selected path changcs by S<.'lling ci1hcr the FilcN;Iln<.' m 
Path property from code. 

These two cxamplcs are froill Visual llasic Hclp. 

Sub Dirl_Change {) 

Filel.Path = Dirl.Path 
End Sub 

'f>,lthCiliinge E.v1•nl (·~x<~rnpl1~ 

Sub Pilel_PathChange () 

Labell.Caption = ~Path: " • Llirl.J';¡r,h 

End Sub 

NÓtice in this cxample that tbc Pat11Changc event is ~cncr;Hed hy <.:odc in;¡ Changc 
cvcnt in the directory list box control to sym:hwnizt: liJe \';due r1!' tl1c File l.P<Jih 
property lo lhe new va fue for Dir l.!'ath. 

For further examples using thc PathChangc evcJll, sce tht• following. 

Applicalion Form 

lconWorks VJEWICON.FRM ¡:¡~e l:ilL·I.i.\1 l';llhChange 

~----~~·----
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The Common Dialog Control 

Example 

File !!ame: Q.irect01ies: l '~"·'r ... ,·~''1 :§\~::rt-"OK~'rtf~WB 

r>{tiC~ri~C~~ 

S ave File as I..Y11e: Orives: 

1 la e: 

The Common Dialog Control 
The e< '""""n dialug control is a vcrsatile tool provided as a standard part of the 
i'rokssional Editiun of Visual I3asic. The most common use for it is as a ti le 
hrowscr. hut ns you will sec, it hns many other possible uses. 

::q!J HHillf-"i leOpen~Click () 

Cl·111i.rl<.>(jl.IICLion = 2 

lkltl\\' is a li.st uf thc Action propc11y scttings aml their associatcd dialog box type. 

r\rtiun wttin~ Typc uf dialog box 
---··---'-------------'-'------'--------------------

.¡ 

(, 

No nction 

l'ilc opcn dialog box 

File savc tlialog box 

Color dialog box 

Choosc l'onl llialog box 

Printcr tlialog box 

lnvokc W!NHELP.EXE 
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I More Controls 

• Grid Control 

• 3-D Panel Controls and Group Push Button 

This final portion ofthc mo<.Julc dcals, briefly. \Vitll co11.:ll ol"lht.: rc111aining lonl,..;, in 
the Toolbox. 

159 



160 Module 7: File Browsers and Olher Controls 
------ ---------------------------

Using the Grid Control to Display Output 

Number 

123 

456 

863 

Gridl. Col = 1 
Gridl. Row =1 

Gridl. Text = · "Narne" 

·------------------------~----

Tllc Grid control allnws you to display output on a grid. 

Thc Cols and Rows properties set the total number of columns and rows you want 
in thc grid. Thcsc properties are availuble at design time or at run time. 

The Col anJ Row properties set or return the curren! cell in the· grid. These 
propcrtics are available at run time only. The Text property sets or returns the text 
in the current ccll. 

---d, ··t,•l.l,•lrlTexL_r:l ici< () 

··· 1. tl1e current cell; remember that the first row and 
',., •1 il :·e 0 

Gridl.Col • 1 

Gridl.Row • 1 

Gridl.Text • ~NameM 

i·:m! ;:q¡_, 

TI! e ( 'lip propcrty .scts ur returns thc contcnts of thc griJ's sclcctct.l rcgion- for 
cxa1nple: 

r:ridl .Cli.p = "AI3C" 

You can include tabs and carriage returns in the string expression to indicate new 
~.:nluniiiS ttiH.l ncw rows. respectivcly. 
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Example 

The following example places tcxt in a two-hy-two ran~c of cclls. 

1 Sub cmdClipText_Click {) 

2 Gridl.SelStartCol 

3 Gridl. SelEndCol : 2 

4 Gridl.SelStartRow 2 

S Gridl. SelEndRow 3 

6 tbS : Chr$(9) 'Trib e::"'·"··· ... ; 

7 crS = ChrS(l3l 'Can iat;· 'll: " 
8 dS •Joe J' + tbS + •12) M . cr$ "S t.~ ¡.· . ¡,::, . "4 56'· 

9 Gridl.Clip . d$ 

10 End Sub 

The grid control is uscd to display output. Howcvcr. yott can sitJntlatc input otl a 
grid with code. The following example urJatcs a grid l'l'il whcn thc uscr tyrcs into a 
text box: 

Sub Textl_Change () 

Gridl.Text = Textl.Text 

End Sub 

Some ofthc kcy propcrtics that you willnccd in ordcr 111 !1:-.L' tlli:-. control ;~re ;1:-. 

follows. 

Property 

CoiAiignment 

Cols. Rows 

CoiWidth 

FixedCols, 
FixedRows 

GridLines 

Picture 

Dcfault 

O- Left Justify 

- 1 - Truc 

Commcnts 

Sets or rctum:-. tlu.: alifiHlH!Ill of data in a 
column 

Sct:-. m rctum:-. thl' tot;d numbcr uf ruws tll' 
..:olu11111S intlll· ¡;rid 

Sct!-. m rctum.-. ti!.: widtll (in twipsJ of ~~· 
specilicd culuHui 

Scts or rcturn:-. liLl· to!;d numbcr of fixt:d 
columns or ro\\'" ft•r ;1 ~rid 

Dctt:nnirw:-. wlll'!IH.:r lllll''- ht:twct:n ct:lb arl· 

displaycd 

St:t:-. or rctum:-. :1 ¡~rapllil· for tht: curn:111 n:ll 
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3-D Panel 

This ci >lltml has a number of possible uses. lt has, however, two primary uses-the 
first is tu providc grcater three-dimensional (3-D) quality to another control or 
~roup uf controls. Fm example, you can place other controls on the panel; it can be 
uscJ in place of a frame. You might also use this control as a background for the 
cntirc ftll"lll. Thc thrcc-dimcnsional panel, becausc it has FloodPcrccnt and 
¡:loodTypc propcrtics. can be used as a status or progress indicator. 

Stllllt' ol"thc kcy pmpcnics that you will nccd in order to use this control are. 

l'ru¡,t·rly Dcf:.ault 

¡\IÍ~IIIII\.."111 O- Lcfl Justilicd Top 

O· Nonc 

lkvr.:l( hllt'l 2 - Raisct.l 

1 :¡t Hltll 't'r U.!Jll 

O- Nonc 

Cummcnts 

Caption alignmcnt for this ~.:ontrol otlcrs ninc 
possiblc ~.:hoiccs. 

Sets thc stylc of thc inncr bcvcl of thc panel: 
none, inset, or raiscd. 

Scts the style of thc outcr bcvcl of thc panel 

Scts or rcturns thc width of both thc outcr and 
inner bcvcls of thc panel. 

Scts or rcturns thc color uscd to paint thc arca 
inside thc panel's inner bcvcl whcn used as a 
status indicator. 

Sets or returns the percentagc of thc painted 
arca insidc thc inncr bcvcl whcn uscU as a 
status indicator. 

Determines whether and how the panel is 
uscU as a status indi~,;ator. 

·.~ 
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Walk Through-Creating a Pércent Meter 
L Tose! thc Percent Meter at work 

l. Frorn thc Walk Through progr:un group. choose 1\'J\'l'IH i\·ktLT. 

The purpose ofthis walk through is to ucrnonstratc tllc st;¡tus rcporting 
capability of the three-dimensional panel control. 

2. On the Perccnt Meter application, clwosc Stan. 

163 

In a"few scconds the panel will progrcssively changl' L·,dor. inUicating along tlll' 
way the percentage completion of the proccss. 

3. Open thc Control menu on the Perccnl Meter application. atlll choosc Ci<>Sc. 

L To crea te thc Pcrccnt Meter application 

l. Start Visual Basic. 

2. From the File menu, choosc Ncw Projcct. 

3. Sct the propcrtics for thc formas follows. 

Propcrty Setting 
----------------- ---------

Caption 

Hcight 

MaxiJutton 

.Min[lutton 

wiuth 

Pcrccm Meter 

4..t25 (<lpprclxirrlatcly) 

Falsc 

F~Jisc 

4. From thc toolbar, doublc-click thc 3-D P;lJicltool ;md :-el its prnpcl1il's as 
follows. 

Pmpcrty St·lling 

Bcvcllnncr 1 - ln~ct 

DcvciOutcr 2- Rai.scd 

llevc!Width 3 

llorderWidth 2 

Caption 

FloodColor Yellow 

FloodType 4 - l3ottom to Tup 

Hcight 2655 (ílpproxinmtcly) 

Lcrt 240 (nppro.<imately) 

Outline Truc 

Top 240 (approxirnatL·Iy) 

Width 1~35 
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:\. Fr<Hll the too\bar, Joub\e-click the Command button and set its properties as 
lúllows. 

l'ropcrty 

l'<ljll ÍPII 

l:ontSit.c 

1 !ci~\11 

1 ).;fl 

Sctting 

Start 

13.5 

495 (approximatcly) 

480 (approximatcly) 

3240 (approximately) 

h. D~ouhlc-click thc Cummand button in design moJe in order to open tbe Code 
wind11W. 

Vi'""l llasic di>plays a Codc window witb tbe Command I_C\ick event 
¡1t t~l'l'dur~.: tctnplatc in it. 

7. I'Ltn· tllc !"o\lo\','ing \incs o!" codc betwccn thc two p:uts of thc te.mplatc: 

\•.~,.,.¡ ;.;¡ Fl•JoH\Percent ::: O 

'"~ il.-= 1 To lOO 

!'~nel3cll.floodPercent 

r¡ •. , • ¡ l 

i 'ti • 1 

X. ¡:rotnthe Runmenu, choosc Statt. 

Tc>l your application. 

1J. 1-"1·1 1111 the Run mcnu, choosc Eml. 

\il. S;tVL' ynur lúnn anJ .MAK fi.lc with appropriate namcs in 
\\\' t\I.KTIIRUISMvlPLES. 

11. C 'I11.'>L' Visutd·Ha:-:.ic. 
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Group Push Buttons 

Group push buttons work likc combin<ltion Ctnnm;md hlllltlll;-; ;ttlll optinn bull\111:-;. 
They are likc command buttons bccausc \vhen thc user l·lid:s lllt.· hutton. S()Jll~thin~ 
happens-a file is opencd or savcd, or tcxt is right-justi!"ic.:d. Cln1up push huttons. 
however, are also like option buttons because, with thc pr~>pcrlic·s set propcrly. 
sclecting one option can automatica/1 y re mm· e 1 he se il'L't i 1 111 fn 1111 anothcr opt i( 111. 

Sorne of the key propertics that you willnccd in order 1<> use lhis control are as 
follows. 

Property Dcfcmlt 

GroupAIIowAIJUp -1 - Truc 

lJ 1 UlljJl 'lJIIJlJCf 

Ourline 

PictureDisablec.l Non e 

Pictu_rcDn Nonc 

PictureDnChange o 

PictureUp Nonc 

Cu111rm:nls 

Dctenninc:-- wllclhl'r all huttons in a loJ..:ic;d 

.'icl~ 11r lt..:llll'll..., llu.: ,!;fllllfl nu111bcr Júr ;¡ givcn 

group push huthlll. Tl1i .... propcrty i:-.used !o 
crea\ e logical !-!'"' )ups 1 1!" huuons. 

Scts or rcunn . ..; \\"hl'lhn 1llc bullon h<IS a 
hmdcr anumd i1. 

Spl!l·ifics thc hi!Jnap lo di .... p/ay onlhc .\D 
group push hutlt 111 whl'll it is disahlcd. 

SpcL·ifics thL' hitJnap 1t1 tt.\C whcn thL' llutton 

is dcprcsscd .. 

Dc:knnincs hHI\' Jhl' J'¡, 1mclJp hit111ap i .... 1t1 

l1c ti.\L'd 111 l·Jc:tll' tl1t: J•¡,·turciJn hillll;tp: ~ 
.lllL'I"Clj' Í!l\'Cib !he ] 1 i~o:ltr1L'Up bitllliiJl. 

SpL'L·ifics tite hilm;¡p h• ,~...,e whcnthc hutlon 

IS u p. 
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Walk Through-Creating a Toolbar 
L To scc lhe interface yo u willbc crcaling 

1. ho1n lhc \Val k Throughs program group. choose Too\ bar. 

This Jitt\c application docsn't do vcry moc\1. Whal il does show is that the user 
c:111 sclcct any oral\ of thc firstthrcc options, whcreas they can only se\ect one 
tlf lhl· seuHHI tlm.·c. More \o thc point, it is an cxamplc ol''how you would go 
:illtttit drawin!:! :1 toulbar likc thc onc found in Microsofl Word for Wíndows or 
t-.·lintlson Excel. 

htttnthe Corl!r11\ menu on thc Tnn\b¡.tr rorm, choosc C\osc. 

L To LTl'ate l he loolhar 

< )íwn Visual H:1sic 

1.-l,tlll th~,; 1-"ilc IIH:nu. chuusc Op!..!n Projccl. 

\.oc·atc TOOLilAR.MAK. lt shou\d be Jocatcd in \WALKTHRU\SAMPLES. 
Thi.s form alrcatJy·contains thc basic form-TOOLBAR.FRM with all of its 
propcrtics airead y sct. In ortlcr to add thc too\ bar. you nccd to complete thc 
lúllowing steps: 

.1. l'lacc se ven group push buttons on thc too\bar panel at the top of the fonn. 

~. Use thc m o use poi ntcr and the control kcy to select all se ven of the group push 
huttoos. and thco sct thc following propcrtics for all of thcm. 

Prupcrty Scttiug 

1-kight 420 

TPp 10 

\\-'¡dlh 450 

:'i. I'I;Jt'l' thrcc {ll' tl1c push buttons siLk by si de on thc lcft cnd of thc pand. 

Tht'-"l' will hcnunc tht.! tcxt formatting buttons for Bo\d, ltalic, and Underlinc. 

·"' ··.• 
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6. Select the first button in this group and set the pn>perties '" i"ollows. 

Propcrty Sctling 

o GroupNumbcr 

PictureUp 

PictureDn 

IJLD-UP.IJMI' lo«llcd in \\'l!\lliTMM'SITOOLIJt\R.1 

IJLD-DWN.BMI' 

These changcs crcatc thc rin;t button onthl' tnolb;1r ;¡nd rn;r~v LIS\.! of l\\'1) 

separare bitmaps to indicatc thc status ~>f till' button 11 • tllL' u . ..,l.'r. 

7. Select thc sccond Qutton inthis group ami . ..;ct thc prt)pntil' .... ;1.., !"ollows. 

Propcrty 

GroupNumber 

PictureUp 

PictureDn 

ScltinJ! 

o 
ITL-UP.IJMP 

ITL-DWN.IJMI' 

8. Sclect the last button in this group antJ set tht,; propnriL'.' as follows. 

Property ScUing __ :..._..:._ ______ _::. _________ ··--------
GroupNumbcr 

PicturcUp 

PicturcDn 

o 
ULIN-UP.U~II' 

UUN-DWN.IlMI' 

Noticc that all thrcc of thcsc buttons lwvc thc sanll.' IHllllhL'I --0. !\ gror1p 

number of O mcans that thcy are nor part ·ora logicd group. ami tl1crcfnrc 
changing the statc of one will not change thc statc tlf (ltlu.:'rs. Aftcr al t. ytJUr u ser 

may want to ha ve bold ami ita tic ami uruJcrlining. Clt1s1crs ,,r cnntrols with tlll)' 
othcr group numbcr will act just likc optinn hutttlll"' ''nly o11L' will hl' in forn· 

al any one time. 

For purposes o.f contras t. wc will takc a slightly diffnl'nt :tfll'~''''lch on tlll.· SL'L'Intd 

group of push buuons. Hcrc you are giving thc u ser tliL' optitlfl of forman in~ IL'.\1 

as either left-, centcrcd-, or right-justificd. li1 this C<ISl', you will want thcsc 
buttons to work as a group bccausc any Plh.: bit of tl'.\1 l"tnl h;,vc only onL' o!" 

these three states. 

9. Create the second group of buttons siuc hy siuc tow:~rd rlre '""ldlc nf thc p:~nel. 

In alllikclihood, you willnnt be ablc lo kn·ptllc IHIII!lll;.. in l''·rfcctlop-lo-holhllll 
alignment. Don't lct that bothcr yo u. You t:an sch:ct thl' L'ntirv group at the cnd of 

this walk through and set the Top propcrty foral! of liJe m in 111lC stcp. as you Jid 
nbove. 

JO. Sclcct thc first button in this group and sctthc propL'rtivs ;¡s tollow~. 

Property 

GroupNumbcr 

PictureUp 

PicturcDnChangc 

Sclting 

2 

LH-UP.UMI' 

2- lnvcrt l'icturcUp Biun:1p 

Nolicc whal Wt' havl'. dtliH'lH'J"l~'! \Ve h;¡vc cn·;¡fl'd tlll' l'il·tn~t·l >mvn hitnltljllly 

invcrling thc inwgc using llll: prnperty PictwcUpChiln¡..'l'. 
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1 1 Svll'l"l thc sccnnd !Juttun inthis group amJ sd thc propcrtics as folluws. 

Prupcrty 

Gn1upNumbcr 

l'irnucUp 

l'irturcOnChangc 

Sctting 

2 

CNT-UP.IJMP 

2- lnvcrt PicturcUp Bitmap 

1 c. Sekcl ihc lhird builon in lhis group and SCIIhe propcnics as follows. 

PrtlfJcrty 

GJ(HrpNurnbcr 

I'ÍcltlrcUp 

1 11l·t lltl'D11Changc 

Sctting 

2 

RT-UP.IJMP 

2 - Invcll PicturcUp Bitmap 

\VI Lit tllis CX<IIllple c1nphasizcs is that thc propetty GroupNumbcr is your way of 
ll'lli11g Visual Uasic how you want individual scts of buttons to be groupcd. 

1 \ ;\," liulc cxtr<~ challcngc, you se11hc propcrlies for ihe lasl control. li's 
."liPJHISL'd to n:pn.;scnt a printcr, so you will nccd to use thc PRT-UP.BMP. 

1~ S""'' your work in \WALKTJ-IRU\SAMPLES. 

I To Code Thc Toolhar 

lf you '"""llo implcmcnllhc loolbar so i1 funclions properly, you can add ihe 
rollowing codc. 

l. Uouhlc-clid ihc buld builünlo opcn lhe code window for GroupPush3D I_Ciick 
l'VL'Ilt and adJ tlle following codc: 

ll·ll·l••ss;Ige.F(JJlt!3old = Villue 

1 >ouhlc-click tllc italic buuonto opcn thc code window for 
c;roupi'ush]U2_Ciick CVCIH and add ihe following code: 

llolt·l<?ssage.Fontitalic = Value 

.1. Douhle-click ihc underlinc buaon lo open ihe code window for 
GroupPush3D3_Ciick event and add ihe following code: 

li,[!-lC>ssage.FontUnderline = Value 

~- Douhlc-click lile lcft-justify bullan 10 open ihe code window fur 
Groupl'ush:ID4_Ciick cvcrll and add ihe following code: 

lr•l;-1•·ssage.r,Ilgnment =O 

')_ 1 >uilhiL'-click tllc Ct:IJlcr button to opcn thc codc winJow for 
c;roupl'ush:ID5_Ciick cv~nl and adu lhe following code: 

ll·il·l•~ssage.Alignment = 2 

¡,_ Douhle-click lile righl-justify bullan lo open lhe code window for 
(;roupl'nsh]l)(¡ Clid cvcnl ;¡nd add ihc l'ollowing couc: 

7 S;¡q· ynur work in \\VALKTHRU\SAMPLES. 
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Summary 

• 
• File Browsing 

• Grid Control • 
• 3-D Panel Controls and Group Push Button 

• 

Objectives 
In this module you learned to: 

• Design and dcvclop a forrn that lcts users brmvsc dri\'l's. dirl·ctorics. úml fiks. 

• Use the Change and PathChangc cvcms. 

• Use the grid control. · 

• Use 3-D panel controls and thc group push llullon. 
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L, Overview 

• Key Terms 

• Using Variables and Constants 

• Scope 

• Additional Visual Basic Data Types 

Overview 
The overall purpose of1his module is to intrmluce airead y knowlcdgcable 
programmers to thC data typcs of Visual Basic ami thcir -.;copin~ rules. Thi." modull' 
is dcsigned as the first of a series of modules onthc impkmcnwtion of Basic withi11 
Visual Basic. 

Prerequisites 
Prior to starting this module, you should :drcady be f:11nili:11 "·irli: 

• Data typcs and scoping rules within sorne othcr prun·dmal l;1nguagc 

• The general Visual Basic prograrnming systL'Ill 

Overall Objective · 
At the end of this module, you will be ablc tu corrcctly ;u11l L'lli~·~~·ntly ust.: allllost all 

of the Visual Basic data types. 

Learning Objectives 
Atthc cnú of this module, you will he ah k tu: 

• List and describe thc se ven variable d<Ha types in V i:-.t1;d ILI.'>H-' 

• Correctly identify the six typc dcclarotion characlcr 'Y"'I"'I' 
• Use !he contcnts of CONSTANT.TXT. 

• Distinguish among thc vnrious le veis of sl'!lpe in Vis11al ll;r"'. 

• Explnin lhc rules for nsing cach leve! of st·opc .. 

• Declare and use a uscr-dcfincd dal:llype. 

• Declare and use simple arrays. 
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Key Terms 

• Variables 

• Constants 

• Procedures 

• Statements 

• Scope 

• Module 

Variables Changcablc values that thc program manipulates 

Conslanls Unchanging vulues that thc program manipulatcs 

Procedures Activitit.:s tlwt tllL! program pcrfonns 

Statements Subactivitics wilhin proccdurcs 

Scope ( 1\ccessihi 1 ity) \Vhich p~u1 of a program can acccss spccific Uaw or 
\lnlCl'lhli\'S 

Module File containing codc and data not attachcd toa form 
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L, Using Variables and Constants 

• Data Types of Variables 

• Data Types of Constants 

• 



_________ 176 Module 8: Using Visual Basic Da1a Types 

Data Types of Variables 

• lnteger % 

• Long & 

• Single 

• Double # 

• Currency @ 

• String $ 

• Varianl (none) 

Thl'll' ;11\' scvcn fundamental Jatatypcs of variables that you can use in Visual 
1 L1:..il". 

Typt• llalllt' Dcs~.:ription 

--
lntc¡..:l'r '1\~'o-byte integer 

l.ung four-byte integer 

Sinl!,ll' Fnur-byte lloating-
pnint number 

1 )uuhll' L::ight-bytc llo.:ning-
poimnumber 

t ·urn·nt·y Eight-byte numbcr 
with a fixcd decimal 
po_int 

St¡·inj.! String of ch<lr<Ktcrs 

v~lriant (l)daull) Date/time, tloating-
point numbcr. string 

Typc-dcclaration 
charactcr 

% 

& 

# 

@ 

$ 

(none) 

Rangc 

-32,768 lo 32.767 

-2.147,483.648 lo 
2.147.483,647 

-3,40E+38 lo 
3.40E+38 

-l. 79D+ 308 lO 

1.790+308 

-9.22E+ 14 lo 
9.22E+ 14 

O 10 65.500 characlcrs 
(approximalcly) 

Date valucs: 

J anuary l. 0000, lo 
Dccembcr 31, 9999: 
numcric values same 
as doublc; string 
valucs samc as string 
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Declaring Variables 
In polite society you always formal\y imroUucc stranger~ ltl c;H.:h othcr thc rirst tirne 
they meet. Visual Basic is no exccption. You should inll.;lducc your variable to 
Visual Basic by declaring the namc of your variable bcft1rc youusc il. You do tlli:-
in one oftwo ways: by using thc Dim statcmcrH, or by using une ofthc two 
keywords-Giobal and Sta tic. As you will scc in a couplc <~1 pagcs. not dcclarin~ 
variables can be risky business in so me situ;rtions bccau .... c the tkfault Jata typc in 
Visual Basic is Variant. 

You have two choices on how w cxplicitly dcclarl..! \'ari;rhlt· dat;r typcs. 

Using As llsing tlll' ty¡n··dt-rlaration rlwr:.l·tn 
--------------------------------
Dim I As Integer !Jim !1, 

Dim Amt As Double 

Dim YourName As String ni m Yo1:1 :J.,¡•,.. 

Dim BillsPaid As Currency lJ i 111 13 i l l .· i '·, 1 • I!.J 

In arder to make compound variable dcclarations. you llll'n:ly :-.lalc: 

Dim X as Integer, Y as Long 

Caution Ifyou declare three sepJrate variables with tilL' i"nllowing stntement. yotl 
will get K$ as a string and 1 and J as varianls, not as :-.tring:-.. 

Di m. I. J, .K$ 

Explicit Declarations 
To require explicit declaration of variables in all uf your cwlc. place thc fulluwing 
statcment in the General Declarations scction of any l"nnn or nH>dule. 

Option Explicit 

If you want to requirc that all vari<lblcs he cxplicitly dL'l"i:lrL·d in :di of your ¡m>.icll." 
from thc Optinns mcnu choose EnvinllllllL'IH and SL'I thL· l~l·quilt' V:1riahll' 

Dcclamtion option to YES. 
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Variable-Length Strings 
Sonlclillles you 111ay neccJ a variable that can hoiJ strings of úi!Tcrcnt lcngths at 
<lillercnt times. This is callctl a variable-length string variable. You declare it like 
thi..-: 

··:ru 1·1•·,;:~ .. {/e i1s St.cing 

Fixed-Length Strings 
r\t olllLT times you know that thc strings that will be assigncJ toa certain varinble 
will ¡¡n·cr llave Ilion~ tllan a ccrtain numbcr of charactcrs. In this case, you can 
dcL·I;~r·c ;¡_lixed-lenglll variable likc this: 

In tlli ..... L'.\illllplc. you are Lkclaring a string variable with thc namc 
1-"i.\L'dl.cnt:thString. ant.l you are tclling thc application that thc variable may contain 
up 111 _')() eharaclcrs. 

You rantt1kc this IHlC stcp furthcr. Forcxample, sct thc lcngth using a Global 
L'IHlst;utt \vith thc na me Fixct..!Lcngth, sct thc valuc of thc constant to 50, and then 
¡)oint to that consta111 namc using the follo,wing syntax: 

¡;Job~ 1 Const FIXEDLENGTH = 50 

l;lobal FixedString As String • FIXEDLENGTH 

Rules When Working with -Variables 
l. Variable names can be up to 40 characters long. 
1 NtHnl's can inctut..!c only Jcttcrs, numbcrs. and unt..!erscorcs. 

3. Thc first charactcr in thc na me must be a letter. 

~. You cannot use Visual Basic reserved words. See the list of programming tapies 
in Visual Basic Help for a partiallist of reserved words. 



' ' 
As the chart abo ve shows. thc Variant U ata type is the dl'fault. Tlle Varianl llat;t 
typc can swrc numcric, string, or date/time inftlflll<ltion. You dtl!l't necd to con ven 
between these kinds of data whcn assigning thcm to '' ,;ariant ,.<Jriahle: Visual f:LtsiL· 
automatically performs any ncccssary tyrc ctlnvcrsitlll.'- (,1r Y''''· 

Rules for Using Variant Variables 
l. Ifyou perform arithmctic opcrations (lf runctit)IJS tlll ;¡ \'ili"Í;Jll[, it lllUS[ L'tlllliiÍil ;¡ 

number. rr you want to test a variant lo see if it COJll<IÍJIS lllHileric dala. use IIIL' 

IsNumeric function. 

2. Normally, when you concatcn;Hc two .-.triJigS ynu WPJt/d U.\L' lile plus (+J .\Í!_-!11. T1• 
avoid ambiguity with variant ú;lla, use the <JJllfJLT:·;;¡¡¡d (8.: ¡ 111 Í11dicate 

concatcnation. 

Note \Vhcn concatcnating. be carcfulto k:1vc a span· hct \\'l'L'Il a variable nan1c 
nnd thc ampcrsand. rr you dllll't. Visual /!;¡sic ilS~IIIlll'' 1/Jal yttU ttrc typccastirl~ 
thc vnriablc into a Long data type. 

3. WJ1en passing a Variant vari~1hlc ;¡s 1111 ar,!:!lllllCnl. cl11·l·~ rllc proccJurc 
p;munctcrs. Ift/1c corrcsponding argunll.:nt is 1111 c>..Jllil·ir d:Jt<~ rypc. yotl JJHISI p:1.,.., 
thc Variant variable with parcnthcscs arnt111d j¡ Íllill'ill'r lil p:1ss it hy \';duc. 

Dim V As Variant 
V= •TestingH 

Debug.Print PrintStringf IVJ) 

Sub PrintString{S As Stringl 

'Do something 

End· sub 

4. To determine thc interna! rcpresentation for a variant v:Jriahlt_., use thc VarT~·pL' 

function. See documcntation for spccific rcturn v:illll':-.. 

5. A variant variable has thc Empty value before ir i~ :t~ .... ignl·tl <t value. Tht.: 
Empty value is a spccial valuc, di ITeren! frorn a zcr11. iti.L'rtt-kngth strin!!. or '' 
NULL value. To test your V;1ri~mt v;,riahk for :tn i':ruply \·;du~:. u."'--' rlll· 
IsEmpty function. To rcassign a Varianl variable b:ll·~ lo llil' Empl_r \';llnl'. 
you musl assign omothcrcr11pty V;~rianl v:tri:Jilil· 111 ir. 

6. To test for a Vari:~nt vari¡tbl~: containing NUI.I .. U~l' lliL' lsNtJLL runction. 

Note For a lisling of thc string convcrsion functiun.'i for thL' Varianl Ua!<li)'JlL'. 

sce thc appropriate table at thc cnd of tllc Visual HiiSÍl' codc module. 
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Example 

· · .. · . Module1.baa ' ·••• ,. t., 1111/:1 
Otl¡ect 

' AL i.grunent 
Glr:,\)al Const 
G.Lobal Const 
Glc,bal Const 

Proc: 

What Are Constants? 
Constants are just that, entities within your program whose value you need, but 
which wi llnot be changcd during the running of thc program. For example, if your 
prugrarn needcd tu work with circles, you would probably nced a constant like 
1'1 = .1.145~. 
L.sarupb uf typical cunstants can be found in CONSTANT.TXT. If you look at 
this fik. you will rinJ severa! constant values dcclarcd that are familiar to you from 
tllt: 'J\'l'rvicw uf prnpct1ics for controls. 

r·,ns~. NONE :: 0 

,.,tts•_ FIXED_SillGLE 1 

r·,n.c;;•_ SIZABLE = 2 

····ll!"l FIXE::O __ DOUBLE 3 

How Are They Declared? 
Visual ltasic contains a CONSTANT.TXT file, which lists all the comrnon 
t'llllSI<IIIIs. You can copy and thcnmf)Llify this file lo mcct thc application.'s spccitic 

rll·c·cb. Y .. u can thcn load CONSTANT.TXT into the General Dcclarations scction 
.,¡a nr<>duk (.Bi\S¡ tu he uscd hy thc application. Following is a paniallisting ol· 
tlll' ~l'tll'ral c;Hq!orics of constants tlclincl,l in CONSTANT.TXT. 
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• Scope of Data 

• Declaring and Using Local Variables 

• Declaring and Using Form-Level and Module-Leve! Variables 

• Declaring and Using Global Variables 
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Scope of Data 

Form FRM 

Forrn ~ Dim A 

Dec/arations 

-~ 
Sub X 
Di m !3 Local 

'Se es A,B,C 

Procedure 

Sub Y 
'Sees A,C 

Procedure 
,,,-, ',c.-<',"M''''~'-''"'' 

1 

1 
l ¡ 
\ 

! ¡ 
~ ¡ 
j 
; 
l 

' í 
1 
1 -· ' 

Global 
Module 

Local t: 

! ' ~ 

Module! BAS 

l Global e 
Dim D 1 • 

Declarations 

1 Sub Pl 
DimE 

'Sees C,D,E l Procedure 

Sub P2 1 
'SeesC,D l Procedure 

--,--~-~----""'"''_..., .. ,.,.___.,~ .... """ 
-- -------------,-------'-----<-

What ls Scope of Data? 
The .... cope of a data variable or constant is.its leve\ of visibility within an 
applic<~tion. Scopc of data fa lis into thrce le veis of visibility: local variables, form
<llld llHidulc-Jcvcl variables, and global variables. 

Scope of Data-An Analogy 
Seo pe of data basically dcals with who can use wha1. The easicsl way 10 1hink of 
tlli .... is by ana\ogy. 

S ay yot~ hada refrigcra1or/frcezer fui! of al! kinds of goodies-candy, sofl drinks, 
ice Cll'<llll. Almost evcryonc likcs thcsc goodics and would lik.e to get to them. Your 
¡oh"-' 1he manager of 1hese resourccsis 10 make surc 1ha1 the righ1 people ge1 10 
ti\...: m and thc wrong pcoplc don't. 

1 f Y• 1u put 1hesc goodics out where everyone can gel 10 1hem, 1hey will be u sed, 
ri);!hi'.' ll"that is , .. ·h;lt yuu want. thcn fine, makc thcm ~lo/J(I//y av<.tilablc. In Visual 
H;1sic ll . .'rlllinology. Ucdan.! aml define variabk.'i that u.\1 functions wi\1 nccLI acccss 

lo usi11~ thc Glohal kcyword in 1he General Declarations section o!" a module 
!. HAS l. noi a for111. 

¡:~,r t\¡c,sc g(l{lLlics tl1al you only want sume pcuplc tu gctto, for cx.ample,just thc 
lllLillhcrs or yuur wmk group. thcn put the rcfrigcru.tor/frcczcr whcre only thcy can 
~ctto it-for cxamplc, in your work group arca. In Visual Basic, declare and 
dcrine thcsc variables using thc keyword Dim in the General Declarations section 
of eithcr the form nr 1hc module. You'll see an example of how 1his is done in jus1 a 
kw li!ÍIItlh';-;. 
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I 

Finally, for those goodics to which only you should havL· aLTO'-. pul the rcfri!!CI"illol 
in )tour office. That is, declare aml define thosc variable~ l11cally- insidc ~~ 
procedure. Again. you'll scc cxamplc.s of this is justa minute . 

Variable Declaration Keywords and Their Scope 
The table below details how thc diffcrcnt vari<~hk dccl¡¡r;11ion kt·yworUs arL' u~L'll. 

S cope 

Local 

Module 

Global 

Dcclarati()n 

Di m, Sto1til'. nr RcDim f\\·itliin a ¡)rnccdureJ 

Di m (in Genera! Dcclarati1m;., .'-CLIÍon of a fonn or ;1 L'Pdc 
module). 

Glohal (in General Declarati<•ns ;.,ccti<Hl (JI' a nH•dulc¡ 

A simple cxamplc of data dcclarations can he found Jhis way 

l. Start Visual Basic. 

2. From the File mcnu, choosc Opcn Pmjcct. 

3. Go to thc C:\VB\SAMPLES\CALC subdircctory . 

4. Double-click CALC.MAK . 

5. Click CALC.FRM in thc Project wimlow . 

6. Click Vicw Codc in thc Project winJow . 

Visual Basic displays the form-level variable declarati""' lúr thc calculator 
application. N atice the dcclaration of se ven variables illlll 1hc < )plion Expli(:it 
statcmcnt. 

Note When you are writing codc and ynu want to cre;11e nHllluk·-- or form-lcvl'l 
variables, make sure that you are rcally in thc general dt'l'laratitHJS scction of thL' 
code before you make chnnges or additions . 

Always be sure that the top of your form window has tlll'st.: two t1ptions sclccted. 

-" ICONWRKS.FRM · 
Proc: 
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Style Guidelines 

I For a 111orc co111plcx listing of global dcclarations 

l. ho111 thc.; hk lllClHI, chuose Opcn Projecl. 

2 e;., lo the C:\Yil\SAMI'LES\ICONWRKS subdirectory . 

. 1. IJ<>uhk-click ICONWRKS.MAK. 

·1. C'lit'k ICONWRKS.GBL in thc Projcct window. 

'i. ('lid..; Vicw Cud~ inthe Prujcct wimlow. 

Scrnll dmvn to thc General Declaratiqns scction of ICON\VRKS.GBL ami inspect 
llll· \'clrillll:-; valucs dcclared and defined. 

Rules for Using Local Variables 
l. /\ loL·;¡I variable i." rccognizcd anO dcclarcd on\y within thc proccllurc in which it 

''11Jll'ill".'-' using thc kcywunJ Dim. The variable is rc-inilializcU to zcro ora 
NUI.L string whcn thc proccdurc bcgins. unlcss tbe local variable is dcclarcd as 
Static. A lúcal variable is a good choice .for any kind of temporary calculation. 

1 r ~·ou use a variable without declaring it. thcn Visual Basic assumes it is local 
and it'\sumcs Variant as thc data typc. Howcvcr, this techniquc may waste 
>~<>ra~c spacc and is notas reliable as declaring the variable in the appropriate 
proccdure. lt is al so notas efficient. 

.. Rules fór Using Form- and Module-Level Variables 
l. A fl wln-lcvcl variable is Jcc\arcd in the General Declarations scction of the · 

l"11n11. using thc kcyword Dinf. A form-lcvcl. variable is aViliiablc to any 
proccJurc on that form and only that form. 

' flllH>dule-levcl variable is declared in the General Declarations scction ofthe 
1111 •dule. usi11g the keyword Di m. A module-leve\ variable is available to any 
pn •cedure in that module and only that module. 

Rules for Using Global Variables 
l. /\ ):_!111\lal variable or constan\ is slwrcJ throughout an application. Multiple 

""""ano mmlules can use a global variable. They are declarcd inthe General 
1 k~.:lar:1tions scctinn of a module using the Global kcyword for variables and 
(; l11l1a 1 Con~t f1 Jr constant~. 

' ul<>hal variables are persistent; they rctain thcir value throughout thc entirc 
applicatiun. 

( iood J'l'll~l"illlllnin~ practiccs whcn using variables ami constants incluUc: 

• ll .... l· ft11"11l-IL:vcl and moJuk>lcvcl const;Jn\S and variables as opposet.l to global
l~vl'l if possiblc. 

• Dl"l.:l;m.! the variable or conslant with the Dim statement rathcr than accepting 
H~L"il· automatic variables. 

• • u.,c lntc~cr deelarations instead of default Variant declarations whenever 
ptl;-,;-,ildc. lutegl!r dcclar;1liun~ takc lcss spacc, avuil1 rouuJing crrur.s, anJ 
L'llll"lllllt: k ........ l"I'U LiiiL\.! Lllan Variaul Jcduralions. 

: Nf·UAA!IZA •. i&iiJ,Uihl 
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Declaring and Using Local Variables 

Example 

Example 

Sub AddEmp ( ... ) 

Sub AddEmp ( ) 
Dim CurrentLocation As Integer 

Local variables reset to value zero (0) oran empty strin~ whcn 1l1c local proceJurc 
begins. 

To declare a local variable, place thc Dim data dccbrati!lll st:llL"IllCilt insidc thc 
local procedure. 

1 

3 

4 

S 

6 

7 

Sub Form_Click () 

·and is reinitializcd to zen' wl1•u1 t.l1·· ¡.>~······•!•;¡.· i~; r·~-··t¡l··r· .. · 

Dim EmployeeNumber As Integer 

EmployeeNumber =Val (Textl.TextJ 

Print -The Employcc Number is: • :.;11': ll·:uqJI••','•"•:f·llimb•:r 1 

End Sub 

In the example above, EmployccNumbcr is dcclarcd ;¡~ :tn lntt·ger. How would th,· 
code be different if you handlcJ itas a Variant"! 

1·'· Sub Form_Cl ick { 1 

2 Dim EmployeeNumber 

3 EmployeeNumb€r = Textl.Text 

4 Print ~The Employee Number is: • Empl,oyeeNwnber 

S End Sub 

Note Notice the use of thc ampcrsand to cuncatcnatc thc literal String and thc 
Variant in the Print statement above? 



186 Module 8: Using Visual Basic Dala Types 

Example 

·11 you want a local variable lO be persisten!. declare itas Static. Static local 
vilri;,hiL·s will rcli!Íll their data val u~ whcn thc proccdurc pcrforms a rcturn. 

·:,¡¡, ~~tatit.:!J•!IHO ( J 

'The stutic variable below will retain its value across 

calls and is used to keep track of how many times 

StaticDemo is called. 
Static Runcount As Integer ' Create a persistent variable 

P.unCount "' Runcount .. 1 · Use it to keep run count. 

!·lsg$= "The RunCount for the StaticDemo procedure is: • 

!·lsg S = Msg S 

Print MsgS 

· ll ¡.:,¡,j 3ub 

StrS(RunCount) 
· Display message. 
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Declaring and Using Form-Level and Module-Leve! Variables 

Example 

TntPger 

Data 
UserName As su·ing 

Use form-level variables or modulc-lcvcl variables whcn sharin~ elata only witilín" 
form ora module. The data rcmains persisten! witllin tlll· f411"1ll ~ •r llHidtrk hut i ..... nt 11 

acccssiblc lo proccdurcs in othcr l'onns or rnodul~.:s. 

To declare a form-lcvel or module-leve! variable, place tl.lc llim st;,tcmcnt in thc 
General Declarations section of thc corrcsponding form ,,r nwdulc, 

The dcclaration bclow appcars in thc GcneraiiJcclaration~ scc!Íllll of thc moduk· 
DEMO.BAS: 

Dim UserName As String 

\Vhcn thc procedurc bclow is ca!lcd. it can acccss ·¡¡,¡..., Jnodulc-ll'vcl v;triahlc. hn· 
CXampfC, SUppüSC that a lCXl bOX is Stlf>f>licd for tlJc llSCI (11 I)'JlC IJis 01" her ll<tllll': 

UserName = txtUserName.Text 

Thcn thc appropriatc valuc for Ust:rN<~nlt:' wi!l hL" prill!l'tl whL·n lilt:' Suh pron·du1,· 

WelcomeDemo is calleu: 

1 Sub WelcomeDemo {) 

2 Variable declared in module's Declaratio:1~ :·>~r:-ti••n can be 

3 referenced here 
4 Print ~welcome ~ + UserName' 

S End Sub 
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Example 

Thc lll<>uulc-lcvcl variable is also available to all other procedures defined in 
llEI'viOJlAS. 

~:,,t, V"!LifyllserName (1 

i·isg5 = "User-Name = " 
· . .r.,,·iable d8clured in module's Declarations section can 

.• i.so be ,-,~(•1renced here 

:-isgBox f·tsgS .. UserName 

;.,,,., ':•Jb 
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Declaring and Using Global Variables 

Example 1 

Example 2 

miJ . MOD0LE1.BAS : :. ,.- ·: . 

Global GlobalNumber As Inteqer 

Lg.l;!!f>j;ilj· 
GlobaiNumber 
Accessible Here 

GlobaiNumber Also 
Accessible Here 

Use global variables antl constanls whcn sh;tring Jata t!JrllllgllPut <lll ;tpplic;Hion. 
Thc datil rcmains pcrsistcnt antl acccssiblc fn>Jll a JI l'tlfiH:-. ;¡nd llltldllll:s witllin lllL' 

application. 

To declare a global variable, place tllc Glohal statcmcnl in illl' (;cncral 
Dcclarations scction of a motlulc-that is. a .HAS file:· 

Global GlobalNumber As Integer 

The variable GlobniNumbcr can now be rcfcrcnccd thnllt~houl th~ applic;l!Ítlll. 

1 

2 

3 

4 

5 

1 

2 

j 

4 

5 

' Cede for Forml 
Sub Form_Click fl 
• Global variables can be refcrcnc:~d herc 

GlobalNumber GlobalNumher • 1 

End Sub 

· Code for Form2 

Sub Form_Cl i e k ( l 

Print 
End Sub 

"Gl-oba!Number " .. Str$ !GlobalNum!J~¡·J 

Load any conslD.nls you wanl declarcd ror ;u¡ cntin.: pro~r;nn in lo thc Gcner;JI 
Declarations section of a module. 

189 
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Walk Through-Scope 
L. To dculollstratc thc conccpts uf seo pe of d.ata.in Visual Uasic 

l. h11tllthe W;dk Throughs program group, start Scope. 

\V!rcrr thc application stans·. you scc two forms. Form \, onthc ldt, contains a 
C11trrrr1andl huttr1n. Fonn2, on thc right, contains a C01mnand l bulton. 

ThL·· purpose or this walk through is to demonstrate thc conccpts of scopc of data 
in Vi . ..;ual Bt~sic. 

"~ CliL·~ Fonnl (on thc rorm, not thc commaml button). 

Tllc· Form_Click evcnt will display values of data itcms as thcir scopc permits. 

Thc· global ami form-levcl data valucs are displaycd. Note, howcver, that the 
l'orm2 miJdule-level V<lriable and the Form I.Command I_Ciick and 
Fo11112.Command I_Ciick local variable values are not displayed. Remember, 
you just rcqucstcd a Form_Ciick evcnt, so the Command I_Ciick variables are 
not yct in seo pe am.l Form2 variables are not in scope until Form2 has focus. 

' 
·'· CliLl h1rm2 (on thc fo.nn, not the command button). 

Tllc· l'urm_Click event will display values of data itcms as their scope permits. 

Thc global anJ fonn-levcl data values are displayed. Note, however, that the 
Furml modulc-lcvcl variable and thc Form I.Command I_Ciick and 
i:orni2.Comm<.~nLII ~Ciick local variable valucs are not displaycd cither. 
Remember, you just requcsted a Form_Ciick event, so the Command2_Ciick 
variable is not yct in seo pe and Form 1 variables are not in seo pe until Form 1 has 
ftlL'US. 

-1. Clid\ the ÜlllllllanLII button on Forml. 

TilL' C()mmand 1_ Click cvcnt will display values of data items as thcir seo pe 
pn1 nits. 

You ha ve just gcncratcd a Form I.Command l~click evcnt, and this pinces the 
l'o>lllli.Commandi_Ciick variable in scope. Forml still has focus. though, so 
hmn2's variables are nut acccssib\c. 

). Click the Command 1 button on Fonn2. 

Tilc Cummand I_Ciick cvcnt will display values of data items as their scope 
pcnnits. 

y, n1 ha ve just gcncratcd a Form2.Command I_Ciick event, and this placcs the 
Fonn2.CommanJI_Click variable in scopc. Form2 still has focus. though, so 
Fonnl's variables are not accessib\e. 

il. Duublc-click lile Controlmcnus on both forms to el ose them. 
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Additional Visual Basic Data Types 

Syntax 

Example 

• User-Defined Data Types 

• Arrays 

User-Defined Data Types 
Earlier in this module standard Visual Basic Jata typc.s werc JiscusseJ. Visual 
Basic also allows you to crcate your own Jata typcs. User-defincJ Jata typcs. callcd 
records or structun!s in somc otllcr programming langu;IJ.!l'S. nHL..;t he dccl;rrcd in tlH' 
General Declarations scction of a module. using thc Typt· '\t;rtcrncnt. 

Type uscrtypc 

elcrnentnamc As typcnamc 

[elementname As typcn<1mcj 

End Typc 

This feature allows you to crcatc ncw variahks tll<tt c;rn he custtJmizcú Lo fit thc 
needs of your application. For cxample, you might w;rnt lil define a data typc !ti ht1hl 
customer information as follows: · 

1 ' Place this declaration in a module 
2 Type CustomerRecord 
3 

4 

5 

6 

7 

8 

CustNum As Long 

CustNarne. As String ~ 38 
CustAddressl As ~tring 38 
CustAddress2 As String JB 
CustZip As String * 10 

End 1'ypa 

Slreel ;"¡,]¡. ~>~ 
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Example 

Example 

Example 

Module 8: Using Visual Basic Dala Types , 
You C<lll ihen declare and use variables of lhis new type in your applicatino;;n~~~~~~~~- e
whcrcvcr you need ihem. To refer toa particular element, use the syntax 
1 ·¡ 1 ri( 1/ J 1 <' 1/(//llC .el e 111 e 11 t 1 JaJ/ie. 

::•1h GeLCusLomerin[o () 

,,,..,.,_.¡,1re n vrtriable of your user-defined type 

11i1" IJewCust_uiiiL'r As CustomerRecord 

ll:c;~ contents of various text boxes on a form to fill in values tO' 

1 h'":! ele1nenls ( Eields) of your new CustomerRecord variable 

ll•.·~'r'lstomer. CustNum "' Val ( txtNumber. Text) 

r J·~·,¡Cus tome r . e u s tAddress 1 = tx tAddr 1 . Text 

[J~wcustomer. Cusr:Address2 = txtAddr2. Text 

11·~·"·1 :•1 s tom<:! r. Cu s tZ ip = tx t Z ip. Text 

Arrays 
Visu;il Bnsic, likL' nwny uthcr progrnmming languagcs, allows you to crcate arrays. 
1\11 arra y i~ a group or variables of thc samc data type that share a common name. 
Lach .<-.L'pilratc ckinenl of thc arra y is iúcntificd by a unique inúcx numbcr. 

!Je•:lnre an array 

i'im i\r r,lytJame(UpperBounds) As DataType 

l'illl T"stScores(23) As Single 

Note Hy Jcfault. thc first c\cmcnt in thc arra y is rcferrcd to with the indexO (zcro). 
This l..'rL·atcs an arra y or 24 (not 23) single-prccision numbcrs in which you could 
-.;¡ore thc scorcs for 24 stmlcnts. 

11' you \\'iiiHcJ to print this scorc outto thc l'orm, you would use thc followin,g: 

:·r in t. "The tesl scor-e for the first student is: -

i'l int T~stScores(O) 

Therc is an aliernate synlax for dcclaring arrays that allows you to specify the lower 
ibeginning) ano upper (ending) indexes, or bounds, of an array. You could declare 
;111 arra y to hold 24 test scorcs Jikc this: 

ilim '1'<'-'~t.Scores(l.To 24) As Single 

You wouiJ thcn rcl"cr tn thc J'irst clcmcnt in thc array as TcstScorcs(J). 

11 you didn'l ha ve arrays, you would ha ve lo create 24 separate variables, named 
somL·thing likc S~.:un:: l. Scorc2, Scorc3, and so on. 

lnthc rnmlu\c on looping structurcs, you will discovcr tlw.t loops are a vcry useful 
1110! for acccssing clemcnts in an array. 

Note To changc thc dt::fault lowt::r bounJ lo l. placean Option Base stalcmcnt in 
1hc (iL·neral Dcclarations section ofthc module, like thi.~: 

a awuCCAM!IS 4& ;;;;ez 9§$P&f# . .; ;, §-;@ .. @ 4 

1 

1 

1 

1 

,· 
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Variations on Array Declaration Syntax 
Depending upon w!1crc thc array i~ dcclan:li ;rnd thc -.¡h_'L'Iid lll'L'd .... of your progr;tnl. 
thc syntax to declare an array nwy vury a hit: 1-kre i:-. .1 tiihk tlr:tr .~Uflllll;rrizc .... thl' 
rules. 

Seo pe nf variable dcch1rnlinn 

App/icotion-wide 

Fonn or module leve! 

\Vithin a procedurc 

Kcywurd lo ü.\t' 

Glnhal (Uscd on/y inthc (;L·ner;d Dcclar;Hion.-. :-.ectio11 

of a .DAS module.) 

Dün (Uscd in thc Gcn~:r:d lkL·Iar;llions scc!ÍtHl ofit 

forrn or module.) 

Static (lflhe cntifc jlnll.:nllln: ¡¡,..., hL'en dcc!an:d Sial k. 
thcn youmay use thc word Di m ltl declare rhc <trT<ly.J 

Multidimensional Arrays 
The arra y described in t/1c last scction, TcstScorcs. is an L'.xamplt: of a onc
dimensional arra y. Yo u could think ·of it <rs rcprcscnting a singk col umn (or row 1 o/ 
numbers. You can al so declare an nrray uf s~vcral diml'JJ.,ion~. Thc maximum 
number of arra y dimensions allows in a Di m .statcment i.o..; (lO. h 1r cxamp/e. to 
representa rabie of nurnbcrs you can declare a twiHiimcnsion;JI arra y a.s fo/lmvs: 

Sub GetNumbers (J 

Static Table(4, 23) As Single 

-Or-

Static Tablefl To S. 1 To 24) As Sinql~ 

End Sub 

This would crcate an arra y of five rows of 24 test scorL'.'i L'ach and proviJc room to 
hold ti ve scores for cach of 24 studcnts. 

Dynamic Arrays 
There are times whcn you want to use an arr;1y, but thc si;.c JH:L'deJ wi/1 chan~e ;¡¡ 
run time. Visual Basic a/lows you to crcatc dyn;unic. or v;¡ri;,hk-lcngtll arrays hy 

doing tl1c fo/lowing: 

Dcclnrc tilc array witiJOut dcclaring its sizc with cithcr IIJt· Dim .'ilatcment (l"or ;¡ 

form· or module-lcvcl array) or the Global statement lfor" ~lohal array). Todo 
this,just placean cmpty sct of parenthcscs to thc right of 111e arra y n<~mc: 

' Place in General Declarations section of a fe.:! 111 "r· n~<·dule 

Dim DynArray(l As String • 25 

-Or-

Global DynArray{J As String • 25 

. Here is another example: 

¡;]ulllll IJytilliLfiJ"t<•Y() A~ Jnl•'w'r 
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Example 

Then insick a proccJurc, whcn you know 1he size you need for lhis array in sorne 
particular circum:-;tancc, redimcnsion thc array to the size you necd: 

Sr1b UseArray {) 

tlotice yuu can use a variable from your program to set the size 

F·-·llim DynArra'/1 Listl.ListCount) 

Importan! Each lime you use thc RcDim statemcnt, all thc valucs currcntly storeJ 
inthc arra y are lost, and cach c!emcnt is resct to zcro ora NULL string dcpemling 
1111 thc type of thc clcmcnts in thc array.lfyou want to preserve thc values'during 
1\>dinll'llsioning of tllc array, use thc Preserve kcyword. 

!··.diiiP l•r,:serve llyllrrayiUBound (l'lyArray) •. 10) 

In thi.s c·a.sc, you are re-dimensioning an arra y callcd M y Arra y to be 10 elements 
L1rgcr ,,·hile mairllaining cxisting data. 

Control Arrays 
VIsual Basic has a spccial typc of arra y called a control arra y, which has special 
fc<.1turcs anü Unes not folluw al\ thc rules uf standard arrays. 

You \villlearn to use control arrays in tlie course that follows this one in the 
f'vticrosoft Univcrsity Visual Basic curriculum. 
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Summary 

• Key Terms 

• Using Variables and Constants 

• Scope 

• Additional Visual Basic Data Types 

Objectives 
In this module ygu lcarncd to: 

• List and describe thc scvcn variable dat:ltypes in Vi ..... tt;d IL~:-.il.'. 

• Correctly identify the six typc declaration character ~ymbols. 

• Use the contents of CONSTANTTXT. 

• Distinguish among the various le veis of scopc in Vistt;d Basic. 

• Explain thc rules for using cach lcvct _or scop~:. 
• Declare and use a uscr-dcfincd Jata typc. 

• Declare and use simple arrays. 
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Lab Time 

Go to tlie Using Constants and Variables portian of your lab manual. 
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I Overview 

-------~----· ··-··· 

• Visual Basic Procedures 

• Scope of General Procedures 

• Writing Code in Visual Basic 

• String and Numeric Conversion Functions 

Overview 
Tbis is the "Everything You Evcr \VantcJ tu Know Ahottl \Vritittg Cmle ... But \VcrL' 

·· Afraid to Ask" module. It gives you the background and proccdurcs nccdcd tn bcgin 
writing the Visual Basic codc that implcments thc interfaces. 

Prerequisites 
To successfully complete this module amJ its associall'd l:dl, you· .... lwu\J ha ve a 
dctailcd understanding of forms, controls. and propertic:-- ;ts tllcy :m.~ implcmcntl'd in 
Visual B.asic. 

Overall Objectives 
There are two overall goals for this module: 

l. To quickly review most of thc fundamental proc~:dutl':-. t>i' Basic as it is used 111 
the Visual Basic producl 

2. To show students thc first stcps rcquireJ for compktitl~ thl' cmk for an 
application 

Learning Objectives 
Atthe end of this module, you will be abk tu: 

• Define importan! charactcristics of Functions aml S11h pron·durcs ~md writc 
code thal correclly uses both. 

• Define and CtliTl'clly codc for appropl'iall' .,~,·,lpL' tJ! d;1ta. 

• \Vritc codc thal uses any or the conuHun Ha sic dat;a 1 yp~._·s. 

.. ~ ..... 
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Sample Code 
Thc hcst \\'ay for you to lcarn how to writc Visual Basic codc is to rcad it. Sample 
coJc fur a four-function calculator application can be found in the 
\VIl\SAMPLESICALC subdircctory. 



• 
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I. Visual Basic Procedures 

Syntax 

Syntax 

• Sub Procedures 

• Functions 
1 

• Arguinents and Parameters 

• Procedures 

Event Procedures 

General Procedures 

Methods 

· What Are Procedures? 
A proccUurc is a block of Visu<ll Uasic .'il;t\l!llll'tlts th;tt ill\' L·alk!l as;¡ l11¡;icd uni1. 

Two Types of Procedures-A First Pass 
Sub Procedures 
After the Sub procedure completes its v.mrk (executc:-. i1s L'tH.kJ. il n.:turns to thL· 
procedure that callcd it. 

Sub SubName () 

statementblock 

EndSub 

Functions 
A Function is similar toa Sub proccdurc. In addition. it llas a d<~l<l typc justas;¡ 
variable does. After it completes its work, it rcturns a \';duc of tll;~t type tu the 
procedure that called it. 

Function FunctionNamc() ¡\s SomeDm(/'f~r¡u· 

sra reme 111 !JI oc k 

FunctionName =So me Vol u e 

· End Function 
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Calling a Sub Procedure with Arguments 

Syntax 

Syntax 

Event Procedure 

Sub Commandl - Click ( ) t¡ 
¡ 

DisplayError 11 MyErroru l 
-1 

~ ~ 
End Sub ~1 
<,:..;~~'<~,;Mflii:•~~--,~,.;~:..-:~v~ti~~~:;.....,-;¡¡¡.,·.oo~~d 

Sub Procedure 

..::::: :::> Sub DisplayError (ErrMsg As String) 1 
lblError.Caption = ErrMsg 

1 
L.:::::::J ~2¡···l5l-l.:lll"l'llil~'i¡fi'"'Oiíf~UO.~i!!'~0'l''"o'lll!ai¡;¡¡¡:¡·:¡¡<.:o:.>'~ 

Arguments 
. .i\ny l""ccJurc can be Jefincd to receivc data when il is callcd. A piece of data scnt 
. toa prtH.:eJurc is callcU an argumcnt; andan argument is matched to its cquivalent 

p<lr;¡¡m·tcr cntry in the pruccdurc \isc Each pa:amete ... is dcclare:d to be of a spedfic 
d;lltl ty¡lL:. 

ThL' rldlti\\'Íil); is a Suh pmccdurc that rcccives two nrgumcnts: 

Suh SoJJJ('.\'11/1 (1 1ormnl As lntcgcr, Param2 As Single) 

S/ii/¡'/1/L'IIlhftlc ·k 

End Suh 

\VhL·n you call this proccdurc yoJJ must make su reto pass it thc samc numbcr ant.l 
lJ'IlL' t~f ;1rt!umcnts in thc same ordcr thcy appe;_¡r in thc Sul> dcfinition. 

,\'IJIIIt'.\td' ¡\rg111111~1f 1, Argu111e1112 

-Or -· 

Ca 11 ,<..;, 1111 e S 11 f, (r\ r8111n e 111/, A r¿; 11111e nt2) 
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The following ca lis" Function proccdurc with argumcnt,. 

Dim Resu/t As lntcgcr 

!?esult = SomeFunclion (Argumem 1, Argllllltllf2) 

" Function SomeFunction (Paraml As lntegcr,/'an1111~ :\.'1 Si111-:kJ 
1\ As lntcgcr 

StatementB/ock 

SomeFrmction = Retunt Va/1{(: 

End Function 

Note The argumcnt names uscU whcn you c;dl tlle prun:dun.: do not ha veto match 
the argumcnt names uscd in the dcfinitionof thc prócedurc as thcy cJo in thc abo\'l' 
example. The number, data typc, and arder or the argunu:JHs must match in t11e 
procedurc definition and cal!. 

An a/ternative notation for the function rcturn valuc diit<l IYJll' is ;1...; l'ollow.-.. 

Function SomeFuncticmo/o (Paroml As JnlcJ!.cr, Porom~ i\.'i Single) 

StatememB/ock 

SomeFunction = Return Value 

End Function 

Note Function procedurc~ witll <.111 cxpl'tcil rL'Iurn valttl' d;t[;¡ ty¡w are mnrl', 
cfricicnt than thosc with ¡¡ Variant n:rurn v;duc da!ttiYJll'. 

Rcmember what wc said about Variant dat;1 rypcs cttrlin".' lf yottr argurnL'tll is a 

Variant and its corrcsponding pararnctcr is Jhll, thc Varh111t ttr~tlllh.:nl musr he 

passed by valuc. This is nccomplishcd by pulling a sct t1i" L'.\tr;t p<~t\.:ntlwsc~ around 
t11c Variant argumcnt. 

You can ~ccomplish thc samc objcctivc hy using !he BJVal keyword whcn yott 
dcclnre your parnrnctcr in thc procctlurc. 

1 FUnction ~everae (S As String, ByVal N As Int~o~r) As Variant 

2 ' ... Somestatements 
3 End Function 

4 Di m U As Variant, V As Variant, ,., As varic>r,l 

S V ~Testing-

6 w lO 

7 u Rever se ({V). W) 
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Passing Arguments by Value 
Visual Hasic passes argumcnts by rcfcrcncc as a dcfault. Whal this mcans is that 
lile pniL'l'durc can nwdify thc valucs of thc argumcnts in thc proccdurc list beca use 
i1 h:now:-. tllc <HJdn.:ss for thc data. This in cJTcct allows yo u to pass back more than 
tllll'. v;tlttc lllcrcly by changing thc argumcnts within thc proccdurc. 

l11 coltlr;tsl. you ctn pass an ~trgument toa proccdurc by valuc. which mcans that thc 
pnlCL'llurc rcccivcs tJnly a copy of thc data and cannot modify the valuc of the actual 
;trgunll~llt. Any changcs rnadc to thc argumcnt within thc proccdurc are local and 
ha ve 110 l'llcct 1111 thc actual data. 

To pass an argumcnt by valuc, usl! thc kcyword By Val in thc parametcr list or pul a 
sct or pmcrllhcscs around thc urgumcnt in thc calling statcmcnt. 
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Types-of-p roced u res 

Syntax 

• Event Procedures 

• General Procedures 

Types of Procedures-A Second Pass 
Visual Basic applications ha ve two catcgories of proc~dun:s: event am.l genera!. 

Event Procedure 
An event procedure is a proccdurc invokcd hy a uscr~ 11r :-.ystem-ti-iggcreJ e ven\. 

Event procedures are a\ways attached toa given fonn m l·ontrol. The first p~1rt u!' :111 

event proccdure's namc indicatcs which ohjcct it is illli!dll'd 111 . 

Sub objectname_eventname () 

statementblock 

End Su u 

Examples of event proéedurcs are: Cornrnaml 1 _Ciici; <~mi h>rm_Ciick. lf thc usc1 

clicks on the command button namcJ Command 1, the ewnt pn1n:durc 
Commaridl_Click will be callcd; but if thc u ser clicb 1111 tlu:.fúmt. thc evetlt 
procedure Form_Ciick will be calleJ . 
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Creating the Event Procedure 

Example 

Procedure Name Determines 
What Event to Respond To 

1\';1 ·· • " '. · .FOR 
Object: j HelloButton 

Sub HelloButton_Click () 

Readout.Text = "Hello, World!" 

End Sub 

Tc1nplatcs (Suh illld End Suh statcmcnts) are supplicJ for all thc cvcnts Visual 
Hasic ;~utomatically rccognizcs. 

·¡\11 you necd tu do is fill in thc coí..lc: 

l. Opcn !he Codc window. 

In tlll· < >hjcct list hox, sclcct thc appropriatc objcct. 

.1. In thc Proceuure list box. select tbe appropriate event. 

-l. TypL' c1HJc into thc tcmplatc providcd by Visual Bnsic. 

Calling the Event Procedure 
You don't ha ve lo do anything to cal! thc cvent procedure. Visual dasic 
autrHnatically rccognizes all the events for all Visual Basic objects (forms and 
controls). As soon as a uscr or the system triggers an event for an object, tbe code in 
the appropriate cvent proccuure will be run by Visual Basic. 

Scope of Event Procedures 
J:vcnt proccdun:s ;u\:: only availablc on thc fonn whcrc they wcrc úefincd. 

Note l:vcnt proccdun:s may only be Sub proccdurcs, not Functíon proccdurcs. 

Thc f1dl_t~\'.:ing is a Click cvcnt pruCc<..Jurc for a command button. 

:-:•11• Cr.'lllillil!Hll_Cl.ick () 

This vill•Je can be found in CONSTANT.TXT 

r:rmst l<f::IJ :: &HF"F& 

.• 
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Event Procedures in Visual Basic 
A large numberofevent proccdurcs are a\·ail;thlc ror yuur u."c in Visuai!LI~il. Til~· 
oncs sct in italic typc bclow are cuvcrcJ i11this cour."l.!. ;tttd tllc I"L'tn;lining cvt:nt 
procedures are covcrcd in thc Pro8run11nin.t: in Micm.\1~/i Visuul/iusic 3.0 cour.'il'. 

Action 

Change [O control 

Drag and drop 

Dynamic data exchange 
(DDE) 

Keystrokc 

Mouse 

Shift in focus 

Tirner interval 

forms anú picturc 

E\'cllt 

Changc 

DropDown (combo bm; Pnlyt 

PatllC/wn¡;e. PatlcrnCiwug¡· tfik ]j_,¡ hn\ on!yJ 

Drag:Dro!.' DragOn.:r 

LinkCiosc. LinkError. l.inkl·:_xc~.:ull'. 1 .inkO¡n.:n 

KcyDown, ¡..;:cytJp. ~cyl'n·_,_, 

C/ick, /JoublcC/ic/.:.. ¡\lou.'.t:I>Hwn. :\lnu ... cUp. 
i'.lousc~Iovc 

GotFocus. I.II.;IFIIL'Wi 

Timcr 

l'aint, Rc.l'i:.e.l.mul, Unfoad 

Use the online He!p or thc ,\Iicrn.wp Visllallfosic Lan.~lltl,t:l' lú·¡i·rcnc" t11 fintl 
descriptions of thc cvcnt proccdurcs in Visu;d lb sic. 

' ' 
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General Procedure 

Example 

~Type 
@§ub 

N ame: 

Q ~unction 

NewProc 

A general procedurc is a procedure executed only whcn explicitly called by Snother 
pn1ct.:dure. 

Creating the General Procedure 
l. Opc11lht.: Codt.: \'-'imlow. 

FnHn 1he Vicw mcnu, choosc New Proccdure. 

l. Typt' tllc llíllllt.: for the proccLlurc, anc.J choosc cither Sub or Functinn. 

~. ;\dd rile coJc lotlie pruccJurc tcmplatc proviJcJ by Visual Basic. lf yuu are 
LTL':tl ill):! a ncw l'unction, rcmernbcr tu define the return typc of thc function ;.¡,mi 
\ll ·1ncluUc a statcmcnt in thc code assigning the value you want returncd to the 
l'ullction namc. 

1 l"unction Stock1/alue WumShares .1\s Integer, SharePrice As Single) 

,., i1s Single 

5 

~toc~Vnlu~ = NumShares • SharePrice 

f<nd Function 

Sub Tnt'al;-ii.<J'~i-: 1 ¡ 

¡•t·int "'T<JLal value of all sc.ock is: 

Pdnt Sr.rJcf:Value(lO, 123.25) ... :St.ockValue(200, 19.75) 

1·.11'1 Sub 

Calling the General Procedure 
You llHJs! cxrlicitly calla general proccdure, or thc codc will nevcr be run. 
TypiL·aJiy. you rlacc a C:.Jllto a gcncr:.JI Sub or Function insid~ :.Jll cvcnt proccdun.! 
¡ 1r insidL· another ~encru! proccdure. 
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Scope ofGenerarProceaures 

Syntax 

Change_.¡Textl Change¡-------~ 
Event . ~ . 

return 

~~~~ 1 -~~ L_c_m_d_l_c_l_l_· c_k_.JI ~ 1 Di s p la yl3a ::-eh a,- t 1 

r---------, relurn t 
Click __ ..,. Cmd2_Click 
Event L_ ____ ___¡ 

return 

Form-Level Scope of Code (.FRM) 
The scopc of a general proccdurc c.Jcp!.:nJ . ..; 011 wh~.;rc Íl ¡_.., dl·fim:d. 1 r you rnllmv lhL' 

steps listed above whilc you are in thc Cmll: wimJow r()r llllC ()r Ytllll" fmms. tllcn 
that procedure is available from anywhcn: u111llat l"mllltllily. 

Global Scope of Code (.BAS) 
lf you ha ve a multiplc·rnrm aprlication :utd lll'L'd 111 hL· :1hk 111 r:dl L·cn:1in 
procctlurcs fmm :mywiH;rc in your applic:ttÍ,lll. ytnl \\ dlill'l'd 111 ,.,.,_::Jtc a ·"''l';tr:Jtl· 

.I3AS'modulc to hold thosc proccumcs. 

Note, for example, if DisplayBarChart ¡_.., Jcri11Cd as;~ t-'l'IIL"ral prtJCcdun.: fpr h1r!lll. 
thcn Tcxtl, Cmt.ll, and CmU2 nlu.'ll all h~ Llllllnd." 011 hlf.l\11. 11'. 1\¡¡wcvcr. · 
Disp\ayi3arChart is defincd in a separat~ .H:\S 1nmluk. TL'.\II, C'111J l. ;111d Ond2 
could each be on a differcnt form ami still he :d>lc t" ,·;tll lii.'PI:'vll;~rCh:ll·t. 

Private Scope of Code (.BAS) 
In sorne cases, you will want to lirnit thc ~1cccssibility llf ;¡ pniCL'durc cuntain~d 
within a module. In order todo this. use the Priva te kl')'\\'Oill in i'nlllt uf Suh lll' 

Function definitions. 

Declaring a Private Sub Procedure 
Priva te Sub SomcSuh () 

Somf!Statements 

End Sub 
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Syntax 

References 

Declaring a Private Function 
PrÍ\'all' Function.")omefuncrinn ()As Intcgcr 

,y, 1/111' .)·tare 111 e 11 r s 

I·:IHI Fum:tion 

Method 
A lllciiHod is a speci;¡ltypc of proccdure provided for you by Visual Basic for 
..,pccil'iL· ubjccts but not Jssociatcd with a specific event. 

Special Characteristics of a Method 
l. Y11U cannot crcatc a method; you can on!y cJII it. 

'{tllll.:annot \:icw or change the code for a method . 

. 1 Tltl' n<tlncs or :di Visual B:1sic mcthods are keywords. You cannot crcate a 
,t!L'IIn:il procL·liun: of your 1.lwn with thc samc namc as a Visual Bu.sic method. 

l"IIL' i'~dlti\\'Íilg c;tll.-. ;¡ lllCtJwJ !'rolll ... l l!Vt.!lll proccJurc attachcJ lO a form: 

Fonn Click 8Vent. tor Forml 

!·· •• :·,.:. Show Display form2 ~t 

Methous in Visual Basic 
A lar~L' number or methods are available for your use in Visual Basic. The oncs ser 
i11 it;dil· 1yp~ bt.:lmv i\J"c covcrcU in rhis coursc. 

1Jraw1n~ ;1nd graplii1..·.-. 

11ri 111 i 11~ 

DIJE 

l.isl hr1.\ rmmagemcnt 

Clipho;ud 

i\toving ~.:ontrols 

l:rlrJil rne~rlagemcnl 

Cin:lc, Cls, Linc, Poinl. Psct 

EndDoc, NcwPagc, Print, PriutForm. TcxtHcighl. 
TcxtWiuth 

LinkExccutc, LinkPokc, LinkRcqucst, LinkScnu 

Addllem, Removeltem, C/car 

Clcar, GctData, GctFormat, GctTcxt, SctData, 
SctTcxt 

Drag, Move 

/lid e, Slww, Rcfrcsh, Scalc. SctFocus 

Use ihc "nline Help or lile Microsoft Visual Basic Lnnguage Reference to tind 
descri¡oti,ns of lile mcthous available for Visual Basic objects. 



'' 



,¡ 

• 
• 
• 
• 
• 
• 
• 
• 
• 
4 

.. 
4 

• 

' 
1 

j 

Writing Code in Visual Basic 

Pns¡ Linl\ 
Dele te 
Find ... 
Find Next 
Find Previous 

Ctri+C 
Ctri+V 

Del 
Ctri+F 
F3 
ShiK+F3 
Ctri+R 
Ctrl+= 
Ctrl+-
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There are severa! facilities built into Visual Basic that IJl;l~c w¡·iting CIH.Jc c;1:-.y .. -\11 u 

of the search and rcplacc proccUurcs Uiscu;-;:-.cd lK:Iuw kt ~·,¡u :-.c;lrL·h in tllc currl..'llt 

procedure only, in thc currcnt module only. llr in all llltldldcs. 

• Cutting, copying and/or pasting codc 

Edil mcnu, Cut or Copy, ami Paste 

• Finding strings (variable namcs. for cxarHpiL·) in._·(ltk· 

Edit mcnu, Find 

• Finding thc ncxt in~tancc of ;¡ string in codc 

Edit mcnu. Find Ncxt 

• Finding thc previous insli\llCC or il strillt! Íll L'lldc 

Edit menu, Find Prcvious 

• Finding and replacing a :;tring in cmlc 

Editn\enu, Rcplacc 

• Loading text from thc hard disk 

File menu, Load Tcxt 

• Saving codeas text outto thc hard disk 

File menu, Savc Tc.xt 

Note Yisu31 Basic offcrs a uscful fcature túr pcopk \witínt! codc. By (.kfauh í1 
chccks thc syntax ofyour coúc as you are wríting it. Tl1i" ís g1H1d ncws hcc;Ju"c ytltl 

gel constant feedback on thc corrcctncss or the syma.\. lkc·ariSe therc might be 
times whcn sorne pcoplc fincllhis inlrusivc. this 11pti"" ,.,,,he did1lcd. 
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Returns Variant 

Sir 

Tri m 

UCnse 

Rcturns String 

Str$ 

Tri m$ 

UCase$ 

Val 

\ll".nling/synla\, L'.X:unplc. note 

(¡1ll\'l'l1.<.. a llllJllh·r IP ;~ -.rnng of digrh. 

RL'I]\(1\'C_\ lcddln~· <tlld tradillg ~p<!cc:-. rri\11\ ,1 

.~tnng. 

Rctun1:-. tllc liJljlL'I,-;¡,-.,L' ¡,,..,l.tllCL' 11( ;¡ llm..__.,..__.,,~,· 

didlíll'lt.:l'. 

Coll\·crb ;_¡ )trlll);.' 1 ,¡ di¡;1h 111 ;¡ nu1nhc1 

String Conversion Functions in the Employee Databa se 
Function Sub proccdurc 1-'nrlll 
------------~---------
Chr$ 

LCase$ 

Left$ 

Len 

LTrim$ 

M id$ 

Right$ 

RTrim$ 

Str$ 

UCase$ 

Val 

(not uscJ} 

(no! uscdJ 

(not usetl) 

Fii!Ficltls 

(not usctl) 

FiiiFiclds 

cmdOK_Ciich: 

Fillfidds 

Fonn_Lo:HJ 

fii!Ficlds 

(not uscJJ 

CllHJVicn· Clich; 

1 MI'DIIII~M 

1 \II'Dii IRM 

\ 1 ) 1 ) 1 , 11 { ,., ( ) .1 .. ,~ )! 

1.\ll'llli 11{,\1 

1·.,\11'1 Jli 1·1{:\1 

Numeric Conversion Functions 
There are a number of functions ;¡vailablc wi1ilin Vi:-.tl:d !LL-.;ic lll;tt H·ill Cllll\'L'rt d;¡t;¡ 
types. 

Function 

CCur 

CDhl 

Clnt 

CLng 

CSng 

CStr 

CVnr 

CVDatc 

Comment.-; 

Convcrts a numcr·,l. l'\fllt::,sitlll 1!1 .t (."urn·rw.v \'<llue. 

Convcns a nunu,;ril e\ pr e . ..,sÍPII 111 d dt lllhl<:-pl e-:isit 111 lltHililL'I. 

Converts a numcric e.\¡m.:s:.IPII 111:111 lllll')..:l'r hy rou1Hii11¡_: tllt· 

frill:!Ít11lt1J pa11 nrtJlL' C\!Hl'SSÍll/1. 

Convcrts a numcnt: c.\pH.: .... sionlu ¡¡ l.ong 1-t-hytc iruq:.l'rJ b;
rounding the fractiun;d p<u1 llf lhl' npn.:ss/(111. 

Convcrts a numcric c.\pre ........ iPlll(l d ..,¡ngk·-¡11Ct:i .... itlll v;dtlt'. 

Converts a nurncric e\¡m: . ..,sitlll lt' .1 ."itrin¡.: \·;duc. 

ConvcJ1S a nurneric t'\¡JIL'"sitll\ ,,, .'it.-iug 1t1 ;¡ V;1riant. 

Convcrts <lll cxrrc.'ISillll (O ll \';¡ri;llll ol \';IITypc 71 [);¡(t_'l. 
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FormatS Function 

Synlax 

1 Today's Date 1111 February 19921 

·1 Time j ! 1 09:16AM 

,, .. ,-.. ,., 

' This funL·tion con\·cns a number toa string and formats it according to instruC~ions 
L'tJnt¡¡incd in a formal cxpression. · 

For111a 1$( 1/UJ//cril ·- npre ssion [, fllll S/ ) 

fmtS 
:\ forlll<ll l'.\f1l"l.:Ssinn is a string of Visual Basic display.format charJctcrs that detail 
hnw tllt· numeric c.\prcssion is to be displayed. 

1 kn: <Ht' >L'\·cral s<Jillpk formal cxprcssions and how thc output wuuld be displaycU . 

Ftlnll:il.''f.! fn1tS 1 Positive 5 Nc¡.:ativc 5 D~.:dlllal .5 
--------

1!.(10 S.IHI -5.00 0.50 

t(U#(J 5 -5 

~#.##11.1111:¡ )#.##111111¡ $5.00 ($5.00) 50.50 

Thc ¡\/ow function can be u sed to return the current system date/time as a serial 
nurnhn Date/tirnt: serial numbers can then be formattcd wilh dale/lime or numeric 
r~~nn;lt' li1LT<tu~c lbtcltimc scrialnumbcrs are storcd as lloating-point valut.:!->) . 

• 1 
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Example 

Further Examples 

The following are examples of Jatc and tilllL' (t!nn:u_ .... 

Format 

rnid/yy 

d-mrnmm-yy 

d-mmmm 

mmmm-yy 

hh:mm AM/PM 

h:mm:ss alp 

h:mm 

h:mm:ss 

mltVyy h:mm 

llispla~ 

1 ~/1/5'<'1 

7-[}(:t.:Cilll•cl -_'1,'\ 

7-IJCCCII\1)1..'1 

11~ 5111',\ 1 

X 511:)5 p 

20:5() 

2!J:50:)) 

12/7/.'iX 2!J::'liJ 

Sub cmdDisplayDate () 

txtTodaysOate.Text 

End Sub 

Fonnat$(Now, "nun/dcl!'/'/''¡ 

A complete description of the Format$ runctitlll can he ¡",¡unJ in Visual Rasic 1-klp. 

A pplication 

lconWorks 

Form 

ABOUTBOX.FRM 

COLORPAL.FRM 

·:oLORPAL.FRM 

ICONEDIT.FR,\.! 

ICONEDIT.FRM 

ICONEDIT.r:RM 

ICONEDIT.I'RM 

ICONEDIT.I'IUv! 

V!EWICON.FRM 

VIEWICON.F!Uvl 

VIEWICON.FRM 

VIEWICON.FRM 

(
1nu.:cd!irl' 

Form_l,oatl 

Txi_Hl.B_ ( 'lwngl' 

1 )i,..;play _l~l' 1, __ Color _;llld_Eil'lllCIII." 

Sa\·c_Sctting . .., _Tn_INJ_Filc 

[•a.'ih:_ Cl i¡1 llt 1a rd _ ( 'tuJtcn ts 

San:_Color ... To_J,~I_Filc 

J•rcpa rc_h,r _j\¡c w_lt:llll 

1 lisplay _1\ 1 JJIJ~l' _ CJIIII"JiinoJ tc.'i 

Form_l.11a11 

l.o;ad_,\11 kons 

¡;¡¡c_Fill'l ,¡_,¡ l'ath( 'han¡..:c 

Furm_llnload 

Icon\Vorks makcs cxtcnsivc use or lhe Fonllal~ l"lllll"l j¡ 111 Thl' ;dHl\'C t;~hk ¡~ llllly ;¡ 

partiallisting. 
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Summary 

-------------------------------------------

• Visual Basic Procedures 

• Scope of General Procedures 

• Writing Code in Visuai Basic 

• String and Numeric Conversion Functions 

Objectives 
ln tlli .... 11\tldule you \earncd to: 

• Ddi11L' imporl<~lll characteristics of Functions and Sub proccdurcs and write 
C\ldl' that Ctl!Tl'L'tly uses both. 

• l >L·t 11\l' anJ co1TcL'tly coJc ror appropriate scope of Jata. 

• Writc uH.k tllill uses thc curnn1on Basic data types. 

1, 

'· 
4!-

~ 

fj 

fj 

1! 

f: 

e: 

~ 

e 

~ 

~ 

~ 

~ ,, 
~ 



• 
~ 

4 

.. 

.. 
~ .. .. .. .. .. 
~ 

" • ... 
... .. 
... 
... 
... 
.... 
.... 
.... 
.... 
.... ... 
.... ... ... 
-.... .... .... .... 

Module 9: Writing Visual Basic Code 217 --------------------------------------------

Lab Time 

Go to thc \Vriting ProccUurcs portion of your Lill lll~lllll<il . 

• 
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I Overview 

• Control Structures 

lf... Then Blocks 

Select Case Statements 

Do While Loops 

Do Until Loops 

For ... Next Loops 

GaTo Statements 

-------------------------------------

Overview 
Control structures are a crucial part of any cornputcr languagc becJusc thcy cnuhk 

· .· · -·systematic decision making within the codc. In this rnoJuk you wi!l Jc;_¡rn how 111 

control the logica.l. tlow of your program. You will al so karn lww to mark off 
blocks ofcode that are to be exccuted if a .... pccificJ condition is truc or f;-¡lst.:. Ytlll 

will also leam how to specify thc numbcr of tillles that ;t ¡_!iven block of st:ttcmctll'
is to be executed. 

Prerequisites 
This module assumes a fairly dctJi!cd understanding lll" l'!)ding tnL'dlinlisrn ... in 
Visuall3asic. You will alsonced pmficÍL'IlLY itt desi~ttÍtl~ ;¡nd building tllL· U>L't 

interface for software applic;.ltions. •You shtlldd ;dn:.<H.Iy ht· r:ttnil'~;tr \'.'itll: 

• Forms nnd properties 

• Statemcnts, Sub proccdurcs. aml Function pnH..:ctltll\'." 

• General and event procedurcs. as well as tncthods 

• Visual Bnsic data types 

• Variables and constnnts 

• Use ofthc MsgBox$ stat.cmcnt anJ CllllCiilt'li:IIÍn~ ."11'111.!..!" 

• String handling functions 

Overall Objective 
At the end of this module, you will be ablc to writl: cmk th;ll rro\·iJes sy ... tcnwliL· 

dccision making within an application. 
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Learning Objectives 
:\llilL' L'IH.l ot' lhis lllíHJulc. ynu will be ab\c to use: 

• IL..Then ... Else blucks 

• Sl'il'l'l Case sWtelncnls 

• Do \V hile lollps 

• Do l intilluups 

• For ... Nc\t h1ops 

• (;ld'u .-.\a\L'IliLill." 

" 
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• lf ... Then Blocks 

• lf ... Then ... Eise Blocks 

• Select Case Statements 

' ' 
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lf ... Then Blocks 

Example 

11 condition Then statement 

11 condition Then 

statements 

End 11 

Tllc r~~il :.;!Jnws tiJ<lt therc are two possible arrangements for lf ... Thcn block;.tYou 
L'<lll u.'-t' L'Íthcr a sint!le linc or multiple lincs containing multiplc statcmcnts. it; you 
ll;n·t· u11dtipk stillt'lllL'Ills. youneeJ to use End lf. 

Operators 
Thl'rt• ;~re si.x tlpcra\tli"S tllat you can use in the condition portion of thc If...Thcn 
hhll'~. 

( )j)l'f":l(lll" ¡\lea ni ni-! 

Equal 

<> Not c4ual 

< Lcss tlwn 

<= Less than or equal to 

> Greatcr than 

>= G!'cutcr than or cquallO 

Note In this case tllc::: opcrator is nor bcing uscd for an assignmcnt statcmcnt. 
su eh as: ReadOul. capt: ion = "o.·; instcad it is being u sed for a conditional test. 

[f o¡,rF•:l!Ti.me. 1/alue = TRUE Then PositionType ·rull Time• 

Examples in the Employee Database Code 
For.,. lis/ of ex;rrople lf...Then blocks, lf ... Thcn •.. Eisc blocks, and Sclcct Cnsc 
sl<rteolc'rr/.s in the l'inployee D;1tabasc codc, sce thc listing at thc cnd of this module. 
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ICThen ... Eise Blocks 

JF condition 1 Then 

statementblock 1 

ELSEIF condition2 Then 

statementblock2 

ELSE 

statementblockn 

ENDJF 

Herc you get a chancc to test for severa! dil"l'L·rcJll .-;itu;¡¡j,¡¡¡..; ;~nd 1\.'<~Ct ;lpprnpri;Jtcly tt 

to each one. Adding Elsc to thc H ... Thcn .'-l<lll'lllCrH prm·i.ks nHtL·J¡ llHm; r!cxihilitv 
in tfie response. . 

Walk Through-lf ... Then ... Eise Example 
I, To use !he If ... Then ... Eise statement 

l. From thc Walk Throughs program group . .'1:11tliH"·· 

\Vhen thc application starts. thcrc will be ;t rorrn with ;¡ ChL'L'k hnx !~tbclcd HP!d 
with an X in it anda command button lahclcd Prinl Stlllh:thÍil):!. 

Thc purposc ofthc <lpplicllion is to sh11\\' ;nJL'.\;JIIIJllt· 11f \\'ht·r~.· an 
If. .. Then ... Eisc block might be uscd. 

2. Click the Print Somcthing com,nanu buuc"1. 

The word "Something" will appcar Olllhc ftlrlll in h,¡Jd 

:l. Click thc Bold check box. 

This rcmovcs thc X from the check bu.,. 

4. Click thc Print Somcthing command buttt 111. 

The word Something will appcar on thc funn witl_l tlll· h,l]LJ f¡ irlll;lt rt.:JlHl\'t.:d 

5. Closc IfEise. 

I, To crcate the Ir ... Thcn ... Eisc cxamplc 

J. Start Visual Basic. 

2. From the File menu, choosc Ncw Projcct. 
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.'. Sckct ¡~·untBoiJ 1lll tht2 Prop~ttics !ist box. 

Vil'W th~ h11·1n ¡Hupcrty FontBo!U. Note that thc LlcLJ.ult va!uc is Truc. This 
ltll'iiiL" whcn tl1c cltld3olc.l check box is crcJtcc.l, its valuc shou!d be set to 
e ·¡ll'ckcd. 

4. D~~uhk-click thc check box tool in the Toolbox. 

.". Sct tllc ful!uwin!;; propcrties for thc check box: 

( ·.q l\ j¡ lll 

V;dtll' 1 - CilcckeJ 

N:illll' e 111d 1 )ri ntS()Illl..::thing 

l1rint Sumt.:thing 

i'J11\\' that you h;t\'C crcatcd the interface, you nced to add thc codc to makc it 
lunction. 

X. h~>!il thc Proj~ct window. choosc View Codc. 

'J. In lile Object list bnx. sclect chkBold_Ciick. 

Hl. t\dd tite follo\'-'ing code: 

c .. r.,'' O!ECKED = l 

;¡ •·:1!-:Bold.Vi'llue = CHECKED Then 

¡.·r¡r;nl. F<Jnt_3old TRUE 

E;.~ ... 

¡:orml. fontBold FALSE 

Thi' '"·ill cause thc font to bC set to bold or not, depcnding on how the user has 
sct tite check box. ' 

11. In tiiL' UbjcL·t li~t hox, sclcct cmdPrintSomething_Click. 

1 ~- :\dLlthL' fol111\~·in¡;: 

i': • lo' "Som~lhi;:<._¡" 

Tln .... will printtltc v .. ·urd Som~thing to the form. Depcnding un thc value of thc 
l'lh'l'k hox, it will he in buld rmm~ll or not. 

1-t l'lll~ntltc Rullllll'IIU, dwu~L' btd. 

1 ~. ¡:ll'llllhc Fik llll'IHI. choosl! Savc As. 

11>. s," e· rile 1<>1'111 '" II'ELSE.FRM in \WALKTHRU\LOGlC. 

17. ·'·'"' ,¡,,. 1''".1'·,·¡ "' 11'1'.1 .SF .. MAK in IW 1\I.KTHRU\I.OGlC. 

""' .. 
" 
" 
• 
• 
• 
• 
'Q 

"' .. 
" 
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.. 
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Select Case Statements 

Select Case testexpression 

Case expressionlist1 

statementb/ock 1 

Case expressionlist2 

statementblock2 

Case Else 

statementblockn 

End Select 

Selcct Case statemcnts look a lot like If ... Titrn ... Else h!!lL·k:,, ;111d thl:r\; is a !:!ood l 

rcason for this: Sclcct Case statcment.s offt:r the s;ullL' kind 11f fttlll.'liunality hut in <l t. 

much more cfficient-for both thc coUe ;u¡d the cmkr lll<lllllL'L ,\s you L·;111 scc 
from the example. Sclcct Case statcment." W11rk panil·IILtrly wcll 11 .... <t mean~ ¡',1r 

handling structured choiccs oftered to the u.,er. 
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Walk Through- Coding a Message Box with a Select Case 
Statement 1 

l11 ;uJ¡,{)¡cr 111\lduk. )'tlU crcated a message box that prompted users to sJve their data 
pri11r tu clt1sing tllc <1pplication. This mcssuge box allowcd users three choiccs: Y es, 
;'-!u. tllltl C<tnccl. 

Tllis !lllldule l1as providcli thc tools ncelleU to writc code to dctcct which button thc 
11.'-t.:r.rlil·~ul: lhl· Sekct Case .st:t!emt.:nL 

L To codl· ;1 messagc ho.x n·ith a Sclcct Case statcmcnt: 

.Slill'l Visu;il IL1siL·. 

¡:tl!lll the File tnenu, clwosc Opcn Projcct. 

~- O¡•L"II ¡\JSGIHL\:. \·IAK. 

Tl11' ti k is l"c"IL'' in \WALKTHRU\LOGIC anu should alrcady contain thc 
ftdlti\~Ítl¡;: 

:~··r· · '·::unam!I __ Cii~k () 

Tl1e ~~lt1es for MsgBox constant declarations 
•;r:~mr~ fr'JIIi \'JB\CO:JSTANT.TXT 

:·l:;c;l;o<"'. ¡Mrameters 

r·.,nst 'ii~SiJOCA:JCEL = 3 Yes, No, & Cancel bt0~ 

• "liS l. !I'P1l•.riJ!-:STI0fJ = )2 'tJarning query 

::~;q$ = ""!lA·:-= '/OU saved all your work?~ 

I·IS<:Box i·lst;S, "(ESNOCA!'iCEL • ICONQUESTION, ·~rsgBox \'lalkThru· 

111 r rr dcr ro ¡;cr tht.: lnruorrs to :-..::.:ponU appropri~tc!y. yo u nccU to JUU ~ numbcr of 
:-.taiL'rncrHs lo tllis. Do t!wt by Ucclaring u variable anU severa! constants. 

4. lnrk."i~n rnodc. doub!c-click thc commancJ button on tllc form. 

T!Jr..., r1pcns tllc CmJc winUuw with thc cvcnt proccdure code in it. 

:'. Add liJe fo!lowing code to tlh.' ... ,eJe window: 0 
C"tr.-· t.:MJCEL ~ ~ 

("• •rr:· · "(ES = r¡ 

C•or, · · ::o = 7 

rJj:r· ·:r• .P:esr,on.-:;•: ,\:; Int:eger 

TilL· l'anccl. Y cs. ~uHJ No Ucr..:larations define more mcuningful namcs for thc 
valuL·~ tllat ;rrc rcturncU for cuch of t/1e buttons. For cxamp!c, if thc user clicks 
tlll' No hutton rlll the rncss;:~gc box, thc value 7 is returned by the system. For 
co<ic· rc·:~u:~bilit)' :~nu 111:1intainability, you shoulu place Const Jcclarations in 
your l'IIUC anu use the constants in the Sclcct Case statement. Remember. you 
C<ill lind thc c11n:ect valucs to declare in \VB\CONSTANT.TXTor by scarching 
1111lnlc llelp lúr tlie tu pie MsgUox lunction and checking-the table of return 
\'dhll'..; 
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In the earlier message box cx~¡¡nplc. you crc~rtcU a rllL'.'.. .... a):!L' htl.\ by calling tllL· 
MsgBox statement. E ven tlwugll you crcatcU a mc.-,:-.ilge box with thrcc hutt111l." 
you had no way to tc!l which button thc U.'ier clickcd. Arwthcr \va y to L'l"l'<!IL' ;r 
message box is to cal! thc i\'lsgBox funuion. In thi." l.,t....,L'. yuu r1ccJ to dccl;rrt: .rr: 

Intcgcr varinble to reccive thc vz¡Juc the i\lsgBox (rrrrct'rtHl rcturn-". 

N ex t. you need to alte'r thc ~·lsgl3ox st~rtcmcnt, m<r~ irr~ it inttt <~ functiPn c;!ll 
Rcmcmber. whcn you call <1 function ytnr rnust <r:-..-..itrl it" I'L'tum \';JIUL' !ttt!lL' 

appropriate type of variable. Ir you p;rs .... thc functitlll ;1rry ;rr~rrrncnl.". tlh..' 
argument list must be cnctoscU in parc111hcscs. 

6. Euit the original i\lsgllox slatcmcnt so thal it ,.c,llh 

MB_Response = MsgBox l Msg~, 'tEs;,.;oc; .. : iCI·.":. •; C<:•i;, ' 'T;' •i: 

"" MsgBox Wa l kThru" ) 

.'Jow you necd to aUd thc Sclect C;lse _-;[;lll'llll..'lll. Y.111 111;1y \\';1111 lo ;~dd PIJI~· lill' 

actual codc amllcave thc commcnts out. 

7. Add the following ende: 

When an integer \talue i.s r<>t'Jr:l··,.-·, ':,·¡ ;-~::;rJi'• 

Select Case MB_Response 

if it matches ~he 'Jalue o: · ·.·· 1 '• ns: 

Case YES 

Print ~user clicked Yes" 

if it matches the value of •.h•: <".,nsl ;; 

Case NO 

' ' • F • 

• indicate that t.he user r·l ¡,.¡.._,~,¡ •1:• ;¡,, 1•·:· '··:• 

Print "User clicked No" 

if it matches the Vil.i.u~ of r_¡,. r· .. nst -ii•TI. 

Case CANCEL 
• indicate that the user .... ::r·k•·cl ::. • ·•::-·•-' ···-·_:..G;-. 

Print "User clicked Cancel" 

End Select 

8. From the Run menu, choose Stott . 

. Test the code of your application. 

9. From the Run menu, choosc End. 

Close the application. 

End the walk through. 

Examples in the Employee Qatabase Code 
Form 

EMPDB.FRM 

ADDPHOTO.FRM 

Prot:cd\lrdHIIII 1 in e 

FiltFidds 

cmdl>ch:lc 
FiltFiclds 

cmciOK_Ciil·k 

( ·oulnd .slnu.:turc typl' 

1 r. .. TIIl·n 
IL .. TlH"n ... EI .... l' 

Sdn·t (';¡_,.;e :-.ldii.:IIILIII 

Sdl·rt C01sc s¡;¡tl!ntcnt 

lf. .. Then ... EI."il' 
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L. Loops 

• Do While 

• Do Until 

• For ... Next 
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Do ... Loop 

Do While condition 

statements 

Loop 

-Or-

Do 

statements 

Loop While condition 

Use a Do •.• Loop to execute a block of st<ltc:mcnts ;ul indl'finitc lllllllber nf times. 
(By contrast, For loops lct you specify ho\\' many tinh:.' <t .... c:t 11r qatcmt.:nl." are 
executed.) In Do ••• Loop \\'hile loops thc nurnbc:r of tilllL'S thc: hulp is e:o.c:~...·uteU i.' 
controlled by a True/Falsc condition. \Vhen sorne ntllc:r L'\'l'lll switches thL· valuL" 1 d 
the condition from Truc to Falsc. thc Jooping stops. 

What's the Difference? 
The location ofthe \Vhilc condition is thc: kc:y dilleren~...'l' het\\'L'L'Il tlle twn e.\;unple.-. 
of syntax abo ve, but what docs thatmean'! Ir tlle \Vhilt· L'tllldition is at th...: top tlf thL· 

block, the statements within thc loop \'.:illnot be cxecutL·d if thL' CtltH.litiun i:' Lti:--L· lt, 
begin with. The block of statcmcnts wil! always be e.\L'l:u!t.:J ;tl IL•;tst once if tlle 

While condition is placed at the bottom or the loop. 
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Walk Through-Coding a Do While Loop 

I To t:od~· a Do \\'hile loop 

l. \t<nl \'isual B<1~ic. 

Fr11lll thc hk lllL'Illl. choosc Ncw Projcct. 

! >t~tdl\c-click thc C\HnlllJlld button too\ in the Toolbox. 

,\ L1•rlll11<111d hu\\111\ appca¡·:; on thc form. 

~- 1 )¡qildc-clich. thL' Ulllll11i!IH.l butwn on thc form. 

T\11, \\·i\1 opc11 thc cl;,nmand buttón Code window. 

-l. :\dd thc !"ullmving coLle tu hmn \.frm: 

1 ;,:. ¡,, ,.,,,, 

Do While í <e:. 

P r 'rrl 
o 1 • ~ 

\{UII lllC appiÍCii\Íilll. 

(l. l·n111' thc !{un lncnu. chnusc EnJ. 

" 
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Do ... Loop 
Do ... Loop Untilloops are almost iUcntic;d ro l>o ... Loup \Vhik. hut thL'y tc..;r h, .... ~-~-

if condition i~ fa be r;1thcr than lrLIL'. 

Further Examples For furthcr examplcs of ... Loop \Vhilc. SL'L' tilL' follúwi••¡..·. 

A p pi ico1 ( iun ;\ !1 •d ul L'/ Ft 1 n11 
_;_:_---'----------------

l'n H't·du n:/Huul im· 

lconWorks !CON \V R 1\.\ .ll.\ .\ 

Walk Through-Do ... Loop Whilc with Lists 

L To use Do ... Loop Whilc with lisis 

l. From thc \Valk Throughs pro¡;ram grou¡1. _-.,¡;¡¡·¡ Dtl \\'l¡iil' ,,·itll 1 .ist.". 

\Vhen the application starts, a fonn with :1 ¡·¡_,¡hu.\ <~lid d l'tlllllll:tnJ hutto11 

labeled Add To List appcars. 

The purpose ofthe application is to sht''' :tn t:.\;llliplt· •d u_,¡¡¡~ :1 Do ... l.unp 
\Vhilc structure. 

2. Choose the Add To List butl\ln. 

An input box will appcar prompting tllL' tiS~o.T to add . IIL'Ill 1•• tllc li:-.t h"-'· 

J. Typc sorne tcxt anu clwosc OK. 

The textjust typed in thc tcxt box wiJI hl' ;Hld~U <l-' ;111 IIL'Ill IP lile Ji-"l 011lllL' l()tll' 

example form. -

4. Repeat the above step seveml times. 

Note that if you add more itcms to thc list 1han CiiiJI'L' displilYL'd at tllll"l' i11 th~· 

Jist box, a vertical scroll bar will ¡¡utonwtic;dly he ;¡tltk'd ltl ;dJ,)\\' you ~~~vil'\~ ;:11 

itcms. In thc case of this cxamplc, you rnu.-.1 adJ 111 lt-:J-..1 '-L'\"\"11 itcrn:-. ltl ti K J¡..,¡ ¡,, 

make a scroll bar appear. 

5. Quit the application. 

L To use Do Whilc loops in list proccssin~ 

l. Start Visual Basic. 

2. From the File menu, choose Ncw Proj~cl. 

Start a ncw project. 

3. Set the following properties: 

Caption 

Height 

Width 

Lcft 

Top 

Do Loop \Vhilc Example 

4035 (approxirnatcly) 

3870 (approximatcly) 

5565 (approximatcly) 

1290 (approxin"ltcly) 

4, Doublc-click thc list box tool intllc Ttltdhtl.\. 

Creatc a list box on thc form. 

• 
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S. Set the following propenics: 

Hcight 

Wiuth 

Lclt 

1455 (approximately) 

1215 (approximately) 

%0 (approximatcly) 

:lf>ll (approximatcly) 

(l. Double-click tlle culllmand button too\ in the Toolbox. 

Cn-'<lle a collltllanJ button. 

7. Sct lilc fnllmvin¿; prop~rtics: 

¡'\i;l]\ll' 

C<tptillll 

lkq:ht 

Width 

Lcli 

ClllJAJUToList 

1\dJ to List 

.'75 (approximately) 

1215 (approximately) 

111~0 (approximatcly) 

1 no (approximately) 

Now thatyou ha ve creatcd thc interface, you necd to add thc code to make it 
runctilm. 

X. Fro111 thc Projcct window, choose Yicw Code. 

'!. In thc Objcct list box, sclect cmdAddToList_C!ick. 

111. AJJ the following code: 

Dim Response As String 

Do 
Response = inputBoxS { •rt:em to add: •, •Add Item", 

1{ Response <> "" Then Listl.Addit~m Response 

Lu••P 'lllhile Kes¡.¡onse <> "* 

o. 1000) 

By crcatíng a \\'hile loop witl¡ the test at the bottom. you ensure going through 
thc loop once to prompt for input, befare any conditions are tcstcd. 

An input box is similar toa mcssJgc box, cxccpt it conLains a tcxt ficJU for uscr 
input. Thc orgulllents for tht.! input box are: 

Arg 1 = Proinpt 

Arg2 = Title bar caption 

Arg3 = Dcfault valuc l'or text box 

· Arg4 = X-rosition for input box 

ArgS = Y -posttion l'or input box 

;\n Ir test is <tddcu so that the cmpty string that indicates the user wants to exit 
tite lo'!r wtllnot be addcd asan item in the list. · 

Kccp this project open. beca use injusta moment you are going to add a Do 
Untilloop. 

1 l. Tesl yo11r cmlc. 

• 
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Do Until 

-

Do Until condition 

statements 

Loop 

-Or-

Do 

statements 

Loop Until condition 

Module 10: Using Conditional Logic and Loops 235 

Do Until is the opposite of Do Whilc. Thc statcrncnts in a Do Until loop are 
executed only while the condition is Falsc. A Oo Until condition is thc eqUivalcnt 
of a Do While Not condition. 

Walk Through-Do Until Example 
L. To use Do Until 

l. From the Walk Throughs program group, stan Do 11111 il. 

This is an cnhanccd vcrsion of thc prcvious Do \V hile cxarnplc. \Vhcn tlle 
application starts, a form with a list box. a comma11ú butt<JII labelcd Aúd Tn List. 
and another command button labeled Clear List appcar. 

The purpose of the application is to add an c.,amplc ol usi11g a Do Until 
structure. 

2. Choose the Add to List button. 

An input box will ;:¡ppcar prompting thc usL'r to ;1dd ;ul ÍlL'Ill [!1 the li ..... t ho.\. 

3. Type sorne text and cl10ose OK. 

The textjust typed into thc text box will be aúúcú as'"' itcm to thc list 011 thc 
Loop Example form. 

4. Repeat the above step severa! times. 

Add scvcral itcms to thc list. 

5. Choose the Clear List button. 

All items will be clcarcd from thc list hox. 

6. Quit the application. 
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----------------I-To·c.rcate·thc-Do-Until-cxamplc-----------------------

1. Start Visual13asic. 

Makc su re tliat you are still working on thc Do \V hile walk through. 

"\ Sl:l the l'ollowing pro[JC11ics rur thc form: 

1 .oop Examplc 

l. Double-click thc command button too! in the Toolbox. 

Creatc anothcr command butlon . 

..J.. Sct tllc fol!owing propt.::rtics of thc comm~mJ bulton: 

Cq1tion 

llciglit 

\Vidll! 

l.clt 

CllHJClcarList 

Clcar List 

l7'> (appmximately} 

121 S (approximately} 

1000 (approximately} 

2:1211 (approximatcly} 

Now tllat you llave crcatcU thc interface, you nccd to udd the code to make it 
fUJlcti:m . 

.". FnHnthc Projcct window, choose Yiew Codc. 

iL In tlie Objcct list box, select cmdCiearList_Ciick. 

7. 1\dcl the following cacle: 

~u Urllil Listl.ListCount O 

l.isrl.RelflfJV"'!tem O 
¡,,,,1, 

A Do Untilloop can be uscd to kecp removing itcms from List 1 un ti\ thc !ist 
box is cmpty. Tlie ListCount propeny keeps track of the nomber of itcms 
currcntly in thc list. 

lnsiJe thc loop is a st;Jtcmcnt to callthc Rcmovcltcm mcthmJ. \Vhcn you pass a 
zcro to Hcmo\'cltcm, you are tclling it LO removc the top itcm in the list. 

Rather than setting up a loop, you can clear an en tire list box with the clcar 
111ctlloJ. 

List! .clear 

X. From the File meno, choose Save File As. 

S ave this file as DOUNTIL.FRM and the project as DOUNTll..MAK in the 
IWALKTHRU\LOGIC subdirectory. Ytiu willneed these files in the For Loop 
la h. 

Enclthe walk throogh. 
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For counter = start To end[ Stepincrement] 

[ statements] 

[ Exit For] 

[ statements] 

Next [ counter] 

For ... Ncxt loops are uscd to cxccutc a blnck of ~t~tcments a fix~d numbcr of times. 
The key difference bctween a For ... Ncxt loop anJ :t Do ... l.oop is th:tl :t For ... Nc.xt 
loop includes a counter tl1at incrcascs or d~creascs \\'itll eacll rcpctition of thc loop. 

Complete the demonstration for on examplc of For ... Ncxt loops. 

Walk Through- Using Visual Basic For ... Next Loops 
I. To use For ... Next loops 

l. Start Visual Basic. 

Opcn Visual Basic. Opcn a ncw forrn. 

2. From the File mcnu, choosc Ncw Pn •ice l. 

3. Double-click thc commanJ bullon tool in thc To<Jihm. 

This will open thc cornmanJ button Codc window. 

4. Add thc fr'lowing ende in tlle Cmk: windm .. ·: 

5. AdJ the appropriatc codc lo llH! Comrn;1nd I_Ciick cwnt: 

Sub Commandl_Click () 
Dim I As Integer 
For I = 1 to 6 

Print I 

Next I 

End Sub 

6. From the Run mcnu, choose Start. 

Test the application you hove crcated. The dcfault v:lluc for Stcp is l. Thc 
application prints thc numhcrs 1 throu~h ó <lll the fonu. 

,, 
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Example 

7. hom the Runmcnu, choose En d. 

X. In thc Codc window, change the Step value to 2. 

'J From thc Run mcnu, choose Start. 

T¡,:st the aprlic1tion aga;n. 

1-iuw has lhe output yo u are gctting dw.nged? 

How would you change thc For. .. Ncxt loop to display only evcn numbers? 

1 \J. ¡:nHnlhi.! Run111t..:nu, choosc End. 

EnJ the w<Jik through. 

A llllll'c Sllphi.-.tic;¡tcJ use \lf tht.! For ... Ncxt loop can be rounU in Visual Basic Hclp. 

·¡.-,,r 

9 

10 .. 

tl~~l Stiltement Example 

1 Ji-~ {'l11 :.(()) • Cl1rS(l0) Define newline. 

For t·k¡J~ :: 5 To l Ste~ -1 Set up five repetitions. 

Equate alphabet to numbers. 

For Indx% = Asc("A") T~ Asc(-Z") 

· Append each letter to string. 

t~sg$ = MsgS + ChrS (Indxl) 

Next.: Indx% 

MsgS = Msg$ + NLS - Add newline for each rep. 
i 1 Next Rep~ 

Msg"Box t.JsgS DispL•Y resul ts, 
l J Ettd Sub 

Nuticl' that onc For .. Ncxt !(.•p is "neste:J" inside the other in this example? This is 
a pow~:rlul tool for processmg multiplc rows or columns in arrays. 

lf you want to scc thi~ code running, fo~':ow the dircctions detailed above and mJke 
thc appropriatc llHHJifications to the codeso thJt it cxccutcs JS thc r~sult of a 
l'lllllllland hutton bcing clickcU. 

'• 
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Walk Through-Another For ... Next Loop Example 
I To use anothcr For ... Ncxt loop 

l. From 1he \Val k Throughs progrom group. stal1 Forl.oop to Clcar List. 

This is an enhanced version of thc previous Do \V hile c."unplc. Whcn thc 
application starts, a form with a list bo:.;, ;¡ cornnwnd huuon liJbelcU AUJ To List. 
and another command button labelcd Clc:u· List appc:or. 

The purpose of 1he application is lo changc the cxample to use a For ... ,'lcxt loop 
10 clear 1he list. 

2. Choóse 1he Add 10 Lis1 button. 

An input box will appear prompting the uscr to aJJ an ítem to the !ist box. · 

3 .. Type sorne 1ex1 and choosc OK. 

The 1extjust 1yped into 1hc IC.\1 box will be addcd as :111 itcm to the list on thc 
loop example form. 

4. Repea1 1he abovc s1cp scvcral times. 

Add sevcral i1cms to thc lis t. 

5. Choose thc Clcar Lis1 button. 

All i1ems will be clcared from tllc list box. 

G. Qui1 1he applica1ion. 

L To crea te thc For ... Ncxt loop cxnmplc 

1. S1ar1 Visual Basic. 

2. From the File menu, choosc Opcn Projcct. 

3. Open DOUNTIL.MAK. 

Open thc projec1 from 1hc Do Until Walk Through. lt i.s locatcd in thc 
\WALKTHRU\LOGIC subdirectory. 

Further Examples 

4. From 1he Project window, choose Vicw Cude. 

5. In thc ~)bjec1 lis1 box, sclcc1 cmdCiearList_Ciick. 

6. Replace the existing code with: 

Dim I As Integer 
For I = OTo Listl.ListCount-1 

Listl.Removeitem O 
Next I 

You can use a For ... Ncxt loop to kccr rcrnoving iteiJlS from l.ist 1 until !he 1 ist 
box is empty. In this case, thc rangc for the loop will he l"rom O (tllt.~ top. _;n in 
1he lis1) 10 ListCouilt-1 (1hc las1 itcrn in tlic list). 

Inside the loop is a s1atemen1 to call thc Hcmovcltcm mctlwJ. Whcn you pass a 
zero to Rcmovcltcm, you are t~.::lling it to r~.::rnuv~.:: tht: top itelll :1 thc list. 

For funher "examples of a For ... Ncx1 loop se e: 

AppiÍl'nlinn 1\'1 ud ul t'/Fo 1'111 1' l't H't'l 1 t 1 rl'l 1 {uul i 1 n: 

E111ploycc O;,twl>asc LM l'IJIJ.l·t<~l l'onn_l.o:ul 
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The GoTo Statement 

Style Guidelines 

Further Examples 

Sub AddEmp ( ) 

:~:Ptr:::It Then GoTo P~ 
P r in t La be l : ~..:::::::::=.~::::::::...---~ 

Print "Hade It ToHere!" 
End Sub 

(;oTo causes cxccution to jump from thc CoTo statcmcnt to anothcr Jucation 
markcJ by a labcl11r linc number. 

-F.venti!Llllg.h the CuTo Sl;"~tcmcnt c.locsn't cnjoy much favor thcsc days, Visuul Basic 
.-.uppolts iL ;u1d thcn; an.: severa] placcs whcrc thcrc is an obviuus use ror it. Error 
h~uHIIing i.-.; a panicular! y gooJ cxamplc. 

Note (;¡,')'os :11t..: 1111\ likl! pnlccUurcs; thcrc is no stanUarJ rcturn fr,<llll aGoTo as 
llll.:n: 1:-. rmm a pmccúurc. 

• F<~L'Il linc lahd lllust bcgin with an alpilabctic charactcr. 

• 1:.:wl1 li11c l:dwl IIHISI cnd with a colorL 

• 1 ·::1d1 lim: lahL·I 1nu."l [l¡; uniquc withín its ow11 moUulc. 

• ¡:,;¡eh linc bhvl ~,·;ul llave no llltlre thau· 40 ch<~ractcrs. 

• 1 Ju 1101 use Visual Uasic keyworcJs in linc Jubcls. 

• Linc labels are not case scnsitive. 

• A linc labclnJust start with thc tirst nonblank charactcr on a linc, but Íl nccd nol 
be in the tirst culumn. Visuall3asic forccs it lo the lcflmost column. 

Examples 

Auuitiunal samplc code is locatcd in Visual Basic Help. 

For further cxamplcs of GaTo stalements see the following. 

Applin1tinn 

ln•••\v,,,k_, 

1.:11 IJllt 'Y l.! e lJatabasl! 

Mudulc/Form 

ll'ONWRKS.IJAS 

U·IPREC.FRM 

Proccdurc/Routinc 

Valid;Jtc_FilcSpcc 

AddEmp 

' ' 



Summary 
• 

' 
• Control Structures 

lf ... Then Blocks 
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Select Case Statements 

Do While Loops 

Do Until Loops 

For ... Next Loops 

GoTo Statements 

Objectives 
In this module you learned to use: 

.• If ... Then ... Eisc blocks 

o Selcct Case statements 

• Do While Joops 

• Do Untilloops 

• For ... Ncxt loops 

• GoTo statements 
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Lab Time 

( i1> ltl tlll' Clllhlllilllldl l~llgic anJ Loups porlion uf your l:.tb nw.nual. 

l. 
1 
! 

·;; 
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I Overview 

• Debugging Terms 

• Debugging Code in Visual Basic 

Using the Call Tree 

Using Watch Variables to Monitor Program Execution 

Overview " 

Visual Basic offers programmcrs of all skill lc,·¡;ls ~~.'>el ~~r nll)lt:-.t tools to use Uuring 
application development. 

Prerequisites 
Prior to starting this module, you sllould airead y be familiar wirll: 

• Controls, forms, and propcrtics 

• Funclion and Sub proccdurcs 

• General and event proccdurcs 

Overall Objective 
The overall objective of this module is to intn1ducc )'llllt,, .'i\Jillt: (\r thc most use fu! 
dcbugging tools availablc in Visual Basic. Tllis i:-. lllll tttiL'tHicd to he C(llltprcllcn:-.ivc 

trcatmcnt of dcbugging tecllniqucs in general. 

Learning Objectives 
At the end of this module, you will be able t<>: 

• Distinguish among run, tlcsign, and tkhu~ 111odc:-. in Vi:-.u:ll ILtsic. 

• Use the Watch window to display thc cttt-rcnt valuc:-. tlr vari~thlcs within a 
program. 

• Set breakpoints within codc. 

• Single step through application rroccdun:s. 
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Debugging Terms 

• Watch Expressions 

• Watch Point Variables 

Wa!ch poinl-break whe'n true 

Wa!ch poinl-break when changed 

• The Debug Window 

The lmmediale pane (?, =) 

Wi!tch pane 

Watch Expressions 
_..;, watch c.xprcssion is a variable whosc value is displayed in thc Debug window 
whclll'\'l'f il rrogram cntcrs break modc. 

Yllu Cilll sct a watcll cxpn.::::.sion by opening the Debug menu und choosing · thc 
AJJ Watch ur EJit Watch command. This can be done in either design moú, "' 
break 1noJc. · 

Watch Point Variables 
,o\ watl'l1 roint variable will cause a program toen ter break mode whenever the 
w¡¡¡cll point cwHJition is sutisficd. 

Yo u c;~n ~ct a watc!l point variable by opening the Debug menu nnd choosing either 
tll~.: Add \V;1tch or Et.lit \Vatch command. This can be done in either design mode or 
ha•;¡h_ IIICI{h,:. 

Watch Point-Break When True 
Tllis \'.:;Jtch point v;,¡riablc will cause a program t9 enter break mode whenever the 
\'ilrit~hk·· s \'aluc beco mes true. 

Watch Point- Break When Changed 
This w;¡tcll poi ni \·ari~1hlc wlll caus.c a program toen ter brcJk modc whcncvcr thc 
vari<~hk':-. value chang~s. 

The Debug Window 
Thc Dchug winJow is broken into two pans: the Immediate pane (the lower half of 
tht• windoll'l :utd lite \V;¡iclt p:u1c (lile uppcr hall). Thc lmmcdi:llc panc is whcrc you 
l·;nJ ha\'l' an intnal·tive convcrsation with rhc dcbuggcr using cithcr thc qucstion 
n1ar~ ¡'!¡ or tlle cqual !::.ign {=). Thc \Vatch panc is wherc the wntch varii.lblcr 
di-.pl<~yL·J Juring break moJe. 
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Debugging-eode-in-Visuai-Basic~----------

lnstant Watch ... 
Edit Watch ... 
Calls 

Single Step 
Procedure Step 

. )' ,, 1' ' ':. ' 

Using the Visual Basic Debugger 

Shirt+F9 
Ctri+W 
Ctri+L 

FB 
Shift+FB 

This module is actually made up ora nurnbL:r or \'.:al k tllrllu):;hs tllat intrmJucc youto 
the various tools availablc within thc Yisualllasic debugger. 

Walk Through-Using the Call Tree 
L To see the first sample application work 

l. From the Walk Through progr<:~m group. st;ul Dchug l. 

2. Click the Cal! Procedures command bunun. 

3. Observe the output generated on thc form. 

1 '1 1 

Start CllllinQ Procedure1 • Comm<!lndl_C1ick 
Thit i1 Procerlure A 
Calling PmcedUie D 

Thit ir Procerlwe B 
Calling Prnr.~oluu~ C 

lhn ut•.,,.:.,.t ... r. e 
neturmroiJ hnrn Prm;r~•hrrr. C 

Aetuming l10m Proceo.Jur11 11 
Aetuu1ing hom Procedr.ne A 

Retu¡ning hom Cnmmo11ndl_Ciod. 

Note thnt Comm:1nd I_Ciick ca lis Pron·d¡¡n·A. Pntt't'dlln·,\ ¡·alls l'flll'l'dlln·H. 

and thcn Proccdurcll calls l'ruccdurcC. 

4. Choose End. 
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L To examine thc codc for thc walk through 

Thc purp11sc uf this walk through is to introduce you to two tools that you willlinJ 
very uscful: thc Call winJow and single stcpping through coJe. 

1. Start Visual llasic. 

1 Opcnthe DEilUG l. MAK file located in IWALKTHRU\DEBUG . 

. 1. Sclcct MOD l.llAS in thc Projcct wimlow and click View Code. 

4. h<~rn thc ProccJurcs cJrop-cJown list b?x, selecl ProcC. 

). E.\alllinc thc cut.le for ProcC. 

As it stancJs, this procecJure prints two statemems at column 49 on your form. 
Thc other thrcc fines are "commcntcd out." 

r,. Rcnwve the thrce comment mark · in front of the Stop and Print statements. 

What will happcn when you cJo tir,;? You ha ve acJcJed thrce new statements lo 
thc application. The first one prints a messagc to thc form at column 40 that te lis 
y<~uthc application is going into break mocJe. The second statement actually 
:-.lops rlwr ;¡pplication using Stop. Tllc tin•ll statcmcnt prints a mcssagc to thc 
l"ullll tll<ll t_LIJ..., yuu tliat yuu llave cntcrcd singll!-stcp muUe uflcr prcssing F~ 
1 \\' ICL'. 

7 hor11 thc f{tnl tllt.:IHI, <.:hoosc Sta11. 

X ('lid.; thc Codl l'nJCcUurcs commanú buuon. 

llyou rnuve tire CocJe wincJow from on top of Fonn 1, you will sec that the out pul 
is slightly clwnged. Now it should look like this. 

= ·. Dellua- Call Uat Exerdae , 

Call froced1..11er 

. 1 

Sldot C•llin<J P1oceduu:• · Com .. •odl_Ciid. 
Thü i1 Procedwe A 
C•lling PlocedUJe B 

Thi1 ¡, P¡ocedu•e B 
C•Uinv P1ocedu1e C 

r hi• ¡, p,oced..,,. e 
Going lnlo S•e•k lolode . 

1J. l-"n11n rile Dchug rncnu, choosc C<Jils. Now you shouiU scc a form like lhis. 

· .. · Calla 

Notice that tire calls are listcd with the most recently called at the top. 
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---------------IO~Glick~the~Showcommand~button:-. ---------------------

This retums you to MOD I.BAS. 

You should scc thc codc for ProcC with ;¡ hox :truund tl!c collc lint..: corHaining 
the Stop statement. 

1 l. Single step by pressing FS once. 

This will start you single stcpping through th~.: rc~t uf thc pnH..:cUurc. This m:1kc~ 
?rint "Going into Single Steó) :-:oc:e·· tllc ncxt statcmcnttn cxccutc. 

lf you pOsition both windows so th:Jt yo u c:1n se e alnH >St al! tlf thcm. y¡JLJ v.:il! sec 
Visual Basic work as you single stcp through thc :.:~pplic:nion. 

12. Press FS one more time. 

This cxecutcs the currcnt Print statcmcnt ami makcs t·r in~_ "P.er.o..::-ni;-;cl ~rn¡r. 
Procedure e· thC next statcmcnt to c:v.:ccutc. 

13. Press FS a third time. 

This exccutcs the currcnt Prinl statcmcnt tcllcck thc output on thc fornl) and 
makcs thc End Sub statement the next statcrncnt tu c.\ccutc. 

14. Press FS a fourth time. 

This executes the End Sub of ProcC and takcs you tu thc ncxt statcmcnt to 
execute in ProcB, which is the Print "Returnir.g fl"'llll PrnceCu:-e 3" 

statement. 

15. From the Deb.ug menu, choose Calls or rrcss CTRL•I.. 

Note the most recent proccdurc is now Pruccuure ll. 

Doing this verifics that thc GJ.I! list has changcJ .-.itKc thc rcturn fmm Pnh..:C 

16. Click the Show command button to return tn Procll. 

17. Press FS a fifth time and then a sixtll time. 

This takes you through thc rcmaining two ProccJurl' H st;HcnH.:nt_s anJ takcs you 
tothenextstatementinProcA-Print ""Returninq from rracedu:· " 

1 R. Prcss FR twicc more. 

This single steps you through thc rcmaining ProccdurL· A .,tatcmctlls aml takcs 
yo u to the next statcment in Comrnand 1_ Clit.:k- ;·¡ 1 ¡,1 ""f, ·1 •1 rn in<: r: "r" 

Commandl_Cl ick •. 

19. Press FS twice more. 

l11is takes you through thc rcmaining thc Ctltt .:1;u1d J C'li\.."k cvcnt procL·durc. 

20. From the Run menu, choosc Break. 

21. From the Debug menu, choose Ca lis. 

N atice that11o calls are listed. That is bcc:tusc no Suh or Function proccdurc ¡_..., 

curren ti y "open" and your application is in iLlle waitill):! for thc uscr ro Jo 
something. 

22. Choose the Clase command bulton on thc Ca lis uial11g hox. 

23. From the File menu of Visual Basic, chousc Exit. 

IJ' you want to try this cxcrcise a sccotld tinte, do not _,;¡ve tilL' clt;nl!!es ltllhL· 
li lr.:s. 



250 Module 11: Debugging Cede in Visual Basic 

Walk Through-Using Watch Variables to Monitor 
Program Execution 
Debugging Applications 
Dcbugging applications is somewherc bctw\!en a scicnce and D.í1 a11. By careful use 
of your Ucbugging tools, sucll as breakpoints, watch variJb!cs. single stepping, and 
proccdu1e stL:pping. you can zcro in on the logical bugs cxisting in your code. 

Tl11s "'"" through applics brcakpoints and watch expressions to locatc a number of 
logical nrors cont;1incU \Vithin thc code. 

L Tu scc lite sccund dcbugging application run 

l. Fn>111 the Walk Through program group, start Dcbug2 . 

.., Click thc l'rint File comrnand button. 

Yt~u gct output that looks likc this. 

111 '" JO 411 511 I ola!'"' 150 Average • 30 

1 l 3 • 5 Total • 165 Average • 16 

1UU 50 25 15 2UO T olal • 615 Avotago • " 
1U 9 9 1 6 rola/ • 655 Average • 32 

11 22 33 .. 55 Total • 920 Average • 32 

o/ alltotala • o 
of al/ totah • o 

·p,lnl'f=¡¡~· 1 1 Cl~~' ·····1 ,.• ~·' '~ 

,, 

This pmgr;nn lists fivc numhcrs, thcir total, nnd thcir average. It docs this f11r 
fi\'l' SCIS of dillil. i\( !ill! l!lltl, it prilllS lhl! tutaJ of tdl t!Jl! llUilllJl!rS anLJ the aVl!f~tgC 
1'1_1r t~ll thc nun1hers. 

·'· 1\ul L"(illllinc tllc output Gtrl!l'u!ly. ll i::.n l giving you what you want: Thc totals 
and ¡¡vcragcs an.:i1't currcct. 

1 r thc application wcre coded corrcctly, final oulpot should loo k something like 
this. 

10 20 30 •o 50 Total • 150 Average • JO 

1 2 3 • 5 Total • 15 Avetage • J 

1UU 50 25 75 200 Total • <50 Avetage • 90 

1U 9 9 1 6 Tolal • <O Avesage • 9 

11 22 JJ " ~~ Total • 165 Average • JJ 

Sum ol all lotah • 920 
vg ol'alllolala • 32 

. IP~i~ Fde(: ;· ~~;,; :;t;;~.;'~.F-;~1 

Yon lll'Cd to corree! thc lo!!iC, hut whcrc U o you hcgin? 

.J. IJPuhlc-click thc Cuntrolmenu on the Debug2 form lo clase lhe application. 
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L To analyzc the variables uscd in thc sample appli<'alion 

l. lfVisual Basic is not running alrcady. '"".' 11. 

2. From the File mcnu, choosc Open Projcct to locllc' '"'d sl:trt DEBUG2.MAK. 
located in \WALKTHRU\DEBUG. 

J. Note that thcrc are two files to this projL'l'1' J)EJlt H i2.1,.f{,\1 <1nd iv10D2.B:\S. 

4. \Vhat are the global-leve! variables. anJ wl1crc thl'y <Jrc loL'<HcLl'? 

If you inspcct the General Dcc!tJrations scction o( :\!C >D2.BAS. you will .'il'L' 

XtSJ. ~n Intcgcr array, and sumcountcr dcclaretl d.'- '''1 lutq . .:er. 

There is al so a String variable callcd Fikn:11nc:> 111 ~11 >IJ2.1lAS. 

5. What are thejorm-level variables. and wilcrc thcy :11\' locatcd'.' 

lfyou inspect the General Declarations scctionnf DUlUG2.FRM, you will find 
Sum declared asan Intcger. But, be carclul hcrc. Vt"t:tlly inspccting lile 
General Declarations section docsn't tcJJ you al/ )'tJLI !lL't.:d to ~now. anJ this wdl t t 

come back to haunt you a linle la ter on. 

\Vhy do you need to know this? Awarcncss uf thc typc:-- illld .\CO[Jt: or !he 
variables within your application will hclp in thc :tnalysis ,,¡·tite ende. 

L To analyzc the proccdurcs uscd in thc samplc application 

l. In DEBUG2.FRM, examine thc cmdPrintl'ilc_Ciiek cvctll pttJccdurc. 

2. \Vhich general procctlurc is ca!lctl in this proceUurc·.1 

lf you said thc Rcadfilc proceLlun: fronl i\1! )j r2.1L·\\ _'¡!!!! \\"l'l"l' Co/TCCI 

3. Examine the ReadFile general proccdurc 111 M01l2/l,\S 

To display the source for tllc Rca<.JFilc gcner;ll pnlLTdllrc. pi<Jl"l.' th~.: cur_-.,ur i11 thl' 

word ReadFile in the cmdPrintFilc_Ciick ptuccdurc :tllll prc" SIIIFr + 1'2 

Note the outer For ... Next loop is controllcd by J. wltcrc:ts tite inner For ... Next 
loop is controlled by I. Thcsc two luops cuntrol p;1rt ¡)f tlle calculation-" in your 
application. 

J • •• 
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L. Tu u~t· hrcakpoints and watch cxprcssions lo observe program lJcha\'ior 

In ordcr to observe the logic flow and l and J's values, wc wil\ use two watch 
c.xpressions anU a breakpoint. 

1. Sct a breakpoint un thc tJext n line. 

Plal:c thc cursor anywhere on the Next n linc and press F9. 

Hi~hlight the 1% variable on the For n line . 

.\. Frornthc Dchug Mcnu, choosc Add \Vatch. 

;\ rmrn will <~ppt!ar on scrccn tilat looks likc this. 

· . . · "' .•. • ···, AddWatch · '"!. 

E_xpreuion: 

r 

Conte<l 

(~ Procet.Jwe 

'? [oom/>4o~ute 
() .Y_IoLal 

\.ll,,lch 1 YPH 

<~ ~alch E~eprenion 

1 Readlile 

I><D02.BAS 

O Break when E11preuion ia Iruo 
() Break whcn Exprcssion has C.hangcd 

1' OK 1 
1· ··cancel.. •; l 

4. ~lakc su re that the valucs for the Add Watch window are as follows. 

Cunlrol Sctting 

Express ion lo/o 

ProL"cJure · Readlile 

F(1rnr/~lodulc MOD2.BAS 

Watch Type \Vatch Expression 

S. Choosc OK. 

' ' 

h. H.cpL'at thc abov\! .stcps ( 1 thorough 5) for J% toe reate a watch cxpression for 
.Jtk. 

Yuu now ha ve two watch expressions. Each time your program entcrs into breJk 
moLle. the currcnt values of these two variables will be displayed at the top of 
thc Dcbug winduw. 
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L To observe your watch exprcssions in action 

l. Start your program by pressing FS. 

2. Arrange the windows so that you can see DEI3UG2.1:RM. the Dcbue winuuw. 
and MOD2.BAS code window. -

You might want to arrangc thcm so that thcy louh: li~L' tllís. 

3. Choose the Print File button. 

Because you ha ve seta breakpoint, your application will stop cxccution on thc 
line Next n. 

4. Note the values of !% and J% in thc Dcbug windtJw. 

Right now they should each be at 1 bcc~wsc you are in thc fir:-.t itcri.ltion nr botll 
Ioops. If you loo k at the output of DEB UG2.H<M. y• "' wí/1 '"" that thc valuc · · 
has been printcd thcrc. 

5. Continue execution by repcatcdly prcssing F5 until p;., L'l¡uals 2 JnJ 1% cqú; .. !ls 5. 

Each time you prcss F5. your application cntcrs break llltH.k cuH..I thc curn:nt 
values of !% and Jo/o are displaycd in thc Watch pane. 

At this point you know that 1% and JS'o are hch<~ving L'OITcctly. lt is time to 
pursue analysis in a diffcrcnt dircction. 

6. From the Run menu; choosc End to stop cxccution of yuur program. 

7. Press F9 to clear your breakpoint on thc OJext n line. 

The Next n line in the RcadfJic proccuurc uf MOUc.llAS should alrcady be 
selected; so press F9. 

To this point, you ha ve seen what wc wantcd to dcrnonstr;He Jb11Ut watch point~ anJ 
watch expressions. If that is all you need from this cxercí,e, thcn quit here. lf. 
however, you want to sharpen your dcbugging ski lis. continuc on with thc cxercisc. 

The question hcre is this: What is going wrong with tlw :q>plic:ttíon° First, it doesn"t 
sccm to be calculaling thc individual totals propnly. Yotl arl' l·nding ur with a 
valuc of 165 for tite SCCOIH.Í SCl of llll1llllCI'S v.l!it:ll it :-h1ndd he l . .:.. \Vhy dun't you 
ncxt sct a watch point on TotJI"/o? 

" 
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L To use wntch points-brcak whcn cxprcssion has chan¡;cd (Total%) 

l. In 1hc Cmle winuow for MOD2.BAS, locate the procedure Readfile and 
hi~hliglllthc variable Total% willlin the For.l% loop. 

' Fr~nnthc Debug rnenu, choose Add \Vatch. 

_,_ M<~kc su re that all the controls for the watch point are as follows. 

Cuntrol 

l:,,¡ncs .... ion 

Pt t H.:cdurc 

h ll'ttt/¡\ Ir Jt.lul e 

Sctting 

Total% 

Readtile 

MOD2.BAS 

I3rc<Jk whcn Exprcsston has Chungcd 

.. ¡_ ('h!H>_"l' OK 11.1 e lose tl1C AJU window. 

I To oltscn·c your watch variable in action 

l. h·orn tllc Run-mcnu, choose Stan to run your program. 

' 

N111c thc cntry <~ddcd 10 the top of the Debug window. This will cause the 
pro.!-!r<llll toen ter into brc<tk moJe whcncvcr Total% cllangc.s. 

Yon ntay nccd to cxpanU thc \Vatch pane display ¡trca in ordcr to scc thc 
;tdditional wah.:h variable. 

Click the P[int File command buuon 10 en ter the Readfile procedure. 

.1. \Vh;¡t is the first va fue for Total%? 

lf you saiU 10. you were correct. 

~- Prcss F5 six more times (so that 1% equals 1 and J% equals 2) . 

. ~. Nt1w, w!wt is tllc valuc ofTotal%? 

lf yt 111 saiJ 151. you wcrc corrcct: but what should thc valuc ofTotal% be Jt this 
poi111. ~UJJ whul does that tel! you? 

Tlic v<~luc for Total% atthis point should be 1, bccause that is thc first value for 
thc sccond pass tl1rough thc J% loop. Whatthis tells y<) · is that you need to reset 
the va fue of Total% befo re each entry into the 1% loop. 

Cl. Frolll thc Run mcnu, choose End. 

7. Auu the following fine just before the For n 1 to s line: 

Total% = O 



,. 
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8. Test your change by running thc codc ag;1in. Notice 1J1at tllc tot;ll i., corrcct. 

You will notice that the avcragcs for thc I~Jst fnur :.;cts ~~r numhcrs Jw.vc thc 
·values 1, 30, 2, and 6. That is, thcy are still wrong. '~'•• t'ix t/iis problcm. wllat 
other variable must you zcro out befo re rccntering thl' 10(. ltlop'? 

If you said counter%, you wcrc corree t. 

0. From the Run menu. choosc EncJ. 

10. Add the following linejust befare t/ic Foc n i 1.' e, Jinc: 

Counter\ = O 

11. Test by running the program again. 

12. lnspect the Total and Average for cach ot' thc livc scts ot' Jat<L 

Total and Average for each set of numbers shouiJ now be correct. Compare 
them with the correct output displaycd carlicr in tliis walk tllrough. 

13. Inspect the values displayed for the overall·sum and average values. 

They are both O. That can't be right. 

. 14. From the Run menu, choose End. 

L To clcnr all wa!ch v~rinblcs nnd all brcakpoints 

l. From the Debug menu, choosc Edit Watcli. 

2. Choose Delete All to delcte all watch points you m ay ha ve sct. 

3. Choose Clase toe lose the Edit Watcli uialog box. 

4. From the Debug mcnu, choosc C!car A lit~• clcar ;di hrc;1kpoints that are sct. 

I To use wntch poinls-brcak wllcu exprt·ssiou htTt~nu·s Tnn· (SIInll 

At this point you ha ve nxcd tlle c<.~!cui;¡{ÍIJII or indi\'Ídliid (111;11 .... ani.l avcragcs. hui 
the calculation of lhe overall total and av~ragc is still wron~. For this re;.~snn. 
closer examination of the Su m variable is w;1rr~mled. 

l. From the Debug mcnu, choosc Aud Watcli. 

2. Fill in the following cntries: 

Expression Su m> O 

Form!Mod DEBUG2.FRM 

Procedure cmdCienr_Ciick 

Break when Expression is Truc 

Choose OK 

3. From the Run menu, choose Start. 

4. Note the cntry nddcd to the top ofthc Dch11~ wind'"''· 

This will cause thc progr;un to cntcr intol)¡cak llll)tk whcncva Sun1 >O 

becomes True. 
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I To ohscr\'C )'Our watch YarialJic in action 

l. i'rL'."~ tlw Print File command button to run thc program. 

Did ynu cvl.!r en ter Break mode? 

Your prograrn should not ha ve entered break mode because the variable Su m 
waS ncvcr grcatcr than O . 

. 1. ¡:nnn thc Runmcnu. clwnsc Break. Not; :3 in thc dcbug window it spccifies Su m 
<Not in Context>. This rs because Sum '"a local variable and you are not 
curn:ntly rtlllning the proccdurc that conlains Su m. 

·-L Fn1111 the Run rncnu. choosc End. 

L. To lix thl' t:odc-using del>ugging amllogical analysis to corrccl thc codc 

l. Firq of all, llow many variables naml.:J Su m are in this application? 

Remembcr at the start of this walk through that we asked that question and said 
th<1t thcrc was nnly one. Wcll, there are really two. If you said two, you werc t t 

t.:tliTCC\. 

·, l.ook in tire General Declarations section ofDEBUG2.FRM. Notice that it 
wntains an e.,plicitly declaredform-level integer variable called Su m. This 
vari;1blc is rwt availablc outside this form . 

. 1. Now look at tire coJc in MOD2.BAS. ls the variable calleJ Su m there, thc sume 
one as in DEI.lUG2.FRM? No, lhis is un implicit variable local lo thc Sull 
pn •cedure Rcadfilc. This is the so urce of your problem. 

How can yo u make sure thatthe variable called Sum in cmdPrintFile in 
DEI.lUG2.FRM and the one referred to in Readfile are the same? 

11 :·''u said dekrc thc local variable dcclaration aml rnakc it Glob~.ll. you wcrc 
ri~ht . . 

4. IJclcte tire Jccl<>ration in DEBUG2.FRM. 

'i. t\dtl thc following Jcclarationto MODULE2.1JAS: 

(j 1· •h,ll Sum As Int.eger 

L To lcsl your scoping changcs 

l. Run the prograrn again. 

Alter making these changes, you'l\ discover thatthe su m of alltotals is 2025 and 
<rvcrage ol all tolals is SI. They're still not right . 

.., Ch( "1se En U from thc Run menu. 
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~--------------,-- 3.-Set.the.breakpointon-Next-I%-and-thc-watch·expres.si••lls·••ll·ISb-anu-J<k-in·the------
Readfile procedure. (Follow the guidclines outlincu earlicr i11 the walk throu!'IL 

1 

if you need to.) 

I To single stcp through your program 

1. From the Run menu, choose Start. 

2. Click the Print File command button. 

The next line of code to be exccutcd shoulu he ""''e , •. 

3. Now, query for the current valuc of Su m hy placin~ y~)ur l'ur~or in the Debut: 
window and typing: 

?Su m 

Thcn prcss thc ENTER kcy. 

4. Observe that the value 10 displaycd inthe lmmedi;Jt~ pan~ ,¡f tllc Dcbug 
window. That's the currcnt valuc of Su m. 

5. Stcp through thc 1% loop agJin. slOpping ~H the salllL' point a~ hcforc. anJ qucry 
the value of Sum. 

6. Observe that the value 40 is disp!Jycd. Howevcr. lO+ 2t' · 't:s not cqual 40. 

What's the problem? 

lf you said the line: suml Total ... sum needs to he ttwvcJ hclow the linc: :;-::..-:r. 

n, you're correct. 

7. Cut and paste the line sum% Total .. sum to just bclow r¡,~ ... :L n. 

I To test your logic changcs 

l. Start and test thc application again to sce if it's working pn1pL:rly now. 

2. Compare your output with the desired li11almnrut ,¡""''" helow. 

10 20 30 40 50 Total • 150 Average ... JO 

1 2 3 4 5 Total= 15 Average = J 

100 50 25 75 200 Total= 450 Average :::: go 

10 9 8 7 6 Total= 40 Average = 8 

11 22 33 44 55 Total= 165 Average = JJ 

um ol all total• = 820 
ol all totat. a 32 

1 "'"'2r~·- · ·-·.·-:·:·:cu 1 '"''t.~Prrnt;File¡ .. ~:., 
1 

Clear 

3. Closc lhc applicatiun anJ givc yoursdf a p111 on llll' h;Lt·~. 
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Summary 

• Debugging Terms 

• Debugging Code in Visual Basic 

Usirig the Call Tree 

Using Watch Variables to Monitor Program Execution 

Objectives 
In llli.'- 111utlull' )'IIIJ k:arnc.:U to: 

• 1 )i;-..t i11guish anwng run. Ucsign, and Jcbug moJes in Visual Basic. 

• U:-...: the \Vatch window lO display thc currcnt valucs of vari;,.¡blcs within a 
pn1gram. 

• Sct hreakpoints within code. 

• Single stcp through application procedures. 
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Module 12: Printing 10 Forms and Printers 

I Overview 

• Scenario 

• Methods for Printing 

• Print-Related Functions 

• Using PrintForm 

Overview 
Printing to forms and printcrs can be as complicHeU ur a., .'>implc as you want t11 

make it. This module shows you somc of thc simple tri~..·~.., tlwt ytlU can us1.: tu 
prepare tcxt for printing. 

Prerequisites 
To succeedin the module, you should airead y be fa111ili:~r with: 

• The general syntax for mcthods. 

• Selcct Case statements and ILThcn ... Eisc block>. 

Overall Objectives. 

261 

1l1e purpose ofthis module is to givc you an intrm.luctionto printing using Visual 
Basic. This module is split into two topics: printing \ll" lúnn and .... ¡_:ndin!! 1hat l"onn 
toa printer. 

Learning Objectives 
At the end of this module, you will be ablc to: 

• Use the Print method to create output dircctly onto" lúrrn. 

• Describe how thc AutoRcdraw propcrty n:I;I(CS (11 prillting dirt.:ctly lo ti runn. 

o Use the CurrentX and CurrentY propenics of a for111 '"'d tllc S pe ond Tah 
functions to controlthc placcmcnt of output printl!d lo ;1 funn. 

• Use thc Cls mcthod toe Icor o form. 

• U:-;c tlic PrlutForm llli.!tlwd to sl!nJ ;lllit-rtlr-hi! lllla)..!t' 111" ;1 !tll"lnlu thL· pri11lL'r. 
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Scenario 

• Printing a Form 

' ' The specifieation for the Ernployee Database requires that users be able to print out .. 
an indi\'idual cmrluyee's pcrsonnel information. 

Individual Reports 
Y !tU h;1vt: dl!tcrlllincd that uscrs want thc individual rcport lo includc thc fo!towing 
infPnllt~lion on individuallines: 

l. l.<l>d n<~lllC, first namc, ami middle initial 

., Elt.:L·trunic 1nail alias ami depurtment coJe 

3. l'u:-.ition tyjx: 

.t. /Jetluctillll inf¡Jf'lllalion 

:\. bnploycc plmtu ccntercd at the bottorn of the page 

..-\ftcr llluch work, you ha ve dctcrmined that a workablc individual report form 
would luok likc this. 

Ernployee Record Details 

Employee: Richardson, Barbara, J. 

Email: barbarar 

Category: Full time 

Deduct: ESPP 

X 

Dept: SAL 

40l(k) United Way 

X 

~·=·· D=-==J 
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Methods for Printing 

Syntax 

Sub Form_Click () 
Dim I As Integer 
For I = 1 to 6 

Print I 
Next r 

End Sub 

Overview 

2 
3 
4 
5 
6 

There are a numbcr of diffcrent methmls. functions. and pro¡x~rties you will need lo 
understand in arder to print toa form rtnd then send that (111"111 [1\ 11 rrinter. 

Mcthods Functions 1' ro l'l' rt ics 

Print S pe Cunt·ntX 

Cls Tab Curren! Y 

PrintForm Formal AutnRctlraw. 

FoiH .... it.e. anJ !'O nn 

The Printer Object 
The Printer object is a prcdefincd object in Visual B~1~il· You L"llll scnJ outru1 111 till' 

Printer object using the Print mcthod. \VIlen ynu are fini .... hcJ placing infmmation 
on thc Printerobjcct. you use thc EndDoc llH:IIIOd lo ,'>;l'lllllllc (l\llput (1• :llL' rrinll'l" 

The output will print on your dcfault printcr. 
Printer.Print 

Printer.NewPage 

Printer. Print 

Printer.EndDoc 

The Print Method 

"Here is som~ in~rJrmati1.:, .. ;· f',"l': c.nt'! 

'This causes a ¡onge '::Jtc,<,k 
"Here is sorr.e mnre ~n!•,:;,,.,, ir,n" 

'This sends the o•Jtpuc L•, Lne ptJnter. 

Thc Print mcthod is uscd to puta lCXl string on a (onu. ¡¡ pictlll'l: box, or Printcr 
object using the current color nnd font. This p11rtion 11f tlil' mmluk will Lli:-.~.:uss thc 
Print method by first talking about it in general aml thcn discussing thc 
irnplications of printing toa form and printing toa pi~.:ttllt' ho.x. 

r n!Jjrcr.]Print r rxprr.uionlisr H 1,:1. 1 1 

Tl!c tJbjct..:t can be cithcr a funn, a pit:turc, 111" a 111 inlcr ¡,. wltit·li lile c.\Jli'L'.'-:•<~Pn 1!_,¡ 

will be printed. • 
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Example 

The cxprcssion list is either tcxt or numbers that you want to print. Multiplc 
cxprcssions con be sepnrated with a semicolon, a comma, ora space. lf the 
exprcssion list is omitted, Visual Basic prims a blank line. 

The ~cJnicolon <.uH..l thc comma- are used to spccify the Jocation of the text cursor for 
tlll! next charactcr Uisplaycd. A semicolon means the cursor is pbccd immediately 
;llú:r lhL· last char~Jctcr displaycd. Thc comrna mcans the cursor is p!Jccd at thc sta1t 
~~r thc IH:xl print Lonc. Print zoncs begin every 14 columns. 

Note ,\ J"orm docs not nccc.J to ha ve thc Visible property sct to Truc to be ablc to 
.'-L'Ild Ollljllll !O Íl. 

Walk Through-Printing with For ... Next Loops 

L. To priul with For ... Ncxt loops 

l. l·~tnnthe Wiilk Throughs program group, stnrt Fancy Print. 

' Cl ick the ronn. 

Thi.> displays the output from the codc contnined on the next page. 

3. Fr11111 thc Contrulmenu, choose Clase. 

The lollow1ng cxample is available in Visual Basic Help. 

1 

2 

., 
'• 

¡ D 

11 

i·i 

; ·, 
¡; 

l 7 

18 

19 

::o 
2i 

.:j 
14 

2S 

;:1) 

'l't irlC MeLl1od Example 

Sub PrintOemo () 

Const 

Const 

Const 

Cls 

I3LUE = 1 

MAGENTA = 5 
8HIGHTWHITE = 15 

':! i r]t_h = noo 
flei.ghl = 5000 

l!~~kColor = QBColor(BLUEJ 

For n = 1 To J 

:;r: 1 •:t·t CitSt..! l ~ 

(US~ l 

Clear form. 
Set form width. 

Set form height. 

Set background color. 

' First time. 

'Set foreground color. 

ForeColor = QBColor(MAGENTA) 

y, l. = 1 : L l = 9 : M\ = 1 

!1sgS 

o: = 
Cuse 2 

"' = 
l1sgS 

ex = 
Case J 

"Visual" 

o 

1: L% = 9' 

= "Basic" 

ScaleWidth 

"' 1 

Set message." 

Set position variable. 

Second time. 

' Third time. 
ForcColor = QBColor(BRIGHTWHITEJ 

K1 = 9: L\ = 1: M\ = -1 

MsgS = "Visual Basic· 
ex = ScaleWidth 1 2 

End Se lect 
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Further Examples 
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28 
29 
JO 
Jl 
32 

Jl 
J4 

JS 
]6 

]7 

38 

39 

40 

41 

42 

4] 

44 

45 

46 

47 
48 
49 

so 
51 

For J% = K% To L% Step 

Select. Case J% 
Case L Fontsiz<:! 

Case 2' Fontsize 

Case J ' Fontsize 

Case 4' Fontsize 
Case S' Fontsize 
Case 6' Fontsize 
Case 7' F'ontsize 
Case ., Fontsize 
Case 9' F'ontsize 

End Select 

I f I\ = 1 Then 

Of Ese::.\ = O 

Elseif Il = 2 Then 

~a 

a 
11] 

12 

1 4 

:2 

JO 
2·t 

]6 

43 

Offset\ = TextWidthiMs~SJ 
El se 

Text in center. 

Offset% 

End If 
CurrentX 
Print MsgS 

ex - Offset% 

Next J\ 

Curren t. Y o 
52 Next n 

53 End Sub 

1'•-:.•1 n:1 ~io¡hl. 

' Reset Lo to¡1 of ~o~m. 

For further examples using lhe Print methoJ, sce lhe following. 

Applic•tion 

kon\Vorks 

Employee Dawbose 

Fnrm 

ICONEDIT.FRM 

ICONEDIT.FRM 

VJEIVJCON.f'RM 

VJEIV!CON.FRM 

EMPREC.FRM 

l'rol'cdurl' 

Display;\ 1 oLL.o.;cCoordinatcs 

J•ic_SI ,.,,,,,,\ rr:•_J•:• i 11 t 

1 ,o a d _ :\ 1/ _ _lrun.s 

l'ic_Scltlll'dh.:oni.:Jhd Pnint 

cm dA dd 1 k/ ctcUpda te_ Clkk 

265 
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I Print-Related Functions 

• Spc Function 

• Tab Function 
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Spc Function 

Syntax 

Example 

Further Examples 

Sub Form_Click () 
FontName = "Hel v" 
FontSize = 12 
Print "Skip 1 space and print a": '.:pe ( 1\ "l" 
Print "Skip 2 spaces and print a" 
Print 3 
Print 4 
Print 5 space ond print a 

'<LJ"'-" Skrp 2 spaces and print a 
Skip 3 spaces and prinl a 

Print 
End Sub 

1~~~~~~~~~ Skip 4 spaces and prrnl a 
~ Skip 5 spaces ;md print a 

Skip 6 spaces and prrnt a 

1 
2 

3 
4 

5 
6 

This function inscrts a specified number of bl;tnk ch;tr;¡~,·¡crs in <t Print metlwJ. 
starting at the curren! print position. 

Spc(numbero/o) 

Thc nwllber argumcnt must be an intcgcr bet\vccn O ;u1d .\'2.7(17 inclusive. 

Importan! When using Fixed pitch fonts (whcrc thc sp;rs·c ;rllowcu for cach 
character is the same size), S pe is not complicatcd to use: hut with a proporlionally 
spaced font (such as Times New Roman®), the width of llll' ..... p;tce is a!way.-.; the 
average width of all characters in ;::e point size of that f,Jtlt. 

1 

.2 

3 

'Spc runction Example 
Sub Form_Click {) 

FontName = ~courier~ 
4 Print r) .. 

5 Print ~12345678!J0123456789012J.1<.Jf,'/H'J!J 1 ::)·1 ,,, 1•1'"\ 1.: ¡.;•, •. /1-!'J(J · 

6 

7 

Print ~I'll skip some spaces ther. pr1:1l ó:1 

End Sub 

spc i .' J; .. ;.o ... 

For other examp!cs using lile S pe funclion .. "L't.: thc: foil m~ in~. 

Application Fnrm l'l"lllTIIIII'l: 

Employec Databusc EMI'REC.J-1<~1 cnuiAdd l'l'intUpdatc_ Clkk 
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Tab Function 

Syntax 

FontName = "Hel v" 
FontSize = 12 
Print "Tab to"; 
Print "Tab to"; 
Print "Tab 

End Sub 

111 o 11 

20 
30 

The Tah IUnction llHl\'CS thc text cursor toa specified print position when used wFlh 
th'e Priut 111cthoJ. .· 

Tah( t·r ,¡ 1111111%) 

Thc para meter cu/umn% is an Intcgcr expression that is the column number of the -. 
ncw print positiun. The Jeftmost print position on an output line is aiways l. 

For fnnns. thc only limit to the rightmost print position is thc rangc ofthc lntcgcr 
dat;1 typL:. 

l'm a complete ucscription of the Tab function. sce Visual Basic Help. 

•.' 
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Using PrintForm 

Syntax 

Example 

Further Examples 

[form.]PrintForm 

PrintForm 
Once you ha ve finishctl formatting al! the uutpul to ;¡ ftll'lll, ytlll L'itn use thl' 
PrintForm method to senda bit-by-bit im;1ge 111" thc ftlnlllo a prirncr. 

[form.] PrintForm 

This example is available in Visual Basic HL'Ip. Ir your lll<lchinc is corrcctly 
connected toa printer, this codc will scnd the currerll fonn to it. 

2 
) 

4 

'PrintForm Method Example 

Sub PrintFormDemo {) 

On Error GaTo ErrorHandler 
Print!"orm. 

S Exit Sub 

6 Er~orHandler: 

.:;._,;_ '•1' ~-::r"' hanc.il'O'.:

?~·ir;r foém. 

7 MsgS = "The form could not be pnnto::ci. 

8 MsgBox MSg$ 

9 Resume Next 
lO End Sub 

Application Form Pron·d u re 

Employee Dntabnse EMPREC.FR~I l:lllll:\ dd Pri 111 U pda le_ Clkk 

Remember, tl1e Print mcthod is uscd to pl;tt:t: tllt: d;¡t;t tHI th~ fnrrn. Tlw Pri11tFnnn 
method is uscd to scnd a bit-by-bit imag~ o!" rile fonnto iltL' dcl"ault printcr. 

You should set the AutoRedraw proper1y ol" a fnrlllto Trttt' if ytlll will print it usin~ 
the PrintForm mcthod. If AutoRcdraW is rHil Truc. ~r;tpllics drawn Jirc(tly un !111.: 
form using Print. Linc, Circlc <tnd othcr gr;tpllic sLtll:ttll'lliS willnut appctr tllllhl' 

printcr. 
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-----------------------------------
Walk Through- Effects of AutoRedraw 

I. To stT lhe ciTctt.s of sctting thc AutoRcdraw Propcrty 

l. r,,,, thc \Val k Throughs program group. start PrintForm & AutoRedraw. 

Click the Draw command button. 

Thi." llr;¡w:; lincs on the form . 

.\. h·tllll thc AultJ!\edraw mcnu notice that AutoRcdraw is set to False. 

-+. IJr;1¡; thc rninimized Program Manager icon onto the form and then move it 
tLWil)'. 

Nt1tice t!lc ronn now has a gap where the Program Manager icon erased thc 
linL"."· Thc lincs are not rcdrawn. Ifyou had printed this form using thc 
PrintFonu rttc!IHJLl, thc !inc-s wou!U not appi..!<lr . 

. ".. hllttlthc Au11d\t.:draw lllcnu clwosc Truc lo sct AutoRcdraw to Truc. 

Tlw l'tl\1¡_; Íll lili:-. lllCJlll selection invokcs the Draw bui\oll ror you. 

11. 1 l1;1~ lhc.nlillirnit.cU l'rogram Manager icon unto thc furm anU tlwn movc it 
;1\\";1\". 

¡'J,,tin: !he r,•nn autorn;1tically rcUraws the Jincs il" ncccssary. Ifyou hac.l printcc.l 
ll1i.\ i"orrnusi11g thl! PriutFormmcthod. thc lines would nppcar. t t 
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Summary 

• Scenario 

• Methods for Printing 

• P rint-Related Functions 

• Using Prin!Form 

Objectives 
In this module you learncd to: 

· ·• Use the Print method ~,, creatc output JirL'ctly onh, ;, r'11nn. 

• Describe how the AutoRedraw propcrty rL'!;ttL's to pri11lill,t! Jin.:ctly toa form. 

• Use the CurrentX and CurrentY propcnicsor a fonn a11u thc S pe a11u Tah 
functions to control the placement of out pul printcJ 1<> a fonn. 

• Use the Cls method to clear a form. 

• Use the PrintForm method to senda bit-for-bit illlil~t· 1Jf a form tn tllt' rrintL'I'. 
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Lab Time 

( iu 111 thL· CiLt1i11~ ( )utput portion of your Jab manu; .. il. 
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I Overview 

• Overview of a Database 

• How.Does Visual Basic Access Databases? 

• The Data Control 

• Binding Controls lo !he Data Control 

• Data Control Walkthru 

• Data Control Methods and Properties 

--------------------------------,,, 

Objectives 
At the end of this module, you will be able to: 

• Describe how Visual Basic acccsscs data bases. 

• Use the data control to view the contents of a Microsoft AcccsS® dala base. 

/ 
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Overview of a Data base 

Employee ID ul· 1 Order ID ll ....., Customer ID 
Las! Name ll J Customer ID~ Company Name 
First Name · - !>fmployee ID ~ Contact Name 

. ~ . . . - . 

. ~ ' ' ' . l . . 
i : -~-·~""'~-.-..... l-;:. . . . . 

Employees Orders Customers 

NWIND.MDB 

Overview of a Database 
The lollo~ing inlürmation will hclp you undcrsland somc of thc tcrrninology and 
conccpts associatcd wilh dalabase slructure and design. 

Relational Databa se Objects 
Visual 13asic provides a reiarionai interface lo database files. Basically, a relalional 
Jatabase is one that stores data of rabies, madc up of coiwmts and rows. In Visual 
Basic. columns are referred to asficids and rows are rcferred lo as records. 

Tables 
A rabie is a logical grouping of related information. For example, the Nonhwind 
Trauers database has atable that lists al! the employees and another table that lisis 
allthe cuslomers. 
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Overview of aTable·-------------~ 

Example 

Rows 
(records) 

Fields 

Employees Table 

Employee ID Last Name 

135 Leverling 

284 Buch¿¡.-,an 
1 

·~ .. ~·..:;;¡..:.,.·~~-"~o..:--.... "·-- ~· •.. . -.v, 

,... 
Cofumns (lields) 

Firsl Na me 

Ti m 
' 

B.L. 
; 

>-,,· .•. < •• :;.· 

Each column or field in a rabie conrains a single rice e of informarion. For example. 
the Employees lable has fields for Employcc ID. La.q N<llllC, and so forth. 

Records 
A row or record in atable contains information about u single cntry in a tab!e. For 
example, a record in lhe Employecs rabie would ha ve informarion on a particular 
employee, Generally, you do nófwan11wo rccords in a rabie 10 ha ve rhc cxacl same 
data. You would not want to ha ve two Employccs with the samc namc and thc samc 
ID number. Most tables ha ve a field or combinarion of ficlds rhut rnust be unique. 

Indexes 
To rnake access to the database fastcr, mosr uatabascs use indc.rc.1. Data bu se tablc 
indexes are sorted lisis that are faster to search rhun thc rabies. 

Structure Query Language (SOL} 
Once the data is stored in thc databasc, retrieving it is nwt.Jc.:: casic.:r by using an 
English-like language called Structured Qucry Lan¡;uag<'. or SQL. SQL has 
evo! ved into the most widely acceptcd mcans to "conver:•.c.::" with a c.Jataba.sc. Thc 
user submits a query and the databasc returns :di thc rows that match that query. 

Select [Last Namej, Title From Employees \'lhere Ti tle = ·Sales Rep' 

Sample Databases 
[n this course you will thc Northwind Tradcrs ""nplc dar abase. Tllis databa se is 
included with Microsoft Acccss. 

.·' 
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How Does Visual Basic Access Databases? 

ODBC 
SOL 

Dtiver 

SOL ORACLE 
DB DB 

Visual Basic 

Other 
ODBC 
Drivers 

Other 
ISAM 

Drivers 

How Does Visual Basic Access Databases? 

M'iciOso!t 
Acces.s 
~ 

. Therc u re threc typcs of databases that yo u can access from Visual Basic: 

• "Nativc" Microsoft Access databases. Thcse databascs are acccssed directly 
by Visual 13usic. 

• lndexed sequential access method (ISAM) databases-for example dBASE, 
Paradox®, and Btrieve® databases. Visuall3asic reaches these databases 
through uscr-installable drivers thatlink Visuai-Basic to the specific 
Uatabascs. 

• Opcn Dalabasc Conncctivity (ODBC)-accessiblc databases. Thcse include 
clicnt-scrvcr databasc managemcnt systems (DI3MSs), such as Microsoft 
SQL Servcr and ORACLE®. Visual Basic rcaches these databases through 
lhc appropriatc ODBC drivers. 

Thcrc are various gatcways that are nvailablc to conncct toa mainframc datJbasc. 
This is typically implcmcntcd through an ODBC driver. 
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The Data Control 

Move Previous 
Move First 

Last 

Move Next 

--------------------------------~------------------------------------------,, 

Data Control 
The data control allows you to link a Yisu'il IJasic form toa úatabasc. With the Jata 
control, you can create an applicationthat displays anu upuatcs Jata from 11 

database-without writing a single linc of cnLk! 

Adding the Data Control to the Toolbox 
If thc data control is not visible in tllc Toolbo.x, adll tllc !"ullowing linr.:: eH thc cn<.l of 
the [Visual Basic] scction in the YB.INI file in thc C:IWINDOWS úircctory: 

DataAccess=l 

The DatabaseName Property 
The data control locates the database through the DatabascNamc propcrty. lf you 
are connecting toa dBASE, Paradox. or Btricvc. Uatah;.¡sc, sct thc D<ltabaseNamc 
property to the directory that contains the Jata base lib. 

Datal.OatabaseName = •c:\walkthru\nwind.mdb" 

The RecordSource Property 
The RecordSource property indicares thc na me of a tahk'. qucry or it contains thc 
tcxt of an SQL string. 

The following example connccts the data control to thc Employecs tablc: 

Datal.Recordsource = "Employees• 

Tllc following cxn111plc rclricvcs a suh~ct of lile F.lnployt·t·s 1;1hlt·. 

Datal.RecordSource = •select • from Employecs ..... ¡¡.,,'"! !L<lSt ilameJ > ·¡.¡· 
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Joining Two Tables 
Thc lúiiPwint! t.:Xittnph.: joins two tablcs. Thc brackcts an:: usct.l with liciUs lhat ha ve 
a spaü' in thc nalll\.!. 

Ordering the Records 

"Select customers. [Customer Id], 

A(Contact. Name). {Order Id) 

Afrom Customers, Orders 
AWhere Customers. {Customer Id] 

AOrders. {Customer Id]· 

Thc following cxample selects only sorne of the fields in the Employces tablc and 
ortlers the rccortls by last name: 

11aLill.fi"'''JrdSollrce = "Selecc (First. Name], (Last. Name\ from 

AEmployees Order by (Last Name]" 



' ' 
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Binding Controls to the Data Control 

Example 

Binding Controls to the Data Control 
The text, picture, image, check box, maskcd cuit, 3D panel, and 3D check box 
controls can be bound to a data control. Whcn a control is bounu to a da tu control, 
the data from the databasc is automatically displaycd in tllc bound comrol. In 
addition, ifthe userchangcs the data in thc bouod contml. tlwsc cllangcs ¡¡re 
automatically postcd to tllc databasc as ll1c u ser llHJ\'~.'> !o <nwtllcr row. 

To bind a control toa data control, sct tilc O;u¡¡Sourcc propcny to thc daw control 
namc and sct the DataFicld propcrty toa I"!cld '"""e frorn tllc lhila control's table. 

'The OataSource property muat be set at design time 

Textl.Da~asource =Data! 

'The Oac.afield property can be set at clesivn ur r•JIL L.irn•; 

Textl.DataField = ~ {Last Namel" 
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Data Control Walkthrough 

Las! Name: L__ __ _j 

First fJame: L__ __ _j 

' ' 
Data Control Walkthrough 
To gct a yuick ovcrview of the data control, let's create a simple application that 
connccts to the Microsoft Access Northwind database and browses the Employees 
table: 

l. Start with a ncw projcct and add the data control to the form; !cave the :~dault 
name Data l. 

2. Sct the folluwing propcnics for Data!: 

DatabaseNamc = c:\walkthru\nwind.mdb 
RccordSource = Employees 

Note When you set thc DatabaseName at design time, Visual Basic attempts to 
connect tu the datubase. lf it successfully connects to the database, it will display a 
list uf possible valucs for the RecordSource property. Notice when you set the 
RecordSource pruperty, you can type data in directly or choose the DOWN ARROW to 
display a list of possible selections. 

:1. Adu two text boxes to the form; lea ve the names Textl and Text2. 

4. ?etthe following properties forTextl: · 

DataSourcc = Data 1 
D<~l<lFickl = Last Nam~.: 

5. Sctthe following properties for Text2: 

DataSource = Data 1 
DataField = First N ame 

(¡. l<un yuur applicatiun! 

( co11fin11eJ 011 júllo~t.-·ing page) 
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7. Click the right arrow button to move forwarJ. left arrow buttnn to move 
backward. 

8. Change a·last name, click the right arrow buttonltl movc forward, anc..J thcn die!\ 
the left arrow button to move back. Tl1e record should he uptlated. 

9. Notice you ha ve not written a single linc of codc! 
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Data Control Methods and Properties 

• Refresh Method 

• Connect 

• Exclusive 

• ReadOnly 

Refresh Method 
The u ata control retlects modiflcotions to existing dato by other users but does not 
rellect recnrds delcted or added by other users. The Refresh method updates the 
Jat<.J control with thc latcst information from the'database. 

Datal.P.efresh 

Connect Property 
The Conncct propcny indicates the typc of database that will be opened. The 
Conncctprnpcrly unes not nccd to be set ifyou are connccting toa Microsoft 
Accc.-;s data base. 

diJ,\SI' 

Btric,·c 

ODBC 

Exclusive Property 

Datab01sc na me 

uri vc:lpathlllle. mub 

uri vc:lpathl 

Jrivc:\po.llh\ 

Jrivc;\path\ 

RcgistcrcU Jata source 
name (scrver) 

Cunncct 

(nonc) 

"Jba:;c Ill:" or "ubase IV:" 

''paraJox;" 

"btricvc;" 

'' oJ bc;dsn=daiusou re e; u id= 
user;pwd=password" 
(Professional Edition only) 

lf yuu sct the Exclusive propeny to Truc and then open thc database, no other 
application will be allowed to open tl;e database untíl you el ose the database. If 
anuther applicatiun has the database open and you attempt to open the database 
\vith F.xclusivc sctto Truc, your ~pplic:¡tion wi\1 rcccivc a run-timc error. 

RcadOnly Property 
:-·"u sct thc RcaLIOnly propcny to Truc, your application will not be allowed to 

wrill: to thc database. 



Module 13: Data Access Using the Data Control 285 

A Sample Application 

ID Number 'Find Ntntl 

Las! N11me Updalo· Prior 

¡oa~oliol] 
Dele! e LF:¿:] 

l="inl N ame 

¡Nancyd Add Lad 1 

11~1:~ IDalal 1~1~11 End 1 

A Sample Application 
Here is a sample application that a<.Jc.Js, fimls, u¡nJ;¡tcs ¡¡nd llclt:tcs rccon.Js'J"rolll ;1 
database. 

The details on how to codc this application are bcy()nd !lit.: ."-copt.' ()r this cl<~ss. 
However, you may flnd this application use fu/ asan cxarnplc. 

The demonstration program DBSAMPLE.MAK is /ocatcd inthc 
\WALKTHRU\DBSAMPLE dircctory. 



286 Module 13: Dala Access U;ing the Data Control 

I Summary ,. 

• Overview of a Database 

• How Does Visual Basic Access Databases? 

• The Data Control 

• Binding Controls to the Data Control 

• Data Control Walkthru 

• Data Control Methods and Properties 

" 
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Language Summary 
Visual 13asic objccls indudc forms, conlrols, and spccial objccls sudt as App. 
Cliphnard, Dclmg, Prinlcr, ami Scrccn. Each objcct has an associ;llcd scl of 
propcrtics, cvcnls and mcthods. This scction indudcs six tablcs: 

- • Tabk 1.1 lisis rclatcd functions, slalcmcnts, and mcthmls. gmupcd by 
programming task. llcms listcd in a givcn catcgory are ol"tcn ~l.sctllogcthcr. 

• Tablc 1.:! lisis propcrlics by objccl. 

• Tahle 1.3 lisis evenls by ohjccl. 

• Tablc 1.4 lisis mclhods by objccl. 

• Tablc 1.5 lisis Rcwrdscl objccls amlthc propcrtics thal apply lo cach objccl. 

• Tablc 1.6 lists Rccordscl objccls amlthc ¡ncthods thal apply lo cach objccl. 

Tahlc 1.1 Functions. Slatemcnls. and Mcthods hy l'rn¡:r:!mmin¡: Task 

3 

Cale¡:ory Action Funclions/Statemcnl.JMcthods 

Arrays 

Conlmlliug 
program llow 

Convcrling 

Change deJ'aull lowcr limil 

Declare anu inilialize 

Find lhc limils 

Rcinilializc 

llranclt 

Exil or pause lhe program 

Loop 

Makc dccisions · 

ANSI value lo slring 

Dale lo serial number 

Decimal numhers lo nlhcr 

· Numbcr lo slriitg 

One numeric dala lypc In 

anolher 

Serial numher lo dale 

Serial numhcr lo lime 

Slring lo ASCII v;duc 

Slring lo munher 

Time lo serial numher 

Option Base 

Di m, Global. RcDim, Slatic 

Lllound. Ullound 

Erase. Rcl>im 

(;oSuh ... l{clurn. GÚ't'o. On 
Error, On ... GoSuh, On ... GoTo 

l>oEvcnts. End, Slo(J, Unlu:ul 

l>o ... Loop. For ... Ncxt, 
Whilc •.• Wcnd 

lr. .. Thcn ... Eisc. Sclccl C:tsc 

Chr. Chr$ 

l>atcScri:tl, D:tlc V :Jiu e 

llcx. Hcx$. Oct. Ocl$ 

Formal. Formal$. Sir, Sir$ 

CCn•·. Cl>hl, Clul, CLn¡:, 
CSn¡:. CSir, CVar, CVDalc, 
Fix. lnl 

D:ty. Moulh, Wcckday, Ycar 

Hour. Minute, Sccond 

Ase 

Val 

TimcScrial. TimcValuc 
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Tahle 1.1 Functions, Statements. and i\1ethods hy l'ru~rmnmin~ Tasi¡ (contilllll'c/) 

Catr~nry 

Copying. cutting, 
aiHI pasting 

Datl'lt i me 

IJynamic data 
cxd1ange ( DDE) 

l~rn)r trapping 

File 110 

Actinn 

Use Cli1ohnard nbjcct 

Gct currcnt date or time 

Sct date or ti me 

Ti me a process 

Use a Visual llasic application 
as a DDE client 

Use a Visual flasic application 
as a DDE servcr 

Gct error mcssagcs 

Gct error-status data 

Simulate non-time crrors 

Trap crrors whilc a program is 
runnmg 

Acccss or crcatc a lile 

Close foles 

Controloutput appcarancc 

Cupy une lile tn anothcr 

Gel information about a lile 

Manage disk drives <ir 
dircctorics 

Manage liJes 

Read from a file 

Sct nr gel file attributcs 

Sct read-write pusition in a file 

Writc to.a file 

.. 

Fu nct inns/S la lt•me n t s/M rt hods 

Clt•m·. Getl>ata. CetFunnat, 
CetText. Sl'lllata. SetTcxt 

Dale, Dall'$, Nuw. Hme. 
Time$ 

Date. Date$. Time. Time$ 

Timer 

l.inkExrnote, l.inld'nke. 
l.inkReqnest 

l.inkSend 

Error$ 

Err, Erl 

Errnr 

On Error. Rt•sume 

O ¡o en 

Close, Rt·srt 

Spt·, Tah, Width # 

FileCu¡oy 

EOF. FileAttr. FiJd):¡ll', 

File Len. FrreFilc, Lnr. LOF. 
Seck 

Chllir. Chllrive. Cnl'lli•·. 
· CnrDir$. M kili•·. Rmllir 

Dir. Dir$, Kili. Lnrk...llnlut·k, 
Nmnc 

Gel. Input. Input#. Input$. 
l.int• ln¡uotll 

(;etAtto·. SeiAilr 

Seek 

l'rintll, Pul. \V rile 11 
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Tahlc 1.1 Funclions. Statcmcnts. :md Mcthods hy l'rn~rammin~ Task (couti1wcd) 

Catc¡:ory 

Graphics 

Manipulating 
objccls 

Math 

Printing 

Aclion 

Changc C(lOrdinatc systcm 

Clcar run-timc graphics 

Draw shapcs 

Draw tcxt 

Find sizc or lCXl 

Load or savc a picturc lile 

Work wilh colurs 

Arrangc fonns or controls on 
lhc scrccn 

Dircct uscr input lo a control 

Display dialog boxcs 

Drag and drop 

Hidc or show forms 

Load or un load objccls 

Movc or rcsizc controls 

Prinl fonns 

Updatc thc display 

Work with Jisl boxcs and 
combo boxcs 

General calculations 
' 

Gcncrat'c random nu1t1hcrs 

Get ahsolute valuc 

Gctthc sign of an cxprcssion 

Numcric co11vcrsions 

Trigonomctry 

Control output appcarance 

Control printcr 

Print 

Funct ions/Statcmcuts/Mct hods 

S cale 

Cls 

Cirdc, Linc, I'Scl 

P1·int 

Tcxlllcighl. Tcx!Widlh 

Loadl'iclurc, Savcl'iclurc 

l'oinl, QUColor, RGU 

Arrangc, ZOrdcr 

Sc!Focus 

lnpulllox, lnpulllox$, Msgllox 

Drag 

Hidc, Show 

Load, Unload 

M ove 

l'rin!Form 

J{cfrcsh 

Addllcm, Rcmovcllcm 

Exp, Log. Sqr 

R:mdmnizc, Rnd 

Ahs 

. Sgn 

Fix, In! 

Atn, Cos. Sin, Tan 

Scalc, S¡1c, Tab, TcxtHcight, 
TcxtWidth 

Endl>oc. Ncwl'agc 

l'rint. l'rintForm 
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Starting Visual Basic 
When you run the Visual Basic Setup program. Setup automatically creates a new 
program group and new program items for Visual Basic in Windows. You are 
then ready to start Visual Basic from Windows. 1 

.,. To start Visual Basic from Windows 

• Double-click the Visual Basic icon. 

You can al so start Visual Basic from either the File Manager or the MS-DOS 
prompt. 

When you first start Visual Basic. you see the interface of the programming 
environment, as shown in Figure 2.1. 

Toolbox Form Project window 

OLECLIEN.VBX 

Figure 2.1 The Visual Basic Programming Environment 

The Visual Basic interface consists of the following elements. 

Toolbar Provides quick access to commonly used commands in the programming 
environment. You click an icon on the toolbar once to carry out the action 
represented by that icon. 
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+ 

Figure 2.2 Drawing a text box with the Toolbox 

3. Place the cross hair where you want the upper-left comer of the control. 

4. Drag the cross hair until the control is the size you want. (Dragging means 
holding the left mouse button down while you move an object with the 
mouse.) 

5. Release the mouse button. 

The control appears on the form. 

A simple way to add a control to a form is to double-click the icon for that control 
in the Toolbox. This creates a default-size controllocated in the center of the 
form. 

Notice that small rectangular boxes called sizing handles appear at the comérs of 
the control; you'll use these in the next step as you resize the control. 

Jloo To resize a control 

l .. Select the control you want to resize by clicking it with the mouse. 

Sizing handles appear on the control. 

2. Position the mouse pointer on a sizing handle, and drag it until the control is 
the size you want. 

The comer handles resize controls horizontal! y and vertical! y, while the side 
handles resize in only one direction. 

'-"\ 3. Release the mouse button. 

1 
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1 

~ To move a control • 

• Position the mouse pointertanywhere on the control other than on a sizing 
handle, and drag the control to a new location on the form. 

You now have the interface for the "Helio. world!" application. shown in Figure 
2.3. 

t~~· Forml 1 '. alll 

1 Commandl Command2 

Figure 2.3 The interface for the "Helio, world!" application 

~etting Properties 
The next step is to set properties for the objects yo u' ve created. The Properties 
window (Figure 2.4) provides an easy way to set properties for all objects on a 
fom1. To open the Properties window, choose the Properties command from the 
Window menu, or click the Properties button on the toolbar. 

Object box 

Properties lis! 

Figure 2.4 The Properties Window · 

,. 

' 1 
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~ To open the Code window 

• Double-click the fonn or control on the fonn for which you want to write 
code . 

...:or-
• From the Project window, select the name of the fonn and choose the View 

Code button. 

Figure 2.5 shows the Code window that appears when you double-click the 
command button control. 

Events for Command1 

Figure ·2.5 The Code Window 

The Code window includes the following elements: 

• Object box-Displays the name of the selected object. Click the arrow to the 
right of the list box to display a list of al! objects associated with the fonn. 

• Procedure list box-Lists the procedures for an object. The box displays the 
· name of the selected procedure-in this case, Click. Choose the arrow to the 

right of the box to display all the procedures for the object. 

Code in a Visual Basic application is divided into smaller blocks called 
procedures. An erenr procedure. such as those you·n create here. contains code 
that is executed when an event occurs (such as a user clicking a button). For more 
infonnation on other types of procedures and event-driven programming in 
general, see Chapter 6, "Programming Fundamentals." 

J 
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Visual Basic Controls 

' 

) 

The Visual Basic Toolbox contains the tools you use to draw controls on your 
forrns. Each too! in the Toolbox (Figure 3.1) represents a control. 

g 

Pointer - ~ 

Label - A 
Frame - o 

Check box - [8J 

Combo box - ~ . 
Horizontal scroll bar - ~ 

Timer - é 
Directory list box - E:i 

Shape - 1()1 

lmage - ~ 
Grid - m 

Common dialog - 1m 

1~ 1--

abl 1--

o 1-

(!) 1-

1~ . 1--

~ 1--
1~ 
10 1-

~ 1-
...._ 1-

li:J!EI 
1~ 

!fl 1--

Picture box 

Text box 

Command button 

Option button 

Ust box 

Vertical scroll bar 

Orive list box 

File list box 

Une 

Data 

OLE 

Figure 3.1 The Visual Basic Toolbox 

The following table summarizes the Visual Basic controls found in the Toolbox. 
You may recognize sorne of these tools from earlier versions of Visual Basic. 

Icon Control 

w Pointer 

~ Picture box 

Label 

Description 

Provides a way to move and resize forms and controls. 
(Note that this is not a control.) 

Displays bitmaps, icons. or Windows metafiles. 
Provides an area in which to display text or acts as a 
visual container of other controls. See Chapter 15. 
"Creating Graphics for Applications.'' 

Displays text a u ser cannot interact with or modifv. 
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Icon Control Description 

~ Text box Provides an area to input or display text. 

D Frame · Provides a visual and functional container for controls. 

§ Command button Carries out a command or action when a user chooses 
it. 

~ Check box Displays a True/False or Y es/No option. Any number 
of check boxes on a form can be checked at one time. 

~ Option button As part of an option group with other option buttons, 
( 

displays multiple choices, from which a user can select 
only one. 

~ Combo box Combines a text box with a list box. Allows a user to 
type in a selection or select an item from a drop-down 
list. 

~ ' 
; 

List box Displays a list of items that a user can choose from. 

~ Horizontal scroll Allows a user to selecta value within a range of 
bar values. (These are used as separate controls and are 

[E] Vertical scroll bar not the same as the built-in scroll bars found with 
many controls.) 

[21 Timer Executes timer events at specified time intervals. See 
. Chapter 17, "lnteracting with the Environment.'' 

[§ Orive list box Displays and allows a user to select valid disk drives. 
See Chapter 18, "Using the ·File-System Controls." 

~ Direct()ry !ist box Displays and allows a user to select directories and 
paths. See Chapter 18, "Using the File-System 
Controls." 

~ File Iist box Displays and allows a user to select from a list of files. 
See Chapter 18, "Using the File-System Controls." 

[2] Shape Adds a rectangle, square, ellipse, or circle toa form. 
See Chapter 15, "Creating Graphics for Applications." 

GJ Line Adds a straight-line segment toa form. See Chapter 
15, "Creating Gráphics for Applications." 



34 Programmer's Guide 

Icon 

~ 
~ 

Control 

Image 

Data 

Grid 

OLE 

Common dialog 

M en u 

Description 

Displays bitmaps, icons. or Windows metafiles; acts 
like a command button when clicked. See Chapter 15, 
"Creating Graphics for Applications." 

Enables you to connect to an existing database and 
display information from it on your forms. See 
Chapter 20. "Accessing Databases with the Data 
Control." 

Displays a series of rows and colurnns and allows you 
to manipulate the data in its cells. See Chapter 13, 
"Using the Grid Control." 

Embeds data into a Visual Basic application. See 
Chapter 22. "Object Linking and Embedding (OLE)." 

Provides a standard set of dialog boxes for operations 
such as opening, saving, and printing files or selecting 
colors and fonts. See Chapter 4, "Menus and Dialogs." 

Creates ,menus in your Visual Basic applications. For 
information about menu controls, see Chapter 4, 
"Menus and Dialogs." You work with menu controls 
in the Menu Design window. which you can access 
either by choosing Menu Design from the Window 
menu or by clicking the Menu icon on the toolbar. 

Y ou can also refer to the summary tables found in the Language Reference and in 
Help for supported methods, properties, and events for each type of control. 

Object Naming Conventions 
When you first create an object (form or control), Visual Basic sets its N ame 
property to a default value. For example, all command buttons ha ve their N ame 
property initially set to Commandn, where n is 1, 2, 3, and so on. Visual Basic 
names the first command button drawn on a form Commandl, the second 
Command2. and the third Command3. 

niere is nothing wrong with keeping the default name: however, when you ha,·e 
severa! controls of the same type. it makes sense to change their N ame propenics 
to something more descriptive. Since it may be difficult to distinguish the 
Commandl button on MyForm from the Commandl button on YourForm, a 
nanting convention can help. This is especially true when an application consists 
of severa! form and code modules. · 
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For example, you can use a prefix to describe the object type, followed by a 
descriptive name for the controL This makes the code more self-documenting and 
alphabetically groups similar objects together in the Properties window in the 
Object list box, 

The following naming conventions forVisual Basic objects are used throughout 
this manuaL / 

Table 3,1 Object Naming Conventions for Visual Basic 

Object Prefix Example 

Form frm frmFileüpen 

Check box chk chkReadOnly 

Combo box cbo cboEnglish 

Command button cmd cmdCancel 

Data dat datBiblio 

Directory list box dir dirSource 

Orive list box drv drvTarget 

File list box fil filSource 

Frame fra . fraLanguage 

Grid grd grdPrices 

Horizontal scroll bar hsb hsbVolume 

Image img imglcon 

Label lbl lblHelpMessage 

Line , !in lin Vertical 

List box 1st lstPolicyCodes 

Menu mnu mnuFileOpen 

OLE ole oleübjectl 

Option button opt optFrench 

Picture box pie picDiskSpace 

Shape (circle, square, oval, shp shpCircle 
rectangle, rounded rectangle, 
and rounded square) 

Text box txt txtGetText 

Timer tmr tmrAlarm 

Vertical scroll bar vsb vsbRate 

( 
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ll11<1 l"iluhru rcscrl'lulu tiene un significado especial para Visual 1\asic. Son 
¡dahr:1s .rescrvad;.¡s las sentencias predcfi ni das ( For) y Jos nombres de !'unciones 
r Y:d l. r1r..'tmlos (Hidc), propiedades (Caption) y operadores (i\11(1). 

Ti pos de datos 

l ln:1 1 ;¡rj;¡h\c puede ser de alguno de los seis tipos siguientes: 

Carácter de dcda-
Tipo Dcscripci<ín raci<'ln del tipo Rango 

\ 

lnh._'''l'l' ,.., Entero % -3276X a 
1(2 bytes) 327(>7 

l.ong Entero largo & -21474X364X a 
(4 bytes) 21474X1,647 

Sin gil- Real simple -3.l7E+3X a 
1 por dd'cl'lo) precisión ( 4 bytes) :U7E+3X 

\)ouhk Real doble 11 -J.(¡7D+30X a 
precisi{m (X bytes) J.(J7D+30X 

( ·urrcm·y Nümcro con punto @ -<J.22E+I4 a 
decimal fijo <J.22E+ 14 

Sl ring Cadena de $ 
c;tractcrcs 

.:\litL·s de utili1.ar una variabk, hay que declarar su tipo. Una J'orma de hacer 
L\iuc·s utilit.amlo la sentenciaDim (o una de las palabr;.¡s Glohal o Slatic). Cual
l(llin ,kc\araciún de ést;¡s inicializa las variabks nu1néricas con el valor cero y las 
1·ar i:il>lcs ;li\'anuméricas con el carácter nulo. Por ejemplo. 

11Í11: :\:; LnLcgcc 
[1i111 [·' ;\;·. [lOIJh]c_• 

i11111 11\Jlld,ll--' ;\:; ~~Lr·i.llg 

l•rrrr 1<1 ir·¡uci_¿¡ 1\:; :;tr.ing * lO 
: 1 i 111 1·' ,\:_; Cu r·1:cncy 
11 i 111 11 ,\:·; l..on~¡, X /\s Currcncy 

l.:1s sentencias anteriores declaran 1 co1no una variable.entera. R como una 
. " 

l·:¡r·i;i\>k re:d de precisi1ín doble. Nomlm· como una variable para contener una ca-
dc·r¡a de L·aracteres de longitud variable, Diquclll como una cadena de caracteres 
de· lon¡:itud J'ija ( 10 caraciLTL'S). ¡;como una variable fraccionaria. L como una 
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v;¡ri;¡bl<.; enll:ra larga. y X como una v;1riahle rraccionaria. Observe t¡IIL' cn una 
sentencia I>im puede realizar más de una declaraci<">n. 

Otra rorma de declarar una vari;1blc es utili1.ando los caracteres de declaraci<">n 
de tipo. Pot· ejemplo, 

1 ·• Variable entera 
"il Variable real de precisiún doble 
l··lotnb u<: Cadena de car;1ctcres 
1''(,1 Variable l"raccionaria 

Si una vat·i;ihle se utiliza y no se declar;¡ se asume que es lk tipo Singlt·. 

Si de una variable se sabe que nunea va a contener un valor rraccionario. es 
mi.<jor declararla como entera. ya que _las operaciones con enteros son más r;ípidas. 
l~n caso conlrario. si el valor no va a tener más de 4 dígitos decimales y 1m m;ís 
de 14 dígitos enteros. es convéniente declararla como l"raccionaria (Üil'l'l'lll')'). 

l:n las variables de lipo Currcncy no tiene lugar el error producido en la convcr
sit'>n entre las bases 2 y 10. que sí tiene lugar cuando la vari:1bk es de tipo Single 
o I>ouhlc. 

Cuando una variable numérica de un tipo se asigna a otra variabk numérica 
de un tipo dil"erente, Visual Basie realiza la convcrsiún correspondiente. 

Ámbito de las variables 

variables globales 
(declaradas Cll clmúdulo ~lohal) 

variables a nivel de la forma 

(secci<íntk declar;Jciones) 

variabks 
locales 

variables 
locales 

Prm:cd i m icntos 

Forma 

Apli<.:acit'>n 

variables a nivel del tm">duln 

(se ce i IÍn de de e l:trac ionL'S) 

variables 
locaks 

variables 
locales 

l'roccd i 111 ie nt '>s 

tvl<ídulo ¡) 
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Variables globales 

Una l'(lriul>/c g/olwl puede ser accedida desde cu;rlquier p;rrte de la aplicaciún. 
Para hacer que una variable sea glob;rl. hay que declar;rl'ia en el nuít!ulo glnhul de 
la aplicaci<'lll. Este múdulo no adrnite cúdigo. solo admite declaraciúnes. U rwrn
bre dado a este módulo por deJ'ecto es G/olwl.lws. 1\rra editarlo. scleccil'JJlelo en 
la vent;rna /'roj¡•c/ y haga clic en el botrín Vinl' C()(h'. 

Para declarar en el múdulo G/ohal.ht1s una variable global. utilice la paJ;¡hra 
clave Glohal en lugar de Dim. Por ejemplo. 

Cluhc~l vorl_9lobal 1\r; Doublc, vcJr:/._g.l.oh;:ll /": :.:L.1 111<_1 

Variables con el mismo nombre en diferentes niveles 

Una variable local, otra a nivel de J¡¡ J'orma ·o tkl rnúdulo y 01ra glob;rl pueden te
ner el mismo nombre, pero no son la misma v;rriable. La regla para estos casos es 
que el proeedin1iento siempre utiliza la variable de nivel rn:is cercano ( loL·al. !'or
Illa o llllídulo v t:lubal). 

Si una variable aparece en un procedimiento y no cst(r explícitarnente decla
rada es por dcJ'ecto local. Para asegurarse de que la variable es local. es mejor 
declararla expl ícitamentc. 

OPERADORES 

La tabla que se muestra a continuaciún -presenta el conjunto de opnadores que 
soporta Visual Basic colocados de mayor a menor prioridad. Los opnadores que 
apar..:c..:n sobr..: una misma línea tienen igual prioridad. Las op..:racionL'S entre pa
n'ntcsis se evaltían primero. ejecutállli(Jse primero Jos paréntesis 1nüs intnnns. 

Tipo 

Aritmético 

Operación 

Ex poncnc iación 
Cambio de signo 
Multiplieaciún y divisiún 
Divisi1ín entera 
Resto de una divisiún enter;r 
Suma y resta 

Igual. distinto. lll<lyor que .... 

Opcradm· 

•:•. 1 

\ 
Mod 
+.-

=.<>.>.>=.<.<= 
¡'( 
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Tipo Opcraci!Íil Opcn1dor 
------------~----------~------------~~-------------

1.( i~ilu 
1 ttl:ltlc·jo de: bits) 

Ncga¡,;iún 
Ano 
Or indusiva 

Nol 
¡\11(( 

()¡· 

Or exclusiva Xor 
Equivalenda (opuesto a Xor) Eqv 
ln!Jllicaciún lmp 
(verdad si primer operando ralso y 
segundo operando verdadero) 

-----'-'='-

SENTENCIAS 

lln:t sentencia es una línea de texto que indica un:1 o m:ís opcraciones.a.realizar. 
['i¡¡;¡ lim·a puede tener varias sentencias separadas unas de otra:' por dos puntos. 

; "' ,, 1 c. c.Jnli.dad * p¡~cc:i.o: '"Uillil = fctllt!t<J -1- LOLJl 

1 .a sentencia m.ís cúmún en Visual 13asic es la sentencia de asignaciún. Su 
l"lll'lll~l ~L'IH.:ral es, 

' 

rariah/e = c.\jlresitÍII 

l:t c·u:d indica que el valor que resul!e ue evaluar la c.r¡)/'(·.virí11 tiene que ser alma
c·c·tl:ido cn la -mriahlc especilicada. Si la expresilin es numérica la variable tiene 
'1"'' sn tainhién mnnéril:a y si la exprcsiún es alJ':nnnnérica la variable tiene que 
.sn t:tinhién :IiJ'anuim5rica. Por cjen1plo. 

(: . t 

1 "' ., <::tC!j = C¿tp.llul * ''l'anlot'orC.i.cnLo 1 100 
i-1( ·Jl::,t_ic~ = .. La opcrución es corree lo" 

PROPIEDADES 

l~c·c·oi'Llar que un qb_jeto (J'ormil o contml) tiene asuciadas \';lrias propiedades. Para 
rct'c-rirse a una propiedad de un objeto se utili1.a la J'om1a. 

1 1/Jj e t 1'. ¡ !1'0 ¡' i cda ti 

J'o¡· eje1nplo, supongamos el objeto Texto y su pmpiedad '/'c.rl. L:1s siguientes 
operaciones ·serían vúlidas 
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Creating Menus at Design Time 
If you want your application to provide a set of commands to users. menus offer a 
convenient and consisten! way to group commands andan easy way for users to 
access them. 

Figure 4.1 illustrates the elements of a menu interface on an untitled Visual Basic 
form .. 

Menu item Menu bar Tille bar 

Menu 

Separator bar -+t-:::-:------1 

Figure 4.1 The elements of a menu interface on a Visual Basic form 

The menu bar appears immediately below the rir/e bar on the form and contains 
one or more menu titles. When you click a menu tille (such as File), a menu 
containing a list of menu items dn:ips down. Menu items can include commands 
(such as New and Exit). separa1or bars. and submenu titles. Each menu ilem 1he 
u ser sees corresponds lo a menu control yo u define in lhe Menu Design window. ) 

To make your application easier lo use: you should group menu ilems according 
lo lheir funclion. In Figure 4.1. for example. the file-rel<ited commands New. 
Open. and Save As are al! found on lhe File menu. 

So me menu ilems perform an aclion direclly: for example. lhe Start menu ilem on 
lhe Run menu runs lhe currently loaded project. 01her menu ilems display a 
dia/og box, a window lhal requires lhe user lO supp!y informaliOil needed by lhe 
application lo perform the action. For example, the Open Projecl command on lhe 
File menu displays the Open Project dialog box. 

1' 
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Chapter 4 Menus and Dialogs n 

Using the Menu Design Window 

' 

Menus are created using the Menu Design window. You add menu items toa 
menu at design time by creating menu controls and setting propenies to define 
their appearance. 

li> To display the Menu Design window 

• Choose Menu Design from the Window menu. 
-Or-
• Choose the Menu Design button on the toolbaL 

This opens the Menu Design window, shown in Figure 4.2. 

Menu control properties 

Menu Design Wiy¡dow ~ 

CaQiion: ~=======~·/ OK 

Name: / Cancel 1 
lnde¡: c=J ~hortcut: Shortcut combo box 
O ~indowlill 

Menu control lis! box 

Figure 4.2 A !\len u Design window 

All the menu control design-time propenies are shown in the Menu Design 
window _ The two most imponant propenies for menu controls are: 

"< • Name-This is the name you use to reference the meno control from code. 

• Caption-This is the text that appears on the control. 

Other propenies in the Menu Design window, including Index and Checked, are 
described later. in this chapter. 

/ 
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The menu controllist box lists all the menu controls for the curren! forrn. When 
you type a menu item in the Caption text box. that item also appears in the menu 
controllist box. Selecting ail existing menu control from the list box allows you to 
edit the propenies for that control. 

For example, Figure 4.3 shows the menu controls for the File menu in the Text 
Editor application. 

~J Menu Oesign Window 

Cagtion: ~~rw~::=======:::; ;:::::":;:<~ 
Nam.e: ~~mn=u=F=ile;----:::--:-;:==~~ ~Ca;n~ce~l 1 
lndex: O ,S.hOflcul:. ":!ln::o~ne;)===l;-'!) 
O 'l!l.indowlill H.elpConlextiD: lc:o ___ ...J 

O ~hecked 

····I.Open ... 
····Save LAs ... 
····&.Ciose 

····E&xil 

Figure 4.3 File menu controls in the Menu Design window 

The position of the menu control in the menu control list box determines whether 
the control is a menu title, menu item, submenu title, or submenu item: 

• A menu control thal appears flush left in the list box is displayed on the menu 
bar as a menu title. 

• A menu control that is indented once in the list box is displayed on the menu 
bar when the u ser clicks the preceding menu title. 

• A menu control followed by menu controls that are funher indented becomes a 

• 

· submenu title. Menu controls indented·below the submenu title become items 
of that submenu. 

A menu control with a hyphen (-) as its Caption propeny setting appears as a 
separator bar. A separator bar divides menu items into logical groups. 

J 

\ 
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Writing Code for Menu Controls 
When the user chooses a menu control, a Click event occurs. You need to write a 
Click event procedure in code for each menu control. Al! menu controls except 
separator bars (and áisabled or invisible menu controls) recognize the Click event. 

Visual Basic displays a menu automatically when the menu title is chosen: 
therefore, it is not necessary to write code for a menu title' s Click event procedure 
unless you want to perform another action, such as disabling certain menu items 
each time the menu is displayed. 

Note Al design time. the rnenus you create are displayed on lhe form when you 
close lhe Menu Design window. Choosing a menu item displays the Click event 
procedure for that rnenu control. 

Writing Code for the Edit Menu 
You refer lo an elernent in a control array by specifying its index value along with 
its name. In the preceding Edit menu from the Text Editor application, for 
example, mnuEditilern(O) refers lo Cut, the firsl rnenu item on the Edit menu and 
lhe first element in the rnnuEdititern control array. 

The index value of the selected menu item is passed to the evenl procedure when 
the user clicks that item on the menu. Since al! the elements in the arra y share the 
same event procedure code, you can use conditional statements such as If ... Then 
or Select Case to determine what code will be executed. For example, this code 
uses Select Caseto cut, copy, and paste with the Clipboard: 

Sub mnuEditltem_Click (!ndex As Integer) 
Select Case lndex 

Case 0 ' If Index - 0, user chose Cut. 
' Copy selected text to Clipboard. 
Clipboard.Clear ' Clear the Clipboard. 
Clipboard.SetText txtEdit.SelText 
' Clear selected text from the document. 
txtEdit.SelText -

Case 1 ' If Index - 1, u ser e hose Copy. 
Clipboard.Clear ' Clear the Clipboard. 
' Copy selected text to Clipboard. 
Clipboard.SetText txtEdit.SelText 

Case 2 ' If Index - 2. u·ser chose Paste. 
' Paste Clipboard text (if any) into document. 
txtEdit.SelText- Clipboard.GetText() 

End Select 
End Sub 
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For More lnformation For infonnation about the Clipboard object, see the 
Language Reference, or'search Help for Clipboard. 

Creating Submenus 
Each menu you create can include up to four levels of submenus. A submenu 
branches off another menu to display its own menu items. You may want to use a 
submenu when: 

• The menu bar is fui!. 

• A particular menu control is seldom used. 

• Y o u want to emphasize one menu control' s relationship to another. 

lf there is room on the menu bar, however. it' s better to crea te an additional m en u 
title instead of a submenu. That way, al! the controls are visible to the user when 
the menu is dropped down. It' s al so good programming practice to restrict the use 
of submenus so users don't get lost trying to navigate your application's menu 
interface. (Most applications use only one leve! of submenus.) 

Figure 4.4 displays a menu interface with four levels of submenus. 

Menu~----------~ 

Submenu1~------------------~ 

Submenu2~------------------------~ 

Submenu3~--------------------------------~ 

Submenu4~------------------------------------------~ 

Figure 4.4 A menu interface with four lewls of submenus 
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Figure 4.5 displays the same submenus individually. Notice that all menu controls 
that display submenus have an arrowhead symbol in their right edge. Visual Basic 
provides this visual cue automatically. 

_6ackColor 
foreColor 

Arrowhead symbol indicating submenu control 

Beq 
.Green 
Hlue ~ .Light Blue 

Qark Blue ~ ~ea Blue 
Midnight Blue 

Figure 4.5 . Visual cues indicating submenus 

In the Menu Design window, any menu control indented below a menu control 
that is 1wt a menu title is a submenu control. In general, submenu controls can 
include submenu items, separator bars, and submenu titles. The founh-level 
submenu can include submenu items and separator bars, but not submenu titles. 
Figure 4.6 shows how the submenu titles and submenu items from the previous 
example are indented in the menu controllist box in the Menu Design window. 

············J.Biue 
Submenu tille- -·······•F•••Cob 

············lRed 

Submenu items 

Submenu items 

SiJbmenu items 

Figure 4.6 Submenu tilles and submenu items in the menu controllist box 

\ 

'-
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Using the Value of a Control 
All controls ha ve a property that you can use for storing or rctricving valucs just 
by rcferring lo thc control, without using thc propcrty namc. This is callcd the 
value of thc control ami is usually thc mosl important or most commonly used 
propcrty for that kind of control. Tablc 6.1 lists thc propcrty thal is considcrcd lo 
he thc valuc for cach kind of control. 

Tahlc 6.1 Controls and thc l'ropcrtics That Are Thcir Valucs 

Control l'rnpcrty 

Check box Yaluc 

Combo box Tcxl 

Commanú button 

Conunon úialog 

Data 

Dircctory list box 

Drivc list box 

File list box 

Framc 

Grid 

llnrizontal scroll bar 

Image 

Lahcl 

Linc 

List box 

Mcnu 

Optiiln hutton 

Picturc box 

Shapc 

Tcxt box 

Timcr 

Vertical scroll bar 

Yaluc 

Action 

Captinn 

Path 

Orive 

FilcNamc 

Caption 

Tcxl 

Yaluc 

Picturc 

Caption 

Yisihlc 

Tcxt 

Enablcd 

Yaluc 

Picturc 

Shapc 

Tcxt 

Enablcd 

Yaluc 

Whencvcr you want to refcr to a property on a control that happcns lo be the valuc 
of that control, you can do so without spccifying the propcrty na me in your codc. 
For cxample, this linc scts the val u e of thc Tcxl propcrty of a tcxt box control: 

Textl - "Thts text ts assigned to the Text property of Textl" A2 
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Thc fir.,t thn:e ilems in the preceding listare decision stnu.:tures. Y ou use themto 
ddine groups or stat..:ments thatmay or may not be exeeuted, depending on run
time conditions. Thc lasttwo ilcms are loop struclurcs. Youusc themlo dclinc 
gmups or slalemcnls thal Visual Basie exccules rcpcatedly. 

Decision Structures 
Likc macros, Visual 13asic proccdurcs canlcsl conditions and thcn, depcnding on 
thc rcsults or lhattcst, pcrfonn di ITeren! opcrations. The dceision slructurcs that 
Visual llasic supporls indudc: 

• lf ... Thcn 

• 1 r...Thcn ... Eisc 

• Sl'icd Case 

lf...Then 
l ls..: an If •.• Thcn block to cxccutc onc or more statcme11ls condition:¡lly.·You can 
use ..:ithcr a singlc-linc syntax ora mulliph:-linc "block" synwx: 

lf nnulitio11 Thcn slt/lcmclll 

lf m11ditirm Thcn 
S/ <1 /1"11/1' 11 /.~ 

End lf 

Thc Clllltiition is usually a comparison, but it can be any exprcssion thal cvaluatcs 
lo a numcric valuc. Visual 13asic intcrprcls this valuc as Truc or Falsc; a t.ero 
llllllleric value is Falsc, all(l any nonzcro numcric valuc is considercd Truc. u· 
··"nditio11 is Truc, Visual Uasic exccutes all.lhe sta/t'llll'/1/s l"ollowing thc Thcn 
kcywonl. You can use cithcr singlc-linc or multiph:-linc syntax lo cxccutc just 
une stalemenl coiH.litionally (ihcsc two cxampks are cquivalcnt): 

1 r unyllale < Now Then anyDate - Now 

l f anyDa.tc < Now Then 
ilnyDate - Now 

End 1 f 

·-;] 
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Notice that the single-fine l"orm or IL.Thrn do~:s not us<: an End Ir stat<:mcnt. If 
you want to cxccutc more than onc fine or codc whcn condition is Truc. youmust 
use thc multiplc-linc blül:k Ir ... Thcn •.. End If synt;tx. · 

lf anyDate < Now Then 
anyDate - Now 
Timerl.Enabled- False 

End 1 f 

lf... Then ... Eise 

' Di sable timer control. 

Use an lf ... Thcn ... Eisc block lo dcline severa! blocks or statcmcnts, onc of which 
gcts cxccutcd: 

Ir collllition 1 Thcn 
1 S/1/ll'II/CIII!Jiock-11 

1 Eisclr condition2 Thcn -
1 Slllll'lifCIII!Jiock ·211 ... 

IEisc 
lstti/C/1/t'lllhlock-n 11 

End Ir 

J 

Visuall3asic flrst tests omditirml. lf it's Falsc, Visuall3asic prncccds tu test 
condition2, and so on, tl'~•il it linds a Truc condition. Whcn it rinds a Truc 
condition, Visual 13asic cxccutcs the corresponding statcmcnt blo<:k amlthen 
.exccut<:s thc codc following thc End If. Asan option, you can indude an Eisc 
slatcnt<:lll block, which Visual Basic <:x<:cut<:s ir nonc or thc condilions are Truc. 

Ir ... Thcn is rcally justa special case of Ir •.. Thcn ... Eisc. Noticc that you can ha ve 
any numhcr of Elscif el a uses, or nonc al al l. You can indudc an Elsc dause 
whcthcr or n¡Ít you ha ve Elsclf dauscs. 

rur cxample. your application could pcrform diiTcrcnt actions d~:pcnding on 
whidt control in a mcnu control array was dickcd: 

Sub mnuCut.~lick (lndex As Integcrl 
lf lndex - 0· Then 

CopyActiveControl 
ClearActiveControl 

Elsclf Index- 1 Then 
CopyActiveControl 

Elsclf lndex- 2 Then 
ClearActivcControl 

El se 
PasteActiveControl 

' End l f 
[nd Sub 

Cut command. 
Call general procedures. 

Copy command. 

Clcur command. 

Paste command. 
.,_ t¡ 

J· 
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Nolicc lilat you can always auu more Elsclf parls to your lf ..• Thcn structure. 
Howcvcr, tilis syntax can gel Leuious Lo writc wilcn eacil Elsclf compares the 
samc áprcssion lo a uifferent valuc. For tilis situation, you can use a Sclcct Case 
dccision structurc. · 

For More lnlo.rmation For auuitional dctails about If ... Thcn ... Elsc, sec the 
/.ung111rgc Rcfercncc, or search Help for lf 

Select Case 
Visual Basic proviucs thc Sclcct Case structure asan alternative Lo 
lf...Thcn ... Elsclf for sclcctivcly cxecuting one block of slalcmcnts from among 
lllUIIiplc blocks of statemcnts. A Sclcct C:ise statcmcnt proviucs capability similar 
lo lhc lf...Thcn ... Eisc statcmcnl, but it makes codc more ciTicient and readable. 

1\ Sclccl C:~sc structurc w1irks witil a single test cxprcssion tila! is cvaluateu once, 
al tilc top of tile structure. Visual Basie thcn compares tile n:sult of this exprcssion 
with th.: valucs for cach C:~sc inthc structurc. lf thcrc is a match, it cxecutes the 
block of statcmcnts associatcd with that C:~sc: 

Select C:~se rcsrcxpression 
1 Case e.rpre.vsionlisr 1 

!.1'/({/C/1/Cillbfock-1 JI 
1 Case c.rprc.vsionlisr2 

istatcmcnrblock-2]] ... 

!Case Else 
isla ICIÍIC//Ibfock-11]] 

Eml Sclcct 

l~ach c.rpressionlist is a list of one or more values. If there is more than one value 
in a single Iist, the values are separated by commas. Each .l'tatcmentblock contains 
zcrn or more statcmcnts. If more than onc Case matchcs thc test cxprcssion, only 
tilc stalcmcnt block associated with thc lirstmatching Case is executcd. Visual 
llasic cxecutes statements in the Case Else clause (which is optional) if none of 
thc valut:s in thc exprcssion lists matchcs the test cxprcssion. 
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foor cxamplc, supposc you addcd annlhLT c·nmm:uulto thc Edil mcnu in thc 
ll'..Thcn .. Elsclf examplc. Youcould ad<i auothcr Elsclf dausc. or you cnuld 
wrilc the funclion with Sclccl C:1sc: 

Sub mnuCut_Click llndex As Integerl 
Select Case Index 

Case 0 
CopyActiveControl 
ClearActivcControl 

Case 1 
CopyActiveControl 

Case 2 Then 
ClearAclivcCorrtrol 

Case 3 
PasteActiveControl 

Case Else 
frmFind.Show 

End Select 
End Sub 

Cut command. 
Call general procedures. 

Copy command. 

Clear command. 

Pa:;tc comrnand. 

' Show Find dialog. 

Notice thallhe Sclcct Case slructure evaluales an cxpression once al thc lop of 
lhe structure. In conlrasl. the ll'...Tht•n ... Eisclf slruclurc can cvalu:ilC a diiTcrcnl 
exprcssion for cach Elsclfstalcmcnl. You can rcplacc anlf ... Thcn ... Eisclf 
structurc with a Sclcct Case struclurc only if each Elsclf slalcment cvalualcs thc 
samc e.~prcssion. 

Loop Structures 
Loop struclurcs allow youlo cxccule onc or more lincs ofende rcpelitivcly. Thc 
loop strucllircs thal Visual llasic supporls indudc: 

• Dn ... Lnnp 

• Fm· ... Ncxt 

Do ... loop 
Use: a Dn loop lo CXC:Cllle a blm:k or slalemenls an indci'inilc' lllllllhcr or times. 
Thcre are severa! variations·or thc Dn ... Lnnp sl:llemcnl. hul cal'h cl'aluatcs a 
muncric condition lo determine whcthcr lo continue cxccutinn. i\s ,,:ith II' ... Thcn. 
the ¡·orulitioumusl he a valuc·or cxprcssionthal cvaluatcs ln Fa!Sl' (IL'ro) orlo 
Trnt• ( n01izcro ). 

In thc following Dn ... Lnnp, lhc ,\'1111<'111<'11/s are: cxcc'utcd as loug as thc nmditiou is 
Tn1c: 

Dn Whilc cwulitiou 
.\'{ ( 1/ ('I//(' 1/{,\' 

Lnnp 
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Wiletl Visual Basic cxccutcs this Do loop, il rirsl tesis colltlilioll. lf colltlilimi is 
Falsc (zem), it skips pasl allthc stalcmcnts. Ir it's Tmc (nonzcro) .. Visual Basic 
nccutc·s the slalemcnls amlthen gocs back lo thc Do \Vhilc slalcmcnl and tests 
!he cundition agai1L · 

C'onscqucntly. thc loop can be cxccutcd any numb.:r of times, as loÍ1g as colltiilioll 
is tH>llt.no nr Tn1c. Thc slalcmcnts are ncvcrcxccut.:d if nnulilio11 is initially 
Falw. For ex;unpk, this proccdurc counts thc occurrcnces of a targct string within 
:uH>thcr siJ·int: by loOJli11!.! as long as thc targcl slring is l'nund: ... ..... ... ..... .... 

lunction CountStrings (longstring, target) 
o i m po~ i ti on, count 

position- 1 
Do Whilc InStr(position, longstrir>g. targct) 

¡Josilion- InStrlposition. longstrirJg, Lorgct) + 1 
count - coun~ + 1 

Loop 
ConnLStrings - count 

l:nd Funclion 

11' thc largct string docsn't occur inthc othcr string, thcn InSp· rcturns O and thc 
l1lup isn't cxccutcd. 

;\nothcr variation of thc Do ... Loop st;llcmcnl nceutcs thc stalcmcnts rirsl and 
thcn tesis cmulilioll alkr cach cxccution. This varialion guarantccs al !casi onc 
l'.\l'Cttlinll ol' Sllllc.'IIICIII.C 

Do 
SIU/c'lll<'lll.'i 

Loop \Vhilc colltiilioll 

Two othcr variations are analogous lo thc prcvious two, cxccpl lhatthcy loop as 
Ion¿: as nmtlilio11 is Falsc rathcr lhan Truc. 

l.oop ZL:ro or more times 

Do Llntil nmditiou 
Sltlft'lllt'.I//S 

l .. oop 

Lciop al kasl once 

Do 
.'\la 1 C'IIU'I 1 ts 

I~OOJI Unlil mndi!im1 

Noticc that Do Unlil co11ditio11 is cxactly c.:quivalcntlo Do Whilc Not ccmditiou. 
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For ... Next 
Do loops work wdl whcn you don't know how m:uiy times you nccd lo exccute 
thc statcmcnts in thc loop. Whcn you know you must cxccute thc·statemcnts a 
spccific numbcr or times. howcvcr, your codc is more cnicicnt ir you use a For 
loop. Unlikc a Do loop. a Fnr loop uses a co11111er variable thal incrcascs or 
dccrcases in value during cach rcpctition or thc loop. Thc syntax. is: 

For coll/1/er = start To cw/IStcp illcrel/lellfi 

s 111 ll'l//l'/1/.v 

Ncxl lcoll/1/erl 

Tite argumcnts Cllllllll'r, start. ellll, ami illcrellll'/1/ are all numeric. 

Note The argumcnt iiiCIT/11<'11/ can be either positive or ncgativc. 1 r i"'Tl'l/ll'lll is 
positive, startmusl be lcss than or cqualto c/1// or thc slalcmcnts in thc loop won't 
he cxecuted. Ir i11áemellt is negativc, .vtart must be grcatcr than nr equalto e11d 

ror thc hody or the loop to be cxccutcd. Ir Stcp isn't sct, then ii/(.Tl'llll'lll deraults 
lO 1 • 

In cxccuting thc For loop, Visüal Basic: 

l. Scts coll/1/cr cqualto start. 

" Tests lo scc ir m11111er is gn:ater thane11ti. Ir so, Visual Basic cxits thc loop. 

(Ir illcremcllt is ncgativc, Visuall3asic tests lo scc ir C/1111111'1' is lcss than e11d.) 

3. Executcs thc statel//l'/11.1'. 

4. lncrcments coll/1/er by 1-or by illl.Temcllt ir it's spccillcd. 

5. Repcats steps 2 through 4. 

This code prints the n:nncs or allthc availahlc Scrcen ronts: 

Sub Forrn_Click () 
Dim i 

for i - 0 To Screen.FontCount - 1 
Print Screen.Font.s(i) 

llexl 
End Sub 

i\nother cxample in Chaptcr 3 ti sed a For ... Ncxl loop lo stcp through .the cntrics 
in thc Sclcctcd propcrty of a multiplc-coiumn list hox: 

Sub crndTransfer: .. Click (l 
For n- 0 To (lstTop.ListCount - 1) 

Next 
End Sub 

lf lstTop~Selected(n)- Tr11e Tl1cn 
lstBottorn.Addltern lstTop.List(nl 

End 1 f 

If selected. 
add to list. :t.J' 
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-Nested Control Structures 
As thc previous cxamplc uemonslrates. you can place control structurcs insiuc 
othcr control struc!Urcs (sudt asan IL.Thcn block within a For ... Ncxt loop). A 
control structure placeo insidc another control structurc is saiu to he II<'Stcd. 

Control structurcs in Visual 13asic can be nestcu toas many lcvcls as you want. 
lt's common practice to makc nestcd dccision strlll:turcs and loop structures more 

' rcad<Jblc by inucnting thc body or thc dccision structure or loop. 

For cxample, this proccdure prints all the ron! namcs thal ;¡re common lo both the 
l'rintcr and Scrccn: 

Sub Form_Cllck () 
Oim SFont, PFont 

For SFont - 0 To Screen.FontCount - 1 
For PFont - 0 To Prlnter.FontCount - 1 

If Screen.Fonts(SFontl - Prlntcr.FontsiPFont) Then 
Prlnt Screen.FontsiSFontl 

End I f 
Next PFont 

Next SFont • 
End Sub 

Notil:c thallhe lirsl Ncxt closcs thc inncr For loop amllhc las! For closcs thc 
outcr For loop. Likcwisc, in ncstcd lf statcmcnts, thc End Ir statcmcnts 
automatically apply lo lhc ncarcsl prior Ir slalcmcnt. Ncslcd Do ... LOOJl slruclurcs 
work in a similar rashion, wilh lhc inncrmosl Loop sl<llcmcnl malclting lhc 
inncrmosl Do slatemcnt. 

Exiting a Control Structure 
Thc I~xit slalcmcnl allows you lo cxil dirc¡;lly rrom a For loop, Do loop, Sub 
proccuure, or Functiun proccdurc. Syntactically, lhe Exit slalcmcnt is simple: 
Exit Fur can <lppcar as mariy times as nccdcu insidc a For loop, and Exit Do can 
appcar as many times as nccdcd insidc a Du loop: 

Forcmmtcr = start To cnd [Stcp illcrcmcJitl 
1 statcmelltblock 1 
[ExitForl 
1 statclllelltblock 1 

Ncxt lcrlll/1/a(, COII/III.'/'1 r .... 11 

L>ol { Whilc 1 Until] co11ditio11l 
l.,·wtcmclltblock 1 
1 Exit Dol 
lstatcllll'lltblock 1 

Loop 

~'1 
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Thc Exit Do statcmcnt works with all vnsions of thc Do loop syntax. 

Exit For ami Exit Do are uscful bccausc somctimcs it's appropriatc to quita loop 
immcdiatcly, without pcrfonning any furthcr itcrations or statcmcnts within thc 
loop. For cxamplc, in thc previous cxamplc that printcd ti1c fonts common lo both 
thc Scrccn and Prin\cr, thc ende continucs to comparc'Printcr fonts against a givcn 
Scrccn font cvcn whcn a match has airead y bccn found with an carlicr Printcr 
font. 1\ more cflicicnt vcrsion of thc runl'linn would cxit the loop ;,s soon as a 
match is found: 

Sub Form_Click () 
Oi1n SFont, PFont 

For SFont- 0 To Screen.FontCo~nt - 1 
For PFont- 0 To rrinter.FontCount - 1 

lf Screen.Fonts(SFont)- rrlriter.Fonts(rfontl Then 

' rrlnt Screen.Fonts(Sfontl 
Exlt For 

End 1 f 
Next PFont 

Next SFont 
End Sub 

Exlt inner loop. 

1 

i\s this cxamplc illustratcs, an Exit statcmcnt almost :dways appcars insidc an If 
statcmcnt or Sclcct Case statcmcnt ncstcd insidc thc'loop. 

Exiting a Sub or Function Procedure . 
Thc syntax of Exit Sub ami Exit Function is similar to that of Exil For and Exit 
Do in thc prcvious scction, "Exiting a Control Structurc." Exil Sub ean appcar as 
many times as nccdcd, anywhcrc within thc body ora Sub proccdurc. Exit 
Funrtion can appcar as many tinics as nccdcd, anywlu:rc within thc body of a 
Function proccdurc. 

Exil Sub ami Exit Function are uscful whcn thc proccdurc has done l'vcrything it 
nccds tu do ami ean rcturn immcdiatcly. For cxamplc, if you want to changc thc 
prcvious cxamplc so it prints only the lirst common Printcr ami Snccn font it 
finds, yuu would uscExil Sub: 

Sub Form_.Cl 1 e k ( 1 
Dlm SFont. rFont 

For SFont - 0 To Screen.FontCount - 1 
For PFont- 0 To Printer.FontCount - 1 

Jf Screen.Fonts(SFont) - Printer.Fonts(rFontl Thcn 
Print Screen.Fonts(Sfo¡¡t) 
Exlt Sub ' Exit-the procedure. 

End 1 f 
Next PFont 

ttext SFont 
End Sub 

1 
' 

··-~ 
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Modulo 1 

Global A 
• Dim MI 

[J l'roccdurc 1 

Dim X 

-1 J•nu..:cdurc2 

·Di m Y 

r 

r 

r 
r-

Can access A, B, M1, and X 
Canno! access M2, Y, or Z 

Can access A, B, M2, and Z -
Cannot acccss M 1, X, or Y 

Can access A, B, M1, and Y 
Cannot access M2, X, or Z 

Figurl' 7.1 Visihility nf v:Jri:~hlt•s with tliiTt•rent scnpes 

Name Conflicts and Shadowing 

Mmlulc2 

Global B 
Dim M2 

-J Proccdurc3 ~ 

Dim Z 

A variable cannol change scope while your code is running. Howevcr, you can 
ha ve a variable wilh lhe same name al a diffcrcnl scope. f'or examplc. you coultl 
ha ve a global vari:1ble called Temp amllhcn, wilhin a proccdurc, declare a local 
variable callcd Temp. Rcfercnccs lo the name Temp within lhc proccdurc would 
acccss ihe local variable; rcfercnces lo Temp outsidc the proccdurc would acccss 
the global variable. 

In general, when variables have the samc name bul di ITeren! scopc (see Figure 
7.1 ). !he more local variable always slwdoli'S (is acccssed in prefercncc to) lcss 
local variables·. So ir yo u al so had a modulc-lcv~l variable named T emp. it would 
shi1dow lhe global variable Temp wilhin thalmodule (amlthe local Temp would 
shadow the module-leve! Temp within that proccdurc). 

Y ou can al so declare a variable with the same na me as a form propcrty. Within 
the codc in a fonn module, a variable \vith the same name as a form property 
shadows the propcrly. Ir you wanl to access a fonn propcrty thal is shadowcd by a 
variable. you must qualify the propcrly na me with a rcfcrcnce lo lhc form i~:~mc or 
!he Me keywonl. Within form ende, similarly. variables with thc samc namcs as 
controls on 1hc fonn shadow thc controls. You must qualify lhe conlrol with a 
refcrcnce lo thc fonn or Meto scl or gel ils value or any of its propcnics. f'or 
ex:unplc: 

Sub Form Click () 
Dim Textl. BackColor 

"'1 

1 
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Data Type and Scoping Differences 
In Visu:d Basic for MS-DOS, thc dd'ault data typc is SIN\. LE. In Visualllasic 
ror Windows, the dd"ault data type is V:lriant. This diiTcrencc can cause serious 
crrors using C.ct and Pnt on cxisting data files, since thc two data types are 
di ITeren! sizcs. To avoid this, add a Dci'Sn¡.: statcment to cach module that docsn'.t 
aln:ady includc a Dcf1y¡w statcment. 

To remain consisten! with carlier versions or llasic, Visual Basic rur M S-DOS 
does not allow shared ;u-ray variables lo he shadowed al the procedurc leve!. For. 
esample. !he J'ollowing ende hchaves di!Tercntly in MS-DOS ami Windows: 

• Module level 
. 1 DIM SI!ARED Array( l AS INTEGER 
/ 

SUB ChangeArray () 
In MS-DOS. dlmenslons shared array. In Wlndows, creates 

· a new copy of the array. (shadows sl1ared array). 
DIM Array(J0) 

END SUB 

To avoid Ihis unexpccted bd1avior. rename !he proccdurc-lcvcl arra y. 

Unsupported Keywords 
Visual 13asic ror Windóws omits about 100 kcywonls that are supporlcd by Visual 
llasic ror MS-DOS. Using any or thcsc keywonls in the M S-DOS application that 
you converl to Windows rcsults in omitted runctionality. Youmust rcwritc any 
codc that rclies on thcsc kcywords. 

• 1 

1\LL CSRLIN EIU>EV$ 

BLOAD CVI EVENT 

BOF cvc FIELI> 

liSA VE CVD FILES 

CALLS CVDMBF FN 

CDECL CVL Fin: 

CHAl N cvs (;ETINDEX$ 

CHECKPOINT CVSMBF INKEY$ 

COLOR DELETEINDEX INP 

COM DELETETABI.E INSERT 

COMMON DRAW IOCTL 

CREATEINDEX EIU>EV IOCTL$ )1.-



Appcndix C Compalibilily with Othcr Vcrsions 

ISA M I'MAI' SSE< ;A DD 

KEY I'OKE STACK 

I.IST I'OS STICK 

LOCATE I'IU\SET STIU<; 

LI'OS RUN SWAI' 

LI'IUNT SADD SYSTEM 

~IKC$ SAYEI'OINT TEXTCOMI' 
' 

i'dKDMBF$ SCIU:EN TIWN 

i\1 K 1$ SEEKEQ TIWFF 

i\IKL$ SEEKGE lJEYENT 

i\IKS$ SEEKGT 
,.. 

UI'I>ATE 

i\IKSMBF$ SEG YARI'TR 

OUT SETINDEX YARI'TR$ 

I'AINT SETMEM YARSEG 

1'1\I,ETTE SETUEYENT VIEW 

I'COI'Y SIGNAL WAIT 

I'EEK SLEEI'· WINDOW 

I'EN SOUND 

PLAY SSEG 

Note Visual Uasil: l'or Winuows .tlocs not suppnrt DEF FN l'um:tions. 

Differen.t Coding Mechanisms 
Thc scopjng mcdwnisms are dillcrcnt hctwccn Visual B;tsic ror MS-DOS ami 
Wintlows. as shown by thc l'ollowing tablc. 

Visual llasic l"nr MS-nos cnnstructinn ViSlt:ll llasic l"nr Wimlnws ~i¡uiYalcnt 

COMI\ION SIIARED (;)ohal. 

llim (:~lmudulc lcvd). 

635 

l>li\1 SIIARED (:~lnu,\lulc leve!) 

Sllt\1{1•:1) :~uribulc (;11 proccdurc leve!) Nonc. Us~...· tnmluk-kvd variable. whil:h is 
visible lo all proeedun.:s. 

COI\11\ION Nonc. i\lodulc-lcvd-·only v:~ri:~blcs :~re nol 
.uscl'ul in Visu:~l B:~sic l'or Wimlows. "J 1 

'· 
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1>- To open the Code window 

• Double-click the fonn or control on the fonn for which vou want to \Hite . . 
code. 

-Or-

• From the Project window. select the name of the fonn and choose the View 
Code bu non. 

Figure 2.5 shows the Code window that appears when you double-click the 
command button control. 
\ 

1! 

11 

1 

Forml.lnn · '·d~; aa 

End Sub 

Figure 2.5 The Code Window 

The Code window includes the following elements: 

Events for Command1 

• Object box-Displays the name of the selected object. Click the arrow to the 
right of the list box to display a list of all objects associated with the form. 

• Procedure list box-Lists the procedures for an object. The box displays the 
name of the selected procedure-in this case. Click. Choose the arrow to the 
right of the box to display all the procedures for the object. 

Code in a \'i<ual Basic applic:;tion is dil'ided into smJiler blocks c:!lled 
;:rr,ct"t':'ures. :-\n e¡·cnl procc,fure. ~uch a::: tho~e y0u·ll crt:~~e h~r=. conL:ins. colL 
::1~t i$ .:xcct:ted when ~:n eYC:it C"~ctur~ (Such 3.~::. u:=:er click1n'; ~ h'>.!tton l. F<.•r r:--., 
ini·armation on other types of pi0~edures ánd eYent-dri\·cn pro;r::.mming in 
general. see Chapter 6. "Programming Fundamentals ... 



For example. you can use a prefix to describe the obj~ct type. followed by a 
descriptive name· for the control. This makes the cede more self-documenting and 
alphabetically groups similar objects together in the Properties \\•indow in the 
Object list box. 

The following naming com·entions for Visual Basic objects are used throughout 
this manual. 

Table·3.1 Object :"aming Con\'entions for Visual Basic 

Object Prefix 

Form fmt 

Check box eh k 

Combo box cbo 

Command bunon cmd 

Data dat 

Director:· list box dir 

Dri,·e list box dn· 

File list box til 

Frame fra 

G~ ~~ 
1 

Horizontal scroll bar hsb 

Image img 

Label lbl 

Line lin 

List box 1st . 

!llenu mnu 

OLE ole 

Option bu non opt · 

Picture box pie 

5~3¡:":! ICi:-..:!e. :'(!U3.J't:'. C\\·~:J. :o:hp 
:-c,::~::·;f.k. :""\)~J:hj~J :-e.:t~:nfl::. 

:..:::d :·c\·...::1::::-: 'q'i.H:re -, 

Timer 

Venical scroll bar 

:.\t 

tmr 

\'Sb 

Example 

frmFileOpen 

chl:ReadOnly 

cboEnglish 

cmdCancel 

datBiblio 

dirSource 

dnTarget 

fi!Source 

fraLanguage 

grdPrices 

hsbVolume 

imglcon 

lb!Help!lfessage 

Ji n \' enical 

lstPolicyCodes 

mnuFileOpen 

oleObjectl 

optFrench 

picDiskSpace 

:-hpCircle 

~:-.:G::tTc.\t 

tmrAiann 

,·sbRate 

• 

\ 

/ 
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Chapter 2 Your Flrst Visual Basic Applic· 

Action 

Creates a new form 

Creates a new module 

Opens an existing project 

Saves the current project 

Dispiays the Menu Design 
window 

Displays the Properties 
window 

Starts an application in 
design mode 

Stops execution of a 
program while it's running 

Stops execution of an 
application and returns to 
design mode 

Toggies breakpoint on the 
current line 

Dispiays the value of the 
curren! seiection in the Code 
window 

Displays the structure of 
active calls 

Executes code one statement 
at a time in the Code 
window 

Executes code one 
procedure or statement at a 
time in the Code window 

Menu equivalen! 

New Form command oo the File menu 

New Module command on the File menu 

Open Project command on the File menu 

Save Project command on the File menu 

Menu Design command on the Window 
menu 

Properties command on the Window menu 

Start command on the Run menu 

Break command on the Run menu 

End command on the Run menu 

Toggle Breakpoint on. the Debug menu 

Instan! Watch on the Debug menu 

Calls command on the Debug menu 

Single Step command on the Debug menu 

Procedure Step command on the Debug 
menu 

) 

· Toolbox Provides a set of tools that you use at design time to place controls on a 
forro. For information on the specific controls. see Chapter 3, "Creating and Using 
Controls:· 

Menu Bar Displays the commands you use to build.your application. 

Form Serves as a window that you customize as the interface of your application~ 
Y o u add controls, graphics, and pictures to a forro to cre~te the loo k yo u want. :u-


